Please note that you can always find the most up-to-date technical documentation on our Web site at http://www.vmware.com/support/.

The VMware Web site also provides the latest product updates.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introducing VMware VirtualCenter</td>
<td>13</td>
</tr>
<tr>
<td>VirtualCenter Overview</td>
<td>14</td>
</tr>
<tr>
<td>About This Manual</td>
<td>15</td>
</tr>
<tr>
<td>Intended Audience</td>
<td>15</td>
</tr>
<tr>
<td>Document History</td>
<td>15</td>
</tr>
<tr>
<td>Conventions</td>
<td>16</td>
</tr>
<tr>
<td>Abbreviations</td>
<td>16</td>
</tr>
<tr>
<td>Understanding the Components</td>
<td>17</td>
</tr>
<tr>
<td>Managed Components</td>
<td>17</td>
</tr>
<tr>
<td>Software Components</td>
<td>18</td>
</tr>
<tr>
<td>Organizational Components</td>
<td>19</td>
</tr>
<tr>
<td>Functional Components</td>
<td>21</td>
</tr>
<tr>
<td>Access Privileges Components</td>
<td>22</td>
</tr>
<tr>
<td>Operations Overview</td>
<td>25</td>
</tr>
<tr>
<td>Understanding Virtual Machines and Hosts</td>
<td>27</td>
</tr>
<tr>
<td>Understanding Templates</td>
<td>27</td>
</tr>
<tr>
<td>Cloning Virtual Machines</td>
<td>31</td>
</tr>
<tr>
<td>Understanding Customization</td>
<td>32</td>
</tr>
<tr>
<td>Understanding Migration</td>
<td>33</td>
</tr>
<tr>
<td>Understanding New Virtual Machines</td>
<td>34</td>
</tr>
<tr>
<td>Understanding Scheduled Tasks</td>
<td>35</td>
</tr>
<tr>
<td>Understanding Events</td>
<td>35</td>
</tr>
<tr>
<td>Understanding Alarms</td>
<td>35</td>
</tr>
<tr>
<td>Understanding the User Interface</td>
<td>35</td>
</tr>
<tr>
<td>Performing Actions</td>
<td>36</td>
</tr>
</tbody>
</table>

## VMware VirtualCenter Requirements and Resources  39

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware VirtualCenter Requirements</td>
<td>40</td>
</tr>
<tr>
<td>VirtualCenter Server Requirements</td>
<td>40</td>
</tr>
<tr>
<td>VirtualCenter Client Requirements</td>
<td>41</td>
</tr>
<tr>
<td>VirtualCenter Database Requirements</td>
<td>41</td>
</tr>
<tr>
<td>VMware SDK Requirements</td>
<td>42</td>
</tr>
<tr>
<td>VirtualCenter Managed Host Requirements</td>
<td>43</td>
</tr>
<tr>
<td>GSX Server or VMware Server as Managed Host Requirements</td>
<td>43</td>
</tr>
<tr>
<td>VirtualCenter Managed Virtual Machine Requirements</td>
<td>44</td>
</tr>
</tbody>
</table>
VirtualCenter Networking Requirements ___________________________44
VirtualCenter Licensing Requirements _____________________________47
VirtualCenter VMotion Requirements ______________________________48
VirtualCenter Template Requirements _____________________________50
VirtualCenter Guest Operating System Customization Requirements _____51
Technical Support Resources ______________________________________54
Documentation on the Web ______________________________________54
VMware Knowledge Base _________________________________________54
VMware Newsgroups ____________________________________________54
VMware Community _____________________________________________54
Reporting Problems _____________________________________________55
Viewing System Logs __________________________________________56
Collecting Log Files ___________________________________________58

Installing VMware VirtualCenter __________________________________65
Preparing for the VirtualCenter Database __________________________67
Preparing to use a VirtualCenter Database ___________________________67
Configuring Oracle 8i, 9i, or 10g Connection to Work Locally __________68
Configuring Oracle 8i, 9i, or 10g Connection to Work Remotely __________68
Configuring a SQL Server ODBC Connection _________________________69
Configuring the Microsoft Access Database _________________________72
Maintaining Your VirtualCenter Database __________________________73
Installing and Upgrading the VirtualCenter Product ___________________75
Starting the VirtualCenter Installer for a First Time Installation ________76
Starting the VirtualCenter Installer for an Upgrade Installation __________77
Selecting the Components to Install ______________________________80
Installing the VirtualCenter Server ________________________________83
Installing the VMware Web Service _______________________________87
Completing the Installation _____________________________________89
Finishing VirtualCenter Web Service Installation _____________________91
Verifying VirtualCenter Web Service Installation _____________________91
Changing VMware Web Service Options After Installation _____________95
Updating VMware SDK Digital Certificates _________________________98
Configuring Communication Between VirtualCenter Components ________100
Connecting to Your VirtualCenter Clients Through a Firewall __________100
Connecting to Your VirtualCenter Hosts Through a Firewall ___________101
Uninstalling VirtualCenter ________________________________________103
Uninstalling VirtualCenter Using the Windows Add/Remove Tool ______103
Uninstalling VirtualCenter Using the VirtualCenter Installer ____________104
Uninstalling a VirtualCenter Component ____________________________106
  Uninstalling a VirtualCenter Component Using the Windows Add/Remove Tool ________________________________106
  Uninstalling a VirtualCenter Component Using the VirtualCenter Installer 107
Adding a VirtualCenter Component _________________________________________109

Starting VMware VirtualCenter ____________________________________117
Starting or Stopping VMware VirtualCenter __________________________118
  Getting Started with VirtualCenter Users ___________________________________________118
  Verifying the VirtualCenter Server Has Started ___________________________________119
  Restarting the VirtualCenter Server ____________________________________________119
  Stopping the VirtualCenter Server _____________________________________________120
  Restarting the VirtualCenter Host Agent _________________________________________121
Starting and Stopping the VirtualCenter Client ______________________124
  Starting the VirtualCenter Client and Logging On _______________________________124
  Stopping the VirtualCenter Client and Logging Off _____________________________126
Adding Licenses _____________________________________________________127
Configuring Communication Through a Firewall ______________________129
  Configuring the Port VirtualCenter Uses to Communicate with the VirtualCenter Client ______________________________________________________129
  Configuring VirtualCenter Communication Over a Web Connection _____________130
Navigating in the VirtualCenter Client _______________________________133
  Selecting Objects ___________________________________________________________133
  Monitoring Objects _________________________________________________________135
  Performing Actions on Objects ________________________________________________136

Working with the VirtualCenter Client ______________________________139
Introducing the VirtualCenter Client Window _________________________140
  Menu Bar _________________________________________________________________141
  Popup Menus _____________________________________________________________142
  Console Menu _____________________________________________________________142
  Navigation Bar __________________________________________________________________143
  Toolbar ________________________________________________________________________145
  Status Bar _____________________________________________________________________147
  Panel Sections __________________________________________________________________147
Understanding the Information Elements ____________________________150
  Symbol Information Elements ________________________________________________150
  Attribute Elements _________________________________________________________151
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing VMware Tools</td>
<td>260</td>
</tr>
<tr>
<td><strong>Working with Templates</strong></td>
<td>261</td>
</tr>
<tr>
<td>Understanding Templates</td>
<td>263</td>
</tr>
<tr>
<td>Template Restrictions</td>
<td>268</td>
</tr>
<tr>
<td>Preparing for Templates</td>
<td>269</td>
</tr>
<tr>
<td>Specifying an Upload Directory for Templates</td>
<td>269</td>
</tr>
<tr>
<td>Configuring ESX Server to Allow Concurrent Template Deploys</td>
<td>270</td>
</tr>
<tr>
<td>Configuring Datastores on GSX Server or VMware Server Hosts</td>
<td>271</td>
</tr>
<tr>
<td>Using a GSX Server or Workstation Virtual Machine as a Template</td>
<td>273</td>
</tr>
<tr>
<td>Using an ESX Server Golden Image as a Template</td>
<td>274</td>
</tr>
<tr>
<td>Using an Unmanaged Virtual Machine as a Template</td>
<td>274</td>
</tr>
<tr>
<td>Using a Managed Existing Host Virtual Machine as a Template</td>
<td>275</td>
</tr>
<tr>
<td>Creating Templates</td>
<td>276</td>
</tr>
<tr>
<td>Cloning a Template</td>
<td>283</td>
</tr>
<tr>
<td>Deleting a Template</td>
<td>285</td>
</tr>
<tr>
<td>Deleting a Template from VirtualCenter</td>
<td>285</td>
</tr>
<tr>
<td>Deleting a Template from Disk</td>
<td>285</td>
</tr>
<tr>
<td>Editing a Template</td>
<td>287</td>
</tr>
<tr>
<td>Reimporting a Template</td>
<td>289</td>
</tr>
<tr>
<td><strong>Copying Virtual Machines</strong></td>
<td>291</td>
</tr>
<tr>
<td>Cloning and Template Restrictions</td>
<td>293</td>
</tr>
<tr>
<td>Creating Virtual Machines from a Template</td>
<td>294</td>
</tr>
<tr>
<td>Manually Deploying Virtual Machine from a Template</td>
<td>296</td>
</tr>
<tr>
<td>Creating a Scheduled Task to Deploy a Template</td>
<td>302</td>
</tr>
<tr>
<td>Creating Virtual Machines by Cloning an Existing Virtual Machine</td>
<td>307</td>
</tr>
<tr>
<td>Manually Cloning a Virtual Machine</td>
<td>308</td>
</tr>
<tr>
<td>Creating a Scheduled Task to Clone a Virtual Machine</td>
<td>312</td>
</tr>
<tr>
<td><strong>Customizing Guest Operating Systems</strong></td>
<td>317</td>
</tr>
<tr>
<td>Preparing for Guest Customization</td>
<td>319</td>
</tr>
<tr>
<td>Installing the Microsoft Sysprep Tools</td>
<td>319</td>
</tr>
<tr>
<td>Installing the VMware Open Source Components</td>
<td>321</td>
</tr>
<tr>
<td>Beginning the Guest Customization Process</td>
<td>324</td>
</tr>
<tr>
<td>Entering the Guest Customization Wizard from the Template Deployment Process</td>
<td>324</td>
</tr>
<tr>
<td>Entering the Guest Customization Wizard from the Cloning Process</td>
<td>325</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Customizing New Guest Operating Systems</td>
<td>327</td>
</tr>
<tr>
<td>Customizing a Windows Guest Operating System</td>
<td>327</td>
</tr>
<tr>
<td>Customizing a Linux Guest Operating System</td>
<td>338</td>
</tr>
<tr>
<td>Completing a Guest Operating System Customization</td>
<td>342</td>
</tr>
<tr>
<td>Completing Linux Guest Operating System Customization</td>
<td>342</td>
</tr>
<tr>
<td>Completing Windows Guest Operating System Customization</td>
<td>342</td>
</tr>
<tr>
<td>Completing a Guest Operating System Customization</td>
<td>342</td>
</tr>
<tr>
<td>Completing Linux Guest Operating System Customization</td>
<td>342</td>
</tr>
<tr>
<td>Completing Windows Guest Operating System Customization</td>
<td>342</td>
</tr>
<tr>
<td>Editing an Existing Virtual Machine Configuration</td>
<td>345</td>
</tr>
<tr>
<td>Beginning to Edit the Virtual Machine Configuration</td>
<td>346</td>
</tr>
<tr>
<td>Changing the Hardware Configuration of a Virtual Machine</td>
<td>348</td>
</tr>
<tr>
<td>Changing the DVD/CD-ROM Drive Configuration</td>
<td>348</td>
</tr>
<tr>
<td>Changing the Floppy Drive Configuration</td>
<td>350</td>
</tr>
<tr>
<td>Changing the Generic SCSI Device Configuration</td>
<td>351</td>
</tr>
<tr>
<td>Changing the Virtual Disk Configuration</td>
<td>351</td>
</tr>
<tr>
<td>Changing the Memory Configuration</td>
<td>354</td>
</tr>
<tr>
<td>Changing the Virtual Ethernet Adapter (NIC) Configuration</td>
<td>355</td>
</tr>
<tr>
<td>Changing the Parallel Port Configuration</td>
<td>358</td>
</tr>
<tr>
<td>Changing the SCSI Controller Configuration</td>
<td>358</td>
</tr>
<tr>
<td>Changing the Serial Port Configuration</td>
<td>360</td>
</tr>
<tr>
<td>Changing the Virtual Processor (or CPU) Configuration</td>
<td>362</td>
</tr>
<tr>
<td>Changing the Audio Configuration</td>
<td>363</td>
</tr>
<tr>
<td>Changing the Mouse Configuration</td>
<td>365</td>
</tr>
<tr>
<td>Changing the USB Configuration</td>
<td>366</td>
</tr>
<tr>
<td>Adding Hardware to a Virtual Machine</td>
<td>367</td>
</tr>
<tr>
<td>Adding a DVD/CD-ROM Drive</td>
<td>368</td>
</tr>
<tr>
<td>Adding a Floppy Drive</td>
<td>371</td>
</tr>
<tr>
<td>Adding a Generic SCSI Device</td>
<td>371</td>
</tr>
<tr>
<td>Adding a Hard Disk</td>
<td>372</td>
</tr>
<tr>
<td>Adding an Ethernet Adapter (NIC)</td>
<td>374</td>
</tr>
<tr>
<td>Adding a Parallel Port</td>
<td>375</td>
</tr>
<tr>
<td>Adding a Serial Port</td>
<td>377</td>
</tr>
<tr>
<td>Adding a USB Controller</td>
<td>381</td>
</tr>
<tr>
<td>Adding a Virtual Sound Adapter</td>
<td>382</td>
</tr>
<tr>
<td>Changing Virtual Machine Options</td>
<td>383</td>
</tr>
<tr>
<td>Changing General Settings</td>
<td>383</td>
</tr>
<tr>
<td>Changing Power State Options</td>
<td>384</td>
</tr>
<tr>
<td>Changing Advanced Settings</td>
<td>385</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Changing Virtual Machine Resource Settings</td>
<td>387</td>
</tr>
<tr>
<td>Scheduling a Resource Settings Change</td>
<td>388</td>
</tr>
<tr>
<td>Changing Processor (or CPU) Settings</td>
<td>389</td>
</tr>
<tr>
<td>Changing Memory Settings</td>
<td>390</td>
</tr>
<tr>
<td>Changing Disk Settings</td>
<td>392</td>
</tr>
<tr>
<td>Changing Network Settings</td>
<td>393</td>
</tr>
<tr>
<td><strong>Working with Scheduled Tasks</strong></td>
<td>395</td>
</tr>
<tr>
<td>Understanding Scheduled Tasks</td>
<td>396</td>
</tr>
<tr>
<td>Creating a Scheduled Task</td>
<td>397</td>
</tr>
<tr>
<td>Rescheduling a Task</td>
<td>403</td>
</tr>
<tr>
<td>Removing a Scheduled Task</td>
<td>404</td>
</tr>
<tr>
<td>Cancelling a Scheduled Task</td>
<td>405</td>
</tr>
<tr>
<td><strong>Working with Alarms and Events</strong></td>
<td>407</td>
</tr>
<tr>
<td>Events and Alarms Overview</td>
<td>408</td>
</tr>
<tr>
<td>Working with Events</td>
<td>409</td>
</tr>
<tr>
<td>Viewing All VirtualCenter Events</td>
<td>410</td>
</tr>
<tr>
<td>Viewing Selected VirtualCenter Events</td>
<td>410</td>
</tr>
<tr>
<td>Sorting and Filtering Event Messages</td>
<td>411</td>
</tr>
<tr>
<td>Exporting Events</td>
<td>412</td>
</tr>
<tr>
<td>Working with Alarms</td>
<td>414</td>
</tr>
<tr>
<td>Preparing for Email Message SMTP Alarm Notification</td>
<td>415</td>
</tr>
<tr>
<td>Preparing for SNMP Alarm Notification</td>
<td>416</td>
</tr>
<tr>
<td>Creating Alarms</td>
<td>420</td>
</tr>
<tr>
<td>Editing Alarms</td>
<td>425</td>
</tr>
<tr>
<td>Removing Alarms</td>
<td>426</td>
</tr>
<tr>
<td><strong>Working with the VirtualCenter Data</strong></td>
<td>429</td>
</tr>
<tr>
<td>VirtualCenter Data Overview</td>
<td>431</td>
</tr>
<tr>
<td>Viewing Scheduled Tasks</td>
<td>434</td>
</tr>
<tr>
<td>Viewing Templates</td>
<td>436</td>
</tr>
<tr>
<td>Viewing VirtualCenter Events</td>
<td>437</td>
</tr>
<tr>
<td>Viewing the VirtualCenter Inventory</td>
<td>439</td>
</tr>
<tr>
<td>Understanding the Inventory Panel</td>
<td>439</td>
</tr>
<tr>
<td>Understanding the Information Panel</td>
<td>439</td>
</tr>
<tr>
<td>Understanding the Summary Tabs</td>
<td>441</td>
</tr>
<tr>
<td>Viewing the Farm Summary Tab</td>
<td>441</td>
</tr>
<tr>
<td>Viewing the Host Summary Tab</td>
<td>443</td>
</tr>
</tbody>
</table>
This chapter introduces VMware VirtualCenter components and operations. This chapter describes the contents of this manual and provides additional references for support. This chapter contains the following topics:

- VirtualCenter Overview on page 14
- About This Manual on page 15
- Understanding the Components on page 17
- Operations Overview on page 25
VirtualCenter Overview

VMware VirtualCenter is virtual infrastructure management software that centrally manages an enterprise's virtual machines as a single, logical pool of resources. VirtualCenter provides the central point of control for workload management, provisioning and availability. It simplifies IT so that companies can leverage their storage, network, and computing resources to control costs and respond faster to changing business demands.

VMware VirtualCenter exploits the benefits of a virtual infrastructure. With VirtualCenter, an administrator can manage thousands of Windows NT, Windows 2000, Windows Server 2003, Linux, and Netware servers from a single point of control.

The VirtualCenter interface provides a powerful overview of all the virtual resources in a data center. From the VirtualCenter interface, administrators can perform:

- **Continuous Workload Consolidation** – Monitor and optimize the utilization of data center resources to minimize unused capacity while maintaining application service levels, by adjusting the resources dedicated to each software service.

- **Instant Provisioning** – Reduce server-provisioning time from weeks to tens of seconds, allowing administrators to respond immediately to requests for IT services. Using server templates, administrators can ensure that new servers are fully consistent with current build and security policies.

- **Zero-Downtime Maintenance** – Safeguard business continuity 24/7, with no service interruptions for hardware maintenance, deployment, or migration. Use VMotion to move running operating systems and their applications off a system that needs maintenance, and then transfer them back when maintenance completes.

The heart of VirtualCenter is the VirtualCenter server, which collects and stores persistent data in a dedicated database that contains per-system and environmental information. The VirtualCenter server automatically executes user-specified scheduled tasks, such as powering on or moving powered-off virtual machines. VirtualCenter with VMotion moves a virtual machine from one managed host to another, while the virtual machine continues operation. This form of migration with VMotion occurs without service interruption on the virtual machine.
CHAPTER 1 Introducing VMware VirtualCenter

About This Manual

This manual, the *VMware VirtualCenter User’s Manual*, describes how to install, configure, and use VMware VirtualCenter to provision, migrate, monitor and manage the virtual machines through the single VMware VirtualCenter interface using virtual farms and groups for organizational ease of operation.

**Intended Audience**

The information presented in this manual is written for system administrators who are experienced Windows or Linux system administrators and who are familiar with virtual machine technology.

**Document History**

*VirtualCenter User’s Manual*, Revision 20060706, Item No. VC-ENG-Q306-195

This manual is revised with each release of the product or when deemed necessary. A revised version can contain minor or major changes.

<table>
<thead>
<tr>
<th>Release</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release 1.4</td>
<td>July 7, 2006</td>
<td>PDF, HTML on web, PDF on CD, Help, Printed</td>
</tr>
<tr>
<td>Release 1.3.x</td>
<td>December 15, 2005</td>
<td>PDF, HTML on web</td>
</tr>
<tr>
<td>Release 1.3</td>
<td>September 22, 2005</td>
<td>PDF, HTML on web, PDF on CD, Help, Printed</td>
</tr>
<tr>
<td>Add GSX Server 3.2 support</td>
<td>July 1, 2005</td>
<td>PDF, HTML on web</td>
</tr>
<tr>
<td>Update VMotion compatibility statement</td>
<td>May 2, 2005</td>
<td>PDF, HTML on web</td>
</tr>
<tr>
<td>Release 1.2 patch 1</td>
<td>March 16, 2005</td>
<td>PDF, HTML on web</td>
</tr>
<tr>
<td>Release 1.2</td>
<td>December 2, 2004</td>
<td>PDF, HTML on web, PDF on CD, Help, Printed</td>
</tr>
<tr>
<td>Patch release 1.1.1</td>
<td>August 27, 2004</td>
<td>PDF Printed</td>
</tr>
<tr>
<td>Patch release 1.1.1</td>
<td>August 3, 2004</td>
<td>PDF, HTML on web, PDF on CD, Help</td>
</tr>
<tr>
<td>Release 1.1</td>
<td>June 24, 2004</td>
<td>PDF, HTML on web, PDF on CD, Help, Printed</td>
</tr>
<tr>
<td>Release 1.0.1</td>
<td>March 29, 2004</td>
<td>PDF, HTML on web, Help</td>
</tr>
<tr>
<td>Release 1.0, editorial updates</td>
<td>January 6, 2004</td>
<td>PDF, HTML on web</td>
</tr>
<tr>
<td>First Release 1.0</td>
<td>December 5, 2003</td>
<td>PDF, HTML on web, PDF on CD, Help, Printed</td>
</tr>
</tbody>
</table>

To view the most current version of the manual, refer to the VMware Web site:


## Conventions

The following conventions are used in this manual.

<table>
<thead>
<tr>
<th>Style</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>blue (online only)</td>
<td>Cross references, links</td>
</tr>
<tr>
<td>Courier</td>
<td>Commands, filenames, directories, paths, user input</td>
</tr>
<tr>
<td>Semi-Bold</td>
<td>Interactive interface objects, keys, buttons</td>
</tr>
<tr>
<td>Bold</td>
<td>Items of highlighted interest, terms</td>
</tr>
<tr>
<td>italic</td>
<td>Variables, parameters</td>
</tr>
<tr>
<td>italic</td>
<td>Web addresses</td>
</tr>
</tbody>
</table>

## Abbreviations

The following abbreviations are used in the graphics in this manual.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VC</td>
<td>VirtualCenter</td>
</tr>
<tr>
<td>UI</td>
<td>VirtualCenter client</td>
</tr>
<tr>
<td>server</td>
<td>VirtualCenter server</td>
</tr>
<tr>
<td>database</td>
<td>VirtualCenter database</td>
</tr>
<tr>
<td>farmn</td>
<td>VirtualCenter farms</td>
</tr>
<tr>
<td>hostn</td>
<td>VirtualCenter managed hosts</td>
</tr>
<tr>
<td>VM#</td>
<td>virtual machines on a managed host</td>
</tr>
<tr>
<td>user#</td>
<td>users with access permissions</td>
</tr>
<tr>
<td>dsk#</td>
<td>storage disk for the managed host</td>
</tr>
<tr>
<td>datastore</td>
<td>storage for the managed host</td>
</tr>
<tr>
<td>SAN</td>
<td>storage area network type datastore shared between managed hosts</td>
</tr>
<tr>
<td>tmp1t</td>
<td>template</td>
</tr>
</tbody>
</table>
Understanding the Components

VirtualCenter components are discussed in the following sections:

- Managed Components
- Software Components
- Organizational Components
- Functional Components
- Access Privileges Components

Managed Components

VirtualCenter monitors and manages various components of your virtual and physical infrastructure:

- **Virtual machines** – A virtualized x86 personal computer environment in which a guest operating system and associated application software can run. Multiple virtual machines can operate on the same managed host machine concurrently.

**Virtualization platforms** are VMware products, such as ESX Server, GSX Server, VMware Server, or Workstation. These are used to create the virtual machines in the form of a set of configuration and disk files that together perform all the functions of a physical machine. Through the virtualization platform, you run the virtual machines, install operating systems and run applications, and configure the virtual machines, which includes identifying the virtual machine's resources, such as storage devices.

- **Hosts** – The physical computers on which the virtualization platform software, such as ESX Server, GSX Server, or VMware Server, is installed. They host the VirtualCenter virtual machines.

  **Note:** When VirtualCenter refers to a host, this means the physical machine on which the virtual machines are running. All virtual machines within the VirtualCenter environment are physically on ESX Server, GSX Server, or VMware Server hosts. The term **host** in this manual means the ESX Server, GSX Server, or VMware Server host that has virtual machines on it.

- **Datastores** – The storage locations for the virtual machine files. Datastores hide the idiosyncrasies of various storage options, such as VMFS, SAN, GSX Server, VMware Server, and ESX Server, thereby providing a uniform model for managing GSX Server, VMware Server, and ESX Server hosts and various storage products in the context of virtual machine management.
Software Components
VMware VirtualCenter monitors and manages all the virtual machines and hosts managed by VirtualCenter. To perform these functions, VirtualCenter provides:

- **VirtualCenter client** – A user interface that runs locally on a Windows machine.
  
  The VirtualCenter client runs on a machine with network access to the VirtualCenter server. This can be on the same machine as the VirtualCenter server or on another machine with network access. The VirtualCenter client requires a computer monitor for access to the graphical user interface.

- **VirtualCenter server** – A service that acts as a central administrator for VMware servers connected on a network to direct actions upon the virtual machines and the virtual machine hosts. VirtualCenter server provides the central working core of VirtualCenter.

  VirtualCenter server is deployed as a Windows service and runs full-time. It must have network access to all the hosts it manages and be available for network access from any machine where the VirtualCenter client is run.

- **VirtualCenter Web service** – A service that can optionally be installed with the VirtualCenter server. It is a required component for third-party applications that use the VMware SDK application programmer interface (API).

- **VirtualCenter agent** – Installed on each managed host, it collects, communicates, and executes the actions received from the VirtualCenter server. It is installed automatically the first time any given host is added to the VirtualCenter inventory.

- **VMotion** – A feature that enables moving running virtual machines from one ESX Server to another without service interruption. It requires licensing on both the source and target host. The VirtualCenter server centrally coordinates all VMotion activities.

- **VirtualCenter database** – A persistent storage area, for maintaining status of each virtual machine, host, and user managed in the VirtualCenter environment. This can be local or remote to the VirtualCenter server machine.
The figure below illustrates the relationships between the VirtualCenter installed components. Refer to Abbreviations on page 16 for a description of abbreviations.

VMware SDK Components
The VMware SDK works with VirtualCenter but is not required for VirtualCenter operations. The VMware VirtualCenter SDK contains the following two components:

- **SDK package** – VMware SDK product documentation and examples files. This is installed through an external link and does not require VirtualCenter to be installed with it. This package is typically for developers only. To install the SDK package, refer to [www.vmware.com/support/developer/vc-sdk](http://www.vmware.com/support/developer/vc-sdk).

- **Web service** – A required component for third-party applications that use the VMware SDK application programmer interface (API). This is installed through the VirtualCenter installer and requires that the VirtualCenter server is also installed.

Organizational Components
Organizational components assist in the handling of the potentially hundreds of virtual machines. They can be renamed to represent their organization purposes; for
example, they can be named after company departments or locations or functions. The organizational components are:

- **Server Farms** – The top level structure for the VirtualCenter server. Only one Server Farms object exists for each VirtualCenter server. Server Farms can contain multiple farm groups and farms. The term *Server Farms* is the default value; the actual name used can be changed.

- **Farm Groups** – An optional grouping structure that is hierarchically contained within the Server Farms structure. The VirtualCenter server supports multiple farm groups. Farm groups can contain other farm groups and farms.

- **Farm** – The main structure under which hosts and their associated virtual machines are added to the VirtualCenter server. VirtualCenter server supports multiple farms.

  **Note:** A host can be managed by only one farm at a time.

  **Note:** All operations between hosts and virtual machines occur within a single farm. For example, hosts and virtual machines are not migrated between farms.

- **Virtual Machine Groups** – An optional grouping structure that is contained within a farm. VirtualCenter server supports multiple virtual machine groups. Virtual machine groups contain virtual machines and other virtual machine groups.

All the VirtualCenter components—the hosts, the virtual machines, and the organizational groupings of server farms, farms, and farm groups—are contained within the VirtualCenter environment.
The figure below illustrates the hierarchy of the VirtualCenter organizational components. Refer to Abbreviations on page 16 for a description of abbreviations.

**Functional Components**

The functional components are groups comprised of the monitoring and managing tasks. The functional components are:

- **Inventory** – A view of all the monitored objects in VirtualCenter. Monitored objects include Server Farms, farms, farm groups, hosts, virtual machines, and virtual machine groups.

- **Scheduled Tasks** – A list of activities and a means to schedule those activities.

- **Templates** – A means to import virtual machines and store them as templates for deploying at a later time to create new virtual machines.

- **Alarms** – A component that allows you to create and modify a set of alarms that you define. Alarms are applied to an object and contain a triggering event and a
notification method. Alarms do not have a navigation toolbar option. Alarms are viewed through the Alarms tab for each object.

**Events** – A list of all the events that occur in the VirtualCenter environment. Use the Navigation option to display all the events. Use an object specific panel to display only the events relative to that object.

The figure below illustrates the relationship of the VirtualCenter functional components. Refer to Abbreviations on page 16 for a description of abbreviations.

![VirtualCenter Functional Components](image)

### Access Privileges Components

Each VirtualCenter user logs on to the VirtualCenter service through the VirtualCenter client. Each VirtualCenter user is identified to the VirtualCenter as someone who has assigned rights and privileges to selected objects, such as farms and virtual machines, within the VirtualCenter environment. VirtualCenter itself has full rights and privileges on all hosts and virtual machines within the VirtualCenter environment. VirtualCenter
passes on only those actions and requests from a VirtualCenter user that the user has permission to perform.

VirtualCenter grants access to each VirtualCenter object, farm, farm group, virtual machine, and virtual machine group. To do this, VirtualCenter assigns a role and a user (or group) to each object.

Individual permissions are assigned through VirtualCenter by pairing a user and a role and assigning this pair to a VirtualCenter object.

- **Users and Groups** – Created through the Windows domain or Active Directory database. VirtualCenter registers users and groups as part of the assigning privileges process.

- **Roles** – A set of access rights and privileges predefined by VirtualCenter. There are four roles. Each subsequent role includes the privileges of the previous role.

The types of roles that can be paired with a user and assigned to an object are:

- **Read Only User** – Users assigned this role for an object are allowed to view the state of virtual machines, hosts, farms, and groups.

  With this role, you can view virtual machines, hosts, farms, farm groups, and virtual machine group attributes, that is, all the tab panels in VirtualCenter except the Console tab. You cannot view the remote console for a managed host. All actions through the menus and toolbars are disallowed. A user with Read-Only User role access can view the templates and scheduled tasks but not perform any actions with them.

- **Virtual Machine User** – Users assigned this role for an object are allowed to perform power operations on virtual machines.

  With this role, you can connect with a remote console and view the states of virtual machines. You cannot modify the configuration of hosts or virtual machines.

- **Virtual Machine Administrator** – Users assigned this role for an object are allowed to add, remove, or modify objects. With this role, you can:
  - Connect/disconnect managed hosts, migrate and migrate with VMotion, clone, remove and configure virtual machines.
  - Create, import, and deploy templates.
  - Add and remove hosts from farms.
  - Create, remove, or modify farms, farm groups, and virtual machine groups and their content.
- **VirtualCenter Administrator** – Users in this role are allowed to change privileges for an object.

  With this role, you can add, remove, and set access rights and privileges for all the VirtualCenter users and all the virtual objects in the VirtualCenter environment.

  The figure below illustrates the three users and their respective access to VirtualCenter objects. Refer to *Abbreviations on page 16* for a description of abbreviations.
Operations Overview

Typical VirtualCenter operations are focused around managing virtual machines on multiple hosts.

The figure below illustrates a VirtualCenter operation overview. Refer to Abbreviations on page 16 for a description of abbreviations.

**Note:** For the remainder of this manual, the term VirtualCenter refers to the VirtualCenter client unless explicitly specified otherwise.

There are two methods for adding virtual machines to VirtualCenter: either register a host with virtual machines on it, or create virtual machines. The list below describes some of the key process options.

- A virtual machine can be created from scratch using the New Virtual Machine Wizard. After creating a virtual machine, you must install a guest operating system.

- An existing virtual machine can be used as a source for new templates using the New Template Wizard.

- An existing virtual machine can be cloned to create new virtual machines using the Clone Wizard.
• Templates can be deployed as new virtual machines using the Template Deployment Wizard.

• When you create a new machine from a template or as a clone, the new virtual machine can be customized using the Guest Customization Wizard. This wizard customizes a virtual machine that already has a guest operating system installed.

• After you create a new virtual machine, irrespective of the method used to create it, it can be edited using the Virtual Machine Properties dialog box.

<table>
<thead>
<tr>
<th>Action</th>
<th>Requires</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Virtual Machine</td>
<td>No previous condition.</td>
</tr>
<tr>
<td>Create Template</td>
<td>Existing virtual machine managed by VirtualCenter or local to VirtualCenter server.</td>
</tr>
<tr>
<td>Deploy Template</td>
<td>Existing template in template upload repository or on datastore of managed host.</td>
</tr>
<tr>
<td>Clone Existing Virtual Machine</td>
<td>Existing registered virtual machine.</td>
</tr>
<tr>
<td>Guest Customization</td>
<td>Triggered from deploy template or clone wizards. Requires existing guest operating system in original source virtual machine or template.</td>
</tr>
<tr>
<td>Edit Existing Virtual Machine</td>
<td>Completed virtual machine. The virtual machine can be the result of the use of either the New Virtual Machine Wizard or the Deploy or Clone Wizards.</td>
</tr>
</tbody>
</table>

The following sections introduce the essential VirtualCenter tasks:

- **Understanding Virtual Machines and Hosts**
- **Understanding Templates**
- **Cloning Virtual Machines**
- **Understanding Customization**
- **Understanding Migration**
- **Understanding New Virtual Machines**
- **Understanding Scheduled Tasks**
- **Understanding Events**
- **Understanding Alarms**
- **Understanding the User Interface**
- **Performing Actions**
Understanding Virtual Machines and Hosts

Hosts are added to the VirtualCenter environment through an Add Host wizard. When VirtualCenter adds a host, it automatically discovers and registers all the virtual machines on that host. Each managed host is associated with a specific farm. Select a farm object to enable the New > Add Host wizard menu option.

The figure below illustrates the process of adding virtual machines to VirtualCenter control. Refer to Abbreviations on page 16 for a description of abbreviations.

Understanding Templates

A template is a golden image of a virtual machine. The template typically includes a specific operating system and configured components which provide virtual counterparts to hardware components. VirtualCenter uses templates to create new virtual machines.

Creating a Template

You create templates from existing virtual machines. These virtual machines can be either:

- Virtual machines located on any VirtualCenter managed host.
  
  Only virtual machines created by ESX Server version 2.0 or greater, GSX Server version 2.5 or greater, or VMWare Server 1.0 or greater can be managed by VirtualCenter.

- Unmanaged virtual machines stored on a disk local to the VirtualCenter server.
These virtual machines must have been created by a supported version of VMware Server, GSX Server, ESX Server, or Workstation. Refer to VirtualCenter Template Requirements on page 50 for additional information.

In addition, you can create templates by making a copy (clone) of an existing template.

When you create a template, VirtualCenter provides an option to store the template at one of two locations:

- **Datastore** – Any datastore accessible to the managed host (local or networked) where the source virtual machine resides. This option works best with a shared datastore between hosts on a farm. This option is typically used for creating templates from virtual machines on registered hosts.

- **Template upload directory** – Located on the VirtualCenter server machine, the upload directory contains copies of the original virtual machine virtual disks. Specify a directory local to the VirtualCenter server as the template upload directory. This option is used when a template might need to be deployed to any managed host.
The figure below illustrates the two methods for storing templates in VirtualCenter. Refer to Abbreviations on page 16 for a description of abbreviations.

Creating a Template

Deploying a Template
When you deploy a template, you create a new virtual machine from the template. If the template is in the template upload directory, place the new virtual machine on any VirtualCenter managed host.

If the template is stored on the datastore of a managed host, place the new virtual machine only on another managed host that has access to the datastore. Only those managed hosts that share the datastore are listed as Deploy a Template Wizard target managed host choices.
The figure below illustrates the process for deploying a template to create a new virtual machine. Refer to Abbreviations on page 16 for a description of abbreviations.
Cloning Virtual Machines

A clone is a copy plus customization of a virtual machine. When you create a clone, VirtualCenter provides an option to customize the guest operating system of that virtual machine. Store clones on any managed host within the same farm as the original virtual machine.

The figure below illustrates the process for cloning an existing virtual machine to create a new virtual machine. Refer to Abbreviations on page 16 for a description of abbreviations.
Understanding Customization

When you create a virtual machine by either deploying a template or cloning an existing virtual machine, you have the option to customize the guest operating system installed on that template or existing virtual machine.

Customizing Windows guest operating system options include:

- Joining workgroups and domains
- Network interface configuration
- Domain suffix and security ID (SID) change

Customizing Linux guest operating system options include:

- Host name
- Domain suffix
- Network interface configuration
**Understanding Migration**

Migration is the act of moving a virtual machine from one managed host to another. There are two types of migration:

- **Migration with VMotion** – Moving a powered on virtual machine between managed hosts on a farm. Moving a powered-on virtual machine allows the virtual machine to continue performing transactions without interruption. This function requires activation of VMotion on both the source and target host. The figure below illustrates migrating a powered on virtual machine from one managed host to another using VMotion. Refer to Abbreviations on page 16 for a description of abbreviations.

![Performing a Migration with VMotion](image-url)
• **Migration** – Moving a powered off virtual machine between managed hosts on a farm. The figure below illustrates the process for migrating a powered off virtual machine from one managed host to another. Refer to Abbreviations on page 16 for a description of abbreviations.

![Diagram](image)

**Performing Migration of a Powered Off Virtual Machine**

### Understanding New Virtual Machines

In addition to providing multiple methods for moving, migrating, deploying, and cloning virtual machines, VirtualCenter also incorporates the creation capabilities of the virtualization platforms. Through the New Virtual Machine Wizard and the Virtual Machine Properties dialog box, you can create new virtual machines from scratch and make configuration modifications to them once they are created.
Understanding Scheduled Tasks

Create scheduled tasks to automatically perform operations at specified times. Configure the tasks to occur once or routinely. Apply tasks to groups, farms, or individual virtual machines. The Scheduled Tasks panel lists all planned for and user-defined actions within the VirtualCenter environment. Create, modify, or remove tasks, as needed. The New Task Wizard provides the following task options:

- Deploy a virtual machine from a template
- Clone an existing virtual machine
- Change the power state of a virtual machine
- Migrate a virtual machine
- Migrate a virtual machine with VMotion
- Change resource settings of a virtual machine

Understanding Events

VirtualCenter events are logged in the VirtualCenter database. Each event panel displays the events relevant to the selected VirtualCenter object. With the Events option in the navigation bar selected, the Events panel displays all the events for the current session. With a farm or managed host selected, only the events that occurred on that farm or managed host appear in the Events panel.

Understanding Alarms

Alarms are preconfigured actions that can be triggered when selected events occur. Apply alarms to any VirtualCenter object. View, modify, and remove an existing alarm through the Alarms tab of the object where the alarm was defined.

Understanding the User Interface

The VirtualCenter client display is a typical Windows screen. It contains a menu bar, a shortcut navigation bar, a navigation specific toolbar, and a display area. For the Inventory navigation item, the display area is divided into:

- **Inventory panel** – Displays an inventory list of all the managed VirtualCenter server objects.
- **Information panel** – Displays the tab-specific content for the selected object in the inventory panel. For the Templates and Events Navigation items, the display
area shows a list of scheduled templates and events, respectively. Scheduled tasks are viewed using the Scheduled Tasks button in the navigation bar.

Performing Actions
Performing an action through VirtualCenter involves:

- Starting and logging on to the VirtualCenter client.
- Adding or selecting a virtual machine, host, farm, or group.
- Selecting the desired action from the corresponding menu for the virtual machine, host, farm, or group, and answering the prompts from the task wizard screens.
The figure below illustrates the process flow for typical VirtualCenter activities.
CHAPTER 2

VMware VirtualCenter
Requirements and Resources

This chapter describes VMware VirtualCenter requirements and provides additional references for support. This chapter contains the following topics:

- VMware VirtualCenter Requirements on page 40
- Technical Support Resources on page 54
- Viewing System Logs on page 56
VMware VirtualCenter Requirements

The VirtualCenter client and VirtualCenter server are both Windows executables that can optionally run in a virtual machine. The following sections describe additional, component-specific requirements.

- VirtualCenter Server Requirements
- VirtualCenter Client Requirements
- VirtualCenter Database Requirements
- VMware SDK Requirements
- VirtualCenter Managed Host Requirements
- GSX Server or VMware Server as Managed Host Requirements
- VirtualCenter Managed Virtual Machine Requirements
- VirtualCenter Networking Requirements
- VirtualCenter Licensing Requirements
- VirtualCenter VMotion Requirements
- VirtualCenter Template Requirements
- VirtualCenter Guest Operating System Customization Requirements

VirtualCenter Server Requirements

The VirtualCenter server must have:

- Administrator privileges on the installing system to install the VirtualCenter server. The VirtualCenter server installation adds VirtualCenter as a Windows service.
- A minimum of 2GB RAM for VirtualCenter configurations managing 50 managed hosts or fewer. For greater than 50 managed hosts configurations, use 3GB RAM. For configurations with 100 managed hosts running 2000 virtual machines, use 4GB RAM.
- As a minimum a Pentium IV 2.0Ghz processor. Dual processors are recommended for deployments with more than 25 managed hosts.
- A minimum of 1 10/100Mbps NIC (1Gbps NIC recommended).
• Windows Script version 5.6 or later. If the server does not have this version, VirtualCenter installer automatically updates to Windows Script version 5.6.

• Disk space sufficient on the machine to support the VirtualCenter database and the template upload directory.

The VirtualCenter server may run on the same machine as the VirtualCenter client, or may be installed separately on another Windows system. The VirtualCenter server can also be installed in a virtual machine.

VirtualCenter Client Requirements

The VirtualCenter client must have:

• .NET Framework version 1.1. If you do not have this version, VirtualCenter automatically updates to .NET Framework version 1.1.4322.573.


• A minimum of 256MB RAM (512 MB recommended).

The VirtualCenter client can be installed on multiple Windows systems and access the VirtualCenter server through the network. These Windows systems can be on your desktop, laptop, or another virtual machine.

**Note:** Do not run the VirtualCenter client on a virtual machine that is currently being managed by VirtualCenter. Attempting to view the console of that virtual machine from that client causes a recursive display, and this might cause the managed host to fail.

VirtualCenter Database Requirements

The VirtualCenter database must have one of the following compatible database formats:

• Microsoft Access (default)

  You do not need to have a Microsoft Access database installed to use this option. VirtualCenter stores the database in Microsoft Access format.

  **Note:** Using the Microsoft Access database for production environments is *not* recommended. It is intended for demonstration and trial purposes only.

• Microsoft SQL Server 2000

• Microsoft SQL Server 7

• Oracle 8i, Oracle 9i, and Oracle 10g
Note: VMware recommends using the Microsoft Access Database only for demonstration environments and proof of concepts. This database is not recommended for production deployments. For production environments, use either the SQL Server or Oracle database.

VMware SDK Requirements
There are two components for the VMware SDK. They are:

- VMware Web Service
- VMware SDK Package

VMware Web Service Package
Your machine must meet the minimum hardware requirements listed for VMware VirtualCenter. Refer to the product documentation for the requirements.

- VMware VirtualCenter – www.vmware.com/support/pubs

To run the Virtual Machine Agent server, you must also have installed and have running the following:

- Microsoft Windows operating system – supported version for the VirtualCenter server
- VMware VirtualCenter

VMware SDK Package
Your machine must meet the minimum hardware requirements listed for the IBM WebSphere Software Developer Kit for Web Services V5.1. Refer to the product documentation for the requirements.


In general, your machine should support a standard development environment:

- 1 GHz processor
- 256MB memory
- 50MB free disk space

To install the VMware SDK package, go to www.vmware.com/support/developer/vc-sdk.

To use the client package, you must also have installed the following:

- IBM WebSphere Software Developer Kit for Web Services V5.1 (WSDK V5.1) at: www-106.ibm.com/developerworks/webservices/wsdk/
• The IBM SDK for Java 2 Standard Edition (J2SE) Technology, version 1.3.1 included with the WSDK download package
• The VMware SDK package, which requires approximately 8.2MB, and the VMware Web Service package, which requires approximately 21.3MB

VirtualCenter Managed Host Requirements
The VirtualCenter registered and managed hosts must be running the following virtualization platforms:

• VMware ESX Server, version 2.0.1 or later
• VMware GSX Server, version 3.1 or later
• VMware Server, version 1.0 or later

The IP address that VirtualCenter server uses to connect to a managed host must be accessible from all other managed hosts. For example, if a managed host H1 has multiple NICs with IP addresses, such as x.x.x.x1 and x.x.x.x2, but DNS resolves H1 to x.x.x.x1 and the VirtualCenter server connects to the managed host at that IP address, then x.x.x.x1 must be reachable from all other managed hosts.

To make sure that a host IP address used by the VirtualCenter is accessible to another host:

1. Log on to the server running VirtualCenterserver and perform a DNS lookup of H1 and type at a command prompt:
   
   nslookup H1

   The example prints the IP address x.x.x.x1.

2. Log on to another managed host and type at a command prompt:
   
   ping x.x.x.x1

   The ping should report the number of successful packets returned.

GSX Server or VMware Server as Managed Host Requirements
Using a GSX Server or VMware Server managed host with VirtualCenter has the following restrictions:

• GSX Server or VMware Server virtual machine configuration and .vmdk disk files must be stored locally to the GSX Server or VMware Server.
A GSX Server or VMware Server virtual machine that uses IDE disks cannot be migrated or cloned to ESX Server, and a GSX Server or VMware Server template that uses IDE disks cannot be deployed to ESX Server.

Virtual machines created on VMware Server or upgraded through VMware Server Console cannot be migrated or cloned back to either a GSX Server or ESX Server. Templates created from a VMware Server virtual machine cannot be deployed to either a GSX Server or ESX Server.

The GSX Server or VMware Server feature that automatically starts virtual machines when the GSX Server or VMware Server starts is not supported in VirtualCenter.

GSX Server must be upgraded to GSX Server 3.1 or later or VMware Server 1.0 or later.

Migration with VMotion using GSX Server or VMware Server hosts is not supported at this time.

GSX Server or VMware Server virtual machines must be configured with network labels. Please refer to your GSX Server or VMware Server documentation for information on how to configure network labels.

Every virtual machine on a GSX Server or VMware Server Windows host must be configured to run as the user account specified when the host was added to VirtualCenter. Refer to your GSX Server or VMware Server documentation for information on changing this setting.

**VirtualCenter Managed Virtual Machine Requirements**

VirtualCenter managed virtual machines must have the following:

**Disks** – Must use SCSI hard disks on ESX Server. IDE hard disks can be used on GSX Server or VMware Server.

**Guest operating system** – Must be one of the supported versions listed for the virtual machine host, ESX Server, GSX Server, or VMware Server. Refer to the following for a complete list of compatible guest operating systems:

*pubs.vmware.com/guestnotes*

**VirtualCenter Networking Requirements**

VirtualCenter managed host and virtual machine networking requirements are as follows:
- Virtual machines
  - Up to four virtual Ethernet NICs. Each virtual NIC may be a high-performance VMware virtual NIC or an AMD PCnet-PCI II-compatible virtual NIC.
  - Support any protocol that the guest operating system supports over the Ethernet. Multiple high-performance, Ethernet-compatible virtual networks.
- VirtualCenter ESX Server managed host
  - Configure a TCP/IP address on an extra network adapter card (NIC) sufficient to support migration.
  
  The minimum number of NICs is two; how the NICs are assigned differs depending upon the version of the VMware virtualization platform being used. One NIC is dedicated to migration activity.
  
  The preferred number is three: one is dedicated to the managed host, one (or more) are dedicated to the virtual machines, and one is dedicated to VMotion activity.

  The figure below illustrates the possible NIC configurations that support VirtualCenter. Refer to Abbreviations on page 16 for a description of abbreviations.
VMotion Network Card Configuration Options

Preferred number of NIC cards

- VM network for host1
  - deduced network for migration activities
  - NIC1 NIC2 NIC3
  - VMs

Minimum number of NIC cards, ESX Server 2.0.1

- net
- NIC1
- NIC2
- shared network for service console and migration activities, separate network for virtual machines

Minimum number of NIC cards, ESX Server 2.1 or later

- net
- bonded network for service console, virtual machines and migration activities, VLANs for dividing into logical networks
- NIC1 NIC2
- VMs
Depending upon the version of ESX Server you are using, configure your networking as follows:

**If you are using ESX Server 2.1 or later:**
1. Create a bond including both NICs.
2. Give the bond to all three entities (service console, VMkernel, and virtual machines).
3. Use VLANs to create separate logical networks.

**If you are using ESX Server 2.0.1:**
1. Configure one NIC for the virtual machines.
2. Configure one NIC to be shared between the service console and the VMotion networks.

Refer to your *ESX Server System Administration Guide* for additional information on sharing NICs between vmkernel and the service console.

**VirtualCenter Licensing Requirements**

There are three elements to VirtualCenter licensing, each of which has a separate set of license keys with a different set of policies.

**VirtualCenter server** – Requires one license for each VirtualCenter Server. VirtualCenter Server licenses are perpetual. A license key is requested the first time VirtualCenter client connects to the VirtualCenter server, not during installation.

**VirtualCenter agent licenses** – Requires one license that comes in assorted configurations for each managed host. Managed processor licenses are perpetual. The license configurations are typically in combinations of pairs, for example, 2, 4, 8, 16, and unlimited processor licenses. Managed hosts cannot be partially licensed. For example, you cannot use 4 processors’ worth of licenses on an 8-way system; this configuration requires an 8 processor license. Additional licenses can be added through the VirtualCenter client.

Licenses are applied to either ESX Server, GSX Server, and VMware Server hosts as specified by the license keys submitted.

Any time you add a host to VirtualCenter, VirtualCenter automatically applies an appropriate number of managed processor licenses towards that managed host. The number of licenses applied depends on the number of processors on the managed host.
**Note:** Newer processors have two CPU cores in each processor package. Systems with dual-core processors must use ESX Server 2.5.2 or later, GSX Server 3.2 or later, or VMware Server 1.0 or later. VirtualCenter licenses are issued by pairs of processor packages, not by processor cores. Therefore, if the system is using two dual-core processors or two single-core processors, the system requires a single 2-processor VirtualCenter license.

**VMotion processor licenses** – Requires one license for each processor for each managed host to be VMotion enabled. VMotion processor licenses are perpetual. As with the managed processor licenses, managed hosts cannot be partially VMotion licensed. For example, an 8-processor server requires eight licenses. Additional licenses can be added through the VirtualCenter client.

Whenever you add a host to VirtualCenter and there are sufficient VMotion processor licenses available, VirtualCenter prompts you to VMotion-enable the new managed host. Select **Yes**. The managed host is then VMotion-enabled, and the appropriate number of licenses are applied by VirtualCenter.

Whenever you remove a managed host from VirtualCenter, the VMotion licenses are released. The VMotion licenses must be reapplied when the host is re-managed by VirtualCenter.

VMotion licenses are not intended to be mobile. The only legitimate circumstances under which you should move a license are when you are:

- Deprecating and replacing a VMotion-enabled host.
- Repurposing a VMotion-enabled host to run services in a new farm.
- Exercising a one-time transfer of VMotion licenses.

**VirtualCenter VMotion Requirements**

If you wish to have VirtualCenter perform a migration with VMotion of your virtual machines, you must also have and activate the VirtualCenter VMotion module. You must activate each managed host. Activation requires a specific VMotion license for each managed host. The only managed hosts supported at this time are ESX Server hosts.

In addition, the managed hosts you are planning to migrate between must meet the following requirements. Complete these requirements before you attempt to perform a migration with VMotion.

- The managed hosts must share a storage area network (SAN) infrastructure.
• Configure all of your managed hosts to use a single Virtual Machine File System (VMFS) volume.
• The virtual machine’s disks have to be on a VMFS that is accessible by both source and target hosts.
• The shared VMFS access mode VMFS setting should be public.
• Set the size of the VMFS volume sufficiently large and spanning enough LUNs to store all of the virtual disks for your virtual machines.
• Ensure that all VMFS volumes on your managed hosts use volume names, and that the virtual machines use the volume names for specifying the virtual disks.

Ensure that the source and destination hosts have a compatible set of processors.

Since VMotion transfers the running architectural state of a virtual machine between underlying VMware ESX Servers, VMotion compatibility means that the processors of Host2 must be able to resume execution using the equivalent instructions where the processors of Host1 were suspended.

Processor clock speeds, cache sizes, and number of ‘cores’ may vary, but in order for two processors to be compatible for migration with VMotion, they must satisfy the following constraints:
• Same vendor class (Intel vs. AMD)
• Same processor family (P4 vs. P3 vs. Opteron)
   Within the Intel P4 and AMD Opteron processor families, VMware also places an additional restriction between processors that do support the SSE3 instructions and processors that do not support the SSE3 instructions.
   VMware, in partnership with CPU and hardware vendors, is working to maintain VMotion compatibility across the widest range of processors. For additional information please contact your VMware representative or check the VMware Knowledge Base:
• The virtual machine configuration file should not reside on a VMFS located on the shared datastore.
• VMotion does not currently support the migration of clustered applications or raw or undoable virtual disks. If you have clustered applications or raw or
undoable disks, store the disks on separate VMFS volumes from the virtual machines you plan to migrate using VMotion.

- VMotion requires a Gigabit Ethernet network between virtual machines. VMotion requires the setup of a private, Gigabit Ethernet migration network between all of the VMotion-enabled managed hosts. When VMotion is enabled on a managed host, configure a unique network identity object for the managed host and connect it to the private migration network.

**VirtualCenter Template Requirements**

Virtual machines to be used as sources for VirtualCenter templates must have been created by one of the following virtualization platforms:

- Workstation version 4.x
- GSX Server version 2.5.x
- ESX Server version 2.x
- VMware Server version 1.x

If you have older virtual machines that you plan to include in the VirtualCenter environment, you must upgrade your Workstation, GSX Server, VMware Server, or ESX Server to the supported version level and upgrade the virtual machines to the supported version level. Refer to your Workstation, GSX Server, VMware Server, or ESX Server documentation for additional information.

**Note:** To be managed by VirtualCenter, ESX Server hosts must be running ESX Server version 2.0.1 or greater although virtual machines can have been created with ESX Server version 2.0 and then imported into a managed host running ESX Server version 2.0.1 or greater. Similarly GSX Server or VMware Server hosts must be running GSX Server version 3.1 or later or VMware Server 1.0 or later, although virtual machines can have been created with GSX Server 2.5.x.

The virtual disks of virtual machines to be used as sources for VirtualCenter templates have the following requirements:

- The Workstation and GSX Server virtual machine's directory path and configuration file must be local to VirtualCenter server. The path must refer to a drive letter corresponding to a local file system. Specifically, it cannot be a network share that is mapped as a local drive.
- VMware Server virtual machines can only be used if the VMware Server is managed by VirtualCenter.
• ESX Server virtual machines must be managed by VirtualCenter. Remove the ESX Server host from VirtualCenter after you have created the template, if needed.

• ESX Server golden images can have their configuration file refer to virtual disks with relative paths. The virtual disks can then reside under the same directory as the configuration file.

• Deploying a template or cloning a virtual machine that uses IDE disks to an ESX Server is not supported.

• Virtual machines created on VMware Server or upgraded through VMware Server Console cannot be migrated or cloned back to either a GSX Server or ESX Server. Templates created from a VMware Server virtual machine cannot be deployed to either a GSX Server or ESX Server.

• Deploying a template or cloning a virtual machine may fail due to SCSI reservation conflicts on the LUN. To prevent this, add the following line to the managed host configuration file to tell VirtualCenter to retry several more times.

   $ echo \n > /proc/vmware/config/Scsi/ConflictRetries

   Where \n is the number of times to retry. The recommended number is 10.

• The template repository, which you have the option to specify, must either be local to the managed host on which the source virtual machine resides or be on a Network Attached Storage (NAS).

**VirtualCenter Guest Operating System Customization**

**Requirements**

To use the guest customization wizard, the virtual machine and the guest operating system, Windows or Linux, must meet the requirements listed in the following sections:

• Virtual Hardware Requirements for Guest Customization

• Windows Requirements for Guest Customization

• Linux Requirements for Guest Customization

**Note:** Customization of a VMware Server virtual machine is supported only for those guest operating systems already approved for GSX Server and ESX Server. Refer to the following sections for the list of approved-for-customization guest operating systems.
Virtual Hardware Requirements for Guest Customization

Guest customization requires that the source virtual machine used to create the clone or templates has the following:

- VMware Tools installed.
- At least one Network Interface Card (NIC) configured.

When a virtual machine is cloned or used for a template, the new virtual machine has the exact same number and type of NICs, for example, AMD VLance/PcNet versus high-performance VMware vmxnet. This cannot be changed during the deployment or guest customization process.

- SCSI disks.

The default configuration for VMware Workstation, GSX Server, and VMware Server creating a Windows XP or Windows Server 2003 virtual machine is IDE disks. If you are customizing a virtual machine with IDE disks, it can only be deployed to a GSX Server or VMware Server host.

VirtualCenter customization operates on the disk attached to the virtual SCSI node with the lowest address on the SCSI controller with the lowest index. As a result, you must make sure that the guest operating system being customized resides on a disk attached as SCSI 0:0 node in the virtual machine configuration.

**Note:** If a virtual machine has mixed IDE and SCSI disks, the first IDE disk is considered the boot disk, and VirtualCenter passes it to the customizer. “First” is in controller:device order, that is, ide0:0, ide0:1, scsi0:0, scsi0:1, and so on.

**For Windows guest operating systems:** Both the active partition (the partition containing boot.ini) and the system partition (the partition containing the system directory, for example, \WINNT or \WINDOWS), are on the same virtual disk and attached the SCSI 0:0 virtual SCSI node.

**Note:** It is not a requirement that active and system partitions be the same partition.

**For Linux guests:** The virtual disk containing the system partition (the partition containing the /etc directory) must reside on the SCSI 0:0 node.

- 32-bit or 64-bit hardware corresponding to the 32-bit or 64-bit operating system being installed.

Windows Requirements for Guest Customization

Guest customization of a Windows guest operating system can occur if:

- The guest operating system is not a primary or backup domain controller.
• The clone or template has one of the following Windows versions installed:
  • Windows 2000 Server, Advanced Server, or Professional
  • Windows XP Professional
  • Windows Server 2003, Web, Standard, or Enterprise Editions

  **Note:** Windows XP Home or Windows NT4 operating system guest customization is not supported.

• The Microsoft Sysprep tools are installed on the VirtualCenter server.

Refer to Installing the Microsoft Sysprep Tools on page 319 for information on installing the Microsoft Sysprep tools.

Microsoft Sysprep tools have certain requirements and impose certain restrictions on the source machine. Please refer to the Microsoft Sysprep documentation for additional information.

**Linux Requirements for Guest Customization**

Guest customization of a Linux guest operating system can occur if:

• The clone or template has one of the following Linux versions installed:
  • Red Hat Enterprise Linux AS 3.0
  • Red Hat Advanced Server 2.1
  • SUSE LINUX Enterprise Server 8

• The clone or template has a root volume formatted with an ext2 or ext3 file system.

  **Note:** A default installation of SUSE LINUX Enterprise Server 8.0 formats the disk using the ReiserFS file system, which is not supported. If you would like to customize your SUSE virtual machines, be sure to format the disk using an ext2 or ext3 file system during the installation of the guest operating system.

• The VMware Open Source Components are installed on the VirtualCenter server.

Refer to Installing the VMware Open Source Components on page 321 for additional information.
Technical Support Resources

There are several resources available for researching and finding solutions for issues and concerns. The following sections describe the options.

Documentation on the Web
Full documentation for VMware VirtualCenter, including the latest updates to the manual, can be found on the VMware Web site at:

www.vmware.com/support

VMware Knowledge Base
You can find troubleshooting notes and tips for advanced users in the knowledge base on the VMware Web site at:


VMware Newsgroups
The VMware newsgroups are primarily forums for users to help each other. You are encouraged to read and post issues, workarounds, and fixes. While VMware personnel may read and post to the newsgroups, they are not a channel for official support.

The VMware NNTP news server is at:

news.vmware.com.

For a listing of all current newsgroups and the topic areas they cover, refer to:

www.vmware.com/support/newsgroups.html

VMware Community
The VMware community is a set of moderated discussion forums hosted on the VMware Web site and is open to users of all VMware products. VMware technical staff regularly monitor the forums to learn about your issues and feedback, and help facilitate discussions when appropriate.

To participate in the community:

1. Go to:
   www.vmware.com/community
2. Create a user account.
CHAPTER 2 VMware VirtualCenter Requirements and Resources

**Reporting Problems**

If you have problems while running VirtualCenter, please report them to VMware technical support.

The following steps should be taken to provide the information we need from you to diagnose problems. This information largely comes from various log files. Which log file we need depends upon the problem you encounter.

1. Register your serial number.
2. Describe the steps you took in the period before the failure occurred.
   - Save any information that might help reproduce the problem.
   - Record a description of your physical hardware and of the software (operating system and applications) that was running in the virtual machine, if applicable.
3. Collect the logs and files requested by VMware technical support.
   Refer to Viewing System Logs below for a description of possible logs and files.
4. Contact your VMware Technical Support representative.

   If you are requesting support directly from VMware, report your problems using the support request form on the VMware Web site at: [www.vmware.com/requestsupport](http://www.vmware.com/requestsupport).

   Refer to your service contract for additional information.
# Viewing System Logs

There are several files available that might be requested by the VMware technical support to help resolve your problem. The following table describes the files you might need.

<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>File Name</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualCenter service log</td>
<td>Windows</td>
<td>vmware-vpxd-[user]-[pid].log</td>
<td>Temp directory&lt;br&gt;Example:&lt;br&gt;C:\Documents and Settings\Administrator\Local Settings\Temp\ vmware-vpxd-Administrator-1024.log&lt;br&gt;C:\WINDOWS\Temp\vmware-VirtualCenter-SYSTEM-1024.log&lt;br&gt;C:\WINNT\Temp\vmware-VirtualCenter-SYSTEM-1024.log</td>
</tr>
<tr>
<td>GSX Server or VMware Server registration service log</td>
<td>Windows, Linux</td>
<td>vmware-serverd.log, vmware-serverd.log</td>
<td>C:\Windows\Temp&lt;br&gt;/var/log/vmware</td>
</tr>
<tr>
<td>ESX Server service log</td>
<td>ESX Server</td>
<td>vmware-serverd.log</td>
<td>/var/log/vmware/</td>
</tr>
<tr>
<td>VMware Management Interface log</td>
<td>Windows, Linux</td>
<td>mui.log, error_log</td>
<td>C:\Program Files\VMware\VMware Management Interface&lt;br&gt;/var/log/vmware-mui</td>
</tr>
<tr>
<td>VMware Virtual Machine Console</td>
<td>Windows, Linux</td>
<td>vmware-&lt;username&gt;-&lt;PID&gt;.log, ui-&lt;PID&gt;.log</td>
<td>Temp directory&lt;br&gt;Example:&lt;br&gt;C:\Documents and Settings&lt;username&gt;\Local Settings\Temp&lt;br&gt;The path to this file appears in the About dialog box. In a console, choose Help &gt; About VMware VirtualCenter, and look under Additional information. &lt;br&gt;The path to this file appears in the terminal when you start the console.</td>
</tr>
<tr>
<td>Component</td>
<td>Operating System</td>
<td>File Name</td>
<td>Location</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>VMware VirtualCenter Agent log</td>
<td>ESX Server, GSX Server, and VMware Server</td>
<td>vmware-ccagent-n.log</td>
<td>/var/log/vmware/ C:\WINNT\TEMP C:\WINDOWS\TEMP on Windows XP or Windows 2003 systems</td>
</tr>
<tr>
<td>VirtualCenter installation log</td>
<td>Windows</td>
<td>VMInst.log</td>
<td>VirtualCenter server managed host.</td>
</tr>
<tr>
<td>VMware Virtual Machine Console installation log</td>
<td>Windows</td>
<td>VMInst.log</td>
<td>Temp directory, Example: C:\Documents and Settings&lt;username&gt;\Local Settings\Temp. The Local Settings folder is hidden by default. To see its contents, open My Computer, choose Tools &gt; Folder Options, click the View tab and select Show Hidden Files and Folders.</td>
</tr>
<tr>
<td>Linux</td>
<td>VMInst.log</td>
<td>/etc/vmware</td>
<td></td>
</tr>
<tr>
<td>Virtual Machine Log</td>
<td>Windows</td>
<td>vmware.log</td>
<td>In the same directory as the configuration file (.vmx) of the virtual machine that had problems. The path to the log file of the active virtual machine appears in the About dialog box. In a console, choose Help &gt; About VMware VirtualCenter, and look under Additional information.</td>
</tr>
<tr>
<td>Linux</td>
<td>vmware.log</td>
<td>In the same directory as the configuration file (.vmx) of the virtual machine that had problems.</td>
<td></td>
</tr>
<tr>
<td>Run the support script or save the log file before you launch the failed virtual machine again</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>virtual machine's event log</td>
<td>Windows</td>
<td>event-&lt;path_to_configuration_file&gt;.vmx.log</td>
<td>On the virtual machine managed host. C:\Program Files\VMware\VirtualCenter\vmserverdRoot\eventlog</td>
</tr>
<tr>
<td>Linux</td>
<td>/var/log/vmware</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Some of the log information appears in the VMware Management Interface.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Virtual machine core file</td>
<td>Windows and Linux</td>
<td>vmkernel-core.&lt;date&gt; and vmkernel-log.&lt;date&gt;</td>
<td>/root directory after you reboot your machine.</td>
</tr>
<tr>
<td>Virtual machine configuration file</td>
<td>Windows and Linux</td>
<td>.vmx</td>
<td>On the virtual machine managed host.</td>
</tr>
<tr>
<td>Migration history log</td>
<td>Windows</td>
<td>/proc/vmware/migration/history</td>
<td>On the VirtualCenter server.</td>
</tr>
</tbody>
</table>
Collecting Log Files

There are several files available that might be requested by the VMware technical support to help resolve your problem. The following describes script processes for generating and collecting some of these files.

Setting VirtualCenter Verbose Logging

There are two ways to set verbose logging.

**Method one: Set verbose log in the VirtualCenter client.**

1. Choose **File > VMware VirtualCenter Settings > Advanced.**
2. Scroll to the **log.verbose** parameter.
3. Set the parameter to a value of 1.
4. Click **OK.**

**Method two: Enable logging:**

1. Open or create one of the configuration files:

<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>File Name</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service console log</td>
<td>ESX Server</td>
<td>/var/log/messages</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To view service console messages: from the management interface, click the Service Console Log tab.</td>
<td></td>
</tr>
<tr>
<td>Service console availability report</td>
<td>ESX Server</td>
<td>/var/log/messages</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To view the server availability report: from the management interface, click the Availability Report tab.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The availability report contains useful information about server uptime and downtime. This includes detailed statistics regarding uptime history and an analysis of downtime.</td>
<td></td>
</tr>
<tr>
<td>VMkernel messages</td>
<td>ESX Server</td>
<td>/var/log/vmkernel</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To view the VMkernel message log: from the management interface, click the VMkernel Log tab.</td>
<td></td>
</tr>
<tr>
<td>VMkernel alerts and availability report</td>
<td>ESX Server</td>
<td>/var/log/vmkernel</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To view VMkernel log and the availability report: as the root user, from the management interface, click Options &gt; System Logs &gt; the appropriate tab for the log file you want to view.</td>
<td></td>
</tr>
<tr>
<td>VMkernel warning</td>
<td>ESX Server</td>
<td>/var/log/vmkernel warning</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To view VMkernel warnings and serious system alerts, from the management interface, click the VMkernel Warnings tab.</td>
<td></td>
</tr>
</tbody>
</table>
Collecting VirtualCenter Settings Information

1. From the VirtualCenter client, open the VMware VirtualCenter Settings and select the Advanced tab.

   Select File > VMware VirtualCenter Settings. When the dialog box appears, select the Advanced tab.

2. Record the information in the server.options field. Click OK.

Collecting VirtualCenter Log Files

A script collects log files for both VirtualCenter client and server. You no longer have to collect the files by hand, except for the Event Viewer log.

The script vclogs.wsf collects log files and saves them to a directory in the location where the script is run. The naming convention for the directory is VirtualCenterLogs-[USER]-[DATE]. After collecting the files, archive the directory and send the file to support, using the method your support representative requests (usually FTP upload).

The script uses the following Windows user and system environment variables on your VirtualCenter client or server host to determine where the log files are located.

<table>
<thead>
<tr>
<th>Environment</th>
<th>Typical Directory Location</th>
<th>Find Files</th>
</tr>
</thead>
</table>
| %WINDIR%\temp\ | C:\WINDOWS\temp\ | vmware-vpxd-\*  
| | | vmware-vmount.log |
| %TMP% | C:\DOCUME~1\<user>\LOCALS~1\Temp | vmware-vpxd-\*  
| | | vmware-vmount.log  
| | | vmware-[USER]-\*  
| | | client-\* |
| %TEMP% | C:\DOCUME~1\<user>\LOCALS~1\Temp | vmmisi.log  
| | | vminst.log |
For VirtualCenter Client: Log on to the machine running VirtualCenter Client, using the same login as the user who encountered the error, and open a command prompt window.

For VirtualCenter Server: Log on to the machine running VirtualCenter Server, using a local Windows administrator account, and open a command prompt window.

1. Change to the directory where VirtualCenter is installed.
   For example, if the default installation directory was used:
   ```
   cd c:\Program Files\VMware\VMware VirtualCenter\n   ```

2. Run the following command to collect the logs:
   ```
   cscript vclogs.wsf
   ```
   Here is an example of the command run with options:
   ```
   cscript vclogs.wsf /n:all /o:vclog
   ```
   Options:
   ```
   /? - Displays help for this script.
   /n:N or /n:all - Number of log files to collect (replace N with the actual number). The default value is 10. Specify all to collect all logs.
   /o:dir - Output directory (replace dir with your directory). The default is VirtualCenterLogs-username-date.
   ```

3. Locate and provide the Event Viewer log files from the VirtualCenter server.
   a. Log on as a user with VirtualCenter Administrator privileges.
   b. Export the files in the default Event Viewer format with .evt extensions.

4. Compress and archive the Event Viewer log files and output directory as a .zip file. Incorporate a timestamp into the .zip file name.

**Collecting ESX Server VMkernel Files**

If the VMkernel fails, normally an error screen appears for a period of time and then the virtual machine reboots.

<table>
<thead>
<tr>
<th>Environment</th>
<th>Typical Directory Location</th>
<th>Find Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>%ALLUSERSPROFILE%</td>
<td>C:\Documents and Settings\All Users\Application Data\VMware\VMware VirtualCenter\</td>
<td>config.ini</td>
</tr>
<tr>
<td>%ALLUSERSPROFILE%\VMA\</td>
<td>C:\Documents and Settings\All Users\Application Data\VMware\VMware VirtualCenter\VMA\</td>
<td>vmware-vmount.log vmaConfig.xml vma-*</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Environment</th>
<th>Typical Directory Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>%ALLUSERSPROFILE%</td>
<td>C:\Documents and Settings\All Users\Application Data\VMware\VMware VirtualCenter\config.ini</td>
</tr>
<tr>
<td>%ALLUSERSPROFILE%\VMA\</td>
<td>C:\Documents and Settings\All Users\Application Data\VMware\VMware VirtualCenter\VMA\vma-***</td>
</tr>
</tbody>
</table>
If you specified a VMware core dump partition when you configured your virtual machine, the VMkernel also generates a core dump and error log.

More serious problems in the VMkernel can freeze the machine without an error screen or core dump.

Collecting ESX Server Service Console Files
This script collects and packages all relevant ESX Server system and configuration information and ESX Server log files. This information can be used to analyze the problem you are encountering.

1. Run the following script on the service console:
   
   ```
   /usr/bin/vm-support
   ```

2. Save the resulting file:
   
   ```
   esx-<date>-<unique-xnumber>.tgz
   ```

Collecting ESX Server Service Log Files
You can enable logging for the VMware Authorization Service (known as vmware-authd on Linux managed hosts) manually.

1. In a text editor, open the following file:
   
   - On a Windows managed host, edit `config.ini`, located in
     `C:\Documents and Settings\All Users\Application Data\VMware\VMware VirtualCenter`.
   - On a Linux managed host, edit `/etc/vmware/config`.

2. Add the following lines to the file:
   
   ```
   vmauthd.logEnabled = TRUE
   log.vmauthdFileName = "vmauthd.log"
   ```

   This creates a file called `vmauthd.log`. On a Windows managed host, this file appears by default in `C:\Windows\system32` or `C:\WINNT\system32`; on a Linux managed host, this file appears by default in `/var/log/vmware`.

3. Save and close the configuration file. The log is enabled on a Linux-managed host.

4. On a Windows-managed host, restart the VMware Authorization Service. Choose
   
   **Start > Administrative Tools > Services.** Right-click VMware Authorization Service and choose Restart. This enables logging.
Collecting GSX Server or VMware Server Files and Logs Using Scripts
The GSX Server or VMware Server log files are generated by GSX Server or VMware Server and are collected by the support script as needed. Since there is no support script on a remote GSX Server or VMware Server client, you need to submit a support request for any issues you encounter on a client and include the console's log file or its installation log file.

With GSX Server or VMware Server hosts, you can simplify the process of collecting the needed information by running the support script to collect the appropriate log files and system information. Follow the steps below that apply to your managed host computer.

**Note:** The support script runs only on the GSX Server or VMware Server host. If you encounter problems on a remote client, you must supply the log files manually. The two log files you should supply, depending upon the problem you encounter on the client, are the VMware Virtual Machine Console log file and the installation log file. See below for more information about these logs.

Running GSX Server or VMware Server Scripts for Windows Hosts
1. Open a command prompt.
2. Change to the GSX Server or VMware Server program directory.
   ```
   C: cd \Program Files\VMware\VMware GSX Server (or VMware Server)
   ```
   If you did not install the program in the default directory, use the appropriate drive letter and substitute the appropriate path in the `cd` command above.
3. Run the support script.
   ```
   cscript vm-support.vbs
   ```
4. After the script runs, it displays the name of the directory where it has stored its output. Use a file compression utility such as WinZip or PKZIP to zip that directory, then include the zip file with your support request.

Running GSX Server or VMware Server Scripts for Linux Hosts
1. Open a terminal.
2. Run the support script as the user who is running the virtual machine or as root.
   ```
   vm-support
   ```
   If you are not running the script as root, the script displays messages indicating that it cannot collect some information. This is normal. If the VMware support team needs that information, a support representative may ask you to run the script again as root.
3. The script creates a compressed `.tgz` file in the current directory. Include that output file with your support request.
Installing VMware VirtualCenter

This chapter describes how to install VMware VirtualCenter on your system. This chapter contains the following topics:

- Preparing for the VirtualCenter Database on page 67
- Installing and Upgrading the VirtualCenter Product on page 75
- Finishing VirtualCenter Web Service Installation on page 91
- Configuring Communication Between VirtualCenter Components on page 100
- Uninstalling VirtualCenter on page 103
- Uninstalling a VirtualCenter Component on page 106
- Adding a VirtualCenter Component on page 109

A single installer package contains the VirtualCenter client, VirtualCenter server, and the VMware SDK Web service. You can install VirtualCenter client and VirtualCenter server components separately or on the same Windows system. The VirtualCenter agent installation is handled automatically by the VirtualCenter server. The VMware SDK Web service is installed with the VirtualCenter server. The VirtualCenter client package includes online help and documentation for administrators and users.
Preparing for the VirtualCenter Database

VirtualCenter supports three types of database formats:

- Microsoft Access (default)
- Microsoft SQL Server 2000, Microsoft SQL Server 7
- Oracle 8i, 9i, 10g

Each database requires some configuration adjustments in addition to the basic installation.

The installation preparation topics are covered in the following sections:

- Preparing to use a VirtualCenter Database
- Configuring Oracle 8i, 9i, or 10g Connection to Work Locally
- Configuring Oracle 8i, 9i, or 10g Connection to Work Remotely
- Configuring a SQL Server ODBC Connection
- Configuring the Microsoft Access Database
- Maintaining Your VirtualCenter Database

Preparing to use a VirtualCenter Database

The following lists the basic steps required to support the VirtualCenter database and ensure that all VirtualCenter tables are placed in the VC_Database instance.

To prepare to use a VirtualCenter Database:

1. Log on as database administrator in your SQL Server.
2. Create your own database instance, for example: VC_Database.
3. Create your database operator account on your VC_Database. Set the VC_Database as the only database instance the database operator can access.
4. Create an ODBC connection. The VC_Database is the only database listed and the default database.
5. Install VirtualCenter with the SQL Server using the database operator account and the ODBC connection.
Configuring Oracle 8i, 9i, or 10g Connection to Work Locally

If you are planning to use an Oracle database as your VirtualCenter database and you are going to have VirtualCenter access the database locally, use the following procedure.

To prepare an Oracle database to work locally with VirtualCenter:

1. From the Oracle database machine install and prepare Oracle:
   a. Install Oracle 8i, Oracle 9i, or Oracle 10g and create a database (VirtualCenter).
      Download Oracle ODBC from the Oracle Web site.
      Install Oracle ODBC corresponding driver through the Oracle Universal Installer (directions are provided with the driver).
   b. Increase the number of open cursors for the database. Add the entry
      `open_cursors = 300` to the
      C:\Oracle\ADMIN\VPX\pfile\init.ora file.
2. Connect Oracle locally:
   a. Create a new tablespace specifically for VirtualCenter using the following SQL statement:
      ```sql
      CREATE TABLESPACE vpx DATAFILE 'C:\Oracle\ORADATA\VPX\vpx.dat' SIZE 500M;
      ```
   b. Create a user, such as vpxAdmin, for accessing this tablespace through ODBC:
      ```sql
      CREATE USER vpxAdmin IDENTIFIED BY vpxadmin DEFAULT TABLESPACE vpx;
      ```
   c. Allow that user CONNECT and RESOURCE privileges:
      ```sql
      GRANT CONNECT, RESOURCE to vpxAdmin;
      ```
   d. Create an ODBC connection to the database. The following are example settings:
      ```
      Data Source Name: VMware VirtualCenter
      TNS Service Name: VPX
      User Id: vpxAdmin
      ```

Configuring Oracle 8i, 9i, or 10g Connection to Work Remotely

If you are planning to use an Oracle database as your VirtualCenter database, VirtualCenter must access the database remotely.
To prepare an Oracle database to work remotely with VirtualCenter:

1. Install the Oracle client on the VirtualCenter server machine.
2. Connect Oracle remotely:
   a. Download and install the ODBC driver.
   b. Edit the `tnsnames.ora` file located at `Ora8I`, `Ora9I` or `10g`, as appropriate.
      
      ```
      C:\Oracle\Oraxx\NETWORK\ADMIN
      Where xx is either 8I, 9I, 10g.
      ```
   c. Use the Net8 Configuration Assistant to add the following entry:
      
      ```
      VPX =
      (DESCRIPTION =
       (ADDRESS_LIST =
        (ADDRESS=(PROTOCOL=TCP)(HOST=vpxd-Oracle)(PORT=1521))
       )
       (CONNECT_DATA =
        (SERVICE_NAME = VPX)
       )
      )
      ```
      
      Where `HOST` is the managed host to which the client needs to connect.

Configuring a SQL Server ODBC Connection

When you install VirtualCenter server, you have the option to establish a connection with a SQL Server database. The following procedure describes how to configure a SQL Server ODBC connection. If you use the SQL Server authentication method, supply the same user name, password, and ODBC system DSN in the wizard that you used to configure the ODBC.

Refer to your Microsoft SQL ODBC documentation for specific instructions regarding configuring the SQL Server ODBC connection.

**Note:** Microsoft Windows NT authentication is not supported with SQL Server.

To prepare a SQL Server database to work with VirtualCenter:

1. On your Microsoft SQL server, perform the following:
   a. Create a SQL Server database using Enterprise Manager on the SQL Server.
   b. Create a SQL Server database user with `db_ddladmin` rights.
2. Perform the following steps on your VirtualCenter server.
3. Open the Windows ODBC Data Source Administrator. Select Settings > Control Panel > Administrative Tools > Data Sources (ODBC).
4. Select the System DSN tab.
5. Modify an existing SQL Server ODBC connection:
   a. Select the SQL Server ODBC DSN you want to modify.
   b. Select the appropriate ODBC connection from the System Data Source list. Click Configure.
   c. Proceed with step 7 for creating a new SQL Server ODBC DSN connection.
6. Create a new SQL Server ODBC connection:
   a. Select Create New Data Source. Click Add.
   b. Select a New Data Source to SQL Server. Click Finish.
7. Specify an ODBC DSN name. Type the name in the Name field. For example, type VMware VirtualCenter.
8. Optionally, specify an ODBC DSN description. Type the description in the Description field.
9. Select the DSN server name from the Server drop-down menu. Type the SQL Server machine name in the text field if you cannot find it in drop-down menu.
10. Configure the SQL Server authentication screen. Click Next.
11. Select an authentication option. Use either of the authentication methods:
    - If you are using local SQL Server, select Windows NT authentication.
    - If you are using remote SQL Server, select SQL Server authentication. You can also choose Windows NT authentication.
**Note:** The authentication option you choose for a remote SQL Server must match the local SQL Server.

To identify the authentication type:

a. Open SQL Server Enterprise Manager.

b. Click the **Properties** tab to view Properties.

c. Check the mode.

The mode indicates either Windows NT or SQL Server authentication type.
12. Enter your SQL Server login and password.
   Refer to your database administrator for this information.

13. Configure the default database. Click **Next**.

14. Select the database.
   Select an option from the **Change the default database to** menu. Click **Next**.

15. Complete the process. Click **Finish**.

16. Verify the database source.
   From the **ODBC Microsoft SQL Server Setup** menu, select **Test Data Source**.
   If the test data source is acceptable, click **OK**. If it is not acceptable, return and reconfigure any incorrect items.

17. Close the ODBC Data Source Administrator. Click **Close**.

**Configuring the Microsoft Access Database**

If you find that the database performance is slow, increase the buffer size.

**Note:** Using the Microsoft Access database for production environments is not recommended. It is intended for demonstration and trial purposes only.

**To adjust the performance of the Microsoft Access database:**

1. Open the Windows ODBC Data Source Administrator.
   Select **Settings > Control Panel > Administrative Tools > Data Sources (ODBC)**

2. Select the **System DSN** tab.
3. Select ODBC Microsoft Access Setup. Click Options.

4. Increase the buffer size and click OK.
   The default value is 2048. Change it to 8192.

5. Restart the VirtualCenter server, if it is running.
   Refer to Starting or Stopping VMware VirtualCenter on page 118 for information on starting and restarting the VirtualCenter server.

Maintaining Your VirtualCenter Database
Once your VirtualCenter database instance and VirtualCenter are installed and operational, be sure to perform standard database maintenance processes. These include:

- Monitoring the growth of the log file and compacting the database log file, as needed. Refer to the documentation for the database type you are using.
- Scheduling regular backups of the database.
- Backing up the database before any VirtualCenter upgrade.

Compressing Your Microsoft Access Database
This should reduce the size of your Microsoft Access database. You might want to verify the size of the database file before and after these steps. You should notice that space is reclaimed.

These directions are for an Microsoft Access database in a Windows 2000 system. The directions may vary a bit in a Windows XP system, but should be essentially the same.

Note: Using the Microsoft Access database for production environments is not recommended. It is intended for demonstration and trial purposes only.

To compress your Microsoft Access database:

1. Shut down the VirtualCenter application.
   b. Locate and stop the following services:
      VMware VirtualCenter Web Service
      VMware VirtualCenter Server

2. Open MS Access.
   Select Start > Programs > Microsoft Access.

3. Display the browse function.
Click **More files > OK.**

4. Open the file.
   c:\documents and settings\all users\application
data\vmware\vmware virtualcenter\vpx.mdb

5. Select **Tools > Database Utilities > Compact and Repair Database.**
   Wait for the process to complete.


7. Start the services again.

8. Log on to VMware VirtualCenter.
Installing and Upgrading the VirtualCenter Product

This section describes how to upgrade or install your VirtualCenter product. This includes performing a fresh installation, adding a component to an existing installation, and upgrading existing components to the latest VirtualCenter version. The topics are described in the following sections:

- Starting the VirtualCenter Installer for a First Time Installation on page 76
- Starting the VirtualCenter Installer for an Upgrade Installation on page 77
- Selecting the Components to Install on page 80
- Installing the VirtualCenter Server on page 83
- Installing the VMware Web Service on page 87
- Completing the Installation on page 89

VMware VirtualCenter installs the following components:

- **VirtualCenter client** – A user interface that runs locally on a Windows managed host with network access to the VirtualCenter server.

- **VirtualCenter server** – A service that acts as a central administrator for VMware servers connected on a network, to direct actions upon the virtual machines and the virtual machine managed hosts. VirtualCenter server is the central working core of VirtualCenter.

  **Note:** A host can be managed by only one VirtualCenter server. If you try to register an host that it is already managed by a different VirtualCenter server, an error message appears and you are prevented from adding the host to the additional VirtualCenter server.

- **VirtualCenter database** – A database dedicated to the VirtualCenter processes. It is installed when the VirtualCenter server is installed.

- **VirtualCenter agent** – An agent installed on each managed host to be under VirtualCenter control. It coordinates the actions received from the VirtualCenter server.

- **VMware Web Service** – A component of the VMware SDK. It is installed by default with the VirtualCenter server. It cannot be installed without the VirtualCenter server.
**Note:** Install and use only one VirtualCenter server to control all, or specific groups of, managed hosts. Do not have multiple VirtualCenter servers controlling the same managed host. Instead, install multiple copies of the VirtualCenter client. From each VirtualCenter client, you can access any networked VirtualCenter server.

**Note:** The VirtualCenter client does not store any persistent information on your local machine.

### Starting the VirtualCenter Installer for a First Time Installation

This section describes how to install VirtualCenter on your system when there is no other VirtualCenter installation present.

**To install a VirtualCenter component on your client, server, or host:**

1. Download the VirtualCenter installer file from the VMware secure Web site to a local drive.
   
   Contact your VMware representative for information on the location of the secure Web site. The installer file is typically named something similar to *VMware-vpx-<build#>.exe*.

2. Run the installer.
   
   Double-click the icon of the VMware installation file or select **Start > Run** and enter the location of the installer in the **Run** window.
   
   The VirtualCenter installer prepares to install the components.

3. If you do not have Microsoft .NET Framework version 1.1 on your machine, a prompt appears to ask if you wish to install it.

   If you click **Yes**, then the installer automatically installs this package. If you have installed an older version, then the installer automatically upgrades your version to version 1.1.

   For more information on .NET Framework 1.1, see: [www.msdn.microsoft.com/netframework/technologyinfo/](http://www.msdn.microsoft.com/netframework/technologyinfo/)

4. Verify you are installing the VirtualCenter product. Click **Next**.

5. Accept the VMware license terms.
   
   Click the **Accept** button, then click **Next**.
6. Enter your customer identification information.

Enter your user name and company name. Then click **Next** to continue the installation.

7. Proceed to the section *Selecting the Components to Install* on page 80.

**Starting the VirtualCenter Installer for an Upgrade Installation**

When you upgrade your VirtualCenter version, you must upgrade all the components, including your VirtualCenter server and VirtualCenter client.

**Note:** VirtualCenter is not backward compatible. Do not install an older version of VirtualCenter over a newer version of VirtualCenter. If you uninstall a newer version of VirtualCenter you must remove the database as well. The VirtualCenter database is not backward compatible.

**To upgrade your VirtualCenter components on each machine that has a client or server:**

1. Back up your VirtualCenter database.
   - It is recommended that your database administrator (DBA) perform this task.

2. **If you are using an Oracle database:** Prior to upgrading, make sure that the `shared_pool_size` parameter is set to no less than 100MB.
   - This ensures that the upgrade performs reasonably.
   - The `shared_pool_size` parameter is in the `init.ora` file. Have your Oracle database administrator check and set this.
3. Download the VirtualCenter installer file from the VMware secure Web site to a local drive.

   www.vmware.com

   Contact your VMware representative for information on the location of the secure Web site.

4. Run the installer.

   Double-click the VMware installation icon or select Start > Run and enter the location of the installer in the Run window.

   The VirtualCenter installer prepares to install the components.

5. Verify you are upgrading the VirtualCenter product. Click Yes at the prompt.

6. Accept the upgrade wizard. Click Next at the wizard opening panel. Click Install at the wizard Ready to Install the Program panel.

   The VirtualCenter installer checks the local machine to identify what VirtualCenter components are installed.

7. **If you are upgrading the VirtualCenter server**: Refer to Installing the VirtualCenter Server on page 83 for additional information.

   a. Specify the database to use.

      Be sure to select the same database type that you used in the previous version of VirtualCenter.

   b. Do not overwrite your database.

      Accept the default, click Yes at the prompt.

      **Caution:** If you click No, your existing database will be overwritten.

      The default is yes. If you press yes, the wizard continues to the next step in the installation process. If you press no, you are prompted to confirm and then the
database is deleted, or rather overwritten by the upgrade and/or new installation.

You see this prompt if a VirtualCenter database exists on the machine. You see this prompt even if you previously uninstalled VirtualCenter and selected to Remove the VMware VirtualCenter Database and Settings from this machine.

c. **If the VirtualCenter server is installed:** Indicate whether or not to install the VMware Web Service.

   ![VirtualCenter Web Service Configuration](image)

   **Note:** The VMware Web Service must be installed on the same machine as the VirtualCenter server.

   To install the Web service, click the **Install VirtualCenter Web service** check box. Then click **Next**.

8. Proceed with the upgrade. Click **Install**.

   If VirtualCenter server is not already installed or an older version is installed, the current version of VirtualCenter server is installed or upgraded, as needed.

9. When the upgrade is complete, click **Finish**.
Selecting the Components to Install

1. Select the type of installation setup.

The choices are:

- **Client** – Installs the VirtualCenter client and VirtualCenter database components on the local machine.

- **Server** – Installs the VirtualCenter server and the Web service component on the local machine.

**Web service** – Installed by default with the VirtualCenter server. It is a programmatic interface that allows customer-written or third-party applications to access services provided by VirtualCenter. This is not a user interface for configuring VirtualCenter.

You must install the VirtualCenter server to install the Web service. For information about writing programs that use the VirtualCenter Web service, refer to the VMware SDK documentation available at:

[www.vmware.com/support/developer/vc-sdk](http://www.vmware.com/support/developer/vc-sdk)

**Custom** — Allows you to select which items to install and where, within the network, they are to be installed.

Click the appropriate radio button. Then click **Next** to continue the installation.

- If you selected **Client only**, skip to Completing the Installation on page 89.
- If you selected **Server only**, skip to Installing the VirtualCenter Server on page 83. The default is to install the Web service with the **Server** option.
• If you selected **Custom**, proceed with the next step.

2. Select the VirtualCenter component(s) to install.

Click the down arrow next to the appropriate component and select from the drop-down menu.

If you unselect an item, its icon changes to an X. The **Space** and **Change** buttons are grayed if a component is not selected.
3. Make adjustments for available disk space.

Click the **Space** button from the Custom Setup screen. In the Disk Space Requirements screen, click and drag column headers to view all columns as needed.

If a volume line is highlighted, click **OK**, return to the previous screen, and select to install either the client or the server, as both do not fit in the available disk space.

Click **OK** to return to the Custom Setup screen.

4. Change location as needed.
Click the **Change** button from the Custom Setup screen. In the **Change Current Destination Folder** screen, browse to find the appropriate location. Click **OK** to return to the Custom Setup screen.

After your selections are made, click **OK** to return to the Custom Setup screen.

5. Complete the Custom Setup screen. Click **Next**.

6. Proceed to the section appropriate to the components you selected.

   If you selected **Client only**, skip to Completing the Installation on page 89.

   If you selected **Server**, proceed to Installing the VirtualCenter Server on page 83.

### Installing the VirtualCenter Server

1. Set up or confirm the type of VirtualCenter database you wish to use.

   ![Database Setup](image)

   Select whether to have the VirtualCenter create a database or create either a custom SQL Server or an Oracle database. If you are upgrading, specify the previous database used. The options are:

   - **Use Access database** – VirtualCenter automatically creates a Microsoft Access database.
     
     This is a file in Microsoft Access format.
     
     **Note:** This database is not recommended for production use.

   - **Use a custom SQL Server database connection** – VirtualCenter prompts for DSN information and then configures the database.
     
     Supported versions are SQL Server 7 and SQL Server 2000.
• **Use a custom Oracle database connection** – VirtualCenter prompts for DSN information, a user name, and a password and then configures the database.

  Supported versions are Oracle 8i, Oracle 9i, and Oracle 10g.

The VirtualCenter database can be remote to the VirtualCenter server. The VirtualCenter database user is configured as the initial Administrative user.

You must already have installed and configured the database application. Refer to Preparing for the VirtualCenter Database on page 67 for additional information.

2. **To create a Microsoft Access database:** Click the Use Access database button and click Next.

3. **To create an Oracle or SQL Server database connection:** Perform the following:
   a. Click Use custom SQL or Oracle database connection and click Next.
   b. Manually create a new System DSN. Click Add. Set the name to VMware VirtualCenter. Then click OK.
c. Select a driver for the data source. Click Finish.

d. Provide a data source name, for example, VMware VirtualCenter. Click OK.
e. When you are returned to the ODBC Data Source Administrator panel, select the new VirtualCenter data source you created. Click OK.

![ODBC Data Source Administrator](image)

f. Provide a user name and a password. Click Next.

![Database Information](image)

g. If an existing custom connection is already present, click Cancel to quit the ODBC Data Source Administrator.

VirtualCenter checks that the connection is valid before it allows the installation to continue.

For an Oracle database, connect through an Oracle driver. You must upgrade the Oracle driver version to match the corresponding Oracle database. If you
have not already done so, refer to Preparing for the VirtualCenter Database on page 67 and perform the preparation steps before proceeding.

VirtualCenter then stores the VirtualCenter database information in the registry.

For additional information on creating an ODBC data source, refer to your Windows documentation.

4. **If you have an existing database:** Click Yes at the prompt.

Do not overwrite your database. Accept the default, click Yes at the prompt.

**Caution:** If you click No, your existing database will be overwritten.

The default is yes. If you press yes, the wizard continues to the next step in the installation process. If you press no, you are prompted to confirm and then the database is deleted, or rather overwritten by the upgrade and/or new installation.

You see this prompt if a VirtualCenter database exists on the machine. You see this prompt even if you previously uninstalled VirtualCenter and selected to Remove the VMware VirtualCenter Database and Settings from this machine.

5. Proceed to the appropriate section.

- If you are not installing the Web service, skip to Completing the Installation on page 89.
- If you are installing the Web service, proceed to Installing the VMware Web Service on page 87.

**Installing the VMware Web Service**

You can install the Web service on any machine that also has the VirtualCenter server. The VMware SDK package is not installed through the VirtualCenter installer. For information about writing programs that use the VirtualCenter Web service, refer to the VMware SDK documentation available at:

www.vmware.com/support/developer/vc-sdk
To install the Web service, continue with the VirtualCenter installer:

1. Enter the information to enable the Web service to connect to the VirtualCenter server.

   - **VMware VirtualCenter user name** – This user must have VirtualCenter Administrator privileges.

   - **VMware VirtualCenter password** – The password for the user name you previously entered.

   The Web service uses this user name and password to connect to the VirtualCenter server and has the privileges assigned to this administrator user. Refer to the VirtualCenter documentation for information on the various users and groups.

   - **VMware Web Service port** – Specifies the Virtual Machine Agent server port number. Use the default port number of 8443, unless this port is already in use.

   - **Use Default VMware Digital Certificates Check box** – If the Use default VMware Digital Certificates check box is un-selected, the SSL screen appears.
2. Select whether to accept the default VMware certificates or use your own certificates.

a. **To accept the VMware certificates**: Leave all the fields unchanged and click Next.

b. **To specify your own certificates**: Enter the path to your own certificates and click Next.

You can update or modify the digital certificates at a later time. Refer to [Updating VMware SDK Digital Certificates on page 98](#).

The following files are required for digital certification:

- **server Certificate**: path to file is specified in vmaConfig.xml as `<sslCert>`
- **server CA Chain**: path to file is specified in vmaConfig.xml as `<sslCAChain>`
- **server private Key**: Stored in the registry under HKEY_LOCAL_MACHINE\SOFTWARE\Vmware, Inc.\VMware SDK\CertInfo

3. Proceed to the next section.

**Completing the Installation**

1. Verify that you are ready to proceed with installation. Click Install to continue the installation.

Progress messages appear while the installation proceeds. The VirtualCenter installer, as specified, installs the VirtualCenter server, starts the VirtualCenter
database, performs a default access setup of the open database connectivity (ODBC), registers and activates the VirtualCenter server, and installs the VirtualCenter client.

**Note:** If you are upgrading your VirtualCenter server, the VirtualCenter database is also upgraded. This can take a long time, from several minutes to hours, depending on the size of your database. Do not click **Cancel**. Be patient.

2. Close the installation wizard. Click **Finish**.

The selected VirtualCenter components are installed on your Windows machine. Appropriate services are started, including the VirtualCenter server and the ProtectedStorage service, as appropriate to the VirtualCenter components installed on the machine.
Finishing VirtualCenter Web Service Installation

After installing the SDK component, you should perform and verify the steps in the following sections:

- Verifying VirtualCenter Web Service Installation
- Changing VMware Web Service Options After Installation
- Updating VMware SDK Digital Certificates

Verifying VirtualCenter Web Service Installation

After installing the VirtualCenter Web service, you can verify that it is installed and working correctly using the following steps.

To verify the VirtualCenter Web Service Installation:

1. Validate that VirtualCenter is installed and running correctly by opening a VirtualCenter client and connecting to the VirtualCenter server. If VirtualCenter is not running, the Web service does not function. Log on with the same user name and password that you entered during installation to make sure that those are valid.

2. Open Internet Explorer on the Windows machine on which the two services are running and open the following URL:

   C:\Documents and Settings\All Users\Application Data\VMware\VMware VirtualCenter\VMA\login\login.html

3. Optionally, enable access from remote locations.
   a. Using a text editor, open the vmaConfig.xml file to include the URL path. The file is located at:
      C:\Documents and Settings\All Users\Application Data\VMware\VMware VirtualCenter\VMA
      This file is designated as hidden. Make sure your Windows Explorer is set to view hidden files if you cannot see the file.
   b. Add the following:

      <vma>
      <service>
      ...
      <docRoot>C:\Documents and Settings\All Users\Application Data\VMware\VMware VirtualCenter\VMA\login</docRoot>
c. Save the file.
d. Restart the Web service.
e. Type the Web service URL directly into your browser, specifying the Web service host machine. For example:

https://<webservicemachine>:8443/login.html

**Note:** Use caution when putting the **docRoot** element into **vmaConfig.xml**. Since this allows access to all files below the specified directory, a mistake in the **docRoot** directory path or placing documents in the directory that should not be present in it can result in documents not intended for public access becoming inadvertently accessible.

4. Enter the log in information

a. Type your user name and password.
b. Type the Web service URL, for example:

https://localhost:8443

**Note:** 8443 is the default port number. If you entered a different port number during installation, use that instead.

If the Web service is installed correctly, an XML message or file appears in the browser. This indicates that the Web service is operating and responding to queries.

If VirtualCenter does not accept the user name and password you entered, the XML message indicates **permission denied**.
If VirtualCenter does accept the user name and password you entered, an XML file similar to the one below appears, showing the top-level information paths available through the Web service.

```xml
<?xml version="1.0" encoding="UTF-8" ?>
<env:Envelope xmlns:xsd="http://www.w3.org/2001/XMLSchema"
              xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
              xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
  <env:Body>
    <GetContentsResponse env:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/"
                        xmlns="urn:vma1">
      <returnval>
        <handle>vma-0000-0000-0000</handle>
        <vHandle>vma-0000-0000-0000@fd0b16f9a6000002</vHandle>
        <body xsi:type="Container">
          <item>
            <key>vma-0000-0000-0001</key>
            <name>vcenter</name>
            <type>Container</type>
            <perm>
              <key>Administrators</key>
              <rights>Admin</rights>
            </perm>
          </item>
          <item>
            <key>vma-0000-0000-0002</key>
            <name>webservice</name>
            <type>Container</type>
          </item>
          <item>
            <key>vma-0000-0000-0008</key>
            <name>host</name>
            <type>Container</type>
          </item>
          <item>
            <key>vma-0000-0000-0009</key>
            <name>vm</name>
            <type>Container</type>
          </item>
        </body>
      </returnval>
    </GetContentsResponse>
  </env:Body>
</env:Envelope>
```
<key>vma-0000-0000-000a</key>
<name>unknownVM</name>
<type>Container</type>
</item>
- <item>
  <key>vma-stats-conf</key>
  <name>perf</name>
  <type>Container</type>
</item>
- <item>
  <key>vma-datastore</key>
  <name>datastore</name>
  <type>DatastoreInfoList</type>
</item>
- <item>
  <key>vma-global-conf</key>
  <name>customProperty</name>
  <type>CustomPropertyList</type>
</item>
- <item>
  <key>vma-0000-0000-0013</key>
  <name>event</name>
  <type>Container</type>
</item>
- <item>
  <key>vma-0000-0000-0018</key>
  <name>task</name>
  <type>Container</type>
</item>
- <item>
  <key>vma-0000-0000-0019</key>
  <name>schedule</name>
  <type>Container</type>
</item>
- <item>
  <key>vma-0000-0000-001a</key>
  <name>template</name>
  <type>Container</type>
</item>
If you see a page not-found message, make sure that you have the correct port number by reviewing the vmaConfig.xml file.

If you get different behavior, ensure that the user name and password you entered during installation are valid within VirtualCenter. Even if you enter an acceptable user name and password through the browser, if the Web service itself is not configured with valid credentials, it does not operate correctly. If necessary, modify the Web service configuration as described in Changing VMware Web Service Options After Installation on page 95, or uninstall and re-install the Web service.

5. Once you have been properly authenticated through the browser interface, review the information available through the Web service and confirm that it matches the VirtualCenter client.

To do this, append paths to the URL, for example:

https://localhost:8443/vcenter

This address returns an XML representation of the VirtualCenter hierarchy. Drill down further by, for example, appending the name of a farm: /vcenter/test-farm. Browsing top-level paths /host or /vm displays lists of the managed hosts or UUIDs of virtual machines being managed by VirtualCenter. Drilling down displays XML documents with managed host and virtual machine details.

Changing VMware Web Service Options After Installation

The Web service provides the vma command for making selected configuration modifications.

To use the vma command:

1. Stop the Web service.
b. Right-click the Web service and select Stop.

2. Start the command line window.

   Select Start > Run. Type cmd. Click OK.

3. Change to the Web service application data directory:

   cd c:\Documents And Settings\All Users\Application Data\VMware\VMware VirtualCenter\VMA

4. Execute the vma.exe command at the prompt:

   c:\Program Files\VMware\VMware VirtualCenter\vma.exe

You can invoke vma.exe in two ways: with and without the -update option.
To view help information on the vma command, type: vma -help.

- **Executing the vma command without the -update option**: Runs the Web service.

  The only option permitted in this mode is -config <config-filename>. This option specifies a configuration file for the Web service to use. If -config is not specified, the service looks for the default configuration file, vmaConfig.xml, in the current directory.

- **Executing the vma command with the -update option**: Updates the specified configuration information and exits. The configuration information that can be updated is listed in the table below.

  For example, to connect to the VirtualCenter server as a user other than the one you specified in the installation, type in the terminal window:

  vma -update -username <username> -password <password>

  where <username> is the new user name and <password> is the new password. The changes are written to the vmaConfig.xml file.
CHAPTER 3 Installing VMware VirtualCenter

The following table lists the `vma -update` command options.

<table>
<thead>
<tr>
<th>vma Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-help</td>
<td>Lists the options for this command.</td>
</tr>
<tr>
<td>-config &lt;config-file&gt;</td>
<td>Update the Web service to use the specified alternate VMA configuration file. The default file is <code>vmaConfig.xml</code>.</td>
</tr>
<tr>
<td>-VMAport &lt;port&gt;</td>
<td>Update the Web service to use the specified port number for the VMA server; the default is 8443.</td>
</tr>
<tr>
<td>-username &lt;username&gt;</td>
<td>Update the Web service to use the specified user name to connect to the VirtualCenter server.</td>
</tr>
<tr>
<td>-password &lt;password&gt;</td>
<td>Update the Web service to use the specified password for the user that connects to the VirtualCenter server.</td>
</tr>
<tr>
<td>-hostname &lt;hostname&gt;</td>
<td>Update the Web service to use the specified name of the VirtualCenter server. Typically, it is the same machine on which the Web service is installed, or <code>localhost</code>.</td>
</tr>
<tr>
<td>-port &lt;port&gt;</td>
<td>Update the Web service to use the specified port number of the VirtualCenter server. The default port number is 905.</td>
</tr>
<tr>
<td>-subject</td>
<td>For internal use.</td>
</tr>
<tr>
<td>-sslCert &lt;sslcert&gt;</td>
<td>Update the Web service to use the specified SSL certificate file.</td>
</tr>
<tr>
<td>-sslCAChain &lt;sslcachain&gt;</td>
<td>Update the Web service to use the specified SSL certificate CA chain file.</td>
</tr>
<tr>
<td>-sslPrivateKey &lt;sslprivatekey&gt;</td>
<td>Update the Web service to use the specified SSL private key file.</td>
</tr>
<tr>
<td>-sslPassphrase &lt;sslpassphrase&gt;</td>
<td>Update the Web service to use the specified SSL passphrase for private key.</td>
</tr>
</tbody>
</table>

5. Restart the Web service for changes to take effect.
   a. Select Start > Programs > Administrative Tools > Services.
   b. Right-click the Web service and select Start.

6. Edit the `vmaConfig.xml` file as needed.

   Although most Web service configuration options should be set through the `vma.exe -update` command, certain options can only be set by editing `vmaConfig.xml` directly.

   • Non-SSL port

   By default, the Web service is bound to an SSL port. To configure the Web service to listen on a non-SSL port, for example 8443, add the following to `vmaConfig.xml`: 
\begin{verbatim}
<vma>
<service>
...
<port>8443</port>
...
</service>
...
</vma>

• Log level

There are three levels of logging available for the Web service: \texttt{error}, \texttt{info}, and \texttt{verbose}. \texttt{Info} is the default level. This is reflected by the following link in \texttt{vmaConfig.xml}:

\begin{verbatim}
<eventlog level="info" />
\end{verbatim}
\end{verbatim}

\textbf{Updating VMware SDK Digital Certificates}

Periodically, for security reasons, you may choose to update your Web service digital certificates. You can modify or create your own. Only PEM format certificates are supported. The required certificates are:

• Server Certificate – stored in \texttt{vmaConfig.xml} as \texttt{<sslCert>}

• Server CA Chain – stored in \texttt{vmaConfig.xml} as \texttt{<sslCAChain>}

• Server private Key – stored in the registry under

\begin{verbatim}
HKEY_LOCAL_MACHINE\SOFTWARE\Vmware, Inc.\VMWare SDK\CertInfo
\end{verbatim}

\textbf{Note:} When you create the certificate files, place the privateKey in a separate file and store it separately from the other Web service digital certificates.

\textbf{To change the digital certificates from the Windows machine on which the Web service is installed:}

1. Start the command line window.

Select \texttt{Start > Run}. Type \texttt{cmd}. Click OK.

2. Change to the Web service application data directory:

\begin{verbatim}
cd c:\Documents And Settings\All Users\Application Data\VMware\VMware VirtualCenter\VMA
\end{verbatim}

3. Execute the \texttt{vma.exe} command at the prompt:

\begin{verbatim}
c:\Program Files\VMware\VMware VirtualCenter\vma.exe -update -sslCert <sslCert file>
\end{verbatim}
vma.exe -update -sslCACChain <sslCACChain file>
vma.exe -update -sslPrivateKey <privatekey file>
    -sslPassphrase <passphrase for privatekey, if one exists>

For example:

vma.exe -update -sslCert certificate.pem
vma.exe -update -sslCAChain root.pem
vma.exe -update -sslPrivateKey key.pem
    -sslPassphrase authentication
Configuring Communication Between VirtualCenter Components

The VirtualCenter server must be able to send data to every VirtualCenter managed host and receive data from each VirtualCenter client. To enable any migration or provisioning activities between VirtualCenter managed hosts, the source and target hosts must be able to receive data from each other.

During normal operations, VirtualCenter is listening for data from its managed hosts and clients on designated ports. Additionally, VirtualCenter assumes that its managed hosts are listening for data from VirtualCenter on designated ports. If there is a firewall between any of these elements, a hole must be created to allow data transfer to these designated ports.

The following sections describe how to facilitate this communication. For information on VMware SDK communication, refer to the VMware SDK documentation.

The following sections describe communication requirements and options.

- Connecting to Your VirtualCenter Clients Through a Firewall on page 100
- Connecting to Your VirtualCenter Hosts Through a Firewall on page 101

Connecting to Your VirtualCenter Clients Through a Firewall

The default port that VirtualCenter server uses to listen for data transfer from the VirtualCenter client is port 905.

If you have a firewall between your VirtualCenter server and VirtualCenter client, you must configure a means for the VirtualCenter server to receive data from the VirtualCenter client.

To enable the VirtualCenter server to receive data from the VirtualCenter client:

- Open port 905 in the firewall to allow data transfer from the VirtualCenter client to the VirtualCenter server. Refer to the firewall system administrator for additional information on configuring ports in a firewall.

If you want the VirtualCenter server to use a different port to receive VirtualCenter client data, refer to Configuring the Port VirtualCenter Uses to Communicate with the VirtualCenter Client on page 129.

If you want to tunnel the VirtualCenter client data through the firewall to the receiving port on the VirtualCenter server, refer to Configuring the Port VirtualCenter Uses to
Communicate with the VirtualCenter Client on page 129. This method is not recommended as it disables the VirtualCenter Console function.

**Connecting to Your VirtualCenter Hosts Through a Firewall**

The default port that VirtualCenter server uses to send data to the VirtualCenter managed host is port 902. The default port that VirtualCenter assumes is available when sending data between VirtualCenter managed hosts is port 902. This applies to both ESX Server and GSX Server hosts.

If you have a firewall between your VirtualCenter server and VirtualCenter managed host, you must configure a means for the VirtualCenter server to send data to the VirtualCenter managed host.

If you have a firewall between two VirtualCenter managed hosts and you wish to perform any source/target activities, such as migration or cloning, you must configure a means for the managed hosts to receive data.

**Note:** As of VirtualCenter version 1.1, GSX Server version 3.1 or later, and ESX Server version 2.1.1 or later, port 902 is used for all provisioning activities across a firewall. This includes migration, using templates, and cloning.

**To enable a VirtualCenter managed host to receive data on the default port:**

- Open port 902 in the firewall to allow data transfer to the VirtualCenter managed host from the VirtualCenter server or another VirtualCenter managed host. Refer to the firewall system administrator for additional information on configuring the ports.

**To enable a VirtualCenter managed host to receive data on a non-default port:**

1. Configure the ESX Server or GSX Server host to receive data through a designated port number.
   Refer to your ESX Server and GSX Server documentation.

2. Use the VirtualCenter Add Host wizard to add the managed host.
   Refer to Adding a Host to a Farm on page 177 for additional information.

**Note:** As of VirtualCenter version 1.2, GSX Server version 3.1 or later and ESX Server version 2.1.1 or later, port 902 is used for adding a managed host across a firewall. If you are adding an ESX Server before version 2.1.1, refer to the Knowledge Base for information on manually installing required VirtualCenter files on the ESX Server host.

3. When prompted, specify the port number you configured in step 1.
Uninstalling VirtualCenter

If both your VirtualCenter client and VirtualCenter server are installed on the same system, then you may uninstall one or both in the same step. You must have Administrator privileges to uninstall the VirtualCenter server. If you try to uninstall the VirtualCenter server while it is running, you must confirm that you really want to take action, as it causes a disruption to any VirtualCenter clients connected to the service.

Uninstalling the VirtualCenter components does not uninstall the .NET framework. Do not uninstall the .NET framework if you have other applications on your system that depend upon it.

To uninstall VirtualCenter, choose use either the VirtualCenter installer or the Windows Add/Remove tool.

Uninstalling VirtualCenter Using the Windows Add/Remove Tool

1. As Administrator on the Windows system, click through the Windows system to the Add/Remove Programs page.

   Select **Start > Settings > Control Panel > Add/Remove Programs**. Scroll through the list of installed programs and select the appropriate **VMware VirtualCenter** component to remove. This includes the VirtualCenter server, VirtualCenter client, and the Web service. Click **Remove**.

2. Confirm that you want to remove the program. Click **Yes**.

3. Select whether or not to remove the VirtualCenter database and settings.
Click **Yes** to remove all traces of VirtualCenter. Click **No** to retain the VirtualCenter database and settings in preparation for a reinstallation.

**Note:** This removes the DSN/ODBC entry so that VirtualCenter does not recognize it. This does not remove the actual database from your system unless it is a Microsoft Access database.

4. Close the installation wizard. Click **Finish**.

All or any installed VirtualCenter components are removed. This includes VirtualCenter client, VirtualCenter server, and Web service.

**Uninstalling VirtualCenter Using the VirtualCenter Installer**

1. As Administrator on the Windows system, run the installer.

   Double-click the VMware installation icon or select **Start > Run** and enter the location of the installer in the **Run** window.

2. Accept the VirtualCenter Installer. Click **Next**.

3. Select the **Remove** option.

![Program Maintenance](image)

Click the appropriate radio button, then click **Next**.

4. Verify that you are ready to proceed with uninstallation. Click **Remove**.

   VirtualCenter displays a progress screen as it proceeds with the uninstallation.
5. **If you are removing the VirtualCenter server:** Select whether or not to remove the VirtualCenter database settings.

   Click **Yes** to remove all VirtualCenter database settings. Click **No** to retain the VirtualCenter database and settings in preparation for a reinstallation.

   **Note:** This removes the DSN/ODBC entry so that VirtualCenter does not recognize it. This does not remove the actual database from your system unless it is a Microsoft Access database.

6. Close the installation wizard. Click **Finish**.

   All or any installed VirtualCenter components are removed. This includes VirtualCenter client, VirtualCenter server, and Web service.
Uninstalling a VirtualCenter Component

If both your VirtualCenter client and VirtualCenter server are installed on the same system, then you may uninstall one or both in the same step. You must have Administrator privileges to uninstall the VirtualCenter server. If you try to uninstall the VirtualCenter server while it is running, you must confirm that you really want to take action, as it causes a disruption to any VirtualCenter clients connected to the service.

Uninstalling the VirtualCenter components does not uninstall the .NET framework. Do not uninstall the .NET framework if you have other applications on your system that depend upon it.

To uninstall a VirtualCenter component, use either the VirtualCenter installer or the Windows Add/Remove tool.

Uninstalling a VirtualCenter Component Using the Windows Add/Remove Tool

1. As Administrator on the Windows system, click through the Windows system to the Add/Remove Programs page.

Select Start > Settings > Control Panel > Add/Remove Programs. Scroll through the list of installed programs and select the appropriate VMware VirtualCenter component to remove. This includes the VirtualCenter server, VirtualCenter client, and the Web service. Click Change.

The VirtualCenter installer starts.

2. Proceed to step 2 in Uninstalling a VirtualCenter Component Using the VirtualCenter Installer on page 107.
Uninstalling a VirtualCenter Component Using the VirtualCenter Installer

1. As Administrator on the Windows system, run the installer.
   Double-click the VMware installation icon or select Start > Run and enter the location of the installer in the Run window.
2. Accept the VirtualCenter Installer. Click Next.
3. Select the Modify option.

Click the appropriate radio button, then click Next.
4. Deselect the components to uninstall, as needed.
**Note:** If you uninstall the VirtualCenter server, the Web service is also uninstalled. If you uninstall the Web service only, the VirtualCenter server remains.

5. Verify that you are ready to proceed with uninstallation. Click **Next**.

VirtualCenter displays a progress screen as it proceeds with the uninstallation.

6. **If you are removing the VirtualCenter server:** Select whether or not to remove the VirtualCenter database settings.

   ![VirtualCenter Installation](image)

   Click **Yes** to remove all VirtualCenter database settings. Click **No** to retain the VirtualCenter database and settings in preparation for a reinstallation.

   **Note:** This removes the DSN/ODBC entry so that VirtualCenter does not recognize it. This does not remove the actual database from your system unless it is a Microsoft Access database.

7. Close the installation wizard. Click **Finish**.

   All or any installed VirtualCenter components are removed. This includes VirtualCenter client, VirtualCenter server, and Web service.
CHAPTER 3 Installing VMware VirtualCenter

Adding a VirtualCenter Component

Modifying your VirtualCenter installation includes adding or removing selected components. If you have installed a VirtualCenter component on a system, you can later install or remove individual components.

Note: To install the Web service on a machine, you must have installed the VirtualCenter server on that machine.

To modify the VirtualCenter installation:

1. Run the VirtualCenter installer.
   - Double-click the VMware installation icon or select Start > Run and enter the location of the installer in the Run window.

2. Specify the type of modification you are performing.

   ![VirtualCenter Modification Options](image)

   Click the appropriate radio button, then click Next to continue.
3. If you selected **Modify**, change the installation options for the VirtualCenter server and/or VirtualCenter client.

If you are adding a VirtualCenter client, skip to step 8.

If you are adding a VirtualCenter server, proceed with the next step.

If you are adding a Web service and the VirtualCenter server is already installed, proceed to step 7.

4. **If you are installing the VirtualCenter server**: Set up the VirtualCenter database.

Select whether to have the VirtualCenter create a database or to create either a custom SQL Server or Oracle database. The options are:
• **Use Access database** – VirtualCenter automatically creates a Microsoft Access database.
  This is a file in Microsoft Access format.

• **Use a custom SQL Server database connection** – VirtualCenter prompts for DSN information and then configures the database.
  Supported versions are SQL Server 7 and SQL Server 2000.

• **Use a custom Oracle database connection** — VirtualCenter prompts for DSN information, a user name, and a password, then configures the database.
  Supported versions are Oracle 8i, Oracle 9i, and Oracle 10g.

The VirtualCenter database can be remote to the VirtualCenter server. The VirtualCenter database user is configured as the initial Administrative user.

You must already have installed and configured the database application. Refer to *Preparing for the VirtualCenter Database on page 67* for additional information.

5. **To create a Microsoft Access database:** Click the **Use Access database** button, then click **Next**.

6. **To create an Oracle or SQL Server database connection:** Perform the following:
   a. Click **Use custom SQL or Oracle database connection** and click **Next**.
   b. Manually create a new System DSN. Click **Add**. Set the name to VMware VirtualCenter. Then click **OK**.

![ODBC Data Source Administrator](image)
c. Select a driver for the data source. Click Finish.

d. Provide a data source name, for example, VirtualCenter. Click OK.
e. When you are returned to the ODBC Data Source Administrator panel, select the new VirtualCenter data source you created. Click **OK**.

f. Provide a username and a password. Click **Next**.

g. If an existing custom connection is already present, click **Cancel** to quit the ODBC Data Source Administrator.

VirtualCenter checks that the connection is valid before it allows the installation to continue.

For an Oracle database, connect through an Oracle driver. You must upgrade the Oracle driver to match the corresponding Oracle database. If you have not
already done so, refer to Preparing for the VirtualCenter Database on page 67 and perform the preparation steps before proceeding.

VirtualCenter then stores the VirtualCenter database information in the registry.

For additional information on creating an ODBC data source, refer to your Windows documentation.

7. **To install the Web service:** You must have the VirtualCenter server installed and have selected the Web service option at the Custom step. Proceed with the VirtualCenter installer.

   a. Enter the information to enable the Web service to connect to the VirtualCenter server.

   - **VMware VirtualCenter server hostname and port** – Typically, this is the same machine on which you are installing the VirtualCenter or localhost. The default port number for the VirtualCenter server is 905.

   - **VMware Web Service port** – Specifies the Virtual Machine Agent server port number. Use the default port number of 8443, unless this port is already in use.

   - **VMware VirtualCenter user name** – This user must have VirtualCenter Administrator privileges.

   - **VMware VirtualCenter password** – The password for the user name you previously entered.
The Web service uses this user name and password to connect to the VirtualCenter server, and has the privileges assigned to this Administrator user. Refer to the VirtualCenter documentation for information on the various users and groups.

b. Select whether to accept the default VMware certificates or use your own certificates.

- **To accept the VMware certificates:** Leave all the fields unchanged and click Next.
- **To specify your own certificates:** Enter the path to your own certificates, then click Next.

You can update or modify the digital certificates at a later time. Refer to Updating VMware SDK Digital Certificates on page 98.

The following files are required for digital certification:

- server Certificate: stored in vmaConfig.xml as <sslCert>
- server CA Chain: stored in vmaConfig.xml as <sslCACChain>
- server private Key: Stored in the registry under HKEY_LOCAL_MACHINE\SOFTWARE\Vmware, Inc.\VMware SDK\CertInfo

8. Verify that you are ready to proceed with reinstallation. Click Install.

The screen title reflects the choice to repair or modify the installation of VirtualCenter on this machine. Click Install.

VirtualCenter displays a progress screen as the reinstallation proceeds. The VirtualCenter database retains any existing content.

10. **If you installed the Web service:** Verify the Web service installation. Refer to Finishing VirtualCenter Web Service Installation on page 91
Starting VMware VirtualCenter

This chapter describes how to start, stop and move around in VirtualCenter. In addition, as licensing is required to add a host, this chapter describes how to add licenses. This chapter contains the following topics:

- Starting or Stopping VMware VirtualCenter on page 118
- Starting and Stopping the VirtualCenter Client on page 124
- Adding Licenses on page 127
- Configuring Communication Through a Firewall on page 129
- Navigating in the VirtualCenter Client on page 133

You need only a Read-Only User role assigned to the farm, host, or virtual machine to view objects in VirtualCenter. However, you need VirtualCenter Administrator role to add or change licenses.
Starting or Stopping VMware VirtualCenter

- The VirtualCenter server is installed.
  The server is a single Windows service and is installed to run automatically. As a Windows Service, the VirtualCenter server runs continuously in the background, performing its monitoring and managing activities even when no VirtualCenter clients are connected and even if nobody is logged in on the computer where it resides.

- The VirtualCenter database is configured during installation.
  Applying changes to the VirtualCenter database after the VirtualCenter server is started might cause a temporary disruption to other users accessing the same VirtualCenter server.

- The VirtualCenter client is installed.
  While all VirtualCenter activities are performed by the VirtualCenter server, you must use the VirtualCenter client to monitor, manage, and control the server. A single server can support multiple, simultaneously connected clients.

To monitor and manage the VirtualCenter activities:

1. Start the VirtualCenter client.
2. Log on to the VirtualCenter server.

The following sections discuss starting and stopping VMware VirtualCenter:

- Getting Started with VirtualCenter Users
- Verifying the VirtualCenter Server Has Started
- Restarting the VirtualCenter Server
- Stopping the VirtualCenter Server
- Restarting the VirtualCenter Host Agent
- Starting the VirtualCenter Client and Logging On
- Stopping the VirtualCenter Client and Logging Off

Getting Started with VirtualCenter Users

When VirtualCenter is installed, all users in the Administrators group are assigned VirtualCenter Administrator privileges by default for the VirtualCenter environment.
Permissions for all other VirtualCenter users need to be explicitly set by a VirtualCenter Administrator.

VirtualCenter supports user groups. Users may belong to one or more groups, to allow aggregate security assignments. Users assume the roles assigned to any group of which they are members. Refer to Assigning Access Permissions on page 482 for additional information on assigning access permission and roles to users and groups.

**Verifying the VirtualCenter Server Has Started**

The VirtualCenter server starts automatically when you start the Windows machine on which it is installed. It also restarts each time the VirtualCenter managed host is rebooted.

**To verify that the VirtualCenter server is running, check your Windows Services:**

1. Depending on your Windows version, go to the Control Panel > Administrative Tools > Services > VMware VirtualCenter Server. The Status column indicates whether or not the service is started.
2. For additional information, display the Properties dialog box.
   - Right-click the VMware VirtualCenter Server and select Properties. In the VMware VirtualCenter Services Properties dialog box, select the General tab and view the service status.

**Restarting the VirtualCenter Server**

The VirtualCenter server service starts automatically when the machine on which it is installed is booted. If you have manually stopped the VirtualCenter server service or need start it for any reason, perform the steps below.

**To restart the VirtualCenter server through your Windows Services:**

1. Depending on your Windows version, go to the Control Panel > Administrative Tools > Services > VMware VirtualCenter Server.
2. Right-click **VMware VirtualCenter Server**, select **Start**, and wait for it to complete.

3. If the VMware Web Service is installed, start its service. Right-click **VMware VirtualCenter Web Service**, select **Start**, and wait for it to complete. The Web service is stopped whenever the VirtualCenter server stops.

4. Close the Properties dialog box by clicking the close symbol X at the top of the dialog box.

   When Windows completes the powering-on process, close the Properties dialog box.

**Stopping the VirtualCenter Server**

The VirtualCenter server is a Windows service, so you should go through your Windows interface to select the service and stop it.

**Note:** You should not have to stop the VirtualCenter server. It is best for the VirtualCenter server to have continuous operation. Continuous operation ensures that all monitoring and task activities are performed as expected.

**To stop the VirtualCenter server:**

1. Select **Start > Control Panel > Administrative Tools > Services > VMware VirtualCenter Service.**
2. Right-click the VMware VirtualCenter Server, select **Stop**, and wait for it to stop.

3. If the VMware Web Service is installed, verify the prompt to stop its service. Click **Yes**.

The Web service is stopped whenever the VirtualCenter server stops.

4. Close the Properties dialog box by clicking the close symbol X at the top of the dialog box.

When Windows completes powering off the process, close the Properties dialog box.

**Restarting the VirtualCenter Host Agent**

The VirtualCenter agent is installed on each managed host automatically. It is also started automatically. If your host is still connected to VirtualCenter but is not responding properly, restart it as follows.

**To restart the VirtualCenter agent:**

1. From the VirtualCenter client, display the inventory panel to display the virtual machine.
Click the **Inventory button** in the navigation bar. Expand the inventory as needed, and click the appropriate host.

2. Display the Managed Host Properties dialog box.
   a. Select the managed host whose VirtualCenter agent you wish to restart.
   b. Select **Edit > Properties** or right-click on the selected managed host and select **Properties**. Alternatively, from the select managed host Summary page, click **Edit Properties**.

3. Select the **Advanced** tab. Click **Restart**.

VirtualCenter displays a confirmation message, **A request to restart the VMware VirtualCenter Agent was sent**. Click **OK**.

4. **If the managed host has lost contact with VirtualCenter**, use the tools available on the host restart the agent.

**To restart the VirtualCenter agent on a GSX Server or VMware Server host through your Windows Services:**

1. Go to the GSX Server or VMware Server host.
2. Select **Start > Settings > Control Panel > Administrative Tools > Services > VMware VirtualCenter agent**.
3. Right-click the VMware VirtualCenter agent and select **Start**.
4. Close the **Properties** box by clicking the close symbol X at the top of the dialog box.
   When Windows completes the powering-on process, close the Properties dialog box.
To restart the VirtualCenter agent on a Linux GSX Server or VMware Server host:
Refer to the GSX Server or VMware Server host and use your standard Linux commands to restart the agent. Refer to your Linux, GSX Server, or VMware Server documentation for further information.

To restart the VirtualCenter agent on a ESX Server host:
Refer to the ESX Server host and use your standard Linux commands to restart the agent. Refer to your Linux or ESX Server documentation for further information.
Starting and Stopping the VirtualCenter Client

This section describes starting and stopping the VirtualCenter client and logging on to a VirtualCenter server.

Starting the VirtualCenter Client and Logging On

VirtualCenter server supports multiple VirtualCenter client logons. The VirtualCenter client can be installed on any machine that has network access to the VirtualCenter server.

To start a VirtualCenter client session:

1. Log on to your Windows system.
   - The first time you start the VirtualCenter client, log on as the administrator.
   - By default, administrators are allowed to log on to VirtualCenter. Administrators here are defined to be either:
     - Members of the local Administrators group if the VirtualCenter server is not a domain controller.
     - Members of the domain Administrators group if the VirtualCenter Server is a domain controller.
   - If the managed host is not a domain controller, log on as either <local host name>\<user> or <user>, where <user> is a member of the local Administrators group.
   - If the managed host is a domain controller, you must log on as <domain>\<user>, where <domain> is the domain name for which the managed host is a controller and <user> is a member of that domain’s Domain Administrators group. This practice is not recommended.

2. Launch the VirtualCenter client.
   - Double-click a shortcut or select the application through Start > Programs > VMware > Vmware VirtualCenter.

3. When you start the VirtualCenter client, log on to the VirtualCenter server.
Enter or select the VirtualCenter server name, your user name, and your password for that VirtualCenter server. Click Log In to continue.

The default localhost location is the local Windows server or machine where you started the VirtualCenter client. Using localhost in the Log In screen, the VirtualCenter client assumes the VirtualCenter server is located on the same host as the VirtualCenter client. Alternatively, click the Server list arrow and select from the list of available VirtualCenter servers or type the name of the VirtualCenter server on your network. An IP address or a name is acceptable.

**Note:** Only previously typed VirtualCenter servers appear in the Server pull-down list.

The default for the user name field is the user currently logged on. To change the user name when you log on, highlight the name and type over it, as you do in any other Windows logon dialog box.

4. Locate and apply the VirtualCenter licenses, if needed.

If your VirtualCenter server does not have its licenses installed yet, the licensing screen appears.
To make licenses available to the VirtualCenter server:

a. Click the Add License button and select the appropriate license file.
b. Click Open.
c. Click Done on the Licensing screen.

Refer to Adding Licenses on page 127 for additional information.

The VirtualCenter client screen appears. The screen settings match those of your last session.

Note: If this is the first time you have logged onto the VirtualCenter server, an empty Inventory screen appears. Adding a farm to begin monitoring and managing your virtual machines through VirtualCenter. Refer to Working with Farms on page 165 for additional information.

Stopping the VirtualCenter Client and Logging Off

Closing a VirtualCenter client does not stop the VirtualCenter server.

To stop a VirtualCenter client session:

- Click the close box (X) in the upper right corner of the VirtualCenter client window or select File > Exit.

The VirtualCenter client shuts down. The VirtualCenter client is logged out from the VirtualCenter server. The VirtualCenter server continues to run all its normal activities in the background. Any scheduled tasks are saved and performed by the VirtualCenter server.
Adding Licenses

Licenses are required for various activities within your VirtualCenter environment. These activities include:

**Starting the VirtualCenter server** – One license is required for each instance of the VirtualCenter server.

**Adding a managed host connection** – VirtualCenter must have sufficient processor licenses to cover all the hosts’ processors. If a managed host is removed from the VirtualCenter environment, the corresponding license is released and is available for another managed host.

Host evaluation licenses are valid for VirtualCenter use.

**Note:** Newer processors have two CPU cores in each processor package. Systems with dual-core processors must use ESX Server 2.5.2 or later, GSX Server 3.2 or later, or VMware Server 1.0 or later. VirtualCenter licenses are issued by pairs of processor packages, not by processor cores. Therefore, if the system is using two dual-core processors or two single-core processors, the system requires a single 2-processor VirtualCenter license.

**Migrating (VMotion) a virtual machine** – You must have sufficient licenses for the processors in the migration host. Performing migration with VMotion requires two managed hosts: the target and the source machine. Both managed hosts must have VMotion licenses.

The VirtualCenter client licensing provides:

- A license inventory window that reports on license usage.
- An uploading license keys window.

**Note:** The migration process has additional requirements. Refer to Enabling VMotion on page 226 for information.

To add your licenses to VirtualCenter:

1. Create your license file in a location accessible by VirtualCenter client.
   - You received the license keys in a confirmation email when you purchased VirtualCenter.
   - Place all your VirtualCenter licenses into a plain text file. You have the option to place all your VirtualCenter licenses into one text file or keep the licenses in separate files. If you use separate files, you need to follow this procedure for each license file.
Ensure that the license key string starts in column 1 of the license text file. That is flush left. Do not have any leading spaces at the beginning of the license file. In addition, be sure to keep the integrity of the licenses you are given; that is, keep the hyphenation format as it is provided. For example, xxxxx-xxxxx-xxxxx-xxxx.

2. From the VirtualCenter client, open the License window.

Select Help > Edit Licensing Information.

3. Select the license key file.

Click Add Licences then browse to locate the license key file. Click Open on the browse window.

VirtualCenter adds the licenses to the VirtualCenter database.

Note: Adding a non-evaluation license removes all previously installed evaluation licenses of that same license type.

4. Close the Licensing window. Click Done.

You are now ready to add hosts and perform migrations.
CHAPTER 4
Starting VMware VirtualCenter

Configuring Communication Through a Firewall

VirtualCenter server receives data transmissions from the VirtualCenter client through a firewall on port 905 by default. If a firewall is preventing the VirtualCenter client from connecting to the VirtualCenter server, you have three options for correcting this.

- Reconfigure your firewall to allow the VirtualCenter client to communicate with port 905 on the VirtualCenter server. Refer to the instructions for your firewall.

- Alternately, you can use some port other than 905 (and if necessary, configure your firewall to open this other port). You need to configure the VirtualCenter server to use the desired port.

  Refer to Configuring the Port VirtualCenter Uses to Communicate with the VirtualCenter Client on page 129 for information on changing this port number.

- If neither of the above options is possible and your firewall allows Web traffic to pass to the VirtualCenter server, then you can connect the VirtualCenter client to the VirtualCenter server using a standard Web connection.

  **Caution:** If you use this option to open a communication channel between your VirtualCenter server and VirtualCenter client, the VirtualCenter Console does not work.

  Refer to Configuring VirtualCenter Communication Over a Web Connection on page 130 for information on setting up the Web site port.

Configuring the Port VirtualCenter Uses to Communicate with the VirtualCenter Client

1. Start the VirtualCenter client.

   Refer to Starting and Stopping the VirtualCenter Client on page 124.

2. Choose File > VMware VirtualCenter Settings.

3. Click the Advanced tab.
4. Scroll to the VirtualCenter.PortNumber field.

5. Enter the port number your VirtualCenter client will use to communicate with the VirtualCenter server. Click OK.
   The port must be less than 64000.

6. Restart the VirtualCenter server to accept the changes.
   Refer to Starting or Stopping VMware VirtualCenter on page 118.

Configuring VirtualCenter Communication Over a Web Connection

One alternative to connecting the VirtualCenter server and VirtualCenter client on opposite sides of a firewall is through a standard Web connection.

Note: You have the option to specify any other port.

Caution: If you use this option to open a communication channel between your VirtualCenter server and VirtualCenter client, the VirtualCenter Console does not work.

To enable your VirtualCenter client to connect with the VirtualCenter server across a firewall using a Web tunnel, change the Web site port address on your VirtualCenter server.

To open a Web port between the VirtualCenter server and the VirtualCenter client, using IIS:

On the VirtualCenter server:
1. Install Internet Information Services (IIS) Manager.
   Typically, this is installed by default with the Microsoft Windows operating system.

2. Enable IIS
   Select Start > Control Panel > Administrative Tools > Internet Services Manager > Internet Information Services

3. From the IIS manager, open the Windows dialog box.
   Expand the <server_name>.
   Right-click on Default Web Site.
   Select Properties > Web Site tab.

4. Set the port value for the VirtualCenter service.
   In the Web Site Description block, enter the value of the TCP Port or, if allowed, the SSL port.
   A value of 80 is the default non-secure TCP Web site port. A value of 443 is the default secure SSL Web site port.

5. Set the dll directory.
   a. If needed, create the directory:
      C:\inetpub\wwwroot\vpx\n   b. Set the permissions for this directory to allow execution.
   c. Copy the file VmdbHttpProxy.dll to this directory.
      The file is in \Program Files\VMware\VMware VirtualCenter

6. Verify that the change has been applied.
   Stop then restart the default Web site.

7. Each time you update the VirtualCenter version, repeat this process.
   When you start the VirtualCenter client, enter the VirtualCenter server Web site address as in the Server field.
   • If you are using the secure Web port or any other non-default port, use the full name: http://<server name>:<port>.
     For example, http://vcs:443.
   • If you are using the default non-secure Web site port, any of the following combinations work: http://<server name>, <server name>80, or http://<server name>:80.
Navigating in the VirtualCenter Client

This section describes common Windows practices that affect the VirtualCenter client. For detailed information on the windows and options in the VirtualCenter client, refer to Working with the VirtualCenter Client on page 139.

Briefly, the VirtualCenter client is divided into two areas.

- A heading area with a main menu, navigation bar, and toolbar.
- A data area which displays different information depending upon the option selected in the navigation bar.

The navigation bar options divide VirtualCenter’s primary tasks into:

**Inventory** – Divided into two subpanels, the inventory panel and the information panel. This navigation bar option displays all the objects contained within VirtualCenter. Through selecting objects in either of the two subpanels, you perform and specify actions.

**Scheduled Tasks** – Displays an information panel that lists all the tasks scheduled to occur.

**Template** – Displays an information panel that lists all the templates available for deploying. This list includes templates that are stored in the template upload directory, stored on a local disk, or stored on the same datastore as their source virtual machine.

**Events** – Displays an information panel that lists all the events that have occurred in the VirtualCenter.

The navigation topics are discussed in the following sections:

- Selecting Objects
- Monitoring Objects
- Performing Actions on Objects

**Selecting Objects**

VirtualCenter objects are farms, groups, hosts, and virtual machines. Selecting an object does the following:

- Allows you to view the status of the object.
- Enables the menus so you can select actions to take upon the object.
To select an object:

1. Select the appropriate navigation bar option. The options are **Inventory**, **Scheduled Tasks**, **Templates**, and **Events**.

2. Browse through the hierarchy in the inventory panel until you see the icon for the object; then click it.

When an object is selected, the object label in the inventory panel backfills and the information panel updates its display to reflect the data for the selected object.

To view an object menu:

Select the appropriate object and select the appropriate action from the Menu bar. Alternatively, right-click the object. A popup menu with the object’s available actions appears.

For each type of object, such as farm, host, or virtual machine, in the inventory panel, a corresponding default tab appears in the information panel. For example, if you select a managed host in the inventory panel, the information panel displays **Summary**, **Virtual Machines**, **Performance**, **Events**, and **Alarms** tabs. If you select a farm, the information panel displays **Summary**, **Virtual Machines**, **Hosts**, **Performance**, **Events**, **Alarms**, and **Permissions** tabs.

Multiple selection has limited support in the inventory panel.

The inventory panel and information panel share a single selection list. Selecting an object in one panel deselects any other object in the other panel.
Menu actions, from either the menu bar or a popup menu, apply to the currently selected object. If no object is selected, the menu action is not available. A popup menu can appear only for a selected object. Refer to Popup Menus on page 142 for additional information on the popup menu options.

To change the name of an object:
Press F2 on a selected item or click the text of a selected item and type the new name.

Monitoring Objects
Monitoring a managed host or a virtual machine requires that it has been added to the VirtualCenter environment. Refer to Adding a Host to a Farm on page 177 for information on adding objects to your VirtualCenter server.

To check the status of an object:
1. Start the VirtualCenter client.
   Refer to Starting or Stopping VMware VirtualCenter on page 118.
2. Select the Inventory button in the navigation bar. The options are Inventory, Scheduled Tasks, Templates, and Events.
   - If you select the Scheduled Tasks, Templates, or Events options, the information panel displays the scheduled tasks, available templates, and all events that have occurred on the VirtualCenter server.
   - If you select the Inventory button, drill through the inventory panel lists to view individual objects, such as hosts, farms, and virtual machines.
3. Click on the object to view it.

When you select an object, the object label in the inventory panel is shown in blue and the information panel updates its display to reflect the object’s data.

4. Click the appropriate tab in information panel.

The data corresponding to the object and tab selected is shown. Click through the tabs to view the information about the object, as needed.

**Performing Actions on Objects**

This section describes only the basic process for performing tasks in the VirtualCenter client. This section does not describe specific settings and conditions. Refer to the chapter specific to the task you wish to perform for additional information.

To view an object, you must have a role of Read-Only User or greater assigned to that object. To take action on an object, you must have Virtual Machine User, Virtual Machine Administrator, or VirtualCenter Administrator role assigned to you for that object. Refer to Setting Access and Permissions on page 469 for additional information on permissions with VirtualCenter objects.

There are three methods for taking actions upon objects in VirtualCenter:

- Selecting the action from the menu bar at the top of the VirtualCenter window. Refer to Menu Bar on page 141 for information on the menu bar options.
- Selecting the action from the object popup menu or button.
The following procedure describes how to select the action from the object menu or button.

- Scheduling the action through the Scheduled Tasks panel.
  
  Refer to Creating a Scheduled Task on page 397 to information on scheduling tasks.

**To perform an action on a VirtualCenter object:**

1. Start the VirtualCenter client
2. Connect to the appropriate VirtualCenter server.
3. Select the object you want to view or upon which you want to perform an action.
   
   Browse through the hierarchy in the inventory panel until you see the icon for the object, then click it. An object can be selected in the inventory panel or the information panel.

   If the object is not in the view:
   
   - Verify you are logged onto the correct VirtualCenter server.
   - Add the host to VirtualCenter control. Refer to Working with Hosts on page 171 for information.

4. Select the appropriate menu option:
   
   Once an object is selected:
   
   - Select a menu option from the main menu.
   - Right-click on the object and select from the popup menu.

5. Follow the VirtualCenter prompts.
   
   Depending upon the action you selected, either the view in the information panel changes or a wizard prompts for information to complete the transaction. The wizard includes the option to schedule the action for a later time.
Working with the VirtualCenter Client

The VirtualCenter client provides mechanisms for interacting with the VirtualCenter server. Conceptually, the VirtualCenter client display combines the simplicity of Windows Explorer (navigating groups and lists of objects) with the more sophisticated capabilities of Windows Task Manager and the Microsoft Management Console (selecting and charting performance information).

This chapter describes the specific layout of the VirtualCenter client. Refer to Working with the VirtualCenter Data on page 429 for descriptions on viewing and interpreting the data displayed in the VirtualCenter client. This chapter contains the following sections:

- Introducing the VirtualCenter Client Window on page 140
- Understanding the Information Elements on page 150
- Accessing Properties and Settings on page 156

You need only a Read Only User role assigned to the farm, host, or virtual machine to perform the activities described in this chapter.
Introducing the VirtualCenter Client Window

The default VirtualCenter client layout is a single window with a menu bar, a navigation bar, a toolbar, a status bar, a panel section, and popup menus.

VirtualCenter Client Layout

The VirtualCenter client areas are covered in the following sections:

- Menu Bar
- Popup Menus
- Console Menu (not shown)
- Navigation Bar
- Toolbar
- Status Bar
- Panel Sections
**Menu Bar**

The menu bar provides access to all commands and operates in a manner consistent with other Windows applications. The table below lists all the options available from these five menus. The menu bar options are:

- **File Menu** – Similar to the File menu in most applications with two exceptions.
  - A print option is not available on the File menu. To print, use either the Print Screen option in Windows to take a copy of the VirtualCenter window or export the VirtualCenter data to another format and print from another application.
  - A save option is not available. The VirtualCenter client is similar to a browser. Most user manipulations are persistent in the display of the VirtualCenter data.

- **Edit Menu** – Displays options relevant to the selected object.

- **VM (Virtual Machine) Menu** – Is enabled only when a virtual machine is selected in the Inventory panel.

- **View Menu** – Controls which panels are visible.

- **Help Menu** – Displays the online help options and the licensing option.

<table>
<thead>
<tr>
<th>File Menu</th>
<th>Edit Menu</th>
<th>VM Menu</th>
<th>View Menu</th>
<th>Help Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>New &gt; Farm Group</td>
<td>Remove</td>
<td>Shut Down Guest</td>
<td>Inventory</td>
<td>Help Topics</td>
</tr>
<tr>
<td>New &gt; Farm</td>
<td>Rename</td>
<td>Suspend after running script</td>
<td>Scheduled Tasks</td>
<td>User Manual</td>
</tr>
<tr>
<td>New &gt; Virtual Machine Group</td>
<td>Delete From Disk</td>
<td>Resume and run script</td>
<td>Templates</td>
<td>Guest Operating System Install Guide</td>
</tr>
<tr>
<td>New &gt; Add Host</td>
<td>Virtual Machine Resources</td>
<td>Power On and run script</td>
<td>Events</td>
<td>VMware on the Web &gt; VMware, Inc. Home Page</td>
</tr>
<tr>
<td>New &gt; Virtual Machine</td>
<td>Host Configuration</td>
<td>Restart Guest</td>
<td>Toolbar</td>
<td>VMware on the Web &gt; Online Support</td>
</tr>
<tr>
<td>New &gt; Deploy Virtual Machine from Template</td>
<td>Properties</td>
<td>Power On</td>
<td>Status Bar</td>
<td>VMware on the Web &gt; Register Now</td>
</tr>
<tr>
<td>New &gt; Alarm</td>
<td></td>
<td>Power Off</td>
<td>Filtering</td>
<td>Check for Updates on the Web</td>
</tr>
<tr>
<td>New &gt; Template</td>
<td></td>
<td>Suspend</td>
<td></td>
<td>Edit Licensing Information</td>
</tr>
<tr>
<td>New &gt; Scheduled Task</td>
<td></td>
<td>Resume</td>
<td></td>
<td>About VMware VirtualCenter</td>
</tr>
<tr>
<td>New &gt; Add Permission</td>
<td></td>
<td>Reset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Host Connect</td>
<td></td>
<td>Send Ctrl+Alt+Del</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Host Disconnect</td>
<td></td>
<td>Install VMware Tools</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Popup Menus

Popup menus provide direct access to many of the menu bar options. Popup menus are available from most objects in both the Inventory panel and the Information panel.

To view a popup menu:
Right-click the selected object or press Shift+F10.

Console Menu

The console of a powered-on virtual machine is available through VirtualCenter.
To view the virtual machine console:

Select the **Inventory Navigation** button, select a powered-on virtual machine in the Inventory panel, and click the **Console** tab in the Information panel.

![Console icon](image1)

To pop out the virtual machine console:

Click the **Console** icon in the navigation bar. A copy of the Console window separates from the VirtualCenter client. Additional menus appear.

Additional menu options are available from the pop-out Console window.

![Additional Console menu](image2)
The popout virtual machine Console has the following menu items. The embedded Console has similar menu items but does not include all of the external Console menu items.

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>VM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit</td>
<td>Properties</td>
<td>Power On</td>
</tr>
<tr>
<td></td>
<td>Preferences</td>
<td>Power Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Suspend</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Resume</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reset</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Send</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Install VMware Tools</td>
</tr>
</tbody>
</table>

**Navigation Bar**

The navigation bar provides shortcut buttons that load the matching toolbar and panel into the VirtualCenter client window. Similar to the Outlook shortcut bar, the navigation bar combines and displays associated tasks and information. When a button has been selected, it remains selected to indicate the current view. The buttons represent the VirtualCenter functional areas:

- **Inventory** – Displays tasks and data related to viewing the status of and managing virtual machines, hosts, farms, and groups.
- **Tasks** – Provides tasks and data related to scheduling tasks.
- **Templates** – Provides tasks and data related to using templates.
- **Events** – Provides tasks and data related to viewing current events.

**To change the look of the navigation bar:**

Right-click the navigation bar and select the appropriate option.
**Toolbar**
The toolbar provides buttons for the most commonly used actions.

**To view or hide a toolbar:**
Select View > Toolbars.

The toolbar provides buttons for the most commonly used actions.

To view or hide a toolbar:
Select View > Toolbars.

![VirtualCenter Client Toolbar Icons and Associated Actions for the Inventory button](image)

Some toolbar options may be grayed out depending upon the navigation bar option and level selected.

The following table describes the toolbar actions.

<table>
<thead>
<tr>
<th>Button</th>
<th>Actions</th>
</tr>
</thead>
</table>
| Back/Forward Arrows | Back – Moves to the previously viewed page.  
Forward – Moves to the next page. |
| Power Off/Suspend/  
Power On/Reset  
Buttons | Power Off – Powers down the selected active virtual machine.  
Suspend – Suspends the selected active virtual machine.  
Power On – Powers up the selected inactive virtual machine.  
Reset – Reboots the selected active virtual machine. |
### Button | Actions
--- | ---
Task List Menu Button | Create a New Virtual Machine – Launches a wizard to configure a new virtual machine.  
New Farm – Creates a new empty farm, used for arranging managed hosts or groups.  
Add Virtual Machine Groups – Creates a new empty group for arranging virtual machines.  
Add Host – Launches a wizard to attach an existing managed host to the VirtualCenter inventory.  
Create a Scheduled Task – Launches a wizard to perform an automated activity at a particular time.  
Import a Template – Imports a virtual machine to use as a template for creating multiple identical new VMs.  
Create an Alarm – Creates an alarm.

Migration Button | This button launches the migration wizard. Migration is the act of moving a virtual machine from one managed host to another. There are two types of migration.  
**Migrate a Virtual Machine** – Moves a powered off virtual machine between managed hosts on a farm.  
**Migrate a Virtual Machine with VMotion** – Moves a powered on virtual machine between managed hosts on a farm. This functionality requires activation of VMotion on both the source and target managed by the host.

Clone Button | This button launches the clone wizard. A clone is a copy plus customization of a virtual machine.

Add Permission Button | This button opens a dialog box in which you can add or change access permissions.
Status Bar
The status bar appears at the bottom of the window. It displays the status of the connection between the VirtualCenter client and the VirtualCenter server.

To hide or view the status bar:
Select View > Status bar.

Panel Sections
The panel section is the primary information and action display area.
The content of this display area varies, depending upon the navigation bar selected.
The content of the panel section for Tasks, Templates, and Events is a simple list.
The content of the panel section for Inventory (of virtual machines, hosts, farms, and groups) is divided into two panels: the inventory panel and the information panel.

- **Inventory panel** – Displays a hierarchical list of VirtualCenter objects when the Inventory button is selected from the navigation bar. The displayed list includes Server Farms, farm groups, farms, hosts, virtual machine groups, and virtual machines.

- **Information panels** – Display lists and charts. There are various information panels. There is one panel each for the Tasks, Templates, and Events navigation bar options. There are multiple panels for the Inventory button, and these are divided into tabbed elements that vary, depending upon the object selected in the inventory panel.
The table below lists the tabbed panel options available for each inventory panel object.

<table>
<thead>
<tr>
<th>Inventory Object</th>
<th>Farms</th>
<th>Summary</th>
<th>Virtual Machines</th>
<th>Hosts</th>
<th>Performance</th>
<th>Tasks</th>
<th>Events</th>
<th>Alarms</th>
<th>Console</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Farms</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Farm Group</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Farm</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Host</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>VM Group</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Virtual Machine</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

- **Active tasks** – Displays any currently running active tasks. Included is a progress bar indicating the percentage complete of each task. The active tasks panel displays across all four navigation button layouts: Inventory, Scheduled Tasks, Templates and Events.

![Image of active tasks](image.png)

To select an object:

Single-click the appropriate object in either the Inventory button or on the information panel.
To view a popup menu:
Right-click the appropriate object.

To close or open a panel:
Click the arrow in the panel menu bar. When the panel is hidden, the panel menu bar is a strip along the side of the VirtualCenter client window.

To resize a panel:
Click on a resizing panel side and drag it to an appropriate size.

Your choices for the panels are persistent across VirtualCenter client sessions. If you run multiple VirtualCenter client sessions using different user names, the settings from the last session to quit determine the values for the next VirtualCenter client session.
Understanding the Information Elements

The information elements include the symbols, attributes, lists, and charts. The information elements are covered in the following sections:

- Symbol Information Elements
- Attribute Elements
- List Elements
- Chart Elements

Symbol Information Elements

Monitoring data appears in the form of tables and charts, and uses color, icons, and timelines for easy viewing and analysis.

Color coding – Depending upon the location of the colored icon, the color indicates status or power state. The color options are red, yellow, and green. Color conditions are propagated up the hierarchy.
Icons – Used in conjunction with color mapping to add a visual representation of the associated text. Icons for virtual machine power states are the same as those used with other VMware virtualization platform products, such as ESX Server, GSX Server, or VMware Server.

Attribute Elements
Attributes are the resources that are being monitored and managed for all the managed hosts and virtual machines in your VirtualCenter environment. Attributes’ status and states appear on the various inventory panels.

Custom attributes – These attributes can be used to associate user-specific meta-information with virtual machines and managed hosts. Once you have created the attributes, set the value for the attribute on each virtual machine or managed host, as appropriate. This value is stored with VirtualCenter and not with the virtual machine or managed host. Then use the new attribute to filter information about your virtual machines and managed hosts. If you no longer need the custom attribute, remove it. A custom attribute is always a string.

To add a custom attribute:
1. Open the Custom Attributes dialog box.
   Select File > Custom Attributes.
2. Add a custom attribute and click Add.

   ![](image)

   The attribute is added to the list of virtual machine characteristics.
3. Change the attribute name as needed.
   Click in the Name field and type the name you want to assign to the attribute.
4. Enter the values for the custom attribute.

a. Select the object one level up the hierarchy that contains the objects to which you wish to apply the attribute. For example, if you want to enter attribute values for managed hosts, select the farm and the Hosts tab for a list of hosts.

b. For each managed host or virtual machine, click the new attribute's column. In the information panel, the new attribute is added to the header.

c. Type the attribute value that is appropriate for each managed host or virtual machine.

**List Elements**

Sort any list by clicking the column label heading. A triangle in the column head shows the sort order as ascending or descending.

The Virtual Machines tab for virtual machines provides a means to filter for selected virtual machines. A filter is sorted by a key word. Select which columns to search for the keyword.

**To sort a list:**

Click a column heading to sort the list by entries in that column. The current selection does not change.

**To change between ascending and descending order:**

Click the triangle in the column heading.
To select items in a list:
Click an individual item. Press Shift-click or Ctrl-click to select multiple items. All lists can be sorted.

To view or remove columns in a list:
Right-click the column header and select the column name from the list.

To filter the view of virtual machines:
Click the arrow to view a list of attributes from which to select. Type text directly into the filtering field to specify search criteria. The Filter field does not support boolean expressions or special characters and is not case sensitive. Click OK to display only those virtual machine that match the criteria. Click Clear to change the filter.

Note: There is a one-second interval between keystrokes. If you type in the text and wait for one second, the search will start automatically. You don’t have to click OK or Enter.

The list is updated based on whether or not filtering is on or off. For example, if you are in the Virtual Machines tab and you have filtered the list and the filtered text is powered on, you only see the list of virtual machines whose state is set to powered on. If the state of any of these virtual machines changes to something else, then they will be removed from the list. New virtual machines that are added are also being filtered. Filtering is persistent for the session.

To remove a filter:
Click Clear, or delete the entry in of the filtering field and click OK. VirtualCenter displays the full list of available items.

To select columns to search for the filtering keyword:
Right-click in the contains: field and select or deselect the appropriate column names. Filtering is inclusive, not exclusive. If the keyword is found in any of the selected columns, the line item is included in the list.

Chart Elements
Each chart contains data relative to the selected object in the inventory panel. The charts display the data across time.

Each resource has a summary graph and one graph per instance of that resource. For example, the processor usage resource has one graph per processor and net usage has one graph per NIC. View only one set of resource graphs at a time.
Note: The graphs for a virtual machine show the shares allocated to that virtual machine as a percentage of the managed host processors.

To view the large version of a chart:
Click the thumbnail, and the larger version appears in the information panel.

To configure the increments of time:
Click the pull-down menu and select the appropriate increment. For the range selected, the interval is shown. The options are:

- **Past Day** – Displays the status of the item in five minute intervals
- **Past Week** – Displays the status of the item in one hour intervals
- **Past Month** – Displays the status of the item in one day intervals
- **Past Year** – Displays the status of the item in one month intervals
To customize the graph view:

Click the **Customize Chart** button and select from the options.

The graph options vary, depending upon the resource selected. In the example above, the options represent the data in the primary chart.
Accessing Properties and Settings

There are five sets of properties and settings dialog boxes. Each set makes adjustments to the corresponding VirtualCenter environment. These adjustments are described in the following sections:

- VMware VirtualCenter Settings
- VMware Management Interface
- Host Properties
- Virtual Machine Resources
- Virtual Machine Properties
- Schedule Task Properties
- Template Properties
- Alarm Properties

VMware VirtualCenter Settings

To access the VMware VirtualCenter settings, select File > VMware VirtualCenter Settings.

**Note:** Changes to this setting apply to the current VirtualCenter server only. If you log out and log on to another VirtualCenter server, the settings are specific to that VirtualCenter server only.

This dialog box has three tabs:
• **Performance** – Lists the interval settings used to collect performance data that appears on the Performance tab in the information panel.

• **Templates** – Displays the field for specifying the template upload directory. This directory stores templates that are not stored on a shared datastore.
• **Advanced** – Lists a variety of fields.

![VirtualCenter Settings](image)

The Advanced tab fields are:

- **instance.id** – Generates unique MAC addresses and UUIDs for virtual machines. In some cases, it is possible to have more than one VirtualCenter running in the same company. Each of these VirtualCenters must have its own unique instance.id. By default, an ID value is generated randomly. However, this value is editable. The only requirement is that it be a unique number from 0 to 63.

- **snmp.receiver.n.name/snmp.receiver.n.port/snmp.receiver.n.community** – Used for alarm notification. Refer to Preparing for SNMP Alarm Notification on page 416 for information on setting these values.

- **mail.sender/mail.smtp.sender/mail.smtp.port** – Used for alarm notification. Refer to Preparing for Email Message SMTP Alarm Notification on page 415 for information on setting these values.

- **host.reconnectThreshold** – Specifies how long, in minutes, VirtualCenter should continue to try to connect automatically to a managed host. The default value is 30 minutes.

- **client.timeout.normal** – Specifies how long, in seconds, the VirtualCenter client waits for a response from the VirtualCenter server before timing out. The default is 30 seconds.
• **client.timeout.long** – Specifies how long, in seconds, the VirtualCenter client waits for a response from the VirtualCenter server for long operations. The default is 120 seconds.

• **perf.numThreads** – Specifies the number of threads used for collecting performance statistics from managed hosts.

• **perf.level** – Specifies the level of detail for performance statistics collection. Legal values are minimal, typical, and full. The default is full, and more information on this setting is available in Configuring the Statistics Detail for Performance Data on page 466

• **log.verbose** – Specifies verbose logging when set to 1.

• **task.interval** – Specifies how often, in seconds, VirtualCenter checks if any scheduled tasks are ready to be executed or alarms should be triggered. The default is 5 seconds.

• **ads.maxFetch** – Specifies the maximum number of users and groups the VirtualCenter stores from the selected domain. To specify no maximum limit, enter zero (0).

• **ads.timeout** – Specifies, in seconds, the maximum amount of time VirtualCenter allows the search to run on the selected domain. Searching very large domains can take a very long time. This value must be greater than zero (0).

• **ads.checkInterval** – Verifies that all users and groups known to VirtualCenter currently exist in Windows. For example, if user Smith is assigned permissions and in the domain the user’s name is subsequently changed to Smith2, VirtualCenter concludes that Smith no longer exists and removes permissions for that user.

• **server.options** – Used for advanced debugging and troubleshooting. Use this field only when directed by VMware technical support.

• **VirtualCenter.PortNumber** – Specifies the port through which VirtualCenter client sends data to the VirtualCenter server. Default is port 905.

**To view a tool tip on each field:**

Drag your mouse over a data field.

**VMware Management Interface**

Selecting a Edit > Host Configuration or right-clicking a host and selecting Edit Host Configuration activates a link in VirtualCenter, starts a browser, and seeks permission to access the VMware Management Interface for the selected managed host. ESX
Server, GSX Server, or VMware Server hosts are configured and managed through the VMware Management Interface.

Host Properties
Selecting a managed host > Properties displays the <host_machine> Properties dialog box. The managed host Properties dialog box has two tabs:

VMotion – This option is available for ESX Server hosts. Use this dialog to configure VMotion settings for the selected managed host. Refer to Enabling VMotion on page 226 for information on setting up a managed host for VMotion.

Datastore – This option is available for GSX Server or VMware Server. Use this dialog to configure datastore settings for the selected managed host. Refer to Configuring
Datastores on GSX Server or VMware Server Hosts on page 271 for information on setting up a managed host datastore.

Advanced – Provides an option to restart the managed host’s VirtualCenter agent.

Virtual Machine Resources
Selecting a Edit > Host Configuration or right-clicking a host and selecting Edit Host Configuration displays the Virtual Machine Resource dialog box. This is a list of all the virtual machines running on the selected managed host and the percentage of
resources allocated to the virtual machine. Refer to Allocating Host Resources on page 194 for information on allocating managed host resources to virtual machines.

Virtual Machine Properties

Selecting a virtual machine > Properties displays the Virtual Machine Properties dialog box. This dialog box has three tabs:

- **Hardware** – Use this tab to add hardware elements to your virtual machine.
- **Options** – This tab lists some general virtual machine settings, actions to take during a power state change, and actions taken for debugging during a process.
- **Resources** – Use this tab to modify the resource shares on the managed host of a virtual machine. The modifiable resources are processor (or CPU), memory, disk, and network.
Refer to Editing an Existing Virtual Machine Configuration on page 345 for more information about editing the configuration of a virtual machine.

Schedule Task Properties
Click the Scheduled Tasks button in the navigation bar. Highlight a task and select Edit > Properties to display the Scheduled Task Properties dialog box. From this box, modify the time, date, and frequency of a scheduled activity.
Template Properties

Click the Templates button in the navigation bar. Highlight a template and select Edit > Properties to display the Template Properties dialog box. From this box, change the name and description of the template.

Alarm Properties

Select File > New > Alarm to display the Alarm Properties dialog box for creating and modifying alarms.
This chapter describes how to perform VirtualCenter farm-related tasks. This chapter contains the following sections:

- Working with VirtualCenter Farms on page 166
- Working with Farm Groups on page 168

You need to use a Virtual Machine Administrator role assigned to the Server Farm to perform the activities described in this chapter.
Working with VirtualCenter Farms

A farm is the primary organizational structure used in VirtualCenter. A farm contains managed hosts and virtual machines. All actions taken upon managed hosts and virtual machines are applied within their farm. Within a farm, you can monitor and manage virtual machines separately from their hosts and use VMotion; you cannot perform migration between farms. The VirtualCenter farm topics are covered in the following sections:

- Adding a Farm
- Removing a Farm

Adding a Farm

To add a farm:

1. From the VirtualCenter client, display the inventory panel and select the appropriate farm group or Server Farms.
   Click the Inventory button in the navigation bar. Expand the inventory as needed.

2. Add a new farm.
   Select the Server Farms icon in the inventory panel. From the main or right-click popup menu, select New Farm or New Farm Group.

A new farm is added to the hierarchy. Type in a useful name.
Removing a Farm

To remove a farm:

1. From the VirtualCenter client, display the inventory panel and select the appropriate farm.
   
   Click the Inventory button in the navigation bar. Expand the inventory as needed, and click the appropriate farm.

2. Remove the farm.
   
   Select the appropriate farm. From the main or right-click popup menu, select Remove.

3. Confirm that you want to remove the farm. Click Yes.

VirtualCenter removes all virtual machine groups, hosts, and virtual machines within the farm from the managed inventory. In addition, all the associated tasks, alarms, and events are also removed. Assigned processor and migration licenses are returned to available status. Virtual machines that were on the managed host remain on the managed host.
Working with Farm Groups

A farm group is an organizational feature. Farm groups can be added only to the Server Farms top level and to other farm groups. Hierarchically, farm groups contain farms or other farm groups. Use farm groups to organize farms into logical entities. For example, group all the systems that support a functional group, such as Sales or Finance, or that support a location, such as the Building 12 site or the San Francisco site. The farm group topics are covered in the following sections:

- Adding a Farm Group
- Moving a Farm to a Farm Group
- Removing a Farm Group

Adding a Farm Group
To add a farm group:

1. From the VirtualCenter client, display the inventory panel.
   
   Click the Inventory button in the navigation bar. Select the appropriate icon for either Server Farms or another farm group.

2. Select New Farm Group.
   
   With the object highlighted, select New Farm Group from the main menu or right-click popup menu. VirtualCenter adds a new group to the Inventory hierarchy.
Moving a Farm to a Farm Group
To move a farm to a farm group:
1. From the VirtualCenter client, display the inventory panel.
   Click the Inventory button in the navigation bar. Select the appropriate icon either Server Farms or another farm group.
2. Click and drag the farm to the farm group.

Removing a Farm Group
Removing a farm group removes all its contents from the VirtualCenter environment. The contents include any other farms, hosts, and virtual machines.

To remove a farm group:
1. From the VirtualCenter client, display the inventory panel.
   Click the Inventory button in the navigation bar.
2. Remove the farm group.
   Select the appropriate farm group and select Remove from the main or right-click popup menu.
3. If you have farms, hosts and virtual machines in the farm group: confirm that you want to remove the farm group. Click Yes.

VirtualCenter removes the selected farm group and all items contained within it from the hierarchy and the VirtualCenter environment. Any assigned processor and migration licenses return to available status. All virtual machines remain on the managed host.
This chapter describes how to perform managed host-related tasks. This chapter contains the following sections:

- Hosts Overview on page 173
- Understanding Host States on page 174
- Preparing to Add a GSX Server or VMware Server Host on page 175
- Adding a Host to a Farm on page 177
- Configuring Network Labels for GSX Server or VMware Server Hosts on page 182
- Connecting or Disconnecting a Host on page 185
- Using Host Power Options on page 187
- Moving Hosts Between Farms on page 189
- Automatically Reconnecting a Host on page 190
- Removing a Host on page 191
- Allocating Host Resources on page 194
- Configuring a Host on page 197
You need to have a Virtual Machine Administrator role assigned to the farm containing the managed host to perform the tasks described in this chapter.
Hosts Overview

ESX Server, GSX Server, and VMware Server hosts can be managed by VirtualCenter. All managed hosts are added to VirtualCenter farms.

All virtual machines on managed hosts are automatically discovered and imported into VirtualCenter.

A virtual machine is removed from VirtualCenter server only when either the virtual machine, the managed host with the virtual machine, or the farm with the virtual machine is explicitly removed through the VirtualCenter client.

When you add multiple managed hosts, VirtualCenter identifies any naming conflicts that exist between virtual machines and alerts the system administrator, who can then rename virtual machines as necessary. Configure the virtual machine to display names. The name can be up to 80 characters long and contain alphanumeric characters and the underscore (_) and hyphen (-) characters. The name must also be unique across all virtual machines within a virtual machine group.

When VirtualCenter connects to a managed host, it does so as a privileged user. The individual VirtualCenter user does not necessarily need to be an administrative user on the managed host. Refer to Setting Access and Permissions on page 469 for information on setting up VirtualCenter users.

A host can be managed by only one instance of the VirtualCenter server.
**Understanding Host States**

Actions taken upon a managed host require that the managed host be in a specific state. Whenever an operation is performed on a managed host, the host state changes. While the state is in transition, the state field displays a term that describes the transition.

**Note:** Disconnecting a managed host is different from removing the managed host from VirtualCenter. Disconnecting a managed host does not remove it from VirtualCenter; it only temporarily suspends all VirtualCenter monitoring activities. The managed host and its associated virtual machines remain in the VirtualCenter inventory. Removing a managed host removes the managed host and all its associated virtual machines from the VirtualCenter inventory.

The figure below illustrates states, transitions and state changing commands for a managed host.
Preparing to Add a GSX Server or VMware Server Host

To accommodate the GSX Server or VMware Server Windows host security option for running a virtual machine as a specific user account, a VirtualCenter user must be configured on the GSX Server or VMware Server host.

**Note:** This section does not apply to virtual machines running on a GSX Server or VMware Server Linux host.

1. Create or select the VirtualCenter user on the to-be-managed GSX Server or VMware Server host. This user:
   - Performs operations on behalf of VirtualCenter on the GSX Server or VMware Server host.
   - May be configured on a domain controller.
   - May be the same user used by VirtualCenter across multiple managed hosts.
   - Must have access to all the files for all the virtual machines on the GSX Server or VMware Server host.
   - Must have access to GSX Server or VMware Server network shares so VirtualCenter can create and store virtual machines on the network share.

2. Configure the user profile so that the user has permission to power on all the virtual machines on the GSX Server or VMware Server Windows host.

If there are any existing virtual machines on the GSX Server or VMware Server host, ensure that they are configured to run as the VirtualCenter user. This ensures that the user authorization to perform a function with a GSX Server or VMware Server virtual machine is set within the confines of VirtualCenter and that the user of the virtual machine has appropriate VirtualCenter access to storage, disk shares, and the GSX Server or VMware Server datastore.

Any virtual machine created on a GSX Server or VMware Server host through VirtualCenter is automatically configured to run as the user account specified when the host was added to VirtualCenter.

Refer to your GSX Server or VMware Server documentation for information on changing the user accounts on your GSX Server or VMware Server virtual machines.
3. Provide VirtualCenter user identification when you add the GSX Server or VMware Server host as a managed host in VirtualCenter. Refer to Adding a Host to a Farm on page 177.

**Note:** Although the VirtualCenter user can view all virtual machines on the GSX Server or VMware Server host, VirtualCenter cannot take actions upon any virtual machines that are not configured to allow the VirtualCenter user to perform the power functions.
Adding a Host to a Farm

Virtual machines exist on managed hosts within the network. Hosts are added to the VirtualCenter environment. The VirtualCenter server automatically discovers and adds all the virtual machines contained within that managed host to the VirtualCenter environment.

The figure below illustrates the process for adding a host to VirtualCenter. Refer to Abbreviations on page 16 for a description of abbreviations.

Adding Host to VirtualCenter Environment with Automatic Discovery of Virtual Machines

A host can be added to only one VirtualCenter server.

To add a host:

1. Ensure a communication channel through a firewall, if needed.

   If any managed host in the VirtualCenter environment is behind a firewall, ensure that the managed host can communicate with the VirtualCenter server and with all other hosts on port 902, or other configured port. Refer to Configuring Communication Between VirtualCenter Components on page 100 for additional information.

2. From the VirtualCenter client, display the inventory panel and select the appropriate farm.

   Click the Inventory button in the navigation bar. Expand the inventory as needed, and click the appropriate farm.

3. Start the Add Host Wizard.
Select the appropriate farm and select **New Host** from the main or right-click popup menu.

4. Confirm proceeding with the Add Host Wizard. Click **Next**.

5. Enter the managed host connection settings.

![VirtualCenter Add Host Wizard](image)

- Type the name of the managed host in the **Hostname** field.
- If the managed host is not using the default port of 902 between the managed host and the VirtualCenter server, specify the port that is open for communication.

Refer to your ESX Server or GSX Server or VMware Server documentation for information on configuring a port on your managed host. Refer to your firewall administrator for information on opening a port in the firewall for communication.

- Enter the **Username** and **Password** for a user account that has administrative privileges on the selected managed host.

  VirtualCenter uses the root account to log in to the system and then creates a special user account. VirtualCenter then uses this account for all future authentication.

- Click **Next** to continue.

When the dialog is complete and you click **Next**, VirtualCenter does the following:

- Connects to the managed host.
• Verifies that the managed host is not already being managed. If it is already being managed on another farm, VirtualCenter displays an information message.

• Reads the number of processors on the managed host and allocates the appropriate number of licenses. The number of processors is stored in the VirtualCenter database and is verified upon each managed host reconnection and VirtualCenter start up.

**Note:** Newer processors have two CPU cores in each processor package. Systems with dual-core processors must use ESX Server 2.5.2 or later, GSX Server 3.2 or later, or VMware Server 1.0 or later. VirtualCenter licenses are issued by pairs of processor packages, not by processor cores. Therefore, if the system is using two dual-core processors or two single-core processors, the system requires a single 2-processor VirtualCenter license.

• Verifies that the managed host version is supported. If it is not, VirtualCenter checks if the current version can be upgraded. If the managed host version can be upgraded, VirtualCenter prompts you to perform an upgrade.

• Imports existing virtual machines.

6. **If you are adding an ESX Server:** Enable VMotion for the managed host, as needed.

   ![VirtualCenter Add Host Wizard](image)

   **To enable VMotion:**

   Click **Yes**. Enter the **Network Label**, **IP Address**, and **Gateway** for the managed host. This is the information for the migration network, including which NIC it
uses, and its IP address and gateway. The migration network should be a separate network.

If VMotion is enabled, VirtualCenter checks for a migration license and adds it to the managed host information.

- **To leave VMotion disabled:** Click No.
- Click Next to continue.

Refer to Enabling VMotion on page 226 for additional information.

7. **If you are adding a GSX Server or VMware Server:** Identify the VirtualCenter user.

When you add a GSX Server or VMware Server host to a farm through the Add Host Wizard, VirtualCenter requires two user names in the following order:

- The user specified in step 5 to add the managed host. This is the user who has administrator privileges on the GSX Server or VMware Server host.
- The VirtualCenter user.

VirtualCenter impersonates the VirtualCenter user on the managed host when accessing files and performing management and provisioning operations on a managed host. This user may be the same or different than the administrator user specified in step 5. This user must have sufficient privileges to access the physical resources that the virtual machines use, such as files and networks.
Note: At any given point in time, there is only one username and password that VirtualCenter stores for a given managed host. That is the account for the VirtualCenter user. At step 5, you specify the administrator user that proves that you have the permission to work in VirtualCenter and on the managed host. If at this step, you choose a different (maybe non-administrator) user, you are essentially saying, “Now that I have proven that I am authorized, connect to that managed host and run all the virtual machines as this other user.” If you decide not to specify a different user account here, you are essentially saying, “I want to connect to this managed host and perform VirtualCenter operations as this administrator.”

8. Complete the Add Host wizard and click Finish.

The Add Host Wizard searches the network for the specified managed host, performs the discovery to identify all the virtual machines on the managed host, and if possible, connects the managed host. If the wizard cannot connect the managed host, the managed host is not added to the inventory. If the wizard can connect to the managed host but for some reason cannot remain connected to the VirtualCenter server, the host is added, but is in an disconnected state. This occurs, for example, if the host is already being managed by another VirtualCenter server.

If you click Cancel, the host is removed from the VirtualCenter inventory.

If you are adding a GSX Server or VMware Server host: All virtual machines on that managed host are listed. This includes virtual machines that are designated as private within GSX Server or VMware Server. Though VirtualCenter can manage private virtual machines, only users with an appropriate VirtualCenter designated permission role can perform actions on a private virtual machine.
Configuring Network Labels for GSX Server or VMware Server Hosts

Prior to using the migration feature or adding new virtual machines on a GSX Server or VMware Server host, you must assign network labels to each network interface in each GSX Server or VMware Server host.

**Note:** Virtual machines created on VMware Server or upgraded through VMware Server Console cannot be migrated or cloned back to either a GSX Server or ESX Server. Templates created from a VMware Server virtual machine cannot be deployed to either a GSX Server or ESX Server.

VirtualCenter allows the management of GSX Server and VMware Server hosts, which is a powerful new feature. But VirtualCenter is centered around the concept of virtual machine migration, while the normal GSX Server and VMware Server console is centered around a single host. This different emphasis causes the two products to have very different views of virtual network connections. In VirtualCenter, the most important thing about a virtual network interface is what network it connects to because that limits what possible managed hosts the virtual machine containing it could migrate to.

The normal GSX Server and VMware Server methods for specifying network interfaces (Bridged, NAT, Host-Only, or Custom) do not apply in the VirtualCenter environment. For example:

- A VirtualCenter-managed farm might include three physical networks:
  - One which connects through a firewall to the Internet
  - One which is internal to the server room
  - One which is dedicated for connection to networked storage
- On a GSX Server or VMware Server host, these networks might be set up as:
  - The *bridged* network
  - A *custom* network on vnet4
  - A network not even visible to the virtual machines directly
- On a second GSX Server or VMware Server host, the network might be set up as:
  - Only one network card, connected to the server-room network only. On this managed host, the network would be a bridged network.
Note: In this example, knowing that a network is bridged is of no value at all in determining what network it is.

VirtualCenter must be able to identify the actual network that the interface connects to. This has to be manually set by someone who knows the physical connections and GSX Server or VMware Server custom settings.

Specifically, VirtualCenter provides a method for assigning a label or name to each network connection on each managed host. This network name becomes a global identifier for the actual network. In the example above, the administrator might choose to call the first network the main or corporate or intranet network, the second network the server link network, and the third network the storage network.

These labels are used by VirtualCenter when a virtual machine is migrated. The virtual NICs are matched up to the networks on the new managed host by the network names.

So in order to provision network cards to virtual machines on GSX Server or VMware Server hosts using VirtualCenter, you must name the network interfaces on each GSX Server or VMware Server host. This naming need only be done once per network per managed host.

To specify network labels for all the virtual NICs in your GSX Server virtual machines:

You only need to do this once. Refer to your GSX Server documentation for additional information.

1. Log on to the management interface as root or Administrator.
2. Click the Options tab.
3. Click the Network connections link.
4. Assign or change the labels as desired and click OK or click Cancel to refuse the change.

To configure a virtual machine to use a named network:

1. From the management interface, select the Hardware tab.
2. Select either Add a New or Edit an Existing network adapter.
3. Select Network Connection and click the Named radio button.
4. Select the appropriate network from the pull-down menu.
Existing virtual machines on your GSX Server hosts continue to work. Naming your networks does not modify the existing virtual machines in any way. Their virtual NICs continue to be read as bridged, NAT, and so on. If you edit the virtual machine configuration under VirtualCenter, you have the option of changing them from their current value to a network name value. Only VirtualCenter specific name options are offered. The GSX Server-specific values, such as Bridged and NAT, are not valid VirtualCenter options.

**To specify network labels for all the virtual NICs in your VMware Server virtual machines:**

You only need to do this once. Refer to your VMware Server documentation for additional information.

1. Register your VMware Server with VirtualCenter.
   
   If you do not perform this step, the option for setting network labels is not available.

2. Log on to the VMware Server Console.

3. Select the **Host menu > Settings**.

4. In the **Host Settings** dialog box, select the **Network Labels** tab.

5. Add your network labels. Click the Add button, enter a label name, click OK.

6. Close the dialog box. Click OK.
Connecting or Disconnecting a Host

You have the option to disconnect and reconnect a managed host that is being managed by a particular VirtualCenter server. This section describes how to reconnect a managed host.

**Note:** Disconnecting a managed host is different from removing the managed host from VirtualCenter. Disconnecting a managed host does not remove it from VirtualCenter; it only temporarily suspends all VirtualCenter monitoring activities. The managed host and its associated virtual machines remain in the VirtualCenter inventory. Removing a managed host removes the managed host and all its associated virtual machines from the VirtualCenter inventory.

**To connect or disconnect to a managed host:**

1. From the VirtualCenter client, display the inventory panel and select the appropriate managed host.
   
   Click the **Inventory button** in the navigation bar. Expand the inventory as needed, and click the appropriate managed host.

2. If needed, add the appropriate managed host to the VirtualCenter.
   
   Refer to **Adding a Host to a Farm on page 177**.

3. Connect or disconnect the appropriate managed host.
   
   Select the appropriate managed host icon in the inventory panel, and select **Connect** or **Disconnect** from the main or right-click popup menu.

   VirtualCenter displays text indicating the transitional state for the managed host until it verifies and adjusts the licensing as needed and completes the transaction.

   When the managed host’s connection status to VirtualCenter is changed, the statuses of the virtual machines on that managed host are updated to reflect the change.
If the managed host is disconnected, the word is appended to the object name in parentheses, and the object is grayed out. All associated virtual machines are similarly grayed out and labeled.

If the managed host is connected, the disconnected designation is removed and the object name is in full black print. All associated virtual machines are similarly labeled.
Using Host Power Options

You have the option to power down or restart (reboot) any VirtualCenter managed host. Powering down a managed host disconnects it though it does not remove it from the VirtualCenter inventory.

**Caution:** When you power off a VirtualCenter managed host, you must use the normal ESX Server, GSX Server, or VMware Server startup processes outside of VirtualCenter. There is no start managed host option through VirtualCenter once the managed host has been shut down. Refer to your ESX Server, GSX Server, or VMware Server documentation for additional information.

**Note:** Disconnecting a managed host is different from removing the managed host from VirtualCenter. Disconnecting a managed host does not remove it from VirtualCenter; it only temporarily suspends all VirtualCenter monitoring activities. The managed host and its associated virtual machines remain in the VirtualCenter inventory. Removing a managed host removes the managed host and all its associated virtual machines from the VirtualCenter inventory.

To power off or reboot a managed host:

1. Select the managed host from the inventory panel and open the power operation dialog box.

   Either select **File > Shut Down Host** or select **Shut Down Host** from the managed host’s Summary tab.

2. Shut down or restart the managed host, as appropriate.

   a. Click the **Shut down** or **Restart** button, as appropriate.

   b. Add notes that describe why you shut down or restarted (rebooted) the managed host and information on when the managed host should be restarted.

   c. Click **OK**.
VirtualCenter enters the provided text into the managed host system event log, then powers off the selected managed host.

When the host is restarted, VirtualCenter attempts to reconnect to the restarted managed host. If this occurs, and you do not want the host connected, cancel the connect command.
Moving Hosts Between Farms

Managed hosts and virtual machines can be on only one farm at a time. To move a managed host from one farm to another, you must disconnect the managed host from the current farm and add or connect it to the new farm. When you add the managed host to the new farm, the virtual machines associated with the managed host are also moved to the new farm.
Automatically Reconnecting a Host

VirtualCenter automatically tries to reconnect to a managed host if the connection is lost.

Define how long VirtualCenter tries to re-establish the connection.

To configure automatic managed host reconnection:

1. From the VirtualCenter client, open the VMware VirtualCenter Settings dialog box and select the Advanced tab.

   Select File > VMware VirtualCenter Settings. When the dialog box displays, select the Advanced tab.

2. Enter a value in minutes in the host.reconnectThreshold field. Click OK.
Removing a Host

Removing a managed host from VirtualCenter breaks the connection and stops all monitoring and managing functions of that managed host and of all the virtual machines on that managed host. The managed host and its associated virtual machines are removed from the inventory. Historical data remains in the VirtualCenter database.

**Note:** If at all possible, remove managed hosts while they are connected. Removing a disconnect managed host does not remove the VirtualCenter agent from the managed host.

**Note:** Removing a managed host is different from disconnecting the managed host from VirtualCenter. Disconnecting a managed host does not remove it from VirtualCenter; it only temporarily suspends all VirtualCenter monitoring activities. The managed host and its associated virtual machines remain in the VirtualCenter inventory.

Removing a managed host from VirtualCenter does not remove the virtual machines from the managed host or datastore. It removes only VirtualCenter's access to the managed host and virtual machines on that managed host.

The figure below illustrates process for removing a managed host from VirtualCenter. Refer to Abbreviations on page 16 for a description of abbreviations. In the example
here, notice the lost link between the VirtualCenter server and the removed managed host, while the managed host files remain on the datastore.

Removing a Host

**To remove a managed host:**

1. From the VirtualCenter client, display the inventory panel and select the appropriate managed host.

   Click the **Inventory button** in the navigation bar. Expand the inventory as needed, and click the appropriate managed host.

2. To remove the VirtualCenter agent from the managed host, ensure that the managed host is in a connected state.

   The managed host can be in a connected or disconnected state when you remove it. However, removing a managed host while it is disconnected does not remove the VirtualCenter agent from the managed host.

   **Note:** Disconnecting a managed host is different from removing the managed host from VirtualCenter. Disconnecting a managed host does not remove it from VirtualCenter; it only temporarily suspends all VirtualCenter monitoring activities. The managed host and its associated virtual machines remain in the VirtualCenter inventory. Removing a managed host removes the managed host and all its associated virtual machines from the VirtualCenter inventory.
3. Select **Remove**.

Select the appropriate managed host icon in the inventory panel and select **Remove** from the main or right-click popup menu.

4. Confirm that you wish to remove the managed host and all its associated virtual machines.

Click **Yes** to remove the managed host. Click **No** to keep the managed host.

If you click **Yes**, VirtualCenter removes the managed host and associated virtual machines from the VirtualCenter environment. VirtualCenter then returns all associated processor and migration licenses to available status.

**Note:** Removing the managed host does not power off or alter any of the virtual machines on the managed host. It only removes the managed host from VirtualCenter control.
Allocating Host Resources

The Virtual Machine Resources dialog box lists all the virtual machines currently installed on the managed host. Use this dialog box to make adjustments to all the managed host’s virtual machines in a single view. Refer to Changing Virtual Machine Resource Settings on page 387 to view resource settings for individual virtual machines.

Note: This option is available for ESX Server hosts only.

To adjust the allocation of resources for each virtual machine on the managed host:

1. From the VirtualCenter client, display the inventory panel and select the appropriate managed host.
   
   Click the Inventory button in the navigation bar. Expand the inventory as needed, and click the appropriate managed host.

2. Select the managed host whose resources you wish to reallocate.

3. Select the Virtual Machine Resources option.
   
   This can be found on the Edit main menu, on the managed host right-click menu, and in the managed host Summary tab commands list.

4. Select the processor (or CPU), memory, disk I/O, or network allocation to adjust.
   
   Click the processor (or CPU), Memory, Disk I/O, or Network tab.

5. Select the virtual machine value to adjust.
   
   Click the row representing the virtual machine whose allocation you are going to adjust. Click in the column of the value to edit it.

   a. If needed, click in the column heading to view a sorted list of values.

   b. Select the row where you want to make a change.

   c. Click the value or empty field you wish to change. In some cases, a pull-down menu appears.

   d. Select from the listed options or type a value in the field.
Once you are in edit mode, keyboard navigation between editable fields applies. This includes arrow keys, Tab, and Shift keys. Pressing Enter commits the changes.

<table>
<thead>
<tr>
<th>Shares</th>
<th>Shares Value</th>
</tr>
</thead>
</table>
| Entitles a virtual machine to a relative fraction of the managed host’s physical resource. For example, a virtual machine that has twice as many shares as another is generally entitled to consume twice as many resources, subject to the virtual machines assigned and respective of minimum and maximum constraints, provided that the virtual machines are both actively using the resources that they have been allocated.

Alternatively, to set a numeric value for shares, you can set the value to low, normal, or high. By default, all shares for all virtual machines are set to normal. What these values mean in terms of the number of shares is a function of the virtual machine’s specific configuration.

Increasing the number of shares allocated to a virtual machine dilutes the effective value of all shares.

A virtual machine may under-utilize its allocation by idling when it is not busy. This extra time is not wasted; rather, it is shared among virtual machines that remain active. Thus, a virtual machine may receive more than its allocation of the system.

Refer to your managed host virtualization platform documentation for additional information.

Min% and Max% columns – Set absolute guarantees for minimum and maximum processor and memory.
If a minimum processor or memory reservation is set on a virtual machine, that virtual machine receives at least the specified minimum percentage of a processor or the specified MB of memory, regardless of changes in the total number of shares in the resource.

If the system does not have enough unreserved processor time or memory available to guarantee the minimum requirements of a virtual machine, that virtual machine is not able to power on. A maximum reservation guarantees that a virtual machine never receives more than specified maximum percentage of a processor, even if extra time is available in the system. The maximum value for processor is configurable. The maximum value for memory is not configurable.

Processor minimums and maximums are percentages of a single processor; therefore, a uniprocessor virtual machine ranges from 0 to 100%, and a dual processor virtual machine from 0 to 200%.

Memory minimum and maximum is in MB, and the maximum is always the memory size of the virtual machine.

Traffic shaping and Kbps values – Located on the Network tab, these values put a cap on the average and peak network bandwidth a virtual machine can use, as well as how much traffic can be sent or received in a single burst.

Configuring a Host

Managed host settings are controlled through the VMware Management Interface.

To configure a managed host through the VMware Management Interface:

1. From the VirtualCenter client, display the inventory panel and select the appropriate managed host.
   Click the Inventory button in the navigation bar. Expand the inventory as needed, and click the appropriate managed host.
2. If the managed host is not connected, connect it now.
   Refer to Connecting or Disconnecting a Host on page 185.
3. Connect to the management interface for the selected managed host.
   a. Select the appropriate managed host icon in the inventory panel.
   b. Start the VirtualCenter Client and select:
      Edit > Properties or Summary > Commands > Edit Host Configuration
      VirtualCenter automatically starts your default browser.
4. Accept the security alerts.
   These are generated from your Windows environment and appear only if your security settings require it.
5. Log on to the VMware Management Interface.
   Enter the managed host user name and password.
6. Make adjustments to the managed host settings as needed. Refer to your managed host virtualization platform documentation for information specific to modifying the managed host configuration and using the management interface.
Interacting with Virtual Machines

This chapter describes virtual machine and virtual machine group tasks, including adding and removing a virtual machine to and from VirtualCenter, and powering on and off virtual machines. Refer to the appropriate chapter for information on deploying from a template; creating a clone from an existing virtual machine; and creating, deleting, migrating, customizing, and editing the configuration of a virtual machine.

This chapter contains the following sections:

- Adding and Removing Virtual Machines on page 200
- Changing Virtual Machine Power States on page 203
- Answering a Pending Question on page 209
- Working with Virtual Machine Groups on page 211

You need to use a Virtual Machine Administrator role assigned to the virtual machine to perform the activities described in this chapter.
Adding and Removing Virtual Machines

Add virtual machines to VirtualCenter through their managed hosts. Remove virtual machines from VirtualCenter control, and optionally from their managed host’s disk. The following sections discuss adding and removing virtual machine:

- Adding Existing Virtual Machines to VirtualCenter
- Removing Virtual Machines from VirtualCenter
- Returning a Virtual Machine to VirtualCenter
- Removing Virtual Machines from the Disk

Adding Existing Virtual Machines to VirtualCenter

When you add a managed host to VirtualCenter, VirtualCenter automatically discovers all the virtual machines on that managed host and adds them to the VirtualCenter inventory. If a managed host is disconnected, the already discovered virtual machines continue to be listed as part of VirtualCenter.

If a managed host is disconnected and reconnected, any changes to the virtual machines on that managed host are identified and VirtualCenter updates the list of virtual machines. For example, if virtualmachine3 is removed and virtualmachine4 is added, the new list of virtual machines shows virtualmachine4 and shows virtualmachine3 as orphaned.

Refer to Adding a Host to a Farm on page 177 for information on adding a managed host and its associated virtual machines.

Removing Virtual Machines from VirtualCenter

If a virtual machine is removed from VirtualCenter control, the link between the managed host and the virtual machine is severed. The managed host and VirtualCenter no longer recognize the virtual machine. However, the virtual machine remains on the datastore connected to the managed host.

To remove a virtual machine:

1. From the VirtualCenter client, display the inventory panel.
   
   Click the Inventory button in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Make sure that the virtual machine is powered down.

3. Remove the virtual machine from VirtualCenter but not from the datastore.
Select the virtual machine in the inventory panel. From the main or right-click popup menu, select **Remove**.

4. Confirm that you want to remove the virtual machine from VirtualCenter. Click **OK**.

VirtualCenter removes references to the virtual machine and no longer tracks its condition.

*Note:* The **Remove** option removes the virtual machine only from VirtualCenter. It does not remove the virtual machine from its datastore. Refer to **Removing Virtual Machines from the Disk** for information about the **Remove From Disk** option.

**Returning a Virtual Machine to VirtualCenter**

If you have removed a virtual machine from a VirtualCenter server but did not remove it from the managed host’s datastore, and you wish to return it to VirtualCenter, refer to your managed host virtualization platform documentation and follow the procedures for adding an existing virtual machine to an ESX Server, GSX Server, or VMware Server.

**Removing Virtual Machines from the Disk**

Through VirtualCenter, remove individual virtual machines from the datastore.

**To remove a virtual machine from VirtualCenter and the datastore:**

1. From the VirtualCenter client, display the inventory panel.
   
   Click the **Inventory button** in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Ensure that the virtual machine is powered down.

3. Select **Remove From Disk** from the virtual machine main or right-click popup menu.

   *Note:* This removes all the files for the selected virtual machine, including the configuration file and the virtual disk files.
4. Confirm removing the virtual machine from VirtualCenter and the datastore. Click **OK**.

VirtualCenter removes the virtual machine from its datastore entirely.
Changing Virtual Machine Power States

There are several options for a virtual machine power state. Each virtual machine power state change has a different effect on the guest operating system in the virtual machine.

There are also several access points for making changes to these power states. Manually select a power state change by selecting the virtual machine then the power option from either the main menu or the right-click popup menu. Alternatively, you can schedule a power state change through the Tasks option in the navigation bar.

The power state topics are covered in the following sections:

- Understanding Virtual Machine Power States
- Understanding Transitional Power States
- Understanding How a Virtual Machine on a GSX Server or VMware Server Windows Host Is Powered On
- Manually Powering a Virtual Machine On and Off
- Scheduling a Power State Change for a Virtual Machine

Understanding Virtual Machine Power States

The basic power state options include:

- **Power on** – Powers up the virtual machine and boots the guest operating system if the guest operating system is installed.
- **Power off** – Powers down the virtual machine. The virtual machine does not attempt to shut down the guest operating system gracefully.
- **Suspend** – Pauses the virtual machine activity. All transactions are frozen until you issue a resume command.
- **Resume** – Allows virtual machine activity to continue, and releases the Suspended state.
- **Reset** – Shuts down the guest operating system and restarts it.

The following power options perform extra functions in addition to the basic virtual machine power operations. These operations require that VMware Tools is installed in the virtual machine.
• **Shut down guest** – Shuts down the guest operating system. If the guest operating system automatically powers off after shutting down, then the virtual machine also powers off.

• **Suspend after running script** – Executes a VMware Tools script, then suspends the virtual machine. Refer to VMware Tools for information on setting up scripts.

• **Resume and run script** – Resumes the virtual machine, and executes a VMware Tools script. Refer to VMware Tools for information on setting up scripts.

• **Power on and run script** – Starts the virtual machine and executes a VMware Tools script. Refer to VMware Tools for information on setting up scripts.

• **Restart guest** – Shuts down and restarts the guest operating system without powering off the virtual machine.

Toolbar power buttons perform as follows:

• **Power off** – Powers off the virtual machine when VMware Tools is not installed or unavailable, or shuts down the guest operating system when VMware Tools is installed and available. A power off operation displays a confirmation dialog box indicating that the guest operating system may not shut down properly.

• **Suspend** – Suspends the virtual machine without running a script when VMware Tools is not installed, or runs a script then suspends the virtual machine when VMware Tools is installed and available.

• **Power on** – Powers on a virtual machine when a virtual machine is stopped, or resumes the virtual machine and runs a script when it is suspended and VMware Tools is installed and available. Resumes the virtual machine and does not run a script when VMware Tools is not installed or unavailable.

• **Reset** – Resets the virtual machine when VMware Tools is not installed, and restarts the guest operating system when VMware Tools is installed and available. A reset operation displays a confirmation dialog box indicating that the guest operating system is not shut down properly.

**Note:** The specific form of the power state action can be modified to include guest operating system shut downs or not, and to include running scripts or not. Refer to Changing Power State Options on page 384 for additional information.

**Understanding Transitional Power States**

Actions taken upon a virtual machine require that the virtual machine be in specific power states. Whenever a power operation is performed on a virtual machine, the
virtual machine power state changes and all other commands are locked out until the first command is completed.

The figure below illustrates states, transitions, and state changing commands for virtual machines.

![Virtual Machine Power State Changes](image)

**Understanding How a Virtual Machine on a GSX Server or VMware Server Windows Host Is Powered On**

Virtual machines on a GSX Server or VMware Server Windows host are powered on and run as specific user accounts.

For more information, see Preparing GSX Server or VMware Server Windows Host Virtual Machines on page 478.

**Manually Powering a Virtual Machine On and Off**

Prior to performing any power state changing activity on a virtual machine, you must have added the virtual machine to your VirtualCenter environment. Refer to Adding and Removing Virtual Machines on page 200.
To manually change the power state of a virtual machine:

1. From the VirtualCenter client, display the inventory panel.
   Click the **Inventory button** in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Choose the **power** option.
   Through either the main or right-click popup menu, display the available options. Or select the power options from the toolbar. If an option is not currently available, it is grey and unselectable.

The following options include the basic virtual machine power operations:
- Power on
- Power off
- Suspend
- Resume
- Reset

Two options affect the guest operating system only:
- Shut down guest
- Restart guest

**Note:** The specific form of the power state action can be modified to include guest operating system shutdowns or not, and to include running scripts or not. Refer to Changing Power State Options on page 384 for additional information.

After the power option is selected, VirtualCenter displays messages in the Summary tab indicating the transition modes.

**Scheduling a Power State Change for a Virtual Machine**

**To make a scheduled task to change the power state of a virtual machine:**

1. Display the Tasks panel.
   Click the **Tasks** option in the navigation bar. The list of scheduled tasks appears.

2. Start the New Task Wizard. Click **New** in the toolbar.

3. Confirm continuing with the New Task Wizard. Click **Next**.

4. Select the task to create.
   Select **Change the power status of a virtual machine** from the list. Click **Next**.
5. Select the power state to which to change the virtual machine. 

Select the appropriate power operation. Click Next.

**Note:** The specific form of the power state action can be modified to include guest operating system shutdowns or not, and to include running scripts or not. Refer to Changing Power State Options on page 384 for additional information.

6. Select the virtual machine whose power state changes.

Select the virtual machine, then click Next.

7. Specify the timing of the task. Click Next.

To see the calendar, click Later, then click the drop-down arrow to select a date from the displayed calendar. A red circle indicates today’s date and a dark circle indicates the scheduled date. Refer to Creating a Scheduled Task on page 397 for additional information.
8. Confirm creating the task.

Optionally, specify an email address for notification when the task is performed. Click **Finish**.

VirtualCenter adds the new task to the scheduled task list and completes it at the designated time. When it is time to perform the task, VirtualCenter first verifies that the user who created the task still has permission to complete the task. If the permission levels are not acceptable, a message is generated and the task is not performed.
Answering a Pending Question

When VirtualCenter is performing a task that requires input from you, the Inventory Summary tab for the selected virtual machine displays **Question Pending** as the status.

**To answer a pending question for a virtual machine:**

1. From the VirtualCenter client, display the inventory panel.
   
   Click the **Inventory button** in the navigation bar. Expand the inventory as needed.

2. Identify a question pending.

   Check the virtual machine in the inventory panel. If the virtual machine is flashing a question mark over its icon symbol, proceed.

3. Select the virtual machine **Summary** tab.

   The **State:** status displays a **Question pending link**.

4. Open the **Answer Question** dialog. Confirm the prompt.

   Click the **Question Pending** link. Or alternatively, with the virtual machine highlighted, choose **VM > Answer Question**.
5. Answer the question dialog that appears. For example:
Working with Virtual Machine Groups

Virtual machine groups are organizational structures. They can be added only to the virtual machine's farm. Hierarchically, virtual machine groups contain virtual machines or additional virtual machine groups.

The figure below illustrates the VirtualCenter organizational components. Refer to Abbreviations on page 16 for a description of abbreviations.

Hierarchical Virtual Machine Groups

The virtual machine group topics are covered in the following sections:

- Adding a Virtual Machine Group
- Adding Virtual Machines to a Virtual Machine Group
- Moving Virtual Machines from a Virtual Machine Group
- Removing a Virtual Machine Group
Adding a Virtual Machine Group
To add a virtual machine group:

1. From the VirtualCenter client, display the inventory panel.
   Click the **Inventory button** in the navigation bar. Select the appropriate farm.

2. Add a new virtual machine group.
   With the farm highlighted, from the main or right-click popup menu, select **New VM Group**. VirtualCenter adds a new group to the inventory panel.

Adding Virtual Machines to a Virtual Machine Group
When you create a virtual machine group, it is empty. Drag and drop the virtual machines as needed to the new virtual machine group.

To add virtual machines to the virtual machine group:

1. From the VirtualCenter client, display the inventory panel.
   Click the **Inventory button** in the navigation bar.

2. If needed, add the virtual machine group to the farm that contains the virtual machines you wish to group.

3. Move the virtual machine to the virtual machine group.
   Select the appropriate virtual machine and drag it to the virtual machine group.
Moving Virtual Machines from a Virtual Machine Group

Moving a virtual machine from a virtual machine group moves it from the organizational structure of the virtual machine group but does not remove it from the managed host, the farm, or VirtualCenter.

To move a virtual machine from the virtual machine group:
1. From the VirtualCenter client, display the inventory panel.
   - Click the Inventory button in the navigation bar.
2. Move the virtual machines.
   - Select the appropriate virtual machines and drag them out to the farm or another virtual machine group.
   - Moving virtual machines between virtual machine groups on the same farm does not move them between managed hosts.

Removing a Virtual Machine Group

Removing a virtual machine group removes all its hierarchical contents from the VirtualCenter environment. These contents includes any virtual machines contained within the group. This process removes control of the virtual machines from VirtualCenter and the managed host.

To remove a virtual machine group:
1. From the VirtualCenter client, display the inventory panel.
   - Click the Inventory button in the navigation bar.
2. Power down all virtual machines in the virtual machine group to be removed.
3. If needed, remove any virtual machines from the virtual machine group.
   - Select the virtual machine and drag it to the farm icon or another group.
   - **Note:** Removing a virtual machine group removes the virtual machines contained within the virtual machine group from VirtualCenter.
4. Remove the virtual machine group.
   - Select the appropriate virtual machine group, and from either the main or right-click popup menu, select Remove.
5. Select whether or not to remove the virtual machines in the virtual machine group.
If there are no virtual machines in the virtual machine group, VirtualCenter removes the virtual machine group without a confirmation message.

a. Select the Remove VM Files check box.
   
   If this box is selected the virtual machines are removed from the datastore. If this box is not selected the virtual machines remain on the datastore.
   
b. Confirm that you want to remove the virtual machine group. Click Yes.
   
   VirtualCenter removes the selected virtual machine group and all items contained within it from the hierarchy and the VirtualCenter environment. Any assigned processor and migration licenses return to available status.
Migrating Virtual Machines

This chapter describes the process of migrating or moving a virtual machine from one host to another. Migrating a powered-off virtual machine is a migration. Migrating a powered-on virtual machine is a migration with VMotion. Migration with VMotion requires VMotion licensing and specific configuration. Refer to Installing VMware VirtualCenter on page 65 for VMotion requirements. You cannot migrate a virtual machine when a virtual machine is in a suspended state.

This chapter contains the following sections:

- Understanding the Migration Options on page 217
- Migration Restrictions on page 220
- Migrating Powered-Off Virtual Machines on page 221
- Enabling VMotion on page 226
- Moving Powered-On Virtual Machines on page 228

To perform the activities described in this chapter, the user initiating the migration must have administrator privileges on both machines.
Note: Copying a virtual machine is creating a new virtual machine. It is not a form of migration. Refer to Copying Virtual Machines on page 291 for additional information.
Understanding the Migration Options

This chapter describes how to perform the two types of migration:

- **Migration** – Moving a powered-off virtual machine.
- **Migration with VMotion** – Moving a virtual machine between hosts while the virtual machine is powered on and performing transactions. This functionality has specific requirements, including the activation of VMotion on both the source and target host. When a migration with VMotion is performed, the operations of the virtual machine can continue without interruption.

  **Note:** Migration with VMotion is possible only between ESX Server hosts.

Virtual machines can be moved between hosts within the same farm. Virtual machines cannot be moved between farms.

The migration general topics are covered in the following sections:

- Understanding Migration with VMotion
- Understanding Migration

**Understanding Migration with VMotion**

VMotion allows working processes to continue throughout a migration with VMotion. The entire state of the virtual machine as well as its configuration file is moved to the new host even while the data storage remains in the same location on the SAN. The associated virtual disk remains in the same location on the SAN storage that is shared between the two hosts. Once the configuration file is migrated to the alternate host, the virtual machine is then run on the new host.

The state information includes the current memory content and all the information that defines and identifies the virtual machine. The memory content includes transaction data and whatever bits of the operating system and applications are in the memory. The defining and identification information stored in the state includes all the data that maps to the virtual machine hardware elements, such as BIOS, devices, processor, MAC addresses for the Ethernet cards, chip set states, registers, and so forth.

Migration with VMotion happens in three stages:

1. When the migration with VMotion is requested, VirtualCenter verifies that the existing virtual machine is in a stable state with its current host.
2. The virtual machine state information, that is, memory, registers, network connections, is copied to the target host.
3. The virtual machine resumes its activities on the new host.

The figure below illustrates the process of migrating powered-on virtual machines with VMotion. Refer to Abbreviations on page 16 for a description of abbreviations.

**Understanding Migration**

Migration requires that the virtual machine being migrated is powered off prior to beginning the migration process. Migration is the process of moving a virtual machine from one host to another. With a migration, you also have the option of moving the associated disks from one host to another. A migration consists of the following steps:
1. The configuration file and the disks of the virtual machine are moved from the source host to the destination host’s associated storage area.

2. The virtual machine is associated (registered) with the new host.

3. After the migration is completed, the old version of the virtual machine is deleted from the source host.

The figure below illustrates the process for migration of powered off-virtual machines. Refer to Abbreviations on page 16 for a description of abbreviations.

If any error occurs during migration, the virtual machines revert to their original states and locations.
Migration Restrictions

Migrating virtual machines works between hosts in most cases. In the below listed situations, the new virtual machine is permitted only as stated.

- Migrating a virtual machine that uses IDE disks to an ESX Server is not supported.
- Migrating a 64-bit virtual machine to 32-bit hardware host is not supported.
- Migrating a virtual machine from an ESX Server or GSX Server to a VMware Server does not automatically upgrade the virtual machine to full VMware Server functionality. To do this you must go through the VMware Server Console.
  
  **Note:** Once you have upgraded the migrated virtual machine, you cannot migrate it back to the original host.

- Virtual machines created on VMware Server or upgraded through VMware Server Console cannot be migrated or cloned back to either a GSX Server or ESX Server. Templates created from a VMware Server virtual machine cannot be deployed to either a GSX Server or ESX Server.

- Migrating a virtual machine that has VMware Virtual SMP enabled to a target host that does not support VMware Virtual SMP is not supported.

- You cannot migrate a virtual machines with raw, clustered, undoable, or append mode disks. You cannot migrate with VMotion, virtual machines with raw, clustered, and non-persistent mode. If you have clustered disks, you can store them on separate VMFS volumes from the virtual machines prior to migrating them using VMotion. Migrations of virtual machines with IDE disks from GSX Server or VMware Server hosts to ESX Server hosts are not supported.

- Migration occurs between hosts on the same farm.

  Migrations between a GSX Server and an ESX Server host is supported only when the GSX Server host is version 3.1 or later and the ESX Server host is version 2.1.1 or later.

  Legacy virtual machines, that is GSX Server or ESX Server virtual machines, can be migrated to a VMware Server. Provided the virtual machine virtual hardware is not upgraded through the VMware Server Console, these virtual machines can be migrated back to a GSX Server or ESX Server.

  Virtual machines created on VMware Server cannot be migrated to either a GSX Server or an ESX Server.
Migrating Powered-Off Virtual Machines

Move virtual machines manually or set up a scheduled task to perform the migration. Migration topics are covered in the following sections:

- Migrating a Powered-Off Virtual Machine Manually
- Creating a Scheduled Task to Migrate a Virtual Machine

Migrating a Powered-Off Virtual Machine Manually

**Note:** This operation can be done only if the virtual machine is powered off.

**To manually migrate a powered-off virtual machine:**

1. From the VirtualCenter client, view the inventory panel to display the virtual machine.
   
   Click the *Inventory* option in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Start the Migration Wizard.
   
   In the inventory panel, select the desired virtual machine. Then perform one of the following:
   
   - From the main or right-click popup menu, select the *Migrate* option.
   - From the information panel *Summary* tab, click the *Migrate to New Host* button.
   - Drag and drop the virtual machine on the target host.
   
   The Migration Wizard starts.

3. Confirm the Migration Wizard. Click *Next*. 
4. Select the target host for the virtual machine. Click **Next**.

![Destination Host](image1.png)

5. Select a datastore for the virtual machine. Click **Next**.

![Specify the Virtual Machine's Location](image2.png)

6. Complete the wizard. Click **Finish**.

VirtualCenter moves the virtual machine, including the virtual disks, to the new host. Event messages appear in the Events tab. The data displayed on the Summary tab shows the status and state throughout the migration.
Creating a Scheduled Task to Migrate a Virtual Machine

This process sets up a scheduled task to migrate a powered-off virtual machine. While a migration task can be scheduled on a running virtual machine, the virtual machine must be powered off at the time the migration task starts.

To create a scheduled task that migrates a virtual machine:

1. Display the Tasks panel.
   - Click the Tasks option in the navigation bar. The list of scheduled tasks appears.
4. Select the task to create.
   - Click the pull-down menu and select the Migrate a virtual machine option. Click Next.
5. Select the virtual machine to migrate. Click Next.
6. Select the target host for the virtual machine. Click **Next**.

7. Select a datastore for the virtual machine. Click **Next**.

8. Set the time and date when you want to migrate the virtual machine. Click **Next**.

   To see the calendar, click **Later** and then click the drop-down arrow to select a date from the displayed calendar. A red circle indicates today’s date, and a dark circle indicates the scheduled date. Refer to Creating a Scheduled Task on page 397 for additional information.

9. Confirm creating the task.
Optionally, specify an email address to receive notification when the task is performed. Click Finish.

VirtualCenter adds the new task to the scheduled task list and completes it at the designated time. When it is time to perform the task, VirtualCenter first verifies that the user who created the task still has permission to complete the task. If the permission levels are not acceptable, VirtualCenter sends a message to the events and the task is not performed. Similarly, if the virtual machine is not in the correct state, VirtualCenter sends a message to the log file and the task is not performed.
Enabling VMotion

You must enable VMotion on both the target and the source host to support migration with VMotion.

**Note:** This applies to ESX Server hosts only.

**To enable a host for VMotion:**

1. Ensure that the host is properly configured.
   - Refer to VirtualCenter VMotion Requirements on page 48 for the list of VMotion requirements.
   - Refer to Adding Licenses on page 127 to ensure that you have sufficient VMotion licenses.
2. From the VirtualCenter client, display the inventory panel to view the host. Click the **Inventory** option in the navigation bar. Expand the inventory as needed, and click the appropriate host.
3. Display the Host Properties dialog box.
   - From the main menu, right-click the popup menu or select the **Summary** tab and choose **Host Properties**.
4. Enable VMotion. Select the **VMotion** tab.

   ![VMotion Tab](image)

   **To enable VMotion:** Click **Yes**. Enter the **Network Label**, **IP Address**, and **Gateway** for the host if the fields are not filled in. Click **OK**.
This is the information for the migration network, including which NIC it uses, and its IP address and gateway. The migration network is preferably its own separate network.

**To leave VMotion disabled:** Click No and click OK.

If VMotion is enabled, VirtualCenter checks for a migration license and adds the license to the host information.
Moving Powered-On Virtual Machines

Move virtual machines that are powered on manually or set up a scheduled task.

Note: Powered-on virtual machines can be moved between ESX Server hosts. This type of migration with VMotion cannot be performed with GSX Server or VMware Server hosts at this time.

Migration with VMotion topics are covered in the following sections:

- Migrating with VMotion a Virtual Machine Manually
- Creating a Scheduled Task to Migrate a Virtual Machine with VMotion

Note: Disconnect any remote consoles that are external to VirtualCenter and connected to the virtual machine you are migrating. Though the virtual machine appears to be migrating, until you disconnect the external remote console, the migration does not complete. If the virtual machine is connected to the console from the Console tab in VirtualCenter, the migration with VMotion completes without any intervention.

Migrating with VMotion a Virtual Machine Manually

Note: Before you begin, disconnect any peripheral devices connected to the virtual machine.

To manually migrate a powered-on virtual machine:

1. From the VirtualCenter client, display the inventory panel to view the virtual machine.

   Click the Inventory option in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.
2. Make sure that both the source and target hosts are VMotion-enabled and using the same SAN.

For each host, click the host. Select the Summary tab. Check the VMotion Enabled field and the Datastores section. The VMotion Enabled field should say Yes. Datastores on both hosts should list the same name.

Refer to VirtualCenter VMotion Requirements on page 48, Adding Licenses on page 127, and Enabling VMotion on page 226 for additional information.

3. Display the inventory panel and select the appropriate farm.

   Click the Inventory option in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

4. Start the migration with VMotion Wizard.

   In the inventory panel, select the desired virtual machine. Then perform one of the following:
   - From the main or right-click popup menu, select the Migrate option.
   - From the information panel Summary tab, click the Migrate to New Host button.
   - Drag and drop the virtual machine on to the target host.

   The migration with VMotion Wizard starts.

5. Confirm the migration with VMotion Wizard. Click Next.
6. Select the migration priority level.

Set the priority of the migration to ensure that sufficient processor resources are available on both the source and target hosts to perform the migration.

Click the appropriate button and click Next.

7. Confirm the migration with VMotion wizard. Click Finish.

VirtualCenter moves the selected virtual machine from the original host to the target host. The virtual disks remain in the same location on the shared datastore.

**Creating a Scheduled Task to Migrate a Virtual Machine with VMotion**

This process sets up a scheduled task to migrate a powered-on virtual machine using VMotion.

**To create a scheduled task that migrates a virtual machine with VMotion:**

1. Display the Tasks panel.

   Click the Tasks option in the navigation bar. The list of scheduled tasks appears.


4. Select the task to create.

   Click the pull-down menu and select the Migrate a Virtual Machine option. Click Next.
5. Select the virtual machine to migrate. Click **Next**.

6. Select the target host for the virtual machine. Click **Next**.
7. Select a priority for the migration.

Set the priority of the migration to ensure that sufficient processor resources are available on both the source and target hosts to perform the migration. Click Next.

8. Set the time and date when you want the virtual machine to migrate. Click Next.

To see the calendar, click Later, then click the drop-down arrow to select a date from the displayed calendar. A red circle indicates today's date and a dark circle indicates the scheduled date. Refer to Creating a Scheduled Task on page 397 for additional information.

9. Confirm creating the task.

Optionally, specify an email address to receive notification when the task is performed. Click Finish.

VirtualCenter adds the new task to the scheduled task list and completes it at the designated time. When it is time to perform the task, VirtualCenter first verifies that the user who created the task still has permission to complete the task. If the permission levels are not acceptable, VirtualCenter sends a message to the events, and the task is not performed. Similarly, if the virtual machine is not in the correct state and VMotion is not enabled, VirtualCenter sends a message to the event log, and the task is not performed.
This chapter describes how to create virtual machines through the New Virtual Machine Wizard. This wizard walks you through the steps required to define a virtual machine. This chapter includes information on setting parameters based on the guest operating system used and the resources allocated. After you create the virtual machine, you must install the guest operating system and install VMware Tools.

This chapter contains the following sections:

- Changing the Default Virtual Machine Directory on page 235
- Creating Typical Virtual Machines Using the New Virtual Machine Wizard on page 236
- Creating Custom Virtual Machines Using the New Virtual Machine Wizard on page 243
- Installing a Guest Operating System and VMware Tools on page 258

To perform the activities described in this chapter, the user must have administrator privileges on the host machine.

Virtual machines created through VirtualCenter have root ownership. This allows VMware processes running on the managed host with root privileges. These
processes can take action (create files, spawn other processes, etc.) “as root” if they decide that it is appropriate.

VirtualCenter sends commands to these processes. It uses the *vpxuser* login and password to authenticate the commands, such as, to prove to the managed host processes that the commands are coming from a legitimate VirtualCenter.

On ESX Server systems, the root password is needed in the initial connection process is to prove that you have the necessary permissions for creating a *vpxuser* login/password. On GSX Server or VMware Server, where virtual machines do not run as Administrator, the user specifies which account to use for accessing the system.
Changing the Default Virtual Machine Directory

VirtualCenter creates the virtual machine using the settings you specified. For ESX Server, the virtual machine files are placed in the /home/vmware directory. In VirtualCenter 1.0.x, virtual machines were placed in the /vpx/vms directory. Update any scripts you created that point to the /vpx/vms directory.

The /home/vmware directory is the default behavior but is configurable on a per-host basis.

To change the default location for an ESX Server, add the following line to the ESX Server configuration file, /etc/vmware/config:

```
location_path = "/whatever/your/path/is"
```

where location_path is:

- `serverd.vpx.defaultVmDir` for ESX Server 2.1.0 or greater
- `vmserverd.vpx.defaultVmDir` for ESX Server 2.0.1

Mixing these two directories is not a concern. However, if a virtual machine was initially in /vpx/vms and it is migrated off of the managed host then later returned to the managed host, it is placed in the newly designated directory, not where it was originally discovered.

For GSX Server or VMware Server systems, a virtual machine configuration file is stored in the same folder along with its disk files and other files. This folder is placed in the GSX Server or VMware Server system's single w folder; the location of this datastore folder can be configured from VirtualCenter in the Datastore panel of the host’s properties dialog.
Creating Typical Virtual Machines Using the New Virtual Machine Wizard

New virtual machines are added to managed hosts. You must select a managed host to be able to start the New Virtual Machine Wizard.

**Note:** A virtual machine on a GSX Server or VMware Server Windows host created through VirtualCenter runs as the user account specified when the host was added to VirtualCenter. For more information, see Preparing GSX Server or VMware Server Windows Host Virtual Machines on page 478.

To create a new virtual machine through the typical path in the New Virtual Machine Wizard:

1. From the VirtualCenter client, display the inventory panel.
   - Click **Inventory** in the navigation bar. Expand the inventory as needed.
2. Select a managed host and start the New Virtual Machine Wizard.
   - In the inventory list, select the managed host to which to add the new virtual machine.
   - Choose **File > New > Virtual Machine**, then click **Next**.
3. Select whether to use a typical configuration or custom configuration. Select **Typical** or **Custom**, click **Next**.

   ![New Virtual Machine Wizard](image)

   **If you select Typical:** you can specify or accept defaults only for:
• The group for the virtual machine.
• The guest operating system.
• The virtual machine name and the location of the virtual machine's files.
• The network connection type.
• The size of the virtual disk.
• Allocating all the disk space for the virtual disk at the time you create it (GSX Server or VMware Server hosts only).
• Creating a virtual disk as a single disk file (GSX Server or VMware Server hosts only). If the virtual disk is larger than 2GB, the managed host file system must support files larger than 2GB.

**If you select Custom:** in addition to the typical settings, you can:
• Specify the number of virtual processors for the virtual machine (ESX Server or VMware Server hosts only).
• Allocate an amount of memory different from the default.
• Choose between the LSI Logic and BusLogic types of SCSI adapters. (An ATAPI IDE adapter is always installed.)
• Use an existing virtual disk.
• Directly access a system LUN instead of using a virtual disk (ESX Server hosts only).
• Use an IDE virtual disk for a guest operating system that would otherwise have a SCSI virtual disk created by default and vice versa (GSX Server or VMware Server hosts only).
• Specify a particular virtual device node for the virtual disk.
• Choose a mode for the virtual disk (ESX Server hosts only).

**Note:** Creating a virtual machine using the custom path is not the same as customizing a template.
4. Select a group location for the new virtual machine. Click Next.

5. Select the guest operating system to use. Click Next.

Under Guest operating system, select the operating system family (Microsoft Windows, Linux, Novell NetWare, Sun or Other, as available), then select the specific operating system from the Version list. VirtualCenter does not install the Guest Operating System for you; your selection here is used only to select appropriate default configuration parameters for the virtual machine.

This screen asks which operating system you plan to install in the virtual machine. The New Virtual Machine Wizard uses this information to select
appropriate default values, such as the amount of memory needed. The wizard also uses this information when naming associated virtual machine files.

You can find detailed installation notes for guest operating systems in the *VMware Guest Operating System Installation Guide*, available from the VMware Web site ([pubs.vmware.com/guestnotes](pubs.vmware.com/guestnotes)).

**Caution:** If you select a guest operating system that requires 64-bit hardware and the host selected for the new virtual machine does not have 64-bit hardware, a warning message appears. This does not prevent you from creating the virtual machine, but the virtual machine cannot be powered on until it is resident on a host with matching 32-bit or 64-bit hardware.

6. Specify a name for the virtual machine and datastore volume for the virtual disks.

   a. Enter the virtual machine name to use.

   The name you enter in the **Virtual Machine Name** field is the name that is listed in the VirtualCenter client inventory, and in other areas, such as the VMware Management Interface, it is also used as the name of the virtual machine's files. Enter a useful name. The name can be up to 80 characters long and contains alphanumeric characters and the underscore (_) and hyphen (-) characters. It should also be unique across all virtual machines.

   Be sure that the virtual machine name is unique. Duplicate names are not allowed within a virtual machine group. Duplicate names on a managed host can cause confusion, so unique virtual machine names are recommended.
For GSX Server or VMware Server hosts: this name becomes the name of the folder that stores the files associated with this virtual machine. All the virtual machine’s files are placed in this folder.

b. Select the datastore on the managed host to use for storing the virtual disk files.

For GSX Server or VMware Server hosts: the name listed under Datastores is the local datastore or the datastore specified in the VirtualCenter managed host properties dialog box. Each GSX Server or VMware Server host is only allowed one datastore.

For ESX Server hosts: the names listed under Datastores are the configured VMFS volumes for that managed host.

c. Click Next.

If you are following the typical path for creating the virtual machine, proceed to the next step.

If you are following the custom path, proceed to Creating Custom Virtual Machines Using the New Virtual Machine Wizard on page 243.

7. For GSX Server or VMware Server hosts: you must configure a network label on the managed host before a NIC can be configured for the virtual machine. See Configuring Network Labels for GSX Server or VMware Server Hosts on page 182 for additional information.

8. Specify the networking settings for the virtual machine.

   a. Select the virtual network name to use from the NIC list.
b. If you are creating the virtual machine on either an ESX Server or a GSX Server: select the network adapter type for the virtual machine. Select from the displayed list, vlance, vmxnet adapter.

If you are creating the virtual machine on a VMware Server, the network adapter type is specific to the guest operating system you selected. For a 32-bit guest operating system the network adapter type is a morphing vlance, which displays as Flexible. For a 64-bit guest operating system the network adapter type is listed as E1000. Either the word Flexible or E1000 displays in the Adapter Type box and it does not have a selectable radio button.

c. If you do not want the virtual network adapter to connect when the virtual machine is powered on, clear the Connect at power on check box.

d. If you do not want the virtual machine to have a connection to the network, select the Do not use a network connection check box.

e. Click Next.

9. Specify the size of the virtual disk.

Enter the disk size in Gigabytes (GB). Your virtual disk can be as small as 0.1GB (100MB). A SCSI virtual disk can be as large as 256GB on a GSX Server or VMware Server host or 2TB on an ESX Server host. An IDE virtual disk can be used on GSX Server or VMware Server hosts only and can be as large as 128GB.

For GSX Server or VMware Server hosts: by default, the full size of the virtual disk is allocated when you create the disk. Allocating all the space at the time you create the virtual disk gives somewhat better performance and ensures that you do not run out of disk space on the managed host, but it requires as much
disk space as the size you specify for the virtual disk. You cannot shrink an allocated disk.

If this setting is larger than the space available on the managed host machine's hard disk, a warning message displays and specifies how much space you have on the managed host. If the disk will exceed the available space on the managed host, make the virtual disk smaller or clear the Allocate all disk space now check box.

An allocated virtual disk is needed for clustering virtual machines. For more information about clustering, see the VMware GSX Server Administration Guide. If you do not allocate the disk, the virtual disk's files start small and grow as needed.

You may also specify whether you want the virtual disk created as one large file or split into a set of 2GB files. You should split the virtual disk if it is stored on a FAT32 file system or a file system that cannot support files larger than 2GB, such as FAT16. To do this, check Split into 2GB files.

For ESX Server hosts: the available space on the selected VMFS volume is listed.

Make the Virtual Disk Big Enough

The virtual disk should be large enough to hold the guest operating system and all of the software that you intend to install, with room for data and growth.

You cannot change the virtual disk's maximum capacity later. But, you can install additional virtual disks later by using the Virtual Machine Properties dialog box.

For example, you need about 1GB of actual free space on the file system containing the virtual disk to install Windows Server 2003 and applications such as Microsoft Office inside the virtual machine.

10. Click Next and then click Finish.

Before you can use your new virtual machine, you need to partition and format the virtual disk, then install a guest operating system and VMware Tools. The operating system's installation program may handle the partitioning and formatting steps for you. For information about installing a guest operating system and VMware Tools, see Installing a Guest Operating System and VMware Tools on page 258.
Creating Custom Virtual Machines Using the New Virtual Machine Wizard

This section describes the steps taken when you select the custom path in the New Virtual Machine Wizard. The custom path provides more flexibility and options.

Note: This section is not describing the process of customizing a new virtual machine that is being created by cloning an existing virtual machine or deploying a template.

Note: A virtual machine on a GSX Server or VMware Server Windows host created through VirtualCenter runs as the user account specified when the host was added to VirtualCenter. For more information, see Preparing GSX Server or VMware Server Windows Host Virtual Machines on page 478.

To create a new virtual machine through the custom path in the New Virtual Machine Wizard:


2. For ESX Server or VMware Server hosts: if you have VMware Virtual SMP for ESX Server or VMware Server, which supports Symmetric Multiprocessors (SMP), select the number of virtual processors for the virtual machine.
Note:

- If you only have GSX Server hosts, this panel does not appear.
- Some guest operating systems, such as Windows NT, can be configured with a single processor only. If you are configuring such a virtual machine, you cannot select more than one virtual processor.
- For more information about VMware Virtual SMP for ESX Server or VMware Server, contact VMware, Inc., or your authorized sales representative.

After you select the number of virtual processors, click Next.

3. Allocate memory to the virtual machine.

The wizard provides a default value based on your guest operating system selection along with the minimum amount of memory recommended by the manufacturer and, for ESX Server hosts, the maximum runnable memory.

You may need to change the memory allocation to meet the demands of applications you plan to run in the virtual machine. You may change this setting later, from the VirtualCenter client.

To change the amount of memory to be allocated to the virtual machine, move the slider to the appropriate location, use the spin controller next to the field, or type a new value in the field.

Caution: For a virtual machine on a GSX Server or VMware Server host, you cannot allocate more than 2000MB of memory to a virtual machine if it is stored on a file system that cannot support files larger than 2GB, such as FAT16. You will not be able to power on such a virtual machine. Further, you cannot allocate
more than 2000MB of memory to a virtual machine if it is stored on a FAT32 file system, even though it does support files up to 4GB in size.

After you allocate memory to the virtual machine, click Next.

4. **For GSX Server or VMware Server hosts:** ensure that you have configured the network labels on the managed host. This must be completed before a NIC can be configured for the virtual machine. See Configuring Network Labels for GSX Server or VMware Server Hosts on page 182 for additional information.

5. Select Network Interface Card (NIC) to define the network connection type.
   a. Select the virtual network name to use from the NIC list.
   b. **If you are creating the virtual machine on either an ESX Server or a GSX Server:** select the network adapter type for the virtual machine. Select from the displayed list, vlance, vmxnet adapter.

If you are creating the virtual machine on a VMware Server, the network adapter type is specific to the guest operating system you selected. For a 32-bit guest operating system the network adapter type is a morphing vlance, which displays as **Flexible**. For a 64-bit guest operating system the network adapter type is listed as **E1000**.

**Caution:** If you select a guest operating system that requires 64-bit hardware and the host selected for the new virtual machine does not have 64-bit hardware, a warning message appears. This does not prevent you from creating the virtual machine, but the virtual machine cannot be powered on until it is resident on a host with matching 32-bit or 64-bit hardware.
c. If you do not want the virtual network adapter to connect when the virtual machine is powered on, clear the **Connect at power on** check box.

d. If you do not want the virtual machine to have a connection to the network, select the **Do not use a network connection** check box.

e. Click **Next**.

6. Choose the type of SCSI adapter you want to use with the virtual machine.

   ![New Virtual Machine Wizard](image)

An IDE and a SCSI adapter are installed in the virtual machine. The IDE adapter is always ATAPI. You can choose between a BusLogic or LSI Logic SCSI adapter. The default for your guest operating system is already selected. Most guests except for newer operating systems like Windows Server 2003 or Red Hat Enterprise Linux 3 default to the BusLogic adapter.

The LSI Logic adapter has improved performance and works better with generic SCSI devices. The LSI Logic adapter is included with Windows Server 2003.

The choice of SCSI adapter does not affect whether your virtual disk is an IDE or SCSI disk. However, most guest operating systems do not include a driver for the LSI Logic adapter; you must download the driver from the LSI Logic Web site. See the *VMware Guest Operating System Installation Guide* for details about the driver and the guest operating system you plan to install in this virtual machine.
7. Select the type of storage for the virtual machine's disk.

For ESX Server hosts: you can store virtual machine data in a new virtual disk, an existing virtual disk, or a system LUN.

For GSX Server or VMware Server hosts: you can store virtual machine data in a new virtual disk or an existing virtual disk only.

Make your selection, click Next, then proceed to the section appropriate to your disk selection and managed host type.

- Creating a New Virtual Disk on a GSX Server or VMware Server Host on page 248
- Creating a New Virtual Disk on an ESX Server Host on page 250
- Using an Existing Virtual Disk on page 252
- Mapping a System LUN Disk on an ESX Server Host on page 253
Creating a New Virtual Disk on a GSX Server or VMware Server Host

1. Select whether you want the virtual disk to be an IDE disk or a SCSI disk.

The wizard recommends the best choice based on the guest operating system you selected.

2. Specify the size of the virtual disk.

Enter the disk size in Gigabytes (GB). Your virtual disk can be as small as 0.1GB (100MB). A SCSI virtual disk can be as large as 256GB; an IDE virtual disk can be as large as 128GB.
By default, the full size of the virtual disk is allocated when you create the disk. Allocating all the space at the time you create the virtual disk gives somewhat better performance and ensures you do not run out of disk space on the managed host, but it requires as much disk space as the size you specify for the virtual disk. You cannot shrink an allocated disk.

If this setting is larger than the space available on the managed host machine's hard disk, a warning message displays and specifies how much space you have on the managed host. If the disk exceeds the available space on the managed host, you must make the virtual disk smaller or clear the Allocate all disk space now check box.

An allocated virtual disk is needed for clustering virtual machines. For more information about clustering, see the VMware GSX Server Administration Guide.

If you do not allocate the disk, the virtual disk's files start small and grow as needed.

You may also specify whether you want the virtual disk created as one large file or split into a set of 2GB files. You should split the virtual disk if it is stored on a FAT32 file system or a file system that cannot support files larger than 2GB, such as FAT16. To do this, check Split into 2GB files.

3. Select which virtual device node should be used by your virtual disk.

For a virtual disk on a SCSI node, select the appropriate SCSI address for the virtual disk.

For a virtual disk on an IDE node, IDE 0:0 corresponds to the primary IDE interface and master device (usually the bootable hard drive); IDE 0:1
corresponds to the primary IDE interface, slave device; IDE 1:0 corresponds to the secondary IDE interface, master device (usually the CD-ROM drive); and IDE 1:1 corresponds to the secondary IDE interface, slave device.

Click Next.

4. Proceed with creating the new virtual machine. Click Finish.

You have finished creating a virtual machine that uses a new virtual disk.

Before you can use your new virtual machine, you need to partition and format the virtual disk and install a guest operating system and VMware Tools. The operating system’s installation program might handle the partitioning and formatting steps for you. For information about installing a guest operating system and VMware Tools, see Installing a Guest Operating System and VMware Tools on page 258.

Creating a New Virtual Disk on an ESX Server Host

1. Select the size of the virtual disk.

![Specify Disk Capacity](image)

Your virtual disk can be as small as 0.1GB (100MB) and can be as large as 2TB.

**Make the Virtual Disk Big Enough**

The virtual disk should be large enough to hold the guest operating system and all of the software that you intend to install, with room for data and growth.

You cannot change the virtual disk’s maximum capacity later. But, you can install additional virtual disks later by using the Virtual Machine Properties dialog box.
For example, you need about 1GB of actual free space on the file system containing the virtual disk to install Windows Server 2003 and applications such as Microsoft Office inside the virtual machine.

Click **Next**.

2. Select the virtual device node and disk mode for the virtual disk.

   ![Virtual Machine Wizard](image)

   To select a disk mode, choose one of the following:
   
   - **Persistent** – Changes are immediately and permanently written to the disk.
   - **Undoable** – Changes are not saved until the virtual machine is powered off and you confirm to save the changes.
   - **Nonpersistent** – Changes to the disk are discarded when you power off or revert to the snapshot.
   - **Append** – Changes are saved when you power off the virtual machine.

   Click **Next**.

3. Click **Finish**.

You have finished creating a virtual machine that uses a new virtual disk.

Before you can use your new virtual machine, you need to partition and format the virtual disk, then install a guest operating system and VMware Tools. The operating system’s installation program may handle the partitioning and formatting steps for you. For information about installing a guest operating system and VMware Tools, see *Installing a Guest Operating System and VMware Tools* on page 258.
Using an Existing Virtual Disk

Follow these steps if you want to use an existing virtual disk with the virtual machine. If the virtual machine is on an ESX Server host and you want to use a system LUN, see Mapping a System LUN Disk on an ESX Server Host on page 253.

1. Select the datastore where the virtual disk is stored.

![Add Hardware Wizard](image)

2. Select the disk to use. Click Browse and navigate to the virtual disk you want to use. Click Next.

3. Select which virtual device node should be used by your virtual disk.

![New Virtual Machine Wizard](image)
If you are creating the virtual machine on an ESX Server host, select a disk mode. Choose one of the following:

- **Persistent** – Changes are immediately and permanently written to the disk.
- **Undoable** – Changes are not saved until the virtual machine is powered off and you confirm to save the changes.
- **Nonpersistent** – Changes to the disk are discarded when you power off or revert to the snapshot.
- **Append** – Changes are saved when you power off the virtual machine.

Click **Next**.

4. Click **Finish**.

You have finished creating a virtual machine that uses an existing virtual disk.

### Mapping a System LUN Disk on an ESX Server Host

Instead of storing virtual machine data in a virtual disk file, you can store the data directly on a system LUN (logical unit number). This is useful if you are running applications in your virtual machines that need visibility to the physical characteristics of the storage device.

If you are creating virtual machines on an ESX Server 2.5 host, you can store the data on a system LUN by mapping it to a VMFS volume in a datastore. You can map a system LUN to a VMFS volume only if the following conditions are met:

- The LUN must be on a SAN and it cannot contain any VMFS or core dump partitions.
- The LUN is not on a SCSI controller that is being shared with the ESX Server service console.
- The LUN must provide a unique ID. Some RAID and block devices do not provide a unique ID.

When you map a LUN to a VMFS volume, VirtualCenter creates a file that points to the raw LUN. Encapsulating disk information in a file allows VirtualCenter to lock the LUN so only one virtual machine can write to it. This is more secure than how LUNs were accessed in older versions of VirtualCenter.

**Note:** This file has a `.vmdk` extension, but the file only contains disk information describing the mapping to the LUN on the ESX Server system; the actual data is stored on the LUN.
**Note:** Using VirtualCenter, you cannot deploy a virtual machine from a template and store its data on a LUN. When you deploy a virtual machine from a template, you can store its data in a virtual disk file.

If you are creating virtual machines on an ESX Server host older than version 2.5, you can store the data on a system LUN by directly accessing the LUN. You can use any LUN on a local disk or on a SAN, as you could with earlier versions of VirtualCenter. However, this method does not allow you to migrate virtual machines with VMotion. You cannot store virtual machine data on LUNs on a GSX Server or VMware Server host.

**To map a system LUN disk for an ESX Server 2.5 virtual machine:**

1. Select an existing LUN to map to in the Target LUN list. The Target LUN list displays the available LUNs that are visible to the managed host.

2. After you select a LUN, do one of the following:
   - If the LUN is already mapped to a VMFS volume, you must reuse the mapping.

   ![New Virtual Machine Wizard](image)

   Go to step 3.
• If the selected LUN is not mapped to a VMFS volume, normally you would map it to a volume. Check the **Map this LUN into a VMFS datastore** check box.

The **Select the datastore** list shows all datastores visible to the managed host. It indicates whether there are any LUNs mapped to any VMFS volumes and how many LUNs are mapped. It is a good idea to put all the mappings on one datastore that is visible to all managed hosts. There must never be more than one mapping for the same LUN.

Select a datastore from the list, then go to step 3.

• If you do not want to map the LUN to a VMFS volume, you can allow the virtual machine to directly access the LUN without mapping it to a datastore. Do not check the **Map this LUN into a VMFS datastore** check box. The virtual machine accesses the physical disk stored on the LUN as it would under earlier ESX Server releases. However, a LUN that is not mapped to a VMFS volume cannot be cloned, made into a template, or migrated.

Click **Next**, and then go to step 4.

3. Select whether the LUN is configured for **Physical** or **Virtual** compatibility.

Physical compatibility is useful if you are using SAN-aware applications in the virtual machine. However, a LUN configured for physical compatibility cannot be cloned, made into a template or migrated (if the migration involves copying the disk). You can migrate a virtual machine with a LUN configured for physical compatibility only to ESX Server 2.5 hosts and only if the migration does not involve copying the disk.
Virtual compatibility allows the LUN to behave as if it were a virtual disk, so you can use features like disk modes. When you clone the disk, make a template out of it, or migrate it (if the migration involves copying the disk), the contents of the LUN are copied into a virtual disk (.vdisk) file.

**Note:** You can migrate a virtual machine with a LUN configured for virtual compatibility to any ESX Server host supported by VirtualCenter, but VMware highly recommends you migrate such a LUN only to an ESX Server 2.5 host. If you migrate the virtual machine to an earlier version of ESX Server, it still can access any of its LUNs configured for virtual compatibility, but those LUNs now appear to VirtualCenter as if they were virtual disk files.

Under **Compatibility**, select whether the LUN is configured for **Physical** or **Virtual** compatibility, then click **Next**.

4. Click **Finish**.

You have finished creating a virtual machine with a virtual disk that is mapped to a LUN.

**To directly access a LUN for an ESX Server 2.1.2 or older virtual machine:**

1. Select an existing LUN to directly access.

![Add Hardware Wizard](image)

The **Device** list displays the available LUNs that are visible to the managed host. These LUNs are not already formatted as VMFS volumes.

2. Click **Finish**.

You have finished creating a virtual machine with a virtual disk that directly accesses a LUN.
Installing a Guest Operating System and VMware Tools

This section describes the following:

- Installing a Guest Operating System in a Virtual Machine
- Installing VMware Tools

After you create a virtual machine, you must install an operating system on its virtual disk just as you do on a new physical machine. You use a standard installation CD-ROM and format the virtual disk at the appropriate place in the installation process. Alternatively, you can install an operating system from image files. ISO image files of installation CD-ROMs and floppy image files of any floppy disks can be used for the installation. Use the VirtualCenter client to connect the virtual machine’s drives to the appropriate image files before you begin the installation.

Once you start the virtual machine, the normal operating system installation takes over. Answer the prompts that appear on the virtual machine console to install the guest operating system.

After your guest operating system is installed, install VMware Tools in the guest.

Installing a Guest Operating System in a Virtual Machine

To install a guest operating system and other software, use the virtual machine console, found on the Console tab for the Inventory button in the navigation bar. Choose an installation method:

- Configure the virtual machine to connect to the managed host CD-ROM and boot an operating system installation disk from it.
- Configure the virtual machine CD-ROM as a path to a networked ISO file and boot from that.

A virtual CD-ROM drive is automatically created when you create a new virtual machine. If you are planning to install the guest operating system from an ISO image, use the Virtual Machine Properties dialog box to change the floppy drive option before powering on the virtual machine. Refer to Changing the Hardware Configuration of a Virtual Machine on page 348 for information on using the Virtual Machine Properties dialog box.

A virtual floppy drive is automatically created when you create a new virtual machine. However, the virtual machines start with the floppy device disconnected. Use the
Virtual Machine Properties dialog box to change the CD-ROM option before powering on the virtual machine, if needed. Refer to Changing the Hardware Configuration of a Virtual Machine on page 348 for information on using the Virtual Machine Properties dialog box.

To install the guest operating system over a CD-ROM drive:

1. Insert the installation CD-ROM for your guest operating system in the managed host’s CD-ROM drive.
2. Click **Power On** on the remote console toolbar to begin setting up your guest operating system. For details on installing specific guest operating systems refer to the VirtualCenter release notes and the Guest Operating System Installation Manual which can be found at pubs.vmware.com/guestnotes.

To install the guest operating system over a network:

1. Prepare ISO image files of installation CD-ROMs and floppy image files of any floppy disks needed for the installation.
2. The installation instructions in this section assume you are installing from physical media. If you are using image files, connect the virtual machine's CD-ROM or floppy drives to the appropriate image files before you begin installing the guest operating system.

Installing a Guest Operating System on a New Virtual Disk

When you are installing a guest operating system on a new virtual disk, you may see a message warning you that the disk is corrupted and asking if you want to place a partition table on the disk. This message does not mean there is any problem with your physical hard disk. It simply means some data needs to be written to the file that holds your virtual hard disk. All you need to do is respond **Yes**. You also need to partition and format the virtual disk as you would with a new, blank hard drive.

Installing a Guest Operating System on a Previously Formatted Raw Disk

If you try to install a guest operating system on a raw or physical disk that was formatted previously with a file system, you may see a **No operating system** error when you power on the virtual machine. This message appears because the boot order specified in the virtual machine's BIOS defaults to the floppy disk, hard disk, and then CD-ROM drive. Instead of booting from the installation CD-ROM, the virtual machine tries to boot from the hard disk.

**Note:** The raw disk option is not supported for virtual machines on a GSX Server or VMware Server host.

To work around this issue, do one of the following:
• Change the boot order in BIOS so the virtual machine boots from the CD-ROM drive before it tries the hard disk. When the virtual machine boots, enter the BIOS and change the boot order on the **Boot** menu.

• Zero out the first 64KB of the raw disk using `dd` or a similar advanced utility.

## Installing VMware Tools

VMware Tools is a suite of utilities that enhances the performance of the virtual machine’s guest operating system and improves management of the virtual machine. It is very important that you install VMware Tools in the guest operating system. Although the guest operating system can run without VMware Tools, you lose important functionality and convenience.

When you install VMware Tools, you install

• The VMware Tools service (or `vmware-guestos` on Linux guests).

• A set of VMware device drivers, including an SVGA display driver, the `vmxnet` networking driver for some guest operating systems, the BusLogic SCSI driver for some guest operating systems and the VMware mouse driver.

• The VMware Tools control panel that lets you modify settings, shrink virtual disks, and connect and disconnect virtual devices.

• A set of scripts that help automate guest operating system operations; the scripts run when the virtual machine’s power state changes.

• A component that supports copying and pasting text between the guest and managed host operating systems.

Refer to the *VMware ESX Server Administration Guide*, the *VMware GSX Server Virtual Machine Guide*, or the *VMware Server Virtual Machine Guide* for instructions on installing and configuring VMware Tools.
Working with Templates

This chapter describes creating and importing templates. A template is a golden image of a virtual machine that can be used as a master copy to create and provision new virtual machines. This chapter contains the following sections:

- Understanding Templates on page 263
- Template Restrictions on page 268
- Preparing for Templates on page 269
- Creating Templates on page 276
- Cloning a Template on page 283
- Deleting a Template on page 285
- Editing a Template on page 287
- Reimporting a Template on page 289

VirtualCenter catalogs and manages the templates. VirtualCenter displays a list of available templates with a name and a brief description. The templates can be stored in a template upload directory, which is a directory local to the VirtualCenter server, or on a SAN VMFS volume.
You need to use a Virtual Machine Administrator role that has permission on the farm to which the host belongs.
Understanding Templates

A template is a golden image created from a virtual machine. The template, as did the source virtual machine, typically includes a specified operating system, a set of applications, and a configuration which provides virtual counterparts to hardware components.

The figure below illustrates creating a template from a managed virtual machine on an ESX Server and a GSX Server or VMware Server. Refer to Abbreviations on page 16 for a description of abbreviations.

VirtualCenter uses virtual machine templates as a quick and consistent method for adding new virtual machines to the VirtualCenter environment. This process of deploying a template includes selecting the appropriate template and designating a VirtualCenter target host to receive the new virtual machine. The deployed virtual
machine is added to the farm where the managed host resides. Refer to Creating Virtual Machines from a Template on page 294 for additional information on deploying templates.
The figure below illustrates creating a new virtual machine from a template (deploying a template) using the optional virtual machine customization feature. Refer to Abbreviations on page 16 for a description of abbreviations.
Templates are created from:

- Existing virtual machines. These virtual machines can be either:
  
  - **GSX Server, VMware Server, or ESX Server** – virtual machines located on any VirtualCenter managed host.

    To create a template from a virtual machine on an ESX Server, GSX Server, or VMware Server host, VirtualCenter must manage the host.

  - **GSX Server or Workstation** – virtual machines stored on a disk local to the VirtualCenter server.

  - Existing templates by making a copy of (cloning) the template.

Templates are stored at the following locations:

- **Template upload directory** – On the VirtualCenter server machine. A copy of the original virtual machine virtual disks is placed in the directory you specify as the template upload directory.

  This method is useful when your source virtual machine is not located on a SAN-based storage device.

  Templates in the template repository can be deployed to any host managed by VirtualCenter.

- **Datastore** – On the managed host with the source virtual machine. Select one from the available datastores. The datastore does not need to be the same datastore as the one on the original virtual machine.

  This method is useful for rapidly deploying templates.

  After a template is created, if it is residing on a VMFS volume or a datastore other than the VirtualCenter template repository, it can be deployed to only managed hosts that have direct access to that datastore.

  **On ESX Server hosts:** The datastores are the VMFS volumes you configured for your ESX Server. You can configure any number of VMFS volumes per ESX Server host.

  **On GSX Server or VMware Server hosts:** The datastore is a designated directory. Each GSX Server or VMware Server host is allowed only one datastore at a time. You can change the designated datastore and rename it, but only one datastore at a time is allowed. Refer to Configuring Datastores on GSX Server or VMware Server Hosts on page 271 for information on designating a GSX Server or VMware Server datastore.
**Note:** If a managed host that has templates stored locally (not in the template repository) is removed from VirtualCenter, all the templates are also removed. Returning the managed host to VirtualCenter does not re-register the templates.

The figure below illustrates the options for creating a template from various virtual machine sources. This includes ESX Server golden images and managed and unmanaged virtual machines. Refer to Abbreviations on page 16 for a description of abbreviations.

![Creating a Template Options](image_url)
Template Restrictions

Template operations function on supported hosts in most cases. In the below listed situations, template operations are permitted only as stated.

- A VMware Server must be registered with VirtualCenter to have its virtual machines used as a source for templates.
  
  To use a VMware Server virtual machine as source for a template, you must register the VMware Server with VirtualCenter.

- Deploying a template or cloning a virtual machine that uses IDE disks to an ESX Server is not supported.

- Deploying a 64-bit template or cloning a 64-bit virtual machine to 32-bit hardware host is not supported.

- Deploying a VMware Server virtual machine template, running a 32-bit guest operating system that is not supported on ESX Server or GSX Server, to an ESX Server or GSX Server host generates a warning message, but allows you to proceed with the deployment. However, the virtual machine cannot be powered on.

- When an ESX Server or GSX Server template is deployed to a VMware Server, the virtual machine does not acquire any of the new features provided by the VMware Server.

- Templates created from a virtual machine that was itself either created on a VMware Server or upgraded through the VMware Server cannot be deployed to ESX Server or GSX Server hosts.

- Deploying a template or cloning a virtual machine that has VMware Virtual SMP enabled to a target host that does not support VMware Virtual SMP is not supported.

- Deploying a template or cloning a virtual machine that has SNMP enabled to a target host that does not support SNMP is not supported.

- Simultaneously creating multiple templates of a virtual machine is not supported.
Preparing for Templates

Prior to creating a template:

- Verify that your system meets the requirements for creating and using templates. Refer to VirtualCenter Template Requirements on page 50.

- Review and complete the steps in the following sections:
  - Specifying an Upload Directory for Templates
  - Configuring ESX Server to Allow Concurrent Template Deploys
  - Configuring Datastores on GSX Server or VMware Server Hosts
  - Using a GSX Server or Workstation Virtual Machine as a Template
  - Using an ESX Server Golden Image as a Template
  - Using an Unmanaged Virtual Machine as a Template
  - Using a Managed Existing Host Virtual Machine as a Template

Specifying an Upload Directory for Templates

When you import a template, you have the option to keep the source virtual machine in its original location or have a copy placed into a managed host located within VirtualCenter.

When you import any created template and select the upload directory option, the new template is copied to the upload directory location. The upload directory must be in a location relative to the VirtualCenter server and local to the VirtualCenter server. It cannot be a network share that is mapped as a local drive.

When you create the template you must have Virtual Machine Administrator or greater role permission on the managed host. When you deploy a template from the upload directory, you must have Virtual Machine Administrator or greater role permission on the target managed host.

Note: If you change the upload directory, all subsequently created templates are stored in the new template upload directory. Templates stored in the old upload directory continue to work.

Note: The template upload directory cannot reside on a network share.

To specify a location for importing templates:

1. From the VirtualCenter client, open the VMware VirtualCenter Settings dialog box and select the Templates tab.
Select **File > VMware VirtualCenter Settings**.

2. Enter the template upload directory location. Click **OK**.

   a. Scroll to the **Template Upload Directory** field.
   
   b. Before you create any templates, enter the full absolute path of the directory to use as the templates upload directory.

   This valid path references an existing directory to which VirtualCenter has access and which is local to VirtualCenter server, not a network share mapped locally.

**Configuring ESX Server to Allow Concurrent Template Deploys**

If template disks are stored on your ESX Server version 2.5 or later and you plan to deploy multiple virtual machines from a single template at the same time, you must create the templates using allocated template disks.

With all ESX Server versions, the default setting is to store template disks as not allocated. In ESX Server version 2.5, you have the option to change the default setting to allocated.

**Note:** Templates created prior to making the ESX Server host configuration change described below are not affected. This configuration change only applies to templates created after you make the change.

The tables below list the typical allocation for ESX Server and GSX Server or VMware Servers.
Disk file in virtual machine:

<table>
<thead>
<tr>
<th></th>
<th>ESX Server</th>
<th>GSX Server or VMware Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not allocated</td>
<td>not possible</td>
<td>possible</td>
</tr>
<tr>
<td>Allocated</td>
<td>default</td>
<td>possible</td>
</tr>
</tbody>
</table>

Disk file of templates:

<table>
<thead>
<tr>
<th></th>
<th>ESX Server</th>
<th>GSX Server or VMware Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not allocated</td>
<td>default</td>
<td>default</td>
</tr>
<tr>
<td>Allocated</td>
<td>possible through configuration file setting (flatdisks=true)</td>
<td>not possible</td>
</tr>
</tbody>
</table>

To enable allocated template disks:

1. On your ESX Server version 2.5 host, find the managed host config file. The file location is:
   
   `/etc/vmware/config`

2. Edit or add the `template.useFlatDisks` parameter.
   
   `template.useFlatDisks="TRUE"`

3. Restart the VirtualCenter agent running on the ESX Server host.

   This ensures that all template disks created after this change on your ESX Server are allocated and able to support concurrent deployment of multiple virtual machines from a single template.

Configuring Datastores on GSX Server or VMware Server Hosts

When a GSX Server or VMware Server host is added to VirtualCenter, the Add a Host Wizard defaults the datastore location for all the virtual machines on that managed host. Only one datastore is allowed per GSX Server or VMware Server. All virtual machine files are stored at the root directory where GSX Server or VMware Server is installed on its managed host if the datastore is not specified.

**Note:** You do not set datastores for an ESX Server host through VirtualCenter. Datastores on an ESX Server are the VMFS volumes that are set when you configured the ESX Server. Refer to your ESX Server documentation for information on configuring VMFS volumes.
To specify a different directory location for the datastores of a particular GSX Server or VMware Server:

1. Select and verify the managed host is a GSX Server or VMware Server host. View the managed host summary page. The title bar lists the managed host name, host type (GSX Server, VMware Server, or ESX Server), and the virtualization platform version.

![Host title bar and datastore name](image)
2. Open the managed host Properties box. Select the **Datastore** tab.

3. In the field, type the name of the datastore and the path to the datastore.
   - This must be in the appropriate format: Linux or Windows path for a GSX Server or VMware Server.
     
     To view the format, check the managed host Summary page in the **Datastore** field. The path specified there is appropriate for the managed host type: Linux or Windows.
   
   - The VirtualCenter user must have read and write permissions on the directory selected.

   Specify the template location as a URL that is on a Network Attached Storage (NAS) local network location.
   - This must be a local directory.
   - Each GSX Server or VMware Server host is allowed one datastore.

### Using a GSX Server or Workstation Virtual Machine as a Template

**To use a virtual machine that is already configured as a template:**

1. Power down the virtual machine.
2. If you have a Workstation or an older GSX Server virtual machine:
   - Upgrade the virtual machine to Workstation 4.0, GSX Server 2.5 or later, or VMware Server 1.0 or later, if needed.
The source virtual machine must be local to the VirtualCenter server.

If the source virtual machine is not local, you must copy the virtual machine to a folder local to the VirtualCenter server. Using the method of your choice, copy the contents of the virtual machine folder. The contents include, but are not limited to, the following files:

- Virtual machine configuration file with a .vmx or .cfg extension.
- Virtual disk files with a .vmdk or .vsk extension. There could be several virtual disk files. Copy all of them.

**Note:** Edit the disk location of any disks that were specified with absolute paths. When you update the paths to the disk, you can use relative or absolute paths to specify the new location of the disks.

**Note:** Although virtual machines with IDE disks can be templatized, that template cannot be deployed to an ESX host.


### Using an ESX Server Golden Image as a Template

**To use an existing ESX Server golden image as a VirtualCenter template:**

1. Use your standard ESX Server procedures to import the golden image and create a virtual machine.

   Refer to your ESX Server documentation for additional information.

2. If the ESX Server host is an unmanaged host, proceed to Using an Unmanaged Virtual Machine as a Template on page 274.

   If the ESX Server host is a managed host, proceed to Using a Managed Existing Host Virtual Machine as a Template on page 275.

### Using an Unmanaged Virtual Machine as a Template

Unmanaged VMware Server virtual machines cannot be used as source for templates.

**To use an existing virtual machine on an unmanaged host as a template:**

1. Power down the virtual machine.

2. If you have a virtual machine that resides on a host that is not managed with VirtualCenter, perform the following:
   - Upgrade to ESX Server 2.0.1 or later, GSX Server 3.1 or later.
Refer to your host virtualization platform documentation for additional information.

- Temporarily register the ESX Server, GSX Server, or VMware Server host with the virtual machine that is the source for the template.
  You may need to adjust your managed hosts to ensure you have sufficient VirtualCenter licenses.
- Create the template by selecting the Copy files to template upload directory option.
  Refer to Creating Templates on page 276 for information on creating the template.
- Unregister the ESX Server, GSX Server, VMware Server host.

**Note:** If a managed host that has templates stored locally (not in the template repository) is removed from VirtualCenter, all the templates are also removed. Returning the managed host to VirtualCenter does not re-register the templates.


**Using a Managed Existing Host Virtual Machine as a Template**

**To use a managed ESX Server, GSX Server, or VMware Server virtual machine as a template:**

1. Power down the virtual machine.
2. Proceed to Creating Templates on page 276.
Creating Templates

If you plan to store a template in the VirtualCenter upload directory, refer to Specifying an Upload Directory for Templates on page 269 and define the upload directory location before proceeding.

Note: You cannot create a template from a virtual machine with undoable disks.

To create a template from a virtual machine:

1. Start VirtualCenter client and log on to the VirtualCenter server.

   From the inventory panel:
   a. Click the Inventory button in the navigation bar.
      The inventory panel and the information panel display information about managed farms, hosts, and virtual machines. The Inventory toolbar appears.
   b. Expand the inventory as needed and click the appropriate virtual machine.
   c. Start the New Template Wizard.
      From the main or right-click popup menu, select New Template from this Virtual Machine.

   From the Templates Navigation panel:
   a. Click the Templates option in the navigation bar.
   b. Click the New button in the Templates toolbar.

3. Confirm to proceed with the New Template Wizard. Click Next.
4. **If you are starting from the Templates panel:** Select a virtual machine. Click Next.

![VMware VirtualCenter New Template Wizard](image)

The options are:

- **A virtual machine in the VMware VirtualCenter Inventory** – Use this option to create a template from a virtual machine on a managed host.

- **A virtual machine on a local or network file system that is not in the VMware VirtualCenter inventory** – Use this option to create a template from a virtual machine that is not being managed by VirtualCenter.
5. **If you are selecting an unmanaged virtual machine:** Locate the source virtual machine. Click **Next**.

Type or copy the full path to the source virtual machine configuration file. This file has either a `.vmx` or a `.cfg` extension.

The Browse option is available only when the VirtualCenter client is running on the same machine as the VirtualCenter server. If the Browse option is not available, type the path to the virtual machine configuration file in the text box.

**Note:** The path to the configuration `.vmx` file must be the fully qualified path on the VirtualCenter server, not the VirtualCenter client.

If you are not running the VirtualCenter client on the same machine as the VirtualCenter server, type in the path on the VirtualCenter server machine where the template source virtual machine is located.

**Note:** This file must be in a folder or file system local to the VirtualCenter server.

**Note:** An ESX Server source virtual machine should not use IDE virtual disks. GSX Server and VMware Server support virtual machines with both IDE or SCSI virtual disks.
6. **If you are using a managed virtual machine and started from the Templates New Template panel:** Select the managed virtual machine to use as the source for the template. Click **Next**.

![VirtualCenter New Template Wizard](image)

7. Give the new template a name and description. Click **Next**.

![VirtualCenter New Template Wizard](image)

Enter a useful name and a brief description of the template. This description can include the operating system, applications, versions, and intended uses for the template. The name can be up to 80 characters long and contain alphanumeric characters and the underscore (_) and hyphen (-) characters. The name should be unique across all templates and cannot start with a space or contain a back slash (\) or forward slash (/).
8. Specify the target location of the template files. Click **Next**.

   The choices are:
   
   - **On the VMware VirtualCenter server** – This option makes copies of the virtual machine disk files and places copies into the VirtualCenter upload directory.

     Copying the files can take some time. After the importing template process, the source virtual machine is available for normal operations. Refer to **Specifying an Upload Directory for Templates on page 269** for information on specifying and using the VirtualCenter upload directory.

     Use this option if the source disk is not on a SAN. This option ensures the template can be deployed to any managed host.

   - **On a datastore** – This option adds a reference to the location of the files.

     The virtual machine disks are copied to the VMFS volume that you specify.

     Use this option when the virtual disk resides in a VMFS volume on a SAN. This ensures a rapid deployment of a new virtual machine because it is a local disk copy.
9. **If you selected On a datastore:**

Select the datastore location in which to place the new template. Click **Next**.

10. Complete the importing template process. Click **Finish**.

VirtualCenter adds the configuration file data into the VirtualCenter database and adds the template to the list of available templates. To view the list, click the **Templates** option in the navigation bar.

Copying the source virtual machine to the template upload directory, can take a long time, depending upon the size of the source virtual machine. Refer to the **Tasks** panel to view the progress of creating the template.
To check the progress of the new template creation, click the Show Active Task toggle. A progress bar displays the percentage of completion.
Cloning a Template

To clone an existing template to create an additional template:

1. From the VirtualCenter client, display the information panel of the Templates function. Click the Templates option in the navigation bar.
   The information panel changes to display the list of current templates and the template toolbar.
2. Select the appropriate template. Click the Clone toolbar button.
3. Confirm adding a new template. Click Next.
4. Give the new template a name and description. Click Next.

   Enter a useful name and a brief description of the template. Description information can include, for example, the operating system, applications, versions, and intended uses for the template. The name can be up to 80 characters long, and can contain alphanumeric characters and the underscore (_) and hyphen (-) characters. It should also be unique across all templates.

5. Pass through the target location screen. Click Next.
   The template files are always copied to the template upload directory.
6. Complete the importing template process. Click Finish.
   VirtualCenter displays the Tasks inventory panel for reference and adds the cloned template to the list in the information panel. The virtual disks are copied to the template upload directory. Refer to the Tasks panel to view the progress of the cloning operation.
Deleting a Template

You have the option to remove a template from VirtualCenter inventory and remove the template files from disk.

Deleting a Template from VirtualCenter

To delete an existing template from VirtualCenter inventory:

1. From the VirtualCenter client, display the information panel of the templates function.
   - Click the Templates option in the navigation bar.
   - The information panel changes to display the list of current templates and the template toolbar.
2. Select and right-click the appropriate template.
3. Select the Remove option from the menu.
4. Confirm removing the template from the VirtualCenter database. Click OK.

All non-datastore template files are removed from the VirtualCenter inventory.

5. If the template is stored on a datastore, it cannot be removed from the VirtualCenter inventory until it is removed from disk.
   - Proceed to Deleting a Template from Disk on page 285.

Deleting a Template from Disk

To delete an existing template from VirtualCenter inventory:

1. From the VirtualCenter client, display the information panel of the templates function.
   - Click the Templates option in the navigation bar.
   - The information panel changes to display the list of current templates and the template toolbar.
2. Select and right-click the appropriate template.
3. Select the Remove option from the menu.
4. Confirm removing the template from the VirtualCenter database. Click **OK**.

   ![Delete Template from Disk](image)

   All non-datastore template files are removed from the VirtualCenter inventory.
Editing a Template

To change the template virtual machine:

1. Deploy the template.
2. Edit the resulting virtual machine.
3. Create a new template from the edited virtual machine.

To change the name and description of a template:

1. From the VirtualCenter client, display the templates panel.
   Click the Templates option in the navigation bar.
   The information panel displays current templates and the template toolbar.
2. Select the appropriate template.
3. Select the Properties option to display the Template Properties dialog box.
   Choose from either Edit > Properties or right-click Properties.

![Template Properties dialog box](image)

Enter a useful name and a brief description of the template. The description can include the operating system, applications, versions, and intended uses for the template. The name can be up to 80 characters long, and contains alphanumeric characters and the underscore (_) and hyphen (-) characters. The name should also be unique across all templates.

Modify the template name or the template description. Edit the text as needed. Click OK.
Reimporting a Template

When you import a file from a local disk to make a template, VirtualCenter expects to import a GSX Server, VMware Server, or Workstation virtual machine. VirtualCenter can also handle importing a GSX Server or VMware Server template. If you have an ESX Server template that you want to import, you have to change it to make it look like a GSX Server or VMware Server template.

To move VirtualCenter templates from one VirtualCenter server to another VirtualCenter server:

1. Copy the template files from the original VirtualCenter server to the target VirtualCenter server and make sure that the disk (.vmtd) files are in the same folder as the .vmtx file.
2. Edit the .vmtx file for this template.
   a. Change the value of suspend.Directory to "." or else just remove that line altogether.
   b. Change any full VMFS path names to bare filenames instead. For example, change /vmfs/myvolume/mydisk.vmtd to mydisk.vmtd.
   c. Change any occurrence of .name in the SCSI keys to .fileName instead. For example, change scsi0:0.name to scsi0:0.fileName.
   d. Replace any occurrence of vmxbuslogic with buslogic.
   e. Replace any occurrence of vmxlsilogic with lsilogic.
3. Open the VirtualCenter client and log onto the new VirtualCenter server.
   a. Select the Templates panel.
   b. Select New to create a new template. Click Next.
5. Select A virtual machine on a local file system that is not in the VMware VirtualCenter Inventory. Click the second choice then Next.
6. Browse to the directory containing the copy of the template and change the Files of type setting to All files (*.*)
7. Select the correct *.vmtx file. Click Next.
8. Update the Name and Description fields if necessary. Click Next.
9. Select the second choice: Use the virtual machine’s files as template files. Click Finish.
This chapter describes how to create a new virtual machine by deploying a template or by cloning an existing virtual machine. Both of these methods provide options to customize the new virtual machine as you create it. This chapter does not describe the customization options. Refer to Customizing Guest Operating Systems on page 317 for detailed customization information. Refer to Creating New Virtual Machines on page 233 for information on creating a virtual machine from scratch.

This chapter contains the following sections:

- Cloning and Template Restrictions on page 293
  Verify that the cloning or template deployment is supported between your source and target hosts.

- Creating Virtual Machines from a Template on page 294
  Use templates to create new virtual machines when you want to create one or more virtual machines easily from a reservoir of virtual machines, each with a specific and consistent configuration and data state.

- Creating Virtual Machines by Cloning an Existing Virtual Machine on page 307
Use the cloning method to create a new virtual machine when you want to create a copy of an individual, typically currently operating, virtual machine.

Assign a Virtual Machine Administrator role to the farm where the deployed or cloned virtual machine is to be located to perform the activities described in this chapter.
Cloning and Template Restrictions

Cloning and deploying templates works between hosts in most cases. In the below listed situations, the new virtual machine is permitted only as stated.

- Deploying a template or cloning a virtual machine that uses IDE disks to an ESX Server is not supported.
- Deploying a 64-bit template or cloning a 64-bit virtual machine to 32-bit hardware host is not supported.
- Deploying a template or cloning a VMware Server virtual machine, running a 32-bit guest operating system that is not supported on ESX Server or GSX Server, to an ESX Server or GSX Server host generates a warning message, but allows you to proceed with the cloning or deployment. However, the virtual machine cannot be powered on.
- Deploying a template or cloning a virtual machine from a VMware Server host to an ESX Server version 2.x or GSX Server version 3.x host is not supported.
- When an ESX Server or GSX Server virtual machine is cloned to a VMware Server, the virtual machine does not acquire any of the new features provided by the VMware Server. The virtual machine is allowed to be redeployed back to the original host.
- Virtual machines created on VMware Server or upgraded through VMware Server Console cannot be migrated or cloned back to either a GSX Server or ESX Server.
- Templates created from a virtual machine that was itself either created on a VMware Server or upgraded through the VMware Server cannot be deployed to ESX Server or GSX Server hosts.
- Deploying a template or cloning a virtual machine that has VMware Virtual SMP enabled to a target host that does not support VMware Virtual SMP is not supported.
- Deploying a template or cloning a virtual machine that has SNMP enabled to a target host that does not support SNMP is not supported.
- Simultaneously creating multiple clones of a virtual machine is not supported.
Creating Virtual Machines from a Template

A template is a golden image of a virtual machine. This image typically includes a specified operating system and configuration which provides virtual counterparts to hardware components. Typically, a template includes an installed guest operating system and a set of applications. Templates are a reservoir of specifically configured virtual machines ready to be deployed to a host within VirtualCenter.

VirtualCenter uses templates to create new virtual machines. This technique is called deploying a template. Templates can reside either in the VirtualCenter template repository or the VMFS volume. Those residing in the VirtualCenter template repository can be deployed to any of the managed hosts. Those residing on a VMFS volume, on the other hand, can be deployed only to hosts that have access to that VMFS volume. The deploying process includes selecting the appropriate template and designating a VirtualCenter target host to receive the new virtual machine. When complete, the deployed virtual machine is added to the inventory panel farm where the host resides.

The deploying template topics are covered in the following sections:

- Manually Deploying Virtual Machine from a Template
- Creating a Scheduled Task to Deploy a Template
The figure below illustrates creating a customized virtual machine. Refer to Abbreviations on page 16 for a description of abbreviations.
Manually Deploying Virtual Machine from a Template

To manually start the Template Deployment Wizard:

1. Start VirtualCenter and log on to the VirtualCenter server.
2. Choose a method for starting the Deploy Virtual Machine from Template Wizard.

   From the inventory panel:
   a. Click the Inventory button in the navigation bar.
      The inventory panel and the information panel display the managed farms, hosts, and virtual machine information. The Inventory toolbar appears.
   b. Expand the inventory as needed, and click the target host.
      This is the host on which the new virtual machine will be located.
   c. Start the Deploy Virtual Machine from Template Wizard.
      From the main or right-click popup menu, select Deploy Virtual Machine from Template.
   d. Accept the Deploy Template Wizard. Click OK.
e. Select the template to deploy.

From the templates panel:

a. Click the Templates button in the navigation bar.

b. Select the template to deploy.

c. Click the Deploy button in the templates toolbar.

3. Confirm the start of the Deployment Wizard. Click Next.
4. Specify the new virtual machine name. Click **Next**.

![Virtual Machine Name]

Enter a name for the new virtual machine. Click **Next**.

**Note:** The virtual machine name cannot exceed 80 characters.

5. Select the farm or virtual machine group on which to deploy the new virtual machine. Click **Next**.

![Virtual Machine Destination]
6. Specify the host on which to deploy the new virtual machine. Click **Next**.

7. Select the datastore on which to store the new virtual machine configuration file and virtual disks. Click **Next**.

   This specifies the location for the virtual machine configuration and disk files. The virtual machine must be placed on a datastore. Select from the list.
8. Select the network interface card (NIC) to use for the virtual machine. Click **Next**.

9. Specify a resource allocation level. Click **Next**.
10. Select whether or not to customize the new virtual machine as it is deployed.

The options are:

**Start the Guest Customization Wizard** – Opens the customization wizard. Proceed to Customizing Guest Operating Systems on page 317 for information on using the Guest Customization Wizard.

**Import customization settings from an XML file** – Browse for and select an existing XML file with customization already defined. Click Browse and select the appropriate XML file. Optionally, click Start the guest customization wizard. Click Next.

**If you are recreating the customized parameters .xml files for use with a new or upgraded VirtualCenter server:**

a. Click the Import customization settings from an XML file option in the Deploy Template Wizard.

b. Click Start the guest customization wizard.

c. In the Customization wizard, modify the entry for the passwords and the administrator passwords so that they are appropriate for the new or upgraded VirtualCenter server. Refer to Customizing a Windows Guest Operating System on page 327.

**Do not customize the guest operating system** – Proceeds with the current deployment and does not make any additional changes to the guest operating system.

Select the appropriate option and click Next.
   VirtualCenter displays the Tasks inventory panel for reference, makes a copy of
   the template, applies changes as specified, and stores the new virtual machine
   on the designated host location.

Creating a Scheduled Task to Deploy a Template

To deploy a virtual machine from a template as a scheduled task:

1. Display the Tasks panel.
   Click the Tasks option in the navigation bar. The list of scheduled tasks appears.
4. Select the task to create.
   Click the pull-down menu and select the Deploy Virtual Machine from a
   Templates option. Click Next.
5. Select the template to deploy. Click Next.
6. Select the virtual machine group in which to place new virtual machine. Click Next.

7. Select a host on which to place new virtual machine. Click Next.
8. Specify a name for the new virtual machine. Click Next.

9. Select the datastore volume on which to store the new virtual machine configuration file and virtual disks.

The virtual machine disk files must be placed on a datastore. Select from the list. Click Next.
10. Select the network interface card (NIC) to use for the new virtual machine. Click Next.

11. Specify a resource allocation level. Click Next.
12. Select whether or not to customize the virtual machine as it is deployed. Click Next.

![Guest Operating System Customization](image)

13. Set the time and date you want the virtual machine to be deployed. Click Next. To see the calendar, click Later, then click the drop-down arrow to select a date from the displayed calendar. A red circle indicates today's date and a dark circle indicates the scheduled date. Refer to Creating a Scheduled Task on page 397 for additional information.

14. Confirm creating the task. Optionally, specify an email address for notification when task is performed. Click Finish.

VirtualCenter adds the new task to the scheduled task list and completes it at the designated time. When it is time to perform the task, VirtualCenter first verifies that the user who created the task still has permission to complete the task. If the permission levels are not acceptable, VirtualCenter logs a message and the task is not performed.
Creating Virtual Machines by Cloning an Existing Virtual Machine

A clone is a copy plus customization of a virtual machine. When you create a clone, VirtualCenter provides an option to customize the guest operating system of that virtual machine. You can place the new clone on any host within the same farm as the original virtual machine.

The figure below illustrates creating a new customized virtual machine by cloning an existing virtual machine. Refer to Abbreviations on page 16 for a description of abbreviations.

Creating a Clone
The following sections discuss cloning a virtual machine:

- Manually Cloning a Virtual Machine
- Creating a Scheduled Task to Clone a Virtual Machine

### Manually Cloning a Virtual Machine

To manually start the Virtual Machine Cloning wizard:

1. Start VirtualCenter and log on to the VirtualCenter server.
2. Start the Clone a Virtual Machine wizard, from the inventory panel:
   a. Click the **Inventory button** in the navigation bar.
   
   The inventory panel and the information panel display the managed farms, hosts, and virtual machine information. The Inventory toolbar appears.
   
   b. Expand the inventory as needed, and click the source virtual machine.
   
   c. Start the Clone a Virtual Machine wizard.
   
   From the main or right-click popup menu, select **Clone**.
3. Confirm continuing with the Clone Wizard. Click **Next**.
4. Select a target host for the clone. Click **Next**.
5. Select a Virtual Machine Group for the clone. Click **Next**.

6. Assign a name to the clone.

Enter a name. Click **Next**.
7. Select the datastore location.

Select a location from list. Click Next.

8. Assign the network interface cards (NIC).

Select from the list, if there is more than one NIC. Click Next.
9. Specify the resource allocation level.

The resource allocating level tells VirtualCenter what percentage of the host resources to make available to the new virtual machine.

Click the appropriate radio button. Click Next.

10. Select whether or not to customize the new virtual machine as you create it.

Click the appropriate radio button. Click Next.

If you select the customization option, refer to Customizing Guest Operating Systems on page 317 for description of the customization wizard and options.
If you decide not to customize the new virtual machine as part of the cloning process, proceed to the next step.

11. Complete the Cloning a Virtual Machine wizard. Click **Finish**.

   VirtualCenter displays the Scheduled Tasks panel for reference and makes a copy of the virtual machine, applies changes as specified, and stores the virtual machine on the designated host location.

**Creating a Scheduled Task to Clone a Virtual Machine**

To create a scheduled task to clone a virtual machine:

1. Display the Scheduled Tasks panel.
   
   Click the Scheduled **Tasks** option in the navigation bar. The list of scheduled tasks appears.

2. Start the New Task Wizard. Click **New** in the toolbar.

3. Confirm continuing with the New Task Wizard. Click **Next**.

4. Select the task to create.
   
   Click the pull-down menu and select **Clone an existing virtual machine**. Click **Next**.

5. Select the virtual machine to clone. Click **Next**.
6. Select a target host for the clone. Click **Next**.

7. Select a virtual machine group for the clone. Click **Next**.
8. Assign a name to the clone.

Enter a name. Click Next.

9. Select the datastore location.

Select a location from the list. Click Next.
10. Assign the network interface cards (NIC).

Select from the list, if there is more than one NIC. Click Next.

11. Specify the resource allocation level.

The resource allocation level tells VirtualCenter what percentage of the host resources to make available to the new virtual machine.

Click the appropriate radio button. Click Next.
12. Select whether or not to customize the new virtual machine as you create it.

![VirtualCenter New Task Wizard]

Would you like to customize the guest operating system?
- [ ] Start the guest customization wizard
- [ ] Import customizations from an XML file
  Filename: [ ]
  Browse: [ ]
- [ ] Do not customize the guest operating system

Click the appropriate radio button. Click Next.

If you select the customization option, refer to Customizing Guest Operating Systems on page 317 for description of the customization wizard and options.

If you decide not to customize the new virtual machine as part of the cloning process, proceed to the next step.

13. Set the time and date when you want the virtual machine to be deployed. Click Next.

To see the calendar, click Later, then click the drop-down arrow to select a date from the displayed calendar. A red circle indicates today’s date and a dark circle indicates the scheduled date. Refer to Creating a Scheduled Task on page 397 for additional information.

14. Confirm creating the task.

Optionally, specify an email address for notification when task is performed. Click Finish.

VirtualCenter adds the new task to the scheduled task list and completes it at the designated time. When it is time to perform the task, VirtualCenter first verifies that the user who created the task still has permission to complete the task. If the permission levels are not acceptable, VirtualCenter sends a message to the log and the task is not performed.
This chapter describes how to customize your guest operating systems. You customize your guest operating system when you create a virtual machine in VirtualCenter from a template or as a clone.

This chapter contains the following sections:

- Preparing for Guest Customization on page 319
- Beginning the Guest Customization Process on page 324
- Customizing New Guest Operating Systems on page 327
- Completing a Guest Operating System Customization on page 342

You need to use a Virtual Machine Administrator role assigned to the target host where the virtual machine is located to perform the activities described in this chapter.

When a new virtual machine is deployed or cloned, starting the Guest Customization wizard is an option.

**Note:** Not all operating systems supported by VMware Server can be customized through the Guest Customization wizard. Refer to VirtualCenter Guest Operating
System Customization Requirements on page 51 for a list of supported guest operating systems.

Customizing Windows guest operating system options include:

- Join workgroups and domains
- Network interface configuration
- Domain suffix, security ID (SID) change

Customizing Linux guest operating system options include:

- Host name
- Domain suffix
- Network interface configuration
Preparing for Guest Customization

When you deploy a template or clone an existing virtual machine, you have the opportunity to customize the new guest operating system. A Guest Customization wizard guides you through the configuration options.

Before you run the Guest Customization wizard, that means, before you start the Template Deployment or Clone wizards, if you intend to perform a Guest Customization, perform the following:

- Verify that your system meets the guest customization requirements listed in VirtualCenter Guest Operating System Customization Requirements on page 51.
- Install the required components on the Windows machine where the VirtualCenter server is installed.

**Note:** After deploying and customizing non-volume-licensed versions of Windows XP or Windows 2003, it may be necessary to re-activate your Microsoft operating system on the new virtual machine.

**Note:** Customization of a VMware Server virtual machine is supported only for those guest operating systems already approved for GSX Server and ESX Server. Refer to VirtualCenter Guest Operating System Customization Requirements on page 51 for additional information.

Installing the components required to support guest operating system customization are covered in the following sections:

- Installing the Microsoft Sysprep Tools
- Installing the VMware Open Source Components

**Installing the Microsoft Sysprep Tools**

If you plan to customize a Windows guest operating system, you must first install the Microsoft Sysprep tools on your VirtualCenter server machine. Refer to VirtualCenter Guest Operating System Customization Requirements on page 51 for a list of the supported guest operating systems.

Microsoft includes the Sysprep tool set on the installation CDs for Windows 2000, Windows XP, and Windows 2003. It also distributes Sysprep 1.1 from the Microsoft web site. In order to perform a Windows customization, you must install the Sysprep tools either from your installation CD, or from the 1.1 download package.

During a customization, VirtualCenter searches for the Sysprep package corresponding to your guest operating system. If the Sysprep tools are not found
under the corresponding provided operating system directory, VirtualCenter searches in the provided \1.1 directory. If VirtualCenter does not find any Sysprep tools, the Windows virtual machine customization does not proceed.

To install the Microsoft Sysprep tools from a Microsoft Web site download:

1. Download the Sysprep package.
   Though the Sysprep version indicates Windows 2000, it works with both Windows XP Professional and Windows Server 2003.

2. Click Next to continue. Click I agree to accept the terms and conditions. Click download. Save the file to your local disk.

3. Run the Microsoft installer.
   Q257813_w2k_spl_x86_en.exe

4. Extract the files to the provided directory.

   Sysprep support directories were created during VirtualCenter installation:
   C:\[VirtualCenter_installation_directory]\resources\windows\sysprep\...esources\windows\sysprep\1.1\...esources\windows\sysprep\2k\...esources\windows\sysprep\xp\...esources\windows\sysprep\svr2003\Select the 1.1 subdirectory.

5. Click OK to expand the files.

   After you have extracted the files from Q257813_w2k_spl_x86_en.exe to the \1.1 directory, you should see:
   ...esources\windows\sysprep\1.1\docs\...esources\windows\sysprep\1.1\samples\...esources\windows\sysprep\1.1\tools\...esources\windows\sysprep\1.1\contents.txt

To install the Microsoft Sysprep tools from the Windows operating system CD:

1. Insert the Windows OS CD into the CD-ROM, for example, D: drive.

2. Locate the DEPLOY.CAB file in the CD directory, \Support\Tools.

3. Open and expand the DEPLOY.CAB file, using a tool such as Winzip.exe or another tool capable of reading Microsoft CAB files.
4. Extract the files to the provided directory appropriate to your Sysprep guest operating system.

Sysprep support directories were created during VirtualCenter installation:

C:\[VirtualCenter_installation_directory]\resources\windows\sysprep\...esources\windows\sysprep\1.1\...esources\windows\sysprep\2k\...esources\windows\sysprep\xp\...esources\windows\sysprep\svr2003\Select the subdirectory that corresponds to your operating system.

5. Click OK to expand the files.

After you have extracted the files from DEPLOY.CAB, you should see:

...\resources\windows\sysprep\<guest>\deptool.chm
...\resources\windows\sysprep\<guest>\readme.txt
...\resources\windows\sysprep\<guest>\setupcl.exe
...\resources\windows\sysprep\<guest>\setupmgr.exe
...\resources\windows\sysprep\<guest>\setupmgx.dll
...\resources\windows\sysprep\<guest>\sysprep.exe
...\resources\windows\sysprep\<guest>\unattend.doc

where <guest> is either 2k, xp, or svr2003.

6. Repeat this procedure to extract Sysprep files for each of the Windows guest operating system (Windows 2000, Windows XP, or Windows 2003) you plan to customize using Virtual Center.

You are now ready to customize a new virtual machine with supported Windows guest operating system when you clone an existing virtual machine or deploy a template.

**Installing the VMware Open Source Components**

If you plan to customize a Linux guest operating system, you must first install the VMware Open Source components on your VirtualCenter server machine. VMware has packaged these components into a separate package called VMware Open Source Components, which you download from the VMware Web site. Refer to: www.vmware.com/download

Perform the installation process once on the VirtualCenter server to support the following Linux guest operating systems:
To install the VMware Open Source Components:

1. On the machine running VirtualCenter server, disable any anti-virus application that interferes with Active Scripting.

   VirtualCenter server uses Windows Active Scripting to perform some of its tasks. Certain anti-virus applications may disable Active Scripting or block scripts from accessing system resources. When this happens, some features of VirtualCenter behave unexpectedly or fail to work. In Norton AntiVirus, the feature is called Script Blocker. In McAfee, it's known as ScriptStopper. If you have one of these or another anti-virus application that interferes with Active Scripting, it is important that you disable these features on the machine running VirtualCenter server.

2. From your VirtualCenter server machine, open a browser.

   Perform this on every machine that has a VirtualCenter server.

3. Locate, download, and start the VMware Open Source Components installer.
   a. Go to the browser path: www.vmware.com/download
   b. Click the Download link for VMware Products > VMware VirtualCenter.
      The reference to Windows operating systems refers to the VirtualCenter installation platform.
   c. If you have not done so already, register your VirtualCenter serial number.
      Click the register your serial number link. Complete the required forms.
      Return to this download login page.
   d. Click Download Binaries for Windows operating systems.
   e. Enter your email address and password. This is the email used to register VirtualCenter. Click Login.
   f. Read and accept the EULA statement.
   g. Click the download link to the Open Source Components installer.
      Answer the prompts to place the installer file on your system.

4. Start the Open Source Components installer.
   Double-click on the VMware Open Source Components’ .exe file.
The VMware Open Source Components installer starts up and displays a download dialog box.

5. Complete the installation.

Follow the installer instructions.

You are now ready to customize a new virtual machines with a supported Linux guest operating system as you clone an existing virtual machine or deploy a template.
Beginning the Guest Customization Process

The Guest Customization wizard option appears during the virtual machine deployment or cloning process.

The beginning the guest customization topics are covered in the following sections:

- Entering the Guest Customization Wizard from the Template Deployment Process
- Entering the Guest Customization Wizard from the Cloning Process

Entering the Guest Customization Wizard from the Template Deployment Process

Add a new virtual machine to a host by deploying a managed template.

To start the guest operating system customization wizard:

1. From the VirtualCenter client Schedule Task panel, start the Template Deployment Wizard.
   a. Display the Tasks panel, by clicking the Tasks option in the navigation bar. The list of existing scheduled tasks appears.
   c. Confirm continuing with the New Task Wizard. Click Next.
   d. Select the task to create. Click the pull-down menu and select the Deploy a virtual machine from Templates option. Click Next.
2. Proceed with the Template Deployment Wizard screens.

   a. Confirm continuing with the Template Deployment Wizard. Click Next.
   b. Select a template to deploy. Click Next.
   c. Specify a name for the new virtual machine. Click Next.
   d. Select a farm or virtual machine group to which to deploy. Click Next.
   e. Select a host to which to deploy. Click Next.
   f. Select the storage location for the virtual machine configuration and disk files.
Click the appropriate volume from the displayed list of possible datastores. Click Next.

g. Select the virtual networks for each of the virtual machine’s Network Interface Cards (NICs).

Click the appropriate network from the pull-down menu. Click Next.

h. Set the resource priority for this virtual machine.

Enter the appropriate information for the displayed fields. Click Next.

The fields may vary depending upon the settings selected.

3. Select whether or not to customize the new guest operating system.

Click Start the guest customization wizard. Click Next. Proceed to Customizing New Guest Operating Systems on page 327.

Entering the Guest Customization Wizard from the Cloning Process

A new virtual machine can be added to a host by cloning an existing virtual machine.

To start the guest operation system customization wizard:

1. From the VirtualCenter client Schedule Task panel, start the Clone Wizard.
   a. Display the Tasks log, by clicking the Tasks option in the navigation bar.

   The list of existing scheduled tasks appears.
   c. Confirm continuing with the New Task Wizard. Click Next.
d. Select the task to create. Click the pull-down menu and select the **Clone an existing virtual machine** option. Click **Next**.

2. Proceed with the Clone Wizard.
   a. Select a virtual machine to clone. Click **Next**.
   b. Select a host for the new clone. Click **Next**.
   c. Specify a name for the new clone.
      Type a name and click **Next**.
   d. Select the volume on which to store the new clone's files. Click **Next**.
   e. Specify the network interface card (NIC) for the new clone. Click **Next**.
   f. Specify the resource priority for the new clone. Click **Next**.

3. Select whether or not to customize the new clone.
   Click **Start the guest customization wizard**. Click **Next**. Proceed to Customizing New Guest Operating Systems on page 327.
Customizing New Guest Operating Systems

The customizing process varies, depending upon the guest operating system to be used in the new virtual machine. Refer to VirtualCenter Guest Operating System Customization Requirements on page 51 for a list of supported guest operating systems.

The customizing guest operating system topics are covered in the following sections:

- Customizing a Windows Guest Operating System
- Customizing a Linux Guest Operating System

Customizing a Windows Guest Operating System

To customize a Windows 2000, Windows XP Professional, or Windows Server 2003 guest operating system while deploying a template or cloning a virtual machine, perform the following.

To customize a Windows guest operating system:

1. Verify the guest operating system can be customized through the Guest Customization wizard. Refer to VirtualCenter Guest Operating System Customization Requirements on page 51 for a list of supported guest operating systems.

2. Start the Guest Customization wizard.
   
   You cannot start the Guest Customization wizard from a menu or toolbar option. The Guest Customization wizard starts indirectly from the VirtualCenter Template Deployment or Clone Wizard.
   
   - If you are deploying a template to create a new virtual machine, refer to Creating Virtual Machines from a Template on page 294.
   
   - If you are cloning an existing virtual machine, refer to Creating Virtual Machines by Cloning an Existing Virtual Machine on page 307.

3. Confirm continuing with the Guest Customization wizard. Click Next.
4. Optionally, specify registration information.

The owner’s name and organization are for your reference purposes only. They do not affect the functioning of the virtual machine.

Enter the name of a person, user, or group, and of the organization in the appropriate fields. Click Next.

5. Specify a computer name for the virtual machine. Click Next.

The host or computer name is the name given to the particular instance of a guest operating system. The operating system uses this name to identify itself on the network. On Windows systems, it is called the computer name. On most other operating systems, it is called the host name.
This is not the same as the virtual machine name that was declared earlier in the Clone or Template Deployment Wizard.

If an asterisk (*) is entered in the Computer Name field, a random name is assigned to the computer name.

When you specify a name, use only characters that are allowed in a Windows computer name.

6. Provide the licensing information.

![Image of VMware VirtualCenter Guest Customization Wizard]

Enter the Windows license key for the new guest operating system. For Windows Server operating systems, click the appropriate license mode and specify the maximum number of simultaneous connections allowed, if appropriate. Click Next.
7. Specify the password for the Administrator account.

![Administrator Password](image)

- Enter the password for the Administrative user. Enter it again in the **Confirm password** field.
- Optionally, click the box to automatically log on as administrator when the virtual machine boots. If this option is selected, also specify how many times the automatic logon is to be performed. This is useful if you know you will have a series of reboots before the virtual machine is ready for normal log on users.
- Click **Next**.

If you specify a new administrator password and the source Windows virtual machine or template already has one, then you must select the **Delete all user accounts** option in step 13. Otherwise the old administrator password is not changed.
8. Specify a time zone. Click **Next**.

9. Specify any commands to be run the first time the new virtual machine is started.

Type the command string in the field. Click **Add**. Use the **Delete** and **Move** options to position the commands in the appropriate order.
10. Select whether or not to use typical or customize network settings. Click **Next**.

The options are:

- **Typical settings** – VirtualCenter automatically configures all network interfaces from a DHCP server.
- **Custom settings** – You specify the network settings.

11. **If you use custom network settings:**

   a. Select the network interface card (NIC) to customize. Click **Next**.

   Optionally, select the NIC, then click **Customize** to make additional specifications.
b. If you are customizing the NIC network properties, select the method and enter the IP and DNS server addresses.

Specify an IP address and DNS server. Click **OK** to close this dialog box and return to the previous dialog box. Then click **Next** in the Network Guest Customizations dialog box.
c. Specify the DNS connections.

Click the **DNS** tab. Enter a new DNS suffix. Click **Add**. If you are adding multiple DNS addresses, use the **Move Up** and **Move Down** buttons to set the order of use. Click **OK** to close this dialog box and return to the previous dialog box. Then click **Next** in the Network Guest Customizations dialog box.
d. Specify the WINS address.

Click the WINS tab. Type the appropriate IP addresses. Click OK to close this dialog box and return to the previous dialog box. Then click Next on the Network Guest Customizations dialog box.

12. Join a workgroup or domain.

Enter the workgroup and domain identification information. Click Next.
13. Select additional guest operating system options.

The options are:

**Generate New Security ID (SID)** – This option is set to default.

**Delete all user accounts** – If you specify a new administrator password in step 7 and the source Windows virtual machine or template already has one, then you must select the **Delete all user accounts** option here; otherwise, the old administrator password is not changed. This option is only available in the customization wizard for Windows 2000 guest operating systems.

Click the buttons to configure any desired options. Click **Next**.

Specify a filename and location. Click Next.

VirtualCenter saves the customized configuration parameters in an .xml file. Later, import these predefined customized parameters, when deploying a template or cloning an existing virtual machine.

If the customization settings are saved to a file then the administrator password of the Windows virtual machine and the domain administrator’s password, as applicable, are stored in encrypted format in the .xml file.

**Note:** Saved customization files are unique to each VirtualCenter server and to each version of VirtualCenter due to encryption. You have to recreate the customization files for each VirtualCenter server. Encryption is preserved between upgrade versions on the same VirtualCenter server. This means you can use the same files between upgrades of VirtualCenter. However if you perform an uninstall and a later fresh install, the ability to decrypt passwords from the earlier installation is lost.

To recreate the customized parameters .xml files, use the Import customizations from an XML file option in the Deploy Template wizard. Click Start the guest customization wizard and modify the entry for the passwords and the administrator passwords again. Refer to Manually Deploying Virtual Machine from a Template on page 296

15. Complete the Guest Customization wizard. Click Finish.

VirtualCenter closes the Guest Customization wizard and returns you to the Deploy a Template or Clone a Virtual Machine wizard, click Finish.
Customizing a Linux Guest Operating System

To customize a Linux RedHat Advanced Server or Linux SuSe guest operating system while deploying a template or cloning a virtual machine:

1. From the VirtualCenter Template or Clone Wizard, start the Guest Customization wizard.

   This wizard starts as a subset of one of the following wizards:
   - Deploying a template to create a new virtual machine. Refer to Creating Virtual Machines from a Template on page 294.

2. Confirm continuing with the Guest Customization wizard. Click Next.

3. Specify a hostname and domain suffix for this virtual machine. Click Next.

   The host, or computer name, is the name given to the particular instance of a guest operating system. The operating system uses this name to identify itself on the network. On Windows systems it is called the computer name. On most other operating systems it is called the host name.

   This is not the same as the virtual machine name. That name was declared earlier in the Clone a Virtual Machine or the Deploy a Template Wizard.

   The name of the domain on which this virtual machine will be running.

   The host, or computer name, is the name given to the particular instance of a guest operating system. The operating system uses this name to identify itself on the network. On Windows systems it is called the computer name. On most other operating systems it is called the host name.

   This is not the same as the virtual machine name. That name was declared earlier in the Clone a Virtual Machine or the Deploy a Template Wizard.

   The name of the domain on which this virtual machine will be running.
4. Select the network settings.

Select the appropriate radio button. Click **Next**.

- **Typical settings** – VirtualCenter automatically configures all network interfaces from a DHCP server.
- **Custom settings** – You specify the network settings.

5. **If you use custom network settings:**

   a. Enter the DNS addresses.

Enter the Primary, Secondary, and Tertiary DNS addresses. Then enter a DNS name. Click **Add**. Click **Next**.
b. Select the Network Interface Card (NIC) to customize. Click Next.

Optionally, select the NIC, then click Customize to make additional specifications.

c. If you are customizing the NIC network properties, select the method and enter the IP and DNS server addresses.
Click **OK** to close this dialog box and return to the previous dialog box. Then click **Next** on the Network Customizations dialog box.


   - Click **Save my customization settings**. Then click **Browse** to identify a location and specify a filename. Click **Next**.
   - Click **No, thanks**. Click **Next**.

   VirtualCenter saves the customized configuration parameters in an `.xml` file. Later, you can import these predefined customized parameters when you deploy a template or clone an existing virtual machine.

7. Complete the Guest Customization wizard. Click **Finish**.

   VirtualCenter closes the Guest Customization wizard and returns you to the Deploy a Template or Clone a Virtual Machine wizard to complete that wizard.
Completing a Guest Operating System Customization

Customization finishes when the new virtual machine boots for the first time. At this time, the guest operating system runs its final customization sequence. As part of this process, the machine may reboot a number of times. Customization is not complete until this sequence finishes and the guest displays the logon screen. The customization process does not complete until the guest operating system boots, runs the finalization scripts, and reaches the logon screen.

If the new virtual machine encounters customization errors while it is booting, the errors are reported using the guest’s system logging mechanism. In Linux these errors are logged to `/var/log/boot.log`. In Windows they are written to the application event log.

The steps required to finalize guest operating system customization are covered in the following sections:

- Completing Linux Guest Operating System Customization
- Completing Windows Guest Operating System Customization

Completing Linux Guest Operating System Customization

A customized Linux virtual machine does not need any additional rebooting and is operational as soon as the logon screen appears after the first boot. If configuration errors occur, they are displayed on the virtual machine’s console screen while the guest operating system is booting.

Completing Windows Guest Operating System Customization

When a customized virtual machine is powered on for the first time, its guest operating system runs a set of scripts that finalize the customization and configuration process. Depending on the guest operating system type, this process may involve additional rebooting, which is automatically performed by the scripts.

The customization process installs scripts that run once in the target virtual machine when it powers on (or boots) for the first time after being deployed or cloned. Those scripts complete the customization process by performing final configuration operations on the guest operating system.

After powering on for the first time, a customized Windows virtual machine automatically reboots twice to finalize the configuration process. It becomes operational when the logon screen appears after the second reboot. This process can
take several minutes, depending upon the speed and load of the host. If any errors occur during the final configuration process, events are logged to the guest operating system’s event database, and can be viewed using Program > Administrative Tools > Event Viewer from the Windows Start menu.

If any of the information required in the configuration finalization process is not correct, the guest operating system pauses when the new virtual machine boots and waits for you to enter the correct information. This information includes:

- The computer name is not unique. The computer name must be unique for the network on which the machine is deployed.
- The product key is incorrect.
- The user specified to join a domain that does not exist.
- The DHCP server for the network is not functioning properly.

To determine if the system is waiting for information, check the virtual machine icon in the inventory panel. If it is flashing, it is waiting for a response. Alternatively, check the Status field in the virtual machine Summary tab. If it is displaying a link, the system is waiting for a response. Refer to Answering a Pending Question on page 209 for additional information.
CHAPTER 14

Editing an Existing Virtual Machine Configuration

This chapter describes how to edit or customize your existing virtual machines. Perform these activities after you create the virtual machine and install the guest operating system. You need to use a Virtual Machine Administrator role assigned to the virtual machine you wish to edit in order to perform the activities described in this chapter. This chapter contains the following sections:

- Beginning to Edit the Virtual Machine Configuration on page 346
- Changing the Hardware Configuration of a Virtual Machine on page 348
- Adding Hardware to a Virtual Machine on page 367
- Changing Virtual Machine Options on page 383
- Changing Virtual Machine Resource Settings on page 387

Note: When you create a virtual machine and install a guest operating system, install VMware Tools. This installation is specific to the type of guest operating system installed. See Installing VMware Tools on page 260.

Note: For comprehensive information about configuring virtual machines, refer to your ESX Server, GSX Server, or VMware Server documentation.
Beginning to Edit the Virtual Machine Configuration

In addition to customizing a virtual machine while you create it, you have the option to edit the virtual machine configuration after you create it. This section describes how to customize an existing virtual machine. Refer to your VMware ESX Server, GSX Server, or VMware Server documentation for information about all the ramifications of specific customizations.

To edit an existing virtual machine configuration:

1. From the VirtualCenter client, display the inventory panel and expand the appropriate farm.
   
   Click Inventory in the navigation bar. Expand the inventory as needed, and click the virtual machine to customize.

2. Power off the virtual machine.
   
   You cannot edit most virtual machine properties if the virtual machine is powered on.

3. Display the Virtual Machine Properties dialog box.
   
   Choose Edit > Properties or click Edit Properties from the Summary tab.
4. Make changes and or additions as needed. Click **OK**.

Select items on the Virtual Machine Properties dialog box, and configure them.

Refer to the appropriate section in this chapter for additional information. Refer to your ESX Server, GSX Server, or VMware Server documentation for comprehensive information about configuring virtual machines.
Changing the Hardware Configuration of a Virtual Machine

This section introduces the changes you can make to the virtual machine hardware. The following sections describe how to change the configuration of existing virtual hardware devices in a virtual machine:

- Changing the DVD/CD-ROM Drive Configuration
- Changing the Floppy Drive Configuration
- Changing the Generic SCSI Device Configuration
- Changing the Virtual Disk Configuration
- Changing the Memory Configuration
- Changing the Virtual Ethernet Adapter (NIC) Configuration
- Changing the Parallel Port Configuration
- Changing the SCSI Controller Configuration
- Changing the Serial Port Configuration
- Changing the Virtual Processor (or CPU) Configuration
- Changing the Audio Configuration
- Changing the Mouse Configuration
- Changing the USB Configuration

Changing the DVD/CD-ROM Drive Configuration

1. From the VirtualCenter client, select the virtual machine.
   
   Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   
   In the Summary tab, click Edit Properties or choose Edit > Properties.
3. Click the **Hardware** tab. Click the DVD/CD-ROM drive in the **Device** list.

4. Make changes as needed. Select the device status, connection, or virtual device node for the virtual machine to use.

5. If you do not want the CD-ROM drive connected when the virtual machine starts, deselect **Connect at power on**.

6. Select **Use physical drive** if you want to connect the virtual machine's drive to a physical drive on the host computer. Select **Use ISO Image** if you want to connect the virtual machine's drive to an ISO image file.

7. Do one of the following:
   - If you selected **Use physical drive**, choose the drive you want to use from the drop-down list or, if you are on a VMware Server, choose **Auto detect**.

   **For an ESX Server virtual machine:** if the virtual machine is using a non-standard CD-ROM or if you are experiencing problems with a CD-ROM, check **Enable raw access**.

   **For a GSX Server or VMware Server virtual machine:** if you are connecting to the host's physical CD-ROM drive (instead of pointing to an ISO image), you can select **Connect exclusively to this virtual machine** to prevent other virtual machines and the host from using the CD-ROM drive until you disconnect it from this virtual machine or you power off or suspend the virtual machine.

   You can select **Legacy emulation**. This is necessary only if you have had problems using normal mode. The legacy emulation mode does not support
all the capabilities of normal mode. This is similar to enabling raw access on an ESX Server host.

For information about exclusive connections and legacy emulation, see www.vmware.com/support/gsx3/doc/

- If you selected **Use ISO Image**, enter the path and filename for the image file or click **Browse** to navigate to the file.

8. Under **Virtual device node**, select the device node the drive uses in the virtual machine.

9. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.

**Changing the Floppy Drive Configuration**

1. From the VirtualCenter client, select the virtual machine.

   Click **Inventory** in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

   In the **Summary** tab, click **Edit Properties**. Or, choose **Edit > Properties**.

3. Click the **Hardware** tab. Click the floppy drive in the **Device** list.

4. To connect this virtual machine to the floppy drive when the virtual machine is powered on, select **Connect at Power On**.

5. Specify whether or not to connect to the host’s floppy drive or to a floppy image. Select **Use physical drive**, then choose the drive from the list or, if you are on a
CHAPTER 14  Editing an Existing Virtual Machine Configuration

VMware Server, choose Auto detect. Or select Use floppy Image, then create a new or browse to an existing floppy image.

6. Click OK to save your changes. The Virtual Machine Properties dialog box closes.

Changing the Generic SCSI Device Configuration

1. From the VirtualCenter client, select the virtual machine.

   Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

   In the Summary tab, click Edit Properties. Or, choose Edit > Properties.

3. Click the Hardware tab. Click the generic SCSI device in the Device list.

4. To connect this virtual machine to the server’s SCSI device when the virtual machine is powered on, select Connect at power on.

5. Under Connection, select the physical device you want to use.

   Under Virtual device node, select the virtual device node where you want this device to appear in the virtual machine.

6. Click OK to save your changes. The Virtual Machine Properties dialog box closes.

Changing the Virtual Disk Configuration

1. From the VirtualCenter client, select the virtual machine.
Click **Inventory** in the navigation bar. Expand the inventory as needed and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   In the **Summary** tab, click **Edit Properties** or choose **Edit > Properties**.

3. Click the **Hardware** tab. Click the appropriate **Hard Disk** in the **Device** list.
4. **For an ESX Server 2.5 virtual machine**: do the following:

   a. If the virtual machine's hard disk is actually a LUN mapped into a VMFS datastore, select **Physical** or **Virtual** compatibility under **Compatibility mode**.

      If the virtual machine is configured with a standard virtual disk, go to step b.

      ![Virtual Machine Properties](image)

      Properties for an ESX Server virtual machine configured with a virtual disk mapped to a VMFS volume.

      Physical compatibility is useful if you are using SAN-aware applications in the virtual machine.

      Virtual compatibility allows the LUN to behave as if it were a virtual disk so that you can use features like disk modes.

   b. Under **Mode**, select a disk mode. For information about disk modes, see the *VMware ESX Server Administration Guide*.

   c. Under **Virtual device node**, select the virtual device node where you want this device to appear in the virtual machine.
5. **For a GSX Server or VMware Server virtual machine:** to change the device node, click **Advanced**, then select the node from the **Virtual device node** list.

![Advanced Virtual Disk Options dialog box](image)

Click **OK** after you specify the node. The Advanced Virtual Disk Options dialog box closes.

6. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.

### Changing the Memory Configuration

1. From the VirtualCenter client, select the virtual machine.

   Click **Inventory** in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

   In the **Summary** tab, click **Edit Properties**. Or, choose **Edit > Properties**.
3. Click the **Hardware** tab. Click **Memory** in the **Device** list.

4. Adjust the amount of memory allocated to the virtual machine.
   The range of memory supported is 4MB to 3600MB and is not limited to the physical memory of the host where the virtual machine resides.

5. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.

**Changing the Virtual Ethernet Adapter (NIC) Configuration**

1. From the VirtualCenter client, select the virtual machine.
   Click **Inventory** in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   In the **Summary** tab, click **Edit Properties**. Or, choose **Edit > Properties**.
3. Click the **Hardware** tab. Click the appropriate **NIC** in the **Device** list.

![Virtual Machine Properties](image)

4. To connect the virtual NIC when the virtual machine is powered on, check **Connect at power on**.

5. Select the network driver you want the virtual machine to use, if applicable.

   - **vlance** – this network interface card adapter driver installs automatically. This option displays for virtual machines that are **not** upgraded to or created on a VMware Server.

   - **vmxnet** – this network interface card adapter driver provides better network performance. The difference in network performance is most noticeable if the virtual machine is connected to a Gigabit Ethernet card on the host. This option displays for virtual machines that are **not** upgraded to or created on a VMware Server.

   - **Flexible** – this network interface card adapter driver is a morphing vlance. This means the virtual machine uses the vmxnet driver by default. If the vmxnet driver is not installed the virtual machine uses the vlance driver. This option displays for virtual machines that **are** upgraded to a VMware Server and the previous adapter option selected was vmxnet. You have the option to select between vlance and vmxnet.

   - **E1000** – this network interface card adapter driver functions as a vlance driver. This option displays for virtual machines that **are** upgraded to a VMware Server and the previous adapter option selected was vlance. You are not given the option to switch to a vmxnet driver.

6. Select a network from the **NIC** list.
7. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.
Changing the Parallel Port Configuration

1. From the VirtualCenter client, select the virtual machine.
   
   Click **Inventory** in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   
   In the **Summary** tab, click **Edit Properties**. Or, choose **Edit > Properties**.

3. Click the **Hardware** tab. Click the appropriate **Parallel** port in the **Device** list.

4. Under **Device status**, the default setting is **Connect at power on**. Clear the check box if you do not want the parallel port device to be connected when the virtual machine powers on.

5. Make the appropriate selection to use a physical parallel port or connect the virtual parallel port to a file.
   
   If you select **Use physical parallel port**, select the port from the list or, if you are on a VMware Server, choose **Auto detect**.
   
   If you select **Use output file**, enter the path and filename.

6. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.

Changing the SCSI Controller Configuration

You can change the SCSI controller configuration for a virtual machine on an ESX Server host only.

**Caution**: Changing the SCSI controller type may result in a virtual machine boot failure.
You can also specify whether or not the SCSI bus is shared. Depending upon the type of sharing, virtual machines can access the same virtual disk simultaneously on the same server or any server. See your ESX Server documentation for more information.

To change the SCSI controller configuration:

1. From the VirtualCenter client, select the virtual machine.
   
   Click **Inventory** in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   
   In the **Summary** tab, click **Edit Properties**. Or, choose **Edit > Properties**.

3. Click the **Hardware** tab. Click the appropriate **SCSI Controller** in the **Device** list.

   
   ![Virtual Machine Properties dialog box](image)

4. Select the SCSI controller type in the list.
   
   **Caution:** Changing the SCSI controller type may result in a virtual machine boot failure.

5. Specify whether or not the SCSI bus is shared. Select the type of sharing in the **SCSI Bus Sharing** list. Select one of the following:
   
   - **None** – virtual disks cannot be shared by other virtual machines.
   - **Virtual** – virtual disks can be shared by virtual machines on same server.
   - **Physical** – virtual disks can be shared by virtual machines on any server.

6. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.
Changing the Serial Port Configuration

1. From the VirtualCenter client, select the virtual machine.
   Click **Inventory** in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   In the **Summary** tab, click **Edit Properties**. Or, choose **Edit > Properties**.

3. Click the **Hardware** tab. Click the appropriate **Serial** port in the **Device** list.

4. Make changes as needed.
   - If you selected **Use physical serial port**, select the port on the host computer that you want to use for this serial connection or, if you are on a VMware Server, choose **Auto detect**.
   - If you selected **Use output file**, enter the path to and name of the file on the host that you want to use to store the output of the virtual serial port.
   - If you selected **Use named pipe**, use the default pipe name, or enter another pipe name of your choice in the **Pipe Name** list.

For a serial pipe for a virtual machine on a GSX Server or VMware Server for Windows host, the pipe name must follow the form `\\.\pipe\<namedpipe>` — that is, it must begin with `\\.\pipe\`. For a serial pipe for a virtual machine on an ESX Server host, GSX Server, or VMware Server for Linux host, enter `/tmp/<socket>` or another Unix socket name of your choice.
Then decide whether you are connecting two virtual machines or a virtual machine to an application on the host.

**If you are connecting two virtual machines:** you must configure a serial port as a named pipe in two virtual machines: a server virtual machine and a client virtual machine.

For the server virtual machine, select **Server** in the **Near end** list.

For the client virtual machine, select **Client** in the **Near end** list.

Select **A virtual machine** in the **Far end** list.

**If you are connecting to an application on the host:** select **Server** or **Client** in the **Near end** list. In general, select **Server** if you plan to start this end of the connection first.

Select **An application** in the **Far end** list.

5. By default, the serial port starts connected when you power on the virtual machine. You may deselect the **Connect at power on** check box if you wish.

6. Under **I/O Mode**, decide whether or not to configure this serial port to use interrupt mode as opposed to polled mode. Polled mode is of interest primarily to developers who are using debugging tools that communicate over a serial connection.

   Polled mode causes the virtual machine to consume a disproportionate share of processor time. This makes the host and other guests run sluggishly. To maintain best performance for applications on the host, check the **Yield Processor on poll** check box. This forces the affected virtual machine to use interrupt mode, which yields processor time if the only task it is trying to do is poll the virtual serial port.

7. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.
Changing the Virtual Processor (or CPU) Configuration

If the virtual machine is on an ESX Server or VMware Server host and you have VMware Virtual SMP for ESX Server or VMware Server, which supports Symmetric Multiprocessors (SMP), you can configure a virtual machine to have two virtual processors.

Caution: Not all guest operating systems support SMP, and most that do require reinstallation if the number of processors changes.

Virtual machines on GSX Server hosts can have only one virtual processor.

To change the virtual processor configuration:

1. From the VirtualCenter client, select the virtual machine.
   - Click Inventory in the navigation bar. Expand the inventory, as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   - In the Summary tab, click Edit Properties or choose Edit > Properties.

3. Click the Hardware tab. Click Virtual Processor (or CPU)s in the Device list.

4. Select the number of virtual processors for the virtual machine. You must have VMware Virtual SMP for ESX Server or VMware Server if you want more than one virtual processors for the virtual machine. If you do not have VMware Virtual SMP for ESX Server or VMware Server, the virtual machine can have one virtual processor only.
Caution: Not all guest operating systems support Symetric Multiprocessors (SMP), and most that do require reinstallation if the number of processors changes.

5. Click OK to save your changes. The Virtual Machine Properties dialog box closes.

**Changing the Audio Configuration**

If the virtual machine is located on a GSX Server or VMware Server host and is configured with a sound adapter, you can change its configuration.

**To change the audio configuration:**

1. From the VirtualCenter client, select the virtual machine.
   
   Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   
   In the Summary tab, click Edit Properties. Or, choose Edit > Properties.

3. Click the Hardware tab. Click Audio in the Device list.

4. Under Device status, the default setting is Connect at power on. Clear the check box if you do not want the sound adapter to be connected when the virtual machine powers on.

5. Specify whether to connect to the host’s default sound adapter or a specific one. Select Use default host sound adapter to use the default host sound adapter. To use a specific adapter, select Specify host sound adapter and select a specific adapter from the list.
6. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.
Changing the Mouse Configuration

If the virtual machine is on a GSX Server or VMware Server for Linux host, you can configure its mouse.

To configure a virtual machine's mouse:

1. From the VirtualCenter client, select the virtual machine.
   Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.
2. Display the Virtual Machine Properties dialog box.
   In the Summary tab, click Edit Properties. Or, choose Edit > Properties.
3. Click the Hardware tab. Click Mouse in the Device list.
4. Select the type of mouse connected to the virtual machine in the Host mouse type list.
5. Under Connection, select whether or not VirtualCenter should detect the mouse automatically or else select Specify the host device and then select the mouse from the list.
6. Click OK to save your changes. The Virtual Machine Properties dialog box closes.
Changing the USB Configuration

If the virtual machine is located on a GSX Server or VMware Server host and is configured with a USB controller, you can change its configuration.

To change the USB controller configuration:

1. From the VirtualCenter client, select the virtual machine.
   Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   In the Summary tab, click Edit Properties. Or, choose Edit > Properties.

3. Click the Hardware tab. Click USB Controller in the Device list.

4. Specify whether or not to automatically detect any new USB devices when the virtual machine console tab is active.

5. Click OK to save your changes. The Virtual Machine Properties dialog box closes.
Adding Hardware to a Virtual Machine

You add virtual hardware to a virtual machine using the Add Hardware Wizard. To start the wizard:

1. From the VirtualCenter client, select the virtual machine.
   Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   In the Summary tab, click Edit Properties. Or, choose Edit > Properties.

3. Click the Hardware tab.

4. Start the Add Hardware Wizard. Click Add.
   Follow the steps in the wizard. The following sections describe how to add virtual hardware to an existing virtual machine:
   - Adding a DVD/CD-ROM Drive
   - Adding a Floppy Drive
   - Adding a Generic SCSI Device
   - Adding a Hard Disk
   - Adding an Ethernet Adapter (NIC)
   - Adding a Parallel Port
   - Adding a Serial Port
   - Adding a USB Controller
   - Adding a Virtual Sound Adapter
Adding a DVD/CD-ROM Drive

1. Start the Add Hardware Wizard, as described in Adding Hardware to a Virtual Machine on page 367.

2. In the Add Hardware Wizard, select DVD/CD-ROM Drive, then click Next.

3. Select Use physical drive if you want to connect the virtual machine’s drive to a physical drive on the host computer. Select Use ISO Image if you want to connect the virtual machine’s drive to an ISO image file. Click Next.

4. Do one of the following:
   - If you selected Use physical drive, choose the drive you want to use from the drop-down list or, if you are on a VMware Server, choose Auto detect.
If you selected **Use ISO Image**, enter the path and filename for the image file or click **Browse** to navigate to the file.

5. If you do not want the CD-ROM drive connected when the virtual machine starts, deselect **Connect at power on**.

6. Click **Advanced** to specify the device node the drive uses in the virtual machine.

**For GSX Server or VMware Server hosts:** if you are connecting to the host’s physical CD-ROM drive (instead of pointing to an ISO image), on the advanced settings screen you may also select **Legacy emulation**. This is necessary only if you have had problems using normal mode. The legacy emulation mode does
not support all the capabilities of normal mode. For information about legacy emulation, see www.vmware.com/support/gsx3/doc/.

7. Complete the wizard. Click Finish.
Adding a Floppy Drive

1. Start the Add Hardware Wizard, as described in Adding Hardware to a Virtual Machine on page 367.
2. In the Add Hardware Wizard, select Floppy Drive, then click Next.
3. Select the type of floppy media.

4. Do one of the following:
   - If you selected Use a physical floppy drive, choose the drive you want to use from the drop-down list or, if you are on a VMware Server, choose Auto detect.
   - If you selected Use a floppy image, type the path and filename for the floppy image file you want to use, or click Browse to navigate to the file.

5. To have the floppy drive be connected to the virtual machine when you power it on, check Connect at Power On.
6. Complete the wizard. Click Finish.

Adding a Generic SCSI Device

1. Start the Add Hardware Wizard, as described in Adding Hardware to a Virtual Machine on page 367.
2. In the Add Hardware Wizard, select **Generic SCSI Device**, then click **Next**.

![Add Hardware Wizard](image)

3. Under **Connection**, select the physical device you want to use.

4. To connect this virtual machine to the server’s SCSI device when the virtual machine is powered on, select **Connect at power on**.

5. Under **Virtual device node**, select the virtual device node where you want this device to appear in the virtual machine.

6. Complete the wizard. Click **Finish**.

**Adding a Hard Disk**

1. Start the Add Hardware Wizard, as described in *Adding Hardware to a Virtual Machine* on page 367.
2. In the Add Hardware Wizard, select **Hard Disk** and click **Next**.

![Add Hardware Wizard](image)

3. Select the type of storage for the virtual machine's disk.

   **For ESX Server hosts:** you can store virtual machine data in a new virtual disk, an existing virtual disk, or a system LUN.

   **For GSX Server or VMware Server hosts:** you can store virtual machine data in a new virtual disk or an existing virtual disk.

   Make your selection, click **Next**, then proceed to the section appropriate to your disk selection and host type.

   - Creating a New Virtual Disk on a GSX Server or VMware Server Host on page 248
   - Creating a New Virtual Disk on an ESX Server Host on page 250
   - Using an Existing Virtual Disk on page 252
   - Mapping a System LUN Disk on an ESX Server Host on page 253
Adding an Ethernet Adapter (NIC)

1. Start the Add Hardware Wizard, as described in Adding Hardware to a Virtual Machine on page 367.

2. In the Add Hardware Wizard, select Ethernet Adapter, then click Next.

3. Select a network from the NIC list.

   For GSX Server or VMware Server hosts: You must configure a network label on the managed host before a NIC can be configured for the virtual machine. See Configuring Network Labels for GSX Server or VMware Server Hosts on page 182 for additional information.

4. To connect the virtual NIC when the virtual machine is powered on, check Connect at power on.

5. Complete the wizard. Click Finish.
Adding a Parallel Port

1. Start the Add Hardware Wizard, as described in Adding Hardware to a Virtual Machine on page 367.
2. In the Add Hardware Wizard, select Parallel Port, then click Next.
3. Make the appropriate selection to use a physical parallel port or connect the virtual parallel port to a file. Click Next.

4. Do one of the following:
   - If you selected Use physical parallel port on the host, choose the port from the drop-down list or, if you are on a VMware Server, choose Auto detect.
• If you selected **Use output file**, enter the path and filename, or browse to the location of the file.

5. Under **Device status**, the default setting is **Connect at power on**. Clear the check box if you do not want the parallel port device to be connected when the virtual machine powers on.

6. Complete the wizard. Click **Finish**.
Adding a Serial Port

A virtual serial port can be configured in several ways.

- You can connect a virtual serial port to a physical serial port on the host computer.
  
  This is useful, for example, if you want to use an external modem or a hand-held device in your virtual machine.

- You can connect a virtual serial port to a file on the host computer.
  
  This is useful, for example, if you want to capture the data that a program running in the virtual machine sends to the virtual serial port, or if you need a quick way to transfer a file from the guest to the host.

- You can make a direct connection between two virtual machines.
  
  This is useful, for example, if you want to use an application in one virtual machine to capture debugging information sent from the other virtual machine's serial port.

- You can make a direct connection between a virtual machine and an application running on the host computer.
  
  This is useful, for example, if you want to use an application on the host to capture debugging information sent from the virtual machine's serial port.

You can also select whether or not to connect the virtual serial port when you power on the virtual machine.

To add a serial port to a virtual machine:

1. Start the Add Hardware Wizard, as described in Adding Hardware to a Virtual Machine on page 367.

2. In the Add Hardware Wizard, select Serial Port, then click Next.
3. Select a serial port type. Click **Next**.

4. Do one of the following:
   - If you selected **Use physical serial port on the host**, select the port on the host computer that you want to use for this serial connection or, if you are on a VMware Server, choose **Auto detect**.
• If you selected **Output to file**, enter the path to and name of the file on the host that you want to use to store the output of the virtual serial port.

![Output to file](image)

• If you selected **Output to named pipe**, use the default pipe name, or enter another pipe name of your choice in the **Pipe Name** field.

For a serial pipe for a virtual machine on a GSX Server or VMware Server for Windows host, the pipe name must follow the form `\\.\pipe\<namedpipe>` — that is, it must begin with `\\.\pipe\`.

For a serial pipe for a virtual machine on an ESX Server host or a GSX Server or VMware Server for Linux host, enter `/tmp/<socket>` or another Unix socket name of your choice.

![Specify Named Pipe](image)

Then decide whether you are connecting two virtual machines or a virtual machine to an application on the host.
If you are connecting two virtual machines, you must configure a serial port as a named pipe in two virtual machines: a server virtual machine and a client virtual machine.

For the server virtual machine, select Server in the Near end list.
For the client virtual machine, select Client in the Near end list.
Select A virtual machine in the Far end list.

If you are connecting to an application on the host: select Server or Client in the Near end list. In general, select Server if you plan to start this end of the connection first.
Select An application in the Far end list.

5. By default, the serial port starts connected when you power on the virtual machine. You may deselect the Connect at power on check box if you wish.

6. Click Advanced if you want to configure this serial port to use interrupt mode as opposed to polled mode. Polled mode is of interest primarily to developers who are using debugging tools that communicate over a serial connection.

Polled mode causes the virtual machine to consume a disproportionate share of processor time. This makes the host and other guests run sluggishly.

To maintain best performance for applications on the host, check the Yield Processor on poll check box. This forces the affected virtual machine to use interrupt mode, which yields processor time if the only task it is trying to do is poll the virtual serial port.

7. Complete the wizard. Click Finish.
Adding a USB Controller

If the virtual machine is located on a GSX Server or VMware Server host, you can add a USB controller to the virtual machine.

To add a USB controller:

1. Start the Add Hardware Wizard, as described in Adding Hardware to a Virtual Machine on page 367.
2. In the Add Hardware Wizard, select USB Controller and click Next.
3. Specify whether or not to automatically detect any new USB devices when the virtual machine console tab is active.
4. Complete the wizard. Click Finish.
Adding a Virtual Sound Adapter

If the virtual machine is located on a GSX Server or VMware Server host, and that host has a sound adapter, you can add a virtual sound adapter to the virtual machine.

To add a virtual sound adapter:

1. Start the Add Hardware Wizard, as described in Adding Hardware to a Virtual Machine on page 367.

2. In the Add Hardware Wizard, select Sound Adapter and click Next.

3. Specify whether to connect to the host’s default sound adapter or a specific one. Select Use default host sound adapter to use the default host sound adapter. To use a specific adapter, select Specify host sound adapter and select a specific adapter from the list.

4. Under Device status, the default setting is Connect at power on. Clear the check box if you do not want the sound adapter to be connected when the virtual machine powers on.

5. Complete the wizard. Click Finish.
Changing Virtual Machine Options

The virtual machine settings allow you define actions that occur in various virtual machine power states. The options are described in the following sections:

- Changing General Settings
- Changing Power State Options
- Changing Advanced Settings

Changing General Settings

1. From the VirtualCenter client, select the virtual machine.
   - Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.
2. Display the Virtual Machine Properties dialog box.
   - Choose Edit > Properties or click Edit Properties from the Summary tab.
3. Click the Options tab.
4. View the general options. Click General in the Settings list.

5. If you want, you can change the name of the virtual machine in the Virtual machine name field. This does not change the name of any virtual machine files or the associated directory.

6. If you are upgrading the guest operating system in the virtual machine, select the new guest operating system. This changes some basic configuration settings to optimize the guest operating system's performance.
For an ESX Server virtual machine: Select the operating system from the Guest operating system list.

For a GSX Server or VMware Server virtual machine: Select the operating system type under Guest operating system, then select the specific operating system from the list.

7. Click OK to save your changes. The Virtual Machine Properties dialog box closes.

Changing Power State Options

To change the settings for actions that occur when the power state of a virtual machine changes:

1. From the VirtualCenter client, select the virtual machine.

   Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.

   Choose Edit > Properties or click Edit Properties from the Summary tab.

3. Click the Options tab.

4. View the power options. Click Power in the Settings list.

5. **GSX Server or VMware Server virtual machines only:** Under Power options, specify virtual machine and console behavior when the virtual machine's power state changes. Do any of the following:
   - To automatically power on the current virtual machine when you connect to it with the console, check Power on after opening this virtual machine. With
this option set, you do not have an opportunity to change the virtual machine's configuration before the virtual machine starts since it powers on immediately.

- To automatically enter full screen mode after powering on the virtual machine, check **Enter full screen mode after powering on**.
- To automatically close the console for the virtual machine after you power it off or suspend it, check **Close after powering off or suspending**.

**Note:** These configuration options are effective only when you change the virtual machine’s power state from the VMware Virtual Machine Console or the GSX Server or VMware Server console, not from the VirtualCenter client.

6. The stop button on the toolbar can be configured to power off the virtual machine or shut down the guest operating system. The reset button on the toolbar can be configured to reset the virtual machine or restart the guest operating system. Choose the desired actions in the lists under **Power Controls**.

7. You can configure VMware Tools scripts to run automatically when you change the virtual machine's power state by checking the appropriate options under **Run VMware Tools scripts**.

**Note:** For ESX Server virtual machines, there are no scripts for resuming and suspending virtual machines.

8. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.

### Changing Advanced Settings

**To change advanced virtual machine settings:**

1. From the VirtualCenter client, select the virtual machine.
   - Click **Inventory** in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   - Choose **Edit > Properties** or click **Edit Properties** from the **Summary** tab.

3. Click the **Options** tab.
4. View the advanced options. Click **Advanced** in the **Settings** list.

![Virtual Machine Properties dialog box]

- **Hiding read-only disk partitions for raw disks:** If the virtual machine is configured with physical (sometimes called raw) disks, you can prevent the virtual machine from seeing any partitions on the physical disk that are read-only. Select the **Hide read-only disk partitions for raw disks** check box.

  **Note:** This setting applies to ESX Server virtual machines only.

- **Collecting debugging information:** You can run a virtual machine so it collects additional debugging information that is helpful to VMware technical support in resolving issues. To enable debugging mode, select the **Run with debugging information** check box.

- **Disabling acceleration:** In rare instances, you may find that when you install or run software inside a virtual machine, the virtual machine appears to hang. Generally, the problem occurs early in the program’s execution. In many cases, you can get past the problem by temporarily disabling acceleration in the virtual machine.

  To disable acceleration, select the **Disable acceleration** check box.

  This setting slows down virtual machine performance, so it is recommended only for getting past the problem with running the program. After you pass the point where the program was encountering problems, deselect **Disable acceleration**. You may then be able to run the program with acceleration.

  You can enable and disable acceleration while the virtual machine is running.

5. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.
Changing Virtual Machine Resource Settings

You can manually change individual resource settings or you can schedule to have the priority for resources changed.

The Virtual Machine Properties dialog box provides a means to adjust the host resource allocation for the selected virtual machine. Refer to Allocating Host Resources on page 194 to adjust all the virtual machines currently installed on a particular host in a single view.

Note: Changing resource settings applies to ESX Server hosts only. Refer to the VMware ESX Server Administration Guide for detailed information on understanding and configuring these resource settings.

Each of the following sections describes adjusting the allocations or priorities of the referenced resource:

- Scheduling a Resource Settings Change
- Changing Processor (or CPU) Settings
- Changing Memory Settings
- Changing Disk Settings
- Changing Network Settings
Scheduling a Resource Settings Change

To periodically change the resource allocation for a virtual machine on a particular host, use the New Task Wizard:

1. Click Scheduled Tasks on the navigation bar.
2. Click New then click Next.
3. From the Select a Task panel, choose Change resource settings of a virtual machine from the list.
4. Select virtual machine whose priorities you wish to change. Click Next.
5. Select a priority level. Click Next.

Assigning Resources configures processor and memory resource allocation for a virtual machine in a host.

6. Schedule a time to implement the change. Click Next.

To see the calendar, click Later, then click the drop-down arrow to select a date from the displayed calendar. A red circle indicates today's date and a dark circle indicates the scheduled date. Refer to Creating a Scheduled Task on page 397 for additional information.

7. Specify an email address if you want to have notification. Click Finish.
CHAPTER 14 Editing an Existing Virtual Machine Configuration

Changing Processor (or CPU) Settings
To change the resource allocation for the processor (or CPU) of a virtual machine:

1. From the VirtualCenter client, select the virtual machine.
   Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   Choose Edit > Properties or click Edit Properties from the Summary tab.

3. View the resource options. Click the Resources tab.

4. Select Processor (or CPU) in the Settings list.

5. Select resource settings, shares and scheduling affinity as needed.
   - **Minimum** – represents the minimum amount of processor capacity that must be available in order to power on the virtual machine.
   - **Maximum** – represents the highest amount of processor capacity the virtual machine can ever consume, even if the processor is idle. The maximum value can be larger than 100% if the virtual machine has more than one virtual processor.
   - **Shares** – represents a relative metric for allocating processor capacity. The values **Low**, **Normal**, and **High** are compared to the sum of all shares of all virtual machines on the server and the service console. Share allocation symbolic values can be used to configure their conversion into numeric values.
For more information on share values, refer to the CPU man page.

- **Scheduling Affinity** – represents on which host processors the virtual machine can run, when the host is a multiprocessor system.

6. Click **OK** to save your changes. The Virtual Machine Properties dialog box closes.

**Changing Memory Settings**

To change the resource allocation for the memory of a virtual machine:

1. From the VirtualCenter client, select the virtual machine.
   
   Click **Inventory** in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   
   Choose **Edit > Properties** or click **Edit Properties** from the **Summary** tab.

3. View the resource options. Click the **Resources** tab.

4. Select **Memory** in the **Settings** list.

5. Select settings and shares as needed.

   - **Minimum** – Represents the minimum amount of memory that must be available in order to power on the virtual machine.

   - **Maximum** – Represents the amount of memory allocated to the virtual machine when it was configured.

   - **Shares** – Represents a relative metric for allocating memory to all virtual machines. Symbolic values **Low**, **Normal**, and **High** are compared to the sum
of all shares of all virtual machines on the server and the service console. Share allocation symbolic values can be used to configure their conversion into numeric values.

For more information on share values, refer to the mem man page.

- Scheduling Affinity – If displayed, represents the NUMA nodes on the host to which the virtual machine can be bound, when the host system is a NUMA system.

6. Click OK to save your changes. The Virtual Machine Properties dialog box closes.
Changing Disk Settings

To change the resource allocation for the disk of a virtual machine:

1. From the VirtualCenter client, select the virtual machine.
   Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.

2. Display the Virtual Machine Properties dialog box.
   Choose Edit > Properties or click Edit Properties from the Summary tab.

3. View the resource options. Click the Resources tab.

4. Select Disk in the Settings list.

5. Select the datastore, then allocate a number of shares of its disk bandwidth to the virtual machine.

   Shares is a value which represents the relative metric for controlling disk bandwidth to all virtual machines. The values Low, Normal, and High are compared to the sum of all shares of all virtual machines on the server and the service console. Share allocation symbolic values can be used to configure their conversion into numeric values.

   For more information on share values, refer to the diskbw man page.

6. Click OK to save your changes. The Virtual Machine Properties dialog box closes.
Changing Network Settings
To change the parameters of network traffic shaping:

1. From the VirtualCenter client, select the virtual machine.
   Click Inventory in the navigation bar. Expand the inventory as needed, and click the appropriate virtual machine.
2. Display the Virtual Machine Properties dialog box.
   Choose Edit > Properties or click Edit Properties from the Summary tab.
3. View the resource options. Click the Resources tab.
4. Select Network in the Settings list.
5. To enable traffic shaping, check Enable Traffic Shaping and then define network traffic parameters.
6. Specify the average bandwidth. In the Average Bandwidth field, specify the average value for network bandwidth, then specify whether or not that amount is in Megabits per second (Mbps), Kilobits per second (Kbps), or bits per second (bps).
7. Specify the peak bandwidth. In the Peak Bandwidth field, specify the peak value for network bandwidth, then specify whether or not that amount is in Megabits per second (Mbps), Kilobits per second (Kbps), or bits per second (bps).
8. Specify the burst size. In the Burst Size field, specify how large a burst can be, then specify whether or not that amount is in Megabytes (M), Kilobytes (K) or bytes (B).
9. Click OK to save your changes. The Virtual Machine Properties dialog box closes.
This chapter describes how to schedule VirtualCenter tasks. This chapter contains the following sections:

- Understanding Scheduled Tasks on page 396
- Creating a Scheduled Task on page 397
- Rescheduling a Task on page 403
- Removing a Scheduled Task on page 404
- Cancelling a Scheduled Task on page 405

You need to use a Virtual Machine User role assigned to the farm to perform the activities described in this chapter.
Understanding Scheduled Tasks

The scheduled tasks option allows you to configure selected VirtualCenter activities to perform at a designated time. The timing options include immediately, later, or on a recurring basis. Scheduled tasks are performed in addition to manually driven activities.

Create a scheduled task through the New Task Wizard, which displays the available task options. After you select an option, the wizard displays the screens that are relevant to the type of task you are scheduling. The New Task Wizard ends when you set the timing of the task. You can reschedule tasks.

If the directions of manually driven and scheduled activities conflict, VirtualCenter performs whichever activity is due first. If a virtual machine is in an incorrect state to perform any activity, manual or scheduled, VirtualCenter sends a message to the log and does not perform the task.

When you create a scheduled task, VirtualCenter verifies that you have the correct permissions to perform the actions on the relevant farms, hosts, and virtual machines. Once the task is created, the task is performed even if you no longer have permission to perform the task.

When an object is removed from VirtualCenter, all associated tasks are also removed.

Events are logged to the event log at start and completion of the tasks. Any errors that occur during the task are also recorded in the event log. Refer to Working with Alarms and Events for additional information on the events log.

Note: Do not schedule multiple tasks to be performed at the same time on the same object. The results are unpredictable.
Creating a Scheduled Task

To create a scheduled task:

1. From the VirtualCenter client, display the Tasks panel.
   Click the Scheduled Tasks option in the navigation bar.
   The current list of scheduled tasks appears.
   Click New in the toolbar or select File > New > Scheduled Task.
4. Select the task to create.
   Click the pull-down menu and select the appropriate option. Click Next.

5. Complete the task specific information.
   The New Task Wizard displays a series of screens that correspond to the screens you see when you perform the task starting from the selected object. The possible tasks that can be scheduled through the New Task Wizard are:
   - Deploy a virtual machine from a template
   - Clone an existing virtual machine
   - Change the power status of a virtual machine
   - Migrate a virtual machine
   - Migrate a virtual machine with VMotion
• Change resource settings of a virtual machine

Refer to the chapter that is appropriate for each option for specific information on each task. Most of the scheduling processes differ from manually performed tasks only in that you must specify the virtual machine, host, or farm to which the task applies, and specify the time to perform the task.

6. Specify the timing of the task.

![VMware VirtualCenter New Task Wizard](image)

**Note:** Only one timing schedule can be set per task. To set more than one frequency type, set up additional tasks.

The default frequency and scheduled time is **Now**. The task starts when you finish creating the task.

**Note:** The time a scheduled task occurs is relative to the VirtualCenter server and not the local VirtualCenter client from which you configure the task.
7. To schedule a one-time occurrence:

Set the Frequency to **Once**. Set the Start Time to **Later**. Type a clock time in the Time field. To view the calendar, click the Date arrow. Click the left and right arrows to view additional months. Click the month and select from the list. Click the year, and click the up and down arrows. When you click the calendar date, the calendar accepts the new date and closes.

**Note:** The time set is relative to the VirtualCenter server and not to the client.

8. To run the task after startup:

Click **After Startup** and enter the amount of the delay.
9. To run the task hourly:

   ![VirtualCenter New Task Wizard](image)

   Click **Hourly**. Then enter the start time after the beginning of the hour and the interval, for example 15 minutes after every eight hours.

10. To run the task daily:

   ![VirtualCenter New Task Wizard](image)

   Click **Daily**. Then enter the start time and interval. For example, enter 14:30 every fourth day to run the task at 2:30 pm every four days.
11. To run the task weekly:

Click **Weekly**. Then enter the start time, day of the week, and interval. For example, Tuesdays and Thursday, 8:00 am, every second week. You can select multiple days of the week.

12. To run the task monthly:

Click **Monthly**. Then enter the start time, day of the month, and interval. For example, enter second Thursday of the month, 11:00 every third month.

If you select a day higher than 28, a warning message displays since some months are 28, 29, 30 or 31 days.
The last <day> of the month selects the last week in the month that the day occurs. If you select the last Monday of the month, and the month ends on a Sunday, the last Monday will be six days before the end of the month.

13. Optionally, enter an e-mail address.

If you enter an e-mail address, VirtualCenter sends a notification message to the addressee when the task is performed.

**Note:** You must configure the SMTP options for this email option to work. Refer to Preparing for Email Message SMTP Alarm Notification on page 415.

14. Complete the wizard. Click **Finish**.

VirtualCenter adds the task to the list in the **Scheduled Tasks** tab.
Rescheduling a Task

To reschedule a scheduled task:

1. From the VirtualCenter client, display the Tasks panel.
   Click the Tasks option in the navigation bar.
   The list of scheduled tasks appears.
2. Select the appropriate task from the list.
   Click Properties in the toolbar or select Edit > Properties.
3. Display the date and time, as appropriate.
   Click in the Time field to change the time. Click the date field arrow to display the calendar. Select the appropriate date and time. Click Finish.
   Refer to Creating a Scheduled Task for more information on working with the calendar.
   VirtualCenter closes the calendar and returns to the Scheduled Task display. The task is updated with the new date and time.

   **Note:** Scheduled task calculation and execution are based on time zone and the time set the VirtualCenter server. If the VirtualCenter client and VirtualCenter server are in different time zones, the task schedule is offset by the difference in time zones of the VirtualCenter server and VirtualCenter client.
Removing a Scheduled Task

Removing a scheduled task removes all future occurrences of the task. The history associated to all previous executions of the task remain in the VirtualCenter database.

Note: Removing a task is different than cancelling a task. Cancelling a task is stopping a task currently occurring, whether started manually or through a schedule task. Removing a task removes future occurrences of a scheduled task.

To remove a task that as been scheduled:

1. From the VirtualCenter client, display the Tasks panel.
   Click the Scheduled Tasks option in the navigation bar.
   The list of scheduled tasks appears.

2. Select the appropriate task from the list. Select Edit > Remove. Or, right-click the appropriate task and select Remove.
   VirtualCenter removes the task the scheduled task list.

3. Verify you want to remove the task. Click OK.
   The task is deleted from the list of tasks.
Cancelling a Scheduled Task

Only tasks that are in process can be cancelled. And only selected tasks can be cancelled while in process. Cancelling task, while it is a running operation, requires that you have the Virtual Machine Administrator role assigned to host where the task is occurring.

**Note:** The cancelling operation is not allowed if one or both of the hosts involved is an ESX Server version 2.0.1.

**Note:** Cancelling a task is different than removing a task. Cancelling a task is stopping a task currently occurring, whether started manually or through a schedule task. Removing a task removes future occurrences of a scheduled task.

The tasks that can be cancelled once started are:

- Connecting to a host
- Cloning a virtual machine
- Migrating a virtual machine
- Deploying a template
- Importing a virtual machine, (only when a file copy is included)
- Creating a template from a virtual machine
- Cloning a template

**To cancel a task that is currently running:**

1. From the VirtualCenter client, display the inventory panel.
   Click the Inventory button in the navigation bar.
2. View the Active System Tasks panel.
   Click the Show toggle at the bottom right of the inventory panel.
3. Select the appropriate task from the list.
4. Cancel the task.
   Right-click on the task and select **Cancel**.
VirtualCenter stops progress on the task, returns the objects to their previous states, and displays the task as cancelled.
Working with Alarms and Events

This chapter describes how to create and edit alarms, and how to view events. Events are messages that report VirtualCenter activity. Alarms are notifications that occur in response to selected events. Events are predefined by VirtualCenter.

You must have the role of VirtualCenter Administrator privileges to work with alarms. You need only the role of Read Only User to view events.

This chapter contains the following sections:

- Events and Alarms Overview on page 408
- Working with Events on page 409
- Working with Alarms on page 414
Events and Alarms Overview

View the events, alarms, and logs from three locations:

- **Events panel** – Displays all the events generated throughout VirtualCenter.
- **Events tab in the inventory panel** – Displays the events for the selected VirtualCenter object. This is a subset of the list of messages in the Events panel.
- **Alarms tab in the inventory panel** – Displays the list of alarms for the selected VirtualCenter object that are activated upon designated events. Alarms can apply to groups, farms, hosts, and virtual machines.
Working with Events

An event is any action that is of interest to VirtualCenter. Each event triggers an event message. All event messages are archived in the VirtualCenter database. View event messages from two locations:

- The **Events** option in the navigation bar displays all events that have occurred on the VirtualCenter server.
- An Events tab for any object under the Inventory button. These Events tab listings show only the events that occurred on or to the selected farm, host, or virtual machine.

The most recent events appear at the end of a scrollable list. Messages are identified by type: Information, Error, or Warning. Messages are also color coded. A shortened event message appears in the description portion of the panel. A more detailed version of a selected event message appears in the Event Details portion of the panel. Typically, the Event Detail entry indicates the host or virtual machine on which the event occurred and describes the action that occurred. The object of the event is a link to the object’s individual event page.

The actions available with Events are described in the following sections:

- **Viewing All VirtualCenter Events**
- **Viewing Selected VirtualCenter Events**
- **Sorting and Filtering Event Messages**
- **Exporting Events**
Viewing All VirtualCenter Events

To view all VirtualCenter events:

Click the Events option in the navigation bar.

Viewing Selected VirtualCenter Events

Each VirtualCenter object in the inventory panel has an Events tab in the information panel. Each event that appears is an object-specific subset of all the VirtualCenter events.

To view the event messages and event detail for an object:

1. From the VirtualCenter client, display the inventory panel and expand the appropriate farm.

   Click the Inventory button in the navigation bar. Expand the inventory as needed and click the appropriate virtual machine.

2. Select the object for which you want to view the events.

   In the inventory panel, select a virtual machine, host, farm, or group, as appropriate. If you select a host, the event messages for all the virtual machines on that host are included in the Events log.

3. Display the Events log. Click the Events tab.
4. View an event detail. Click on the event.
A full text message with links to related objects appears in the Event Details box.

5. Link to a message object.
Click any of the blue highlighted items in the Events Details box. VirtualCenter displays the items under the Events tab for the highlighted object.

**Sorting and Filtering Event Messages**
Sort all items in the list by clicking in the column label heading. A triangle in the column head shows the sort order as ascending or descending.

**To sort a list:**
Click the column heading to re-sort the list by the entries in that column. The current selection does not change.

**To change ascending or descending order:**
Click the column heading to toggle between ascending and descending order.

**To select items in a list:**
Click on an individual item. Use Shift-click or Ctrl-click to select multiple items.

**To view all/host only entries:**
For a host object this toggle is available. Click Show all entries or Show host entries.
To view selected columns only:
Click the down arrow to toggle-select the list of data fields to be displayed.

To search and list selected items:
Enter text into the data field. Click Clear to empty the data field.

Exporting Events
VirtualCenter provides an option for exporting all or part of your events log file.

To export the events file:
1. From the VirtualCenter client, open the VirtualCenter Export Events dialog box.
   Select File > Export Events.
2. Specify the time range of messages and the type of messages to export.

3. Specify a file name, file type, and location for the exported file. Click the Browse button to view the Save As dialog.
   The file type options are: Text Documents (*.txt), Microsoft Excel Workbook (*.xls), Web Page (*.html, *.htm), CSV [Comma delimited] (*.csv), and XML File (*.xml).
   Select the file location. Select the file type. Specify a file name. Click Save. VirtualCenter returns to the Export Events dialog.
4. Indicate how far back from the current date and time to select the messages to export by selecting the appropriate **Time** radio button. The options are: **Hours, Days, Weeks, Months** and **From/To** date ranges.

5. Indicate the type of event message to include in the exported file by selecting the appropriate **Type** radio button. The options are: **Info, Error**, and **Warning**.

6. Click **OK**.

   VirtualCenter creates a file of the selected data based on the file extension provides and stores the file at the specified location. If no file extension is provided, the default is a text file. The file contains Type, Time, and Description.
Working with Alarms

Alarms send notification messages when selected events occur to or on hosts or virtual machines. Alarms indicate the status levels of an object, or collection of objects, in the hierarchy. Alarms can be defined at all hierarchical levels, including farms, groups, hosts and virtual machines.

Alarms are inherited from parent levels, and cannot be changed or overridden at a child level. Add new alarms to any object, and contribute to the collection of alarms that are in force at any of its child levels.

When an alarm is created, VirtualCenter verifies the user permissions to perform the actions on the relevant farms, hosts, and virtual machines. Once the alarm is created, the alarm is performed even if the creating user no longer has permission to create the alarm.

Alarms are applied to either hosts or virtual machines. Each alarm has a triggering event and a notification method.

There are two kinds of alarm triggers:

- **Percentage** – Monitors host processor (or CPU) usage, host memory usage, virtual machine processor (or CPU) usage, virtual machine memory, and virtual machine heartbeat
  
  The triggering options are: Is Above (percent) and Is Below (percent). Default monitor for virtual machine heartbeat is set to Is Below. Default monitor for all other percentage options is set to Is Above.

- **State** – Monitor host state and virtual machine state
  
  The triggering options are: Is (state) and Is Not (state)

There are several types of alarm notification methods:

- **Send a notification email message**
  
  SMTP sends an email message. The SMTP must be ready when the email message is sent. There are two ways to set SMTP: through VirtualCenter, or through Microsoft Outlook Express. The VirtualCenter setup is not always needed if the SMTP setting in Outlook Express is correct.

  The VirtualCenter server generates the subject and body text of the email message. Only the To list (receiver) is required from user input. Specify the email message address where the message should be sent. Separate the names of multiple receivers with commas or semi-colons.
• **Send a notification trap**
  The VirtualCenter server is the default SNMP notification receiver. An SNMP trap viewer is required to view a sent trap. The VirtualCenter server host must be configured to receive SNMP traps. See Preparing for SNMP Alarm Notification on page 416.

• **Run a script**
  The user script command and its arguments need to be formatted into one string.
  The user script is running as separate process and does not block the VirtualCenter server processes. But the script does run and consume the resources on the VirtualCenter server machine, such as processor and memory.

• **Suspend the virtual machine**
• **Power off the virtual machine**
• **Reset the virtual machine**

The actions available with alarms are described in the following sections:

• Preparing for Email Message SMTP Alarm Notification
• Preparing for SNMP Alarm Notification
• Creating Alarms
• Editing Alarms
• Removing Alarms

### Preparing for Email Message SMTP Alarm Notification

If you are going to use email message to send SMTP notification, you need to:

• Define the SMTP and email message addressing information.
• Specify the email message address for those to receive the notification when you create the alarm.

**To define the SMTP and email message addressing information:**

1. From the VirtualCenter client, display the VirtualCenter Settings, Advanced tab dialog box.
   Select *File > VirtualCenter Settings > Advanced* tab.
2. Enter the SMTP and mail addressing, as appropriate. Click **OK**.

For email message notification set the SMTP server, SMTP port, and email message sender.

- **mail.sender** – The email message address of sender, for example, `mail_server@datacenter.com`
- **mail.smtp.server** – The DNS name or IP address of the SMTP gateway to use for sending email message.
- **mail.smtp.port** – The port number for the SMTP gateway. If the port value is empty, VirtualCenter uses the default port of 25.

Scroll through the **Advanced** tab options. Enter data into the fields. Click **OK**.

### Preparing for SNMP Alarm Notification

To use SNMP traps, you must configure:

- The VirtualCenter server host.
- The SNMP receiver server to accept the traps from VirtualCenter.

When you create an alarm, only one trap is triggered and sent. The alarm parameters include:

- **Type** – The state VirtualCenter is monitoring for the alarm. Options include: Host Processor (or CPU) usage, Host Memory usage, Host State, Virtual Machine
Processor (or CPU) usage, Virtual Machine Memory usage, Virtual Machine State, Virtual Machine Heartbeat

- **Name** – The name of the host or virtual machine that triggers the alarm.
- **Old Status** – The alarm status before the alarm was triggered.
- **New Status** – The alarm status when the alarm is triggered.
- **Object Value** – The object value when the alarm is triggered.

**To define the SNMP information:**

1. From the VirtualCenter client, display the VirtualCenter Settings, Advanced tab dialog box.
   
   Select **File > VirtualCenter Settings > Advanced** tab.

2. Enter the SNMP and mail addressing, as appropriate.

   ![VirtualCenter Settings dialog box](image)

   Configure up to four receivers of SNMP traps. They must be configured in numerical order, 1, 2, 3, and 4. Each SNMP trap requires a corresponding host name, port and community. For example:

   - **snmp.reciever.1.name** – The DNS name, and IP address of the SNMP receiver.
   - **snmp.reciever.1.port** – The port number of the receiver.
     
     If the port value is empty, VirtualCenter uses the default port. The default port is 162.
   - **snmp.reciever.1.community** – The community identifier.

   Scroll through the Advanced tab options. Enter the data into the fields. Click **OK**.
Using MIBs with Your SNMP Traps

VirtualCenter allows you to configure SNMP version 1 traps for alarm notification of events occurring in VirtualCenter; however, you should continue to use your GSX Server, VMware Server, or ESX Server MIBs for host-related alarms.

The traps defined here are sent typically to other management programs. These management programs need to know how to interpret the SNMP traps sent by VirtualCenter.

To configure your management program to interpret VirtualCenter SNMP traps:

1. Download the management information base (MIB) definitions.
   - Vmware-Root-Mib.mib
   - Vmware-Traps-Mib.mib

   The MIB definition files can be found at C:\Program Files\Vmware\Vmware VirtualCenter\MIBS, when the default installation directory is used.

   A technical note describing the MIB definitions can be found at www.vmware.com/pdf/vc_dbviews_11.pdf.

2. Modify your management program to include and interpret the VMware MIBs.
   Refer to your management program documentation for information on adding MIB definitions to your program.

SNMP Trap and Variable Definitions

There are two groups of SNMP MIB definitions. These can be downloaded for your use. Refer to Using MIBs with Your SNMP Traps on page 418.

The SNMP trap tree for VMware VirtualCenter is at:

(.1.3.6.1.4.1.6876.50.).

The SNMP trap type for VMware VirtualCenter is 201.

The table below lists the identification mapping for each VirtualCenter MIB group.

<table>
<thead>
<tr>
<th>Identification Map</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.3.6.1.4.1.6876.50.301</td>
<td>vpxdTrap Type</td>
</tr>
<tr>
<td>1.3.6.1.4.1.6876.50.302</td>
<td>vpxdHostName</td>
</tr>
<tr>
<td>1.3.6.1.4.1.6876.50.303</td>
<td>vpxdVMName</td>
</tr>
<tr>
<td>1.3.6.1.4.1.6876.50.304</td>
<td>vpxdOldStatus</td>
</tr>
</tbody>
</table>
The following tables describe the VMware SNMP MIB root and primary subtrees. Currently each subtree has its own MIB file. The tables list the variables used in the SNMP Trap groups.

- From VMware-ROOT-MIB.mib, the following definition mapping:

<table>
<thead>
<tr>
<th>Identification Mapping</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.3.6.1.4.1.6876.50.305</td>
<td>vpxdNewStatus</td>
</tr>
<tr>
<td>1.3.6.1.4.1.6876.50.306</td>
<td>vpxObjValue</td>
</tr>
</tbody>
</table>

- From VMware-TRAPS-MIB.mib, the following trap types:

<table>
<thead>
<tr>
<th>Trap Label</th>
<th>Description</th>
<th>Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>vmPoweredOn</td>
<td>This trap is sent when a virtual machine is powered on from a suspended or a powered off state.</td>
<td>vmID, vmConfigFile</td>
</tr>
<tr>
<td>vmPoweredOff</td>
<td>This trap is sent when a virtual machine is powered off.</td>
<td>vmID, vmConfigFile</td>
</tr>
<tr>
<td>vmHBLost</td>
<td>This trap is sent when a virtual machine detects a loss in guest heartbeat.</td>
<td>vmID, vmConfigFile</td>
</tr>
<tr>
<td>vmHBDetected</td>
<td>This trap is sent when a virtual machine detects or regains the guest heartbeat.</td>
<td>vmID, vmConfigFile</td>
</tr>
<tr>
<td>vmSuspended</td>
<td>This trap is sent when a virtual machine is suspended.</td>
<td>vmID, vmConfigFile</td>
</tr>
</tbody>
</table>
Creating Alarms

If you are going to use email message or SNMP notification, refer to Preparing for Email Message SMTP Alarm Notification and define the address information before you create your alarm.

To create an alarm:

1. From the VirtualCenter client, display the inventory panel and expand to the appropriate object.

   Click the Inventory button. Expand the inventory as needed and click the appropriate object.
2. Display the Alarms properties.

   ![Image of VMware VirtualCenter interface showing Server Farms and Alarm properties]

   Right-click the object on which you want to apply the alarm and select New Alarm. If you start from a server farm, farm group, or farm, the Alarm properties dialog displays the option to create an alarm for either a host or a virtual machine. If you start from a host or a virtual machine, the **Monitor a host** or **Monitor a VM** is preselected and grey.

3. Select the alarm type and enter the alarm general information.

   ![Image of Alarm Properties dialog]

   Specify a name for the alarm, the object to be monitored (host or virtual machine), and whether or not to enable this alarm.

   To define the alarm but not have it active, uncheck the **Enable** box.
4. Specify the triggering parameters for the alarm.

In the Trigger tab, there are four pull-down menus:

- **Alarm triggering item**
  
The options listed apply to either the host or virtual machine.

  For host alarms the options are: **Host Processor (or CPU) Usage**, **Host Memory Usage**, **Host State**

  For virtual machine alarms the options are: **VM Processor (or CPU) Usage**, **VM Memory Usage**, **VM Heartbeat**, **VM State**

- **When condition item**
  
The options for percentage triggers are: **Is Above** (percent) and **Is Below** (percent).

  The options for state triggers are: **Is** (state) and **Is Not** (state)

- **Exiting (From) state or percentage and Entering (To) state or percentage**
  
  Percentage options range from 5% to 100% in 5% increments. Exiting condition is considered a yellow condition at \( n \) percentage.


  Host state options correspond to activities: **Connecting**, **Disconnecting**, **Reconnecting**, **Removing**, **Shutting down**, **Connected**, **Disconnected**.

  Exiting state is considered a yellow condition at selected state.

  The colors corresponding to the exiting/from and entering/to states are set in the **Actions** tab. The default is **From yellow to red**.
To define the trigger:

a. Click the **Triggers** tab.

b. Using the pull-down menus, indicate the type and condition of the state.

c. Optionally, define multiple conditions for the alarm triggering event. Click **Add**. Enter the parameters for each condition.

5. Specify the action to be taken when the alarm is triggered.

a. Click the **Actions** tab. Click the **Add** button.

b. Click the appropriate check box.

There are four different level changes: green to yellow, yellow to red, red to yellow, and yellow to green. Attach an action for each change from one level to another.

c. Select the action to be taken when the event is triggered and specify the associated information. The options are:

- Send a notification email.
Provide the email address for the notification recipient.

SMTP sends a notification email. The SMTP must be ready when the email is sent. There are two ways to set SMTP: through VirtualCenter or through Microsoft Outlook Express. VirtualCenter setup is not always needed if the SMTP setting in Outlook Express is correct.

VirtualCenter server generates the email message subject and body text. Only the “to” list (receiver) is required from user input. Specify the email address to which the message should be sent. Separate multiple receivers with commas or semi-colons. See Preparing for Email Message SMTP Alarm Notification on page 415.

• Send a notification trap.
  There is a default SNMP notification receiver, the VirtualCenter server. An SNMP trap viewer is required to view a sent trap. The VirtualCenter server host must be configured to receive SNMP traps. See Preparing for SNMP Alarm Notification on page 416.

• Run a script.
  Provide the path to the script to run.
  The user script command and its arguments need to be formatted into one string.
  The user script runs in other processes and does not block the VirtualCenter server from running; however, the script consumes server resources, such as processor and memory.

• Suspend the virtual machine.
  This applies to a virtual machine alarm.

• Power off the virtual machine.
  This applies to a virtual machine alarm.

• Reset the virtual machine.
  This applies to a virtual machine alarm.

6. Complete the alarm. Click OK.

VirtualCenter verifies the configuration of the alarm and adds the alarm to the list of alarms for the selected object.
Editing Alarms

To edit an existing alarm:

1. From the VirtualCenter client, display the inventory panel and expand the appropriate object.
   
   Click the **Inventory button** in the navigation bar. Expand the inventory as needed.

2. Identify and select the object where the alarm is defined.
   
   a. Select an object where the alarm is applied.
   
   b. To display the Alarms list, click the **Alarms** tab.
   
   c. Click the linked object in the Defined in column.
     
     VirtualCenter displays the Alarms panel for the object where the alarm was defined.

3. Display the alarm properties.
   
   The entry in the **Defined in** column for the alarm must be **This object**.
   
   Select the alarm to edit. Select **Properties** from either the main or right-click menu.
4. Edit the alarm general, triggers, or actions, as needed. Click **OK**.

![Alarm Properties](image)

VirtualCenter verifies the configuration of the alarm and edits the alarm for the selected object. Refer to Creating Alarms on page 420 for additional information.

**Removing Alarms**

Remove alarms from the object in which they were defined. You cannot remove them from a child level.

**To remove an alarm:**

1. From the VirtualCenter client, display the inventory panel and expand the appropriate object.
   
   Click the **Inventory button** in the navigation bar. Expand the inventory as needed.

2. Identify and view the Alarms panel for the object where the alarm is defined.
   a. Select an object where the alarm is applied.
   b. Select the Alarms tab.
c. If the **Defined in** column for the alarm you wish to edit has a blue link, that is it does not say **This object**, then click the blue link.

VirtualCenter displays the Alarms panel for the object listed in the blue link. This is where the alarm was defined.

3. Remove an alarm.

Select the alarm, select the right-click menu, and click **Remove**. Alternatively, select the alarm and press the Delete key on the keyboard.
A confirmation popup appears. Click **Yes**. The alarm is removed.
This chapter describes the scope of the VirtualCenter data presented in the VirtualCenter client. This chapter describes the display of current data. This chapter contains the following topics:

- VirtualCenter Data Overview on page 431
- Viewing Scheduled Tasks on page 434
- Viewing Templates on page 436
- Viewing VirtualCenter Events on page 437
- Viewing the VirtualCenter Inventory on page 439
- Understanding the Summary Tabs on page 441
- Viewing the Farms Tab on page 447
- Viewing the Hosts Tab on page 448
- Viewing the Virtual Machines Tab on page 449
- Viewing the Tasks Tab on page 451
- Viewing the Events Tab on page 452
• Viewing the Alarms Tab on page 453
• Viewing the Permissions Tab on page 454
• Viewing the Console Tab on page 455
• Viewing the Performance Tab on page 457
• Working with Performance Chart Data on page 460
VirtualCenter Data Overview

You can access the general display of data and activity through the information panel of the VirtualCenter client window. The information panel is the visual center of your VirtualCenter monitoring activities. Through the information panel, view status, resource usage, and performance information about your hosts, virtual machines, and farms. View scheduled tasks, available templates, and a list of events.

When an object is removed from the VirtualCenter inventory, its log and event history remains until purged through the normal processes.

This information is in one of the following two sets of panels:

- **Navigation bar** – Provides shortcuts to generalized areas of related activities. The options are: Inventory, Scheduled Tasks, Templates, and Events.

  The Scheduled Tasks, Templates, and Events options display a single information panel. The Inventory button displays an inventory panel or an information panel. The Inventory information panel displays a set of tabs. The displayed tabs depend upon the object you select in the inventory panel.

  When you select any other navigation bar, the information panel appears.

- **Inventory tabs** – A subset of the Inventory button. The Inventory tabs are a set of panels that display task oriented information pertaining to the selected VirtualCenter object. Each VirtualCenter object has its own set of tabs. The tab options are: Summary, Farms, Hosts, Virtual Machines, Performance, Tasks, Events, Alarms, Console, and Permissions.

  When you select the Inventory button in the navigation bar, an information panel appears on the right side of the screen. When you select an object (host, virtual machine, group, or farm) from the inventory panel, the information panel displays tabs corresponding to the selected object. This data appears until you select another Inventory button.

The following table shows the available panels and their source mapping.

**Note:** You can use either the navigation bar or the information panel tabs to view events information.

<table>
<thead>
<tr>
<th>Panel</th>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms</td>
<td>inventory panel</td>
<td>Lists the configured alarms for the selected object.</td>
</tr>
<tr>
<td>Panel</td>
<td>Source</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Console</td>
<td>inventory panel</td>
<td>Displays a remote console to interact directly with the virtual machine. Through the remote console you can take selected actions upon the virtual machine.</td>
</tr>
<tr>
<td>Events</td>
<td>navigation bar</td>
<td>Lists the recent event messages for all objects managed by VirtualCenter. Keeps all event messages.</td>
</tr>
<tr>
<td>Events</td>
<td>inventory panel</td>
<td>Lists the recent event messages that report on the status of the selected object.</td>
</tr>
<tr>
<td>Farms</td>
<td>inventory panel</td>
<td>Lists the farms assigned to the selected farm group.</td>
</tr>
<tr>
<td>Hosts</td>
<td>inventory panel</td>
<td>Lists the hosts assigned to the selected farm.</td>
</tr>
<tr>
<td>Inventory</td>
<td>navigation bar</td>
<td>Provides access for managing all the Server Farms entities.</td>
</tr>
<tr>
<td>Performance</td>
<td>inventory panel</td>
<td>Displays the performance charts for the selected host or virtual machine resources. The charts for farms and hosts display combined charts that show the usage of each resource.</td>
</tr>
<tr>
<td>Permissions</td>
<td>inventory panel</td>
<td>Lists the users and groups that have permissions on the selected object and at what level the permission was assigned.</td>
</tr>
<tr>
<td>Summary</td>
<td>inventory panel</td>
<td>Displays a collection of data for the selected object.</td>
</tr>
<tr>
<td>Scheduled Tasks</td>
<td>navigation bar</td>
<td>Provides access for creating and managing scheduled tasks.</td>
</tr>
<tr>
<td>Tasks</td>
<td>inventory panel</td>
<td>Lists the all tasks for the selected object.</td>
</tr>
<tr>
<td>Templates</td>
<td>navigation bar</td>
<td>Provides access for managing templates.</td>
</tr>
<tr>
<td>Virtual Machines</td>
<td>inventory panel</td>
<td>Lists the virtual machines assigned to the selected farm or host and group. To access, select Virtual Machines and the virtual machines in the group are displayed.</td>
</tr>
</tbody>
</table>

Each navigation bar has a primary information panel and associated tab. The Inventory button has an inventory panel from which you can select objects. Each
selected object has its own set of associated information panel tabs. The following table lists the possible tab views for each VirtualCenter object.

<table>
<thead>
<tr>
<th>Inventory Object</th>
<th>Summary</th>
<th>Farms</th>
<th>Virtual Machines</th>
<th>Hosts</th>
<th>Performance</th>
<th>Tasks</th>
<th>Events</th>
<th>Alarms</th>
<th>Console</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Farms</td>
<td></td>
<td>Farms</td>
<td>Virtual Machines</td>
<td>Hosts</td>
<td></td>
<td>Tasks</td>
<td>Events</td>
<td>Alarms</td>
<td></td>
<td>Permissions</td>
</tr>
<tr>
<td>Farm Group</td>
<td></td>
<td>Farms</td>
<td>Virtual Machines</td>
<td>Hosts</td>
<td></td>
<td>Tasks</td>
<td>Events</td>
<td>Alarms</td>
<td></td>
<td>Permissions</td>
</tr>
<tr>
<td>Farm</td>
<td>Summary</td>
<td></td>
<td>Virtual Machines</td>
<td>Hosts</td>
<td>Performance</td>
<td>Tasks</td>
<td>Events</td>
<td>Alarms</td>
<td></td>
<td>Permissions</td>
</tr>
<tr>
<td>Host</td>
<td>Summary</td>
<td></td>
<td>Virtual Machines</td>
<td></td>
<td>Performance</td>
<td>Tasks</td>
<td>Events</td>
<td>Alarms</td>
<td></td>
<td>Permissions</td>
</tr>
<tr>
<td>Virtual Machine Group</td>
<td></td>
<td></td>
<td>Virtual Machines</td>
<td></td>
<td></td>
<td>Tasks</td>
<td>Events</td>
<td>Alarms</td>
<td></td>
<td>Permissions</td>
</tr>
<tr>
<td>Virtual Machine</td>
<td>Summary</td>
<td></td>
<td></td>
<td></td>
<td>Performance</td>
<td>Tasks</td>
<td>Events</td>
<td>Alarms</td>
<td>Console</td>
<td>Permissions</td>
</tr>
</tbody>
</table>
**Viewing Scheduled Tasks**

You can view a list of VirtualCenter tasks that are scheduled to be performed, and you can create and edit scheduled tasks.

**To view scheduled tasks:**

Click **Scheduled Tasks** in the VirtualCenter client navigation bar.

The scheduled task activities include:

- Create a new task
- Edit the task properties

The type of scheduled tasks that can be created through the New Task Wizard include:

- Deploying a virtual machine from a template
- Cloning an existing virtual machine
- Changing the power status of a virtual machine
- Migrating a virtual machine
- Migrating a virtual machine with VMotion
- Changing resource settings of a virtual machine
For more information on scheduled tasks, refer to Working with Scheduled Tasks on page 395. The table below lists the possible attributes that appear in a Scheduled Tasks panel list.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Details of the task, such as the task, the name of the VirtualCenter object where the setting was made, the expected name of the object, and the location</td>
</tr>
<tr>
<td>Last Run</td>
<td>Date and time the task was last performed</td>
</tr>
<tr>
<td>Next Run</td>
<td>Date and time the task is to be performed next</td>
</tr>
</tbody>
</table>
Viewing Templates

The Templates option in the navigation bar displays the list of available templates and provides the means to create, deploy, and clone templates.

To view the templates:

Click Templates in the VirtualCenter client’s navigation bar.

The template activities include:

- Create a new template
- Deploy a template (create new virtual machine)
- Clone a template

For more information on templates, refer to Working with Templates on page 261. The table below lists the possible attributes that appear in the Template panel list.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of template</td>
</tr>
<tr>
<td>Guest OS</td>
<td>Guest operating system in the virtual machine</td>
</tr>
<tr>
<td>Size</td>
<td>Size of the template, in MB</td>
</tr>
<tr>
<td>Datastore</td>
<td>Indicates if the template is on a shared datastore</td>
</tr>
<tr>
<td>Description</td>
<td>Text entered for reference</td>
</tr>
</tbody>
</table>
Viewing VirtualCenter Events

An event is any action that is of interest to VirtualCenter. Each event triggers an event message. All event messages are archived in the VirtualCenter database. Event messages appear in two locations:

- **Events option in the navigation bar** – Displays all events that have occurred on the VirtualCenter server.
- **Events tab for an object under the Inventory button** – List the events that occurred on or to the selected object.

To view VirtualCenter events:

Click **Events** in the VirtualCenter client’s navigation bar.

Events activities include:

- Sorting the list of event messages.
- Viewing the event details for a selected message.
- Following the links in an Event Detail message.
- Exporting events to a text file. The exported data can be a set of messages selected by time, date, and type.
For more information on events, refer to the chapter, *Working with Alarms and Events on page 407*. The table below lists the possible attributes that can be displayed in an Events panel list.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Text explanation of action</td>
</tr>
<tr>
<td>Type</td>
<td>Type of event that occurred</td>
</tr>
<tr>
<td>Time</td>
<td>Date and time event occurred</td>
</tr>
<tr>
<td>Task</td>
<td>Task that triggered the event, if there is one</td>
</tr>
<tr>
<td>Target</td>
<td>Object the event occurred on</td>
</tr>
</tbody>
</table>
Viewing the VirtualCenter Inventory

The Inventory button in the navigation bar displays an inventory panel and an information panel. Each object in the inventory panel displays a particular set of tabs in the information panel. The remainder of this chapter describes each of the Inventory tab panels.

To view the inventory, click **Inventory** in the VirtualCenter client's navigation bar.

The navigation bar topics are covered in the following sections:

- Understanding the Inventory Panel
- Understanding the Information Panel

Understanding the Inventory Panel

The inventory panel is located on the left side of the screen when you select the Inventory button in the navigation bar. The inventory panel elements include:

- Hierarchical listing of VirtualCenter server objects.
- Status icons associated with each object.
- Toggle to close or open the inventory panel.
- Popup menu bar for close, dock, and float options.

The root of the inventory panel is a top-level group labeled Server Farms. All farms, groups, hosts, and virtual machines fall within the Server Farms group. All of these items are added to the VirtualCenter server through the VirtualCenter client.

Depending upon your user permissions, you may be able to see but not expand a farm or group. You must be assigned the appropriate permissions levels before you can view and take action upon objects managed by VirtualCenter.

Understanding the Information Panel

The information panel is the visual center of your VirtualCenter monitoring activities. Through the information panel you:

- View status, resource usage, and performance information about your hosts, virtual machines, and farms.
- View scheduled tasks, available templates, and a list of events for the object selected.
Select any button in the navigation bar or any object in the inventory panel and the corresponding information panel appears. Select the Inventory button in the navigation bar and the information panel appears to the right side of the inventory panel. Use the docking option in the inventory panel menu, to place the information panel on the left side of the screen.

The information panel elements are:

- Toolbar – specific to each navigation button
- Tabbed panel – for all but the Inventory button, lists in column form, all the objects that apply to the navigation button. For the Inventory button, there are multiple tabbed panels that vary depending upon the object selected in the inventory panel.
- Identification line – displayed with the Inventory button only, it lists the name and, if relevant, the version level of the object selected in the inventory panel.
Understanding the Summary Tabs

The Summary tab is available when you select a farm, host, or virtual machine object from the inventory panel. The Summary tab information panel is grouped into sections, depending upon the object type selected.

The Summary tab topics are covered in the following sections:

- Viewing the Farm Summary Tab
- Viewing the Host Summary Tab
- Viewing the Virtual Machine Summary Tab

Viewing the Farm Summary Tab

The farm Summary tab displays information that applies to the hosts and virtual machines within the farm.
The farm **Summary** tab content is described in the following table.

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification</td>
<td>Total Hosts</td>
<td>Number of hosts on the farm.</td>
</tr>
<tr>
<td></td>
<td>Disconnected Hosts</td>
<td>Number of disconnected hosts on the farm.</td>
</tr>
<tr>
<td></td>
<td>Total Virtual Machines</td>
<td>Number of virtual machines on the farm.</td>
</tr>
<tr>
<td></td>
<td>Disconnected Virtual Machines</td>
<td>Number of disconnected virtual machines on the farm.</td>
</tr>
<tr>
<td></td>
<td>VMs Powered On</td>
<td>Number of virtual machines in a powered on state.</td>
</tr>
<tr>
<td></td>
<td>VMs Suspended</td>
<td>Number of virtual machine in a suspended state.</td>
</tr>
<tr>
<td></td>
<td>Total VMs Provisioned</td>
<td>Number of virtual machines that have been created by either cloning or deploying a template.</td>
</tr>
<tr>
<td></td>
<td>Total VM Migrations</td>
<td>Number of times virtual machines have been migrated between host machines.</td>
</tr>
<tr>
<td>View tables for</td>
<td>Processor (or CPU), Memory, Disk, Network</td>
<td>The resource whose data you wish to see.</td>
</tr>
<tr>
<td>Processor (or CPU)</td>
<td>Usage, Hot List</td>
<td>Most active hosts — Least active hosts Where the hosts fit, relative to the critical ends of the range.</td>
</tr>
<tr>
<td></td>
<td>Usage, Resource Contention (last 24 hrs)</td>
<td>All hosts Percentage of time any host was in contention for the past 24 hours.</td>
</tr>
<tr>
<td></td>
<td>Usage, Resource Volatility (last 7 days)</td>
<td>All hosts Percentage change in host utilization in the past seven days.</td>
</tr>
</tbody>
</table>
Viewing the Host Summary Tab

The host Summary tab displays information that applies to the host machine and its resources.

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification</td>
<td>Manufacturer</td>
<td>Manufacturer of the host machine.</td>
</tr>
<tr>
<td></td>
<td>Model</td>
<td>Model type of the host machine.</td>
</tr>
<tr>
<td></td>
<td>Total Memory</td>
<td>Memory installed in the host machine.</td>
</tr>
<tr>
<td></td>
<td>Processor (or CPU)</td>
<td>Manufacturer, type, and speed of processor.</td>
</tr>
<tr>
<td></td>
<td>VMotion Enabled</td>
<td>Whether or not the host machine is licensed for VMotion.</td>
</tr>
<tr>
<td></td>
<td>Virtual Machines</td>
<td>Number of virtual machines currently located on the host machine.</td>
</tr>
<tr>
<td></td>
<td>Number of Processors</td>
<td>Number of processors installed in the host machine.</td>
</tr>
<tr>
<td></td>
<td>Number of NICs</td>
<td>Number of NICs installed in the host machine.</td>
</tr>
<tr>
<td>Section</td>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active Tasks</td>
<td></td>
<td>Indicates if at least one task is occurring on object currently.</td>
</tr>
<tr>
<td>Commands</td>
<td>Manage Virtual Machine Resources</td>
<td>The Virtual Machine Resources panel for adjusting the resource allocation for virtual machines on the host. Available for ESX Server hosts only.</td>
</tr>
<tr>
<td></td>
<td>Edit Properties</td>
<td>The virtual machine Properties panel.</td>
</tr>
<tr>
<td></td>
<td>Edit Host Configuration</td>
<td>Opens a Web browser to connect to the VMware Management Interface. Requires that you log on.</td>
</tr>
<tr>
<td></td>
<td>Shut Down</td>
<td>Displays a menu to shut down or restart the host. Starting the host is not available.</td>
</tr>
<tr>
<td>Available Resources</td>
<td>Available Disk Space</td>
<td>Free disk space on all datastores available to the host machine.</td>
</tr>
<tr>
<td></td>
<td>Memory Available to New VMs</td>
<td>Unreserved memory on the host machine.</td>
</tr>
<tr>
<td>Processor (or CPU)</td>
<td>Virtual Machines</td>
<td>Percentage of processor used by running virtual machines.</td>
</tr>
<tr>
<td>Utilization</td>
<td>Other</td>
<td>Percentage of processor used for other purposes.</td>
</tr>
<tr>
<td></td>
<td>System Total</td>
<td>Total percentage of processor used on the host machine.</td>
</tr>
<tr>
<td>Memory Utilization</td>
<td>Virtual Machines</td>
<td>Percentage of memory used by running virtual machines.</td>
</tr>
<tr>
<td></td>
<td>Other</td>
<td>Percentage of memory used for other purposes.</td>
</tr>
<tr>
<td></td>
<td>System Total</td>
<td>Total percentage of memory used on the host machine.</td>
</tr>
<tr>
<td>Networks</td>
<td></td>
<td>List of networks accessible by the host machine.</td>
</tr>
<tr>
<td>Datastores</td>
<td></td>
<td>List of datastores accessible by the host machine.</td>
</tr>
</tbody>
</table>
Viewing the Virtual Machine Summary Tab

The virtual machine Summary tab displays information that applies to a virtual machine and its resources.

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification</td>
<td>Hosted on</td>
<td>Host where virtual machine is currently located.</td>
</tr>
<tr>
<td>Status</td>
<td></td>
<td>Condition status of the virtual machine. Options: Alert, Warning, or OK.</td>
</tr>
<tr>
<td>State</td>
<td></td>
<td>Power state of the virtual machine. Options: Powered on, Powered Off, or Suspended.</td>
</tr>
<tr>
<td>Active Tasks</td>
<td></td>
<td>Transition status of any running task.</td>
</tr>
<tr>
<td>Guest OS</td>
<td></td>
<td>Operating system installed in the virtual machine.</td>
</tr>
<tr>
<td>IP Address</td>
<td></td>
<td>Primary IP address assigned to this virtual machine displayed in powered-on state.</td>
</tr>
<tr>
<td>DNS Name</td>
<td></td>
<td>DNS name assigned to this virtual machine, if any.</td>
</tr>
<tr>
<td>VMware Tools</td>
<td></td>
<td>Indicates if VMware Tools is installed and/or current. Unknown indicates that the virtual machine is in a suspended state.</td>
</tr>
<tr>
<td>Section</td>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Commands</td>
<td>Power Off/Suspend/Resume/Reset/Power On this virtual machine</td>
<td>Powers Off/On, Resets, or Suspend/Resumes the virtual machine now.</td>
</tr>
<tr>
<td></td>
<td>Edit Properties</td>
<td>Opens the Virtual Machine Properties dialog box for editing the configuration.</td>
</tr>
<tr>
<td></td>
<td>Open Console</td>
<td>Opens the virtual machine console. Screen is black if the virtual machine is not powered on.</td>
</tr>
<tr>
<td></td>
<td>Migrate to New Host</td>
<td>Opens the Migration Wizard.</td>
</tr>
<tr>
<td></td>
<td>Create Template</td>
<td>Opens the New Template Wizard. Available when virtual machine is powered off.</td>
</tr>
<tr>
<td></td>
<td>Clone this Virtual Machine</td>
<td>Opens the Clone Virtual Machine Wizard. Available when virtual machine is powered off.</td>
</tr>
<tr>
<td>Devices</td>
<td></td>
<td>Installed or configured devices. For example: Memory, Hard Disk, Processor, or NIC.</td>
</tr>
</tbody>
</table>
Viewing the Farms Tab

The Farms tab is available when you select a server farm or farm group object from the inventory panel of the navigation bar. The Farms tab displays information about the farms in the group.

The Farms tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of farm in the farm group or Server Farms.</td>
</tr>
<tr>
<td>Status</td>
<td>Condition of the farm.</td>
</tr>
<tr>
<td>Number of VMs</td>
<td>Number of virtual machines in the farm group or Server Farms.</td>
</tr>
<tr>
<td>Number of Hosts</td>
<td>Number of hosts in the farm group.</td>
</tr>
</tbody>
</table>
Viewing the Hosts Tab

The Hosts tab is available when you select a server farm, farm group, or farm object from the inventory panel of the navigation bar. The Hosts tab displays information about the hosts in the farm.

The Hosts tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of host.</td>
</tr>
</tbody>
</table>
| State          | State of host, for example, powered on or connected.  
  **Note:** Different options are displayed depending upon whether the virtual machine is connected or disconnected and powered on or off. |
| Status         | Condition of the host.                       |
| % Processor (or CPU) | Percentage of the processor being used. |
| % Memory       | Percentage of the memory being used.         |
| Memory Size - MB | System memory.                               |
| Processor (or CPU) Count | System processor Count. |
| NIC Count      | Number of NICs.                              |
| Uptime         | Uptime of system.                            |
Viewing the Virtual Machines Tab

The Virtual Machines tab is available when you select a server farm, farm, farm group, host, or virtual machine group object from the inventory panel of the navigation bar. The Virtual Machines tab displays information about the status of virtual machines within the farm, host, or virtual machine group selected. The Virtual Machines tab’s panel provides filtering capabilities to view only selected virtual machines.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of virtual machine.</td>
</tr>
<tr>
<td>State</td>
<td>State of virtual machine, such as, powered on or connected.</td>
</tr>
<tr>
<td>Status</td>
<td>Condition of the virtual machine.</td>
</tr>
<tr>
<td>Host</td>
<td>Host where virtual machine is currently resident.</td>
</tr>
<tr>
<td>% Processor (or CPU)</td>
<td>Percentage of the processor being used.</td>
</tr>
<tr>
<td>% Memory</td>
<td>Percentage of the memory being used.</td>
</tr>
<tr>
<td>Guest OS</td>
<td>Guest operating system in the virtual machine.</td>
</tr>
<tr>
<td>Memory Size - MB</td>
<td>System memory.</td>
</tr>
<tr>
<td>Processor (or CPU) Count</td>
<td>System processor Count.</td>
</tr>
<tr>
<td>NIC Count</td>
<td>Number of NICs.</td>
</tr>
<tr>
<td>List Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Uptime</td>
<td>Uptime of system.</td>
</tr>
<tr>
<td>IP Address</td>
<td>IP address of the virtual machine.</td>
</tr>
</tbody>
</table>
| Tools Status   | whether or not VMware Tools is available.  
|                | **Note:** The status is unknown if the virtual machine is powered off. |
| Path           | Location of the virtual machine in the inventory. |
| DNS Name       | DNS name used on the network. |
| UUID           | UUID used on the network to uniquely identify this virtual machine. |
CHAPTER 17 Working with the VirtualCenter Data

Viewing the Tasks Tab

The Tasks tab is available when you select any object from the inventory panel. Selecting a task displays its details in the Task Details field. Click the link in the Task Details field to shift the display to the linked object.

The Tasks tab displays a filtered view of the Tasks. It displays either all tasks in the VirtualCenter server or only those tasks that occurred on the selected object through a toggle. The toggle option state, Show all entries or Show <object> entries, displays in the bottom right status bar of the VirtualCenter client.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the task.</td>
</tr>
<tr>
<td>Target</td>
<td>Object task performed on.</td>
</tr>
<tr>
<td>Progress</td>
<td>Progress state of the task, if it is in progress.</td>
</tr>
<tr>
<td>Status</td>
<td>State of complete of the task.</td>
</tr>
<tr>
<td>Reason</td>
<td>Name of user initiated the task or whether or not the task was a scheduled task.</td>
</tr>
<tr>
<td>Time</td>
<td>Time task started.</td>
</tr>
</tbody>
</table>
Viewing the Events Tab

The Events tab is available when you select any object from the Inventory panel. Selecting an event displays its details in the Event Details field. Click the link in the Event Details field to shift the display to the linked object.

The Events tab displays a filtered view of the Events. It displays either all events in the VirtualCenter server or only those events that occurred on the selected object through a toggle. The toggle option state Show all entries or Show <object> entries displays in the bottom right status bar of the VirtualCenter client.

Inventory > Virtual Machine > Events Tab

The Events tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Text explanation of action.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of event that occurred.</td>
</tr>
<tr>
<td>Time</td>
<td>Time event occurred.</td>
</tr>
<tr>
<td>Task</td>
<td>Task that caused event.</td>
</tr>
<tr>
<td>Target</td>
<td>Object on which the event occurred.</td>
</tr>
</tbody>
</table>
Viewing the Alarms Tab

The **Alarms** tab is available when you select any object from the inventory panel of the navigation bar. The **Alarms** tab displays the alarms that have been created for the selected object and the status of the alarm.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of object.</td>
</tr>
<tr>
<td>Status</td>
<td>Condition of the alarm.</td>
</tr>
<tr>
<td>Defined in</td>
<td>VirtualCenter object where the setting was made.</td>
</tr>
<tr>
<td>Defined for</td>
<td>VirtualCenter to which the setting applies.</td>
</tr>
<tr>
<td>Last triggered</td>
<td>Date and time the alarm was most recently triggered.</td>
</tr>
</tbody>
</table>
Viewing the Permissions Tab

The Permissions tab is available when you select any object from the inventory panel except a host. The Permissions tab displays the users and groups with their associated permission roles assigned to the selected object.

The Permissions tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User/Group</td>
<td>Name of user or group assigned the role.</td>
</tr>
<tr>
<td>Role</td>
<td>The role assigned to the user or group. options: Read Only User, Virtual Machine User, Virtual Machine Administrator, and VirtualCenter Administrator.</td>
</tr>
<tr>
<td>Defined In</td>
<td>The VirtualCenter object where the permission user+role pair is assigned. If it is not the current object, a link to the defined in object appears.</td>
</tr>
</tbody>
</table>

Inventory > Virtual Machines > Permissions Tab
Viewing the Console Tab

The Console tab is available when you select a virtual machine object from the inventory panel of the navigation bar. The Console tab displays a blank screen when the virtual machine selected is not powered on. When the virtual machine is powered on, the Console tab displays the running console of the virtual machine. When you select the Console tab, a popout version of the console is also available by clicking on the Console toolbar button.

![Inventory > Virtual Machine > Console Tab](image)

The Console tab provides live access to the virtual machine console from within the VirtualCenter client and allows you to interact with the operations of the virtual machine. A detachable virtual machine console window can be operated independently from the VirtualCenter client by selecting the appropriate virtual machine from the inventory panel and clicking the Console option in the Inventory.
toolbar. This separate console operates in addition to, not to the exclusion of, the embedded console.

The behavior of the VirtualCenter client console is similar to, but not an exact duplicate of, the VMware Remote Console provided with VMware ESX Server or the VMware Virtual Machine Console provided with VMware GSX Server or VMware Server. For example, quick switch mode (for switching between console windows), snapshots, and full screen mode are not included in VirtualCenter. The VirtualCenter client console does not provide access to selected functions (such as power or configuration operations) of the virtual machine. These tasks are handled on the VirtualCenter client toolbar.
Viewing the Performance Tab

The Performance tab is available when you select a farm, host, virtual machine group, or virtual machine from the inventory panel of the navigation bar.

The Performance tab displays the selected object’s information in graph form. Performance views show graphs for four primary attributes: Processor (or CPU) Usage, Memory Usage, Disk I/O Usage, and Network I/O Usage.

Performance charts for hosts and virtual machines display in two forms:

- **Summary charts** – For farms and virtual machine groups, VirtualCenter displays thumbnail charts of processor, memory, disk and network utilization for each host in the farm or virtual machine in the group.

- **Individual charts** – For hosts and virtual machines, VirtualCenter displays thumbnail charts of processor, memory, disk and network utilization along with a detailed chart of a selected resource.

Performance charts for farms and virtual machine groups display the summary charts for each host or virtual machine in their group, respectively.

The Performance tab topics are covered in the following sections:

- Viewing Summary Performance Charts
- Viewing Individual Performance Charts

**Viewing Summary Performance Charts**

The Performance tab of a farm or a virtual machine group displays summary charts for each host in the farm or each virtual machine in a virtual machine group. These summary charts include the total processor, memory, disk, and network utilization over a selected time range, along with the average utilization over that same time range. Clicking on the chart links displays the charts.
If there are more than four hosts or virtual machines in the farm or virtual machine group, then the **First, Prev, Next,** and **Last** buttons are available to shift the view to additional hosts or virtual machines.

![Inventory > Farm > Performance Tab](image)

The **Performance** tab content is described in the following table.

<table>
<thead>
<tr>
<th>List Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Host or virtual machine name.</td>
</tr>
<tr>
<td>Processor (or CPU)</td>
<td>Reports the percentage of processor being used.</td>
</tr>
<tr>
<td>Memory</td>
<td>Reports the memory usage in MBytes.</td>
</tr>
<tr>
<td>Disks</td>
<td>Reports the number of bytes per second of read and write activity to and from the disk.</td>
</tr>
<tr>
<td>Network</td>
<td>Reports the number of bits per second of input and output to each and all network interface (NIC) cards.</td>
</tr>
<tr>
<td>Range</td>
<td>Selectable range of time to display in the charts. Options include: day, week, month, year.</td>
</tr>
</tbody>
</table>
Viewing Individual Performance Charts

The Performance tab displays four thumbnail charts and one expanded chart of the monitored resource for each selected host or virtual machine.

The thumbnail charts at the top of the panel are the same as the summary charts. Clicking a summary chart displays an expanded version of that chart in the body of the panel.
Working with Performance Chart Data

There are several things you can do to alter the view, the data collected, and the range of information stored to the VirtualCenter database. The following sections describe these activities:

- Displaying the Performance Panel Legend on page 460
- Changing the Performance Panel Range on page 460
- Customizing Performance Charts on page 460
- Viewing Performance Panel Resource Charts on page 462
- Configuring Performance Measurement Intervals on page 464
- Configuring the Number of Threads for Collecting Performance Statistics on page 465
- Configuring the Statistics Detail for Performance Data on page 466
- Exporting Performance and Host Summary Data on page 467

Displaying the Performance Panel Legend

Click the Show legend/Hide legend link to view or hide the legend for the charts. The legend at the bottom of the panel displays a key for:

- Chart Entries – These map the line styles to the item they are representing.
- Event Indicators – These triangular icons on the expanded chart indicate when significant events occurred for the host or virtual machine. Click the Events tab to locate the nature and condition of the event.

Changing the Performance Panel Range

In the Range list, you can adjust the time increment for the charts. The charts can display data from the past day, week, month or year.

Customizing Performance Charts

When you select the Customize Chart link, the Customize Performance Chart dialog box appears and provides options that affect the display of the chart. The chart options differ between hosts and virtual machines.

Host customize chart options:

- Processor (or CPU):
  - Total processor (or CPU) utilization [line chart]
- Total processor (or CPU) utilization by virtual machine [stacked chart]
- Memory:
  - Total memory utilization [line chart]
  - Total memory utilization by virtual machine [stacked chart]
    This also provides an option for selecting which metric to display and a selectable list of virtual machines to include in the chart data.
- Disk I/O and network I/O only:
  - Total disk/network I/O
  - Total disk/network I/O by device
  - Total disk/network I/O by virtual machine [stacked chart]
    This provides an option for selecting which metric to display and a selectable list of virtual machines to include in the chart data.
- Individual disk/network I/O
  This provides an option to specify a device and list the performance data by virtual machine.

Virtual machine chart options:
- Total utilization (line chart) – All devices
- Total disk/network by device (stacked chart) – Disk and network only
This option provides an option for **Total/Reads/Writes** and a selectable list of virtual machines to include in the chart data.

- **Individual disk I/O – Disk only**

This provides an option to specify a device in the virtual machine.

![Virtual Machine Performance Chart Options](image)

**Viewing Performance Panel Resource Charts**

To view the following information, select the corresponding chart.

The Performance panel displays the usage of the following resources:

- **Processor (or CPU)** – Chart reports the percentage of processor being used.

  To display the Chart Entries legend, click the Show/Hide legend link.

  The host machine processor chart has one usage line while the virtual machine processor chart has two lines on it: a usage line and a guarantee line.

  - **Usage**: Percentage of processor time used by the virtual machine (or by all virtual machines on the host)
  
  - **Guarantee**: Percentage of processor time guaranteed to be available to the virtual machine (not available on the host chart); value is determined by the min/max/shares settings of this virtual machine and all virtual machines currently running on the host

  The processor chart displays the percentage of combined processor usage. If there is more than one processor, the chart distributes the data based on the
combined usage at 100%. The legend lists the values as a portion of the 100% total.

- **Memory** – Chart reports the memory usage. This is calculated as a percentage of shares of the entire physical plus swap memory on the host assigned to the virtual machine. Virtual machine memory maximum and minimum usage is configurable.

  The display is one chart per host. This does not include NUMA systems. To display the Chart Entries legend, click the Show/Hide legend link.

  The memory chart has two lines on it: an active line and a granted line.

  - Active: Memory recently used by the virtual machine (or by all virtual machines on the host)
  - Granted: Memory allocated to the virtual machine (or to all virtual machines on the host)

  If several virtual machines are sharing the same processor or memory, the usage line steps down or up as additional virtual machines are powered on or off. If there is no contention for the processor or memory, usage is reported as a flat line.

- **Disk** – Chart reports the amount of read and write activity to and from the disk.

  The data is defined by shares of the disk resource per volume. There is no line to show the percentage of the disk space read/write usage assigned to the virtual machine.

  To display the Chart Entries legend, click the Show/Hide legend link.

  Data is collected on each disk connected to the ESX Server and GSX Server or VMware Server host. This tracks the VMFS traffic and access to the network share. For any disk, the reported data is relative to the host selected in the inventory panel. Traffic with a disk that is due to additional hosts attached to the disk is not included in the chart.

  Host data appears in two aggregate charts: one for read activity and one for write activity. With VMFS systems, separate charts display volume inbound read traffic and volume outbound write traffic. Note logical volumes span partitions.

  - Total: Total I/O
  - Reads: Disk reads, network traffic received
  - Writes: Disk writes, network traffic transmitted
• **Network** – Chart reports the number of bits per second of input and output to each and all network interface cards (NIC).

The virtual machine aggregate chart shows all the input and output activity per virtual machine. The detail charts show the activity for each NIC for the virtual machine.

To display the Chart Entries legend, click the Show/Hide legend link.

Host aggregate chart reports all the network input and output per host. Network input and network output usage are given separate charts reporting the usage of the physical NIC based on the configuration of the virtual machines on that host.

• Total: Total I/O
• Reads: Disk reads, network traffic received
• Writes: Disk writes, network traffic transmitted

**Configuring Performance Measurement Intervals**

**Note:** Existing performance data is reset (lost) when you change the interval configuration. However, only the data for that interval is reset. For example, if you change only the weekly time interval, the daily and monthly data are maintained.

To configure performance intervals:

1. Start the VirtualCenter client.
2. Choose **File > VMware VirtualCenter Settings**. The VirtualCenter Settings dialog box appears.
3. On the Performance tab, modify intervals and sampling values as needed. Under Current Performance Intervals, you can remove an existing interval. Select the interval in the list and click Remove.

To add a new interval:
   a. In the Name field, enter name of the interval. This name appears in the Range list on the Performance tab.
   b. In the Minutes per sample field, enter the length of time in minutes between each sample taken.
   c. In the Number of samples field, enter the maximum number of samples that are displayed on the Performance tab. As new samples are collected, old samples beyond the maximum number are purged.
   d. Click Add. The new interval appears in the list under Current Performance Intervals.

4. Click OK. The charts on the Performance tab reflect the adjusted values.

**Configuring the Number of Threads for Collecting Performance Statistics**

You can configure multiple statistical refresh threads and distribute their updates over time. On an SMP VirtualCenter host, you can use multiple threads to increase the number of managed hosts and take advantage of the additional processor. On a uniprocessor host, you can adjust this value to smooth out processor usage.

The number of threads is used for collecting performance statistics from managed hosts. The default value is 1, and the maximum setting is 8.

**To configure the number of threads:**

1. Start the VirtualCenter client.
2. Choose File > VMware VirtualCenter Settings. The VirtualCenter Settings dialog box appears.
3. Click **Advanced**.

4. Modify the **perf.numThreads** value as needed.

   On SMP hosts, using multiple threads increases the number of managed hosts possible by taking advantage of the additional processors. On UP hosts, it improves the processor utilization.

5. Click **OK** to save your change.

6. Restart the VirtualCenter server to apply the changes. For information, see **Restarting the VirtualCenter Server on page 119**.

**Configuring the Statistics Detail for Performance Data**

You can configure the amount of detailed information that is collected for the statistics. A minimum amount of information is always displayed in the VirtualCenter client. This setting applies to the amount of information collected and stored in the VirtualCenter database, which can viewed through the VirtualCenter database views. Refer to the technical note, Using VirtualCenter Database Views for additional information on the statistics collected and the database views.

The acceptable values for collecting detailed performance statistics are minimal, typical, and full. The minimal and typical values match the information displayed in the VirtualCenter client. The full value stores all the possible detail.

**To configure the statistics data collected:**

1. Start the VirtualCenter client.
2. Choose File > VMware VirtualCenter Settings. The VirtualCenter Settings dialog box appears.

3. Click Advanced.

4. Modify the perf.level value as needed.
   The choices are: minimal, typical, and full.
   
   **Note:** Selecting full does not alter the performance statistics viewed in the VirtualCenter client.

5. Click OK to save your change.

---

**Exporting Performance and Host Summary Data**

You can export performance data for a specific virtual machine or for a specific host. You can export host summary data.

Performance data includes processor Usage, Memory Utilization, Disk I/O, and Network I/O. The performance data is exported in a combination of XML and Microsoft Excel files.

The host summary data contains information about the host hardware, VirtualCenter settings, and resource and performance data. The host summary data is exported in HTML or Excel format.

**To export host summary data:**

1. Select a host in the VirtualCenter client inventory.
To export performance data:

**Note:** Performance data is only exported in Excel format.

1. Select a host or a virtual machine in the VirtualCenter client inventory.

3. In the **File location** field, type a location for the report or click **Browse** and navigate to a location and enter a file name.

4. Under **Devices**, deselect any data you do not want included in the report. By default, processor, memory, disk I/O, and network I/O data are included in the report.

5. Under **Settings**, select the range of the report and the size of the graph
   - In the **Range** list, select from the past day, week, month, or year.
   - In the **Graph Size** list, select a small, medium, or large graph.

6. Click **OK** to create the report.
   - The output is in Excel format.
This chapter describes how to manage access to VirtualCenter managed objects for users and groups. This chapter contains the following sections:

- Understanding Users and Groups on page 470
- Planning Access Permission on page 478
- Assigning Access Permissions on page 482
- Changing Access Permissions on page 485
- Removing Access Permissions on page 487

You must have VirtualCenter Administrator permission to change the role permissions assigned to any object in VirtualCenter.
Understanding Users and Groups

VirtualCenter has full access rights and privileges on all managed virtual objects, such as, farms, farms groups, virtual machines, and virtual machine groups. VirtualCenter access is not granted to users for hosts, templates, events, alarms, or scheduled tasks.

When a host is managed with VirtualCenter, VirtualCenter is granted privileges on the host. VirtualCenter can move virtual machines to and from hosts, and perform configuration changes needed to support virtual machines. Some configuration conditions are not handled within VirtualCenter, but can be controlled through the standard ESX Server, GSX Server, or VMware Server interfaces: the VMware Management Interface (ESX Server and GSX Server), remote or virtual machine console, or service console (ESX Server only).

VirtualCenter registers any selected Windows domain or Active Directory user or group through the process of assigning privileges. By default, all users who are members of the Administrators group on the VirtualCenter server machine are granted VirtualCenter Administrator access. Users who are members of the Administrator group can log on as individuals and have the appropriate access.

VirtualCenter grants access to each VirtualCenter object by assigning a role and a user (or group) to each object.

Individual permissions are assigned through VirtualCenter by pairing a user and a role and assigning this pair to a VirtualCenter object.

- **Users and Groups** – Created through the Windows domain or Active Directory database. VirtualCenter registers users and groups as part of the assigning privileges process.

- **Roles** – A VirtualCenter pre-defined set of access rights and privileges. There are four roles. Each subsequent role includes the privileges of the previous role.

The types of roles that can be paired with a user and assigned to an object are:

- **Read Only User** – Users assigned this role for an object are allowed to view the state of virtual machines, hosts, farms, and groups.

  With this role, view virtual machines, hosts, farms farm groups, and virtual machine group attributes, that is, all the tab panels in VirtualCenter — except the Console tab. You cannot view the remote console for a host. All actions through the menus and toolbars are disallowed. A Read Only User role can view the templates and scheduled tasks but not perform any actions with them.

- **Virtual Machine User** – Users assigned this role for an object are allowed to perform power operations on virtual machines.
With this role, you can connect with a remote console and view the states of virtual machines. You cannot modify the configuration of hosts or virtual machines.

- **Virtual Machine Administrator** – Users assigned this role for an object are allowed to add, remove, or modify objects. With this role you can:
  - Connect and disconnect virtual machine devices, migrate and migrate with VMotion, clone, remove, and configure virtual machines.
  - Create, import, and deploy templates.
  - Add and remove hosts from farms.
  - Create, remove, or modify farms, farm groups, and virtual machine groups and their content.
  - Cancel running operations.

- **VirtualCenter Administrator** – Users in this role are allowed to change privileges for an object.

  With this role, you can add, remove, and set access rights and privileges for all the VirtualCenter users and all the virtual objects in the VirtualCenter environment.

<table>
<thead>
<tr>
<th>Read Only User</th>
<th>Virtual Machine User</th>
<th>Virtual Machine Administrator</th>
<th>VirtualCenter Administrator</th>
<th>Access Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>View farms, hosts, and virtual machines</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>Perform power operations on virtual machines</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>Access remote console</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>Add and remove hosts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>Add, remove and move virtual machines, including deploy templates and clone existing virtual machines</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>Add and remove farms, and groups</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>Add and remove templates, tasks</td>
</tr>
</tbody>
</table>
The following table lists the VirtualCenter objects and the role required to perform functions on each object. Permissions do not apply to hosts. Activities through VirtualCenter apply to the virtual machines on a host. Permissions are applied to the virtual machines or the farms and groups containing the virtual machines.

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Action to be Taken</th>
<th>Minimum Role Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permissions</td>
<td>Read</td>
<td>Read Only User</td>
</tr>
<tr>
<td></td>
<td>Change permissions</td>
<td>VirtualCenter Administrator</td>
</tr>
<tr>
<td>Farm</td>
<td>Read</td>
<td>Read Only User</td>
</tr>
<tr>
<td></td>
<td>Modify</td>
<td>Virtual Machine Administrator</td>
</tr>
<tr>
<td>Groups</td>
<td>Read</td>
<td>Read Only User</td>
</tr>
<tr>
<td></td>
<td>Modify</td>
<td>Virtual Machine Administrator</td>
</tr>
<tr>
<td>Server Farms</td>
<td>Read settings</td>
<td>Read Only User</td>
</tr>
<tr>
<td></td>
<td>Change settings. Includes</td>
<td>Virtual Machine Administrator on the Server Farms</td>
</tr>
<tr>
<td></td>
<td>performance intervals, SNMP,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SMTP, and template upload directory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Read licenses</td>
<td>Read Only User</td>
</tr>
<tr>
<td></td>
<td>Adding or removing licenses</td>
<td>VirtualCenter Administrator on the Server Farms</td>
</tr>
<tr>
<td></td>
<td>Read alarms</td>
<td>Read Only User</td>
</tr>
<tr>
<td></td>
<td>Add or modify alarms</td>
<td>Virtual Machine Administrator on the Server Farms</td>
</tr>
<tr>
<td>Object Type</td>
<td>Action to be Taken</td>
<td>Minimum Role Required</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Templates</td>
<td>Read</td>
<td>Read Only User</td>
</tr>
<tr>
<td></td>
<td>Creating templates</td>
<td>Virtual Machine Administrator on the Server Farms</td>
</tr>
<tr>
<td></td>
<td>Deploying templates with or without customization</td>
<td>Virtual Machine Administrator on both the farm that contains the source and the target machine</td>
</tr>
<tr>
<td>Virtual Machines</td>
<td>Read</td>
<td>Read Only User</td>
</tr>
<tr>
<td></td>
<td>Power operations</td>
<td>Virtual Machine User</td>
</tr>
<tr>
<td></td>
<td>Connect remote console</td>
<td>Virtual Machine User</td>
</tr>
<tr>
<td></td>
<td>Configure</td>
<td>Virtual Machine Administrator</td>
</tr>
<tr>
<td></td>
<td>Connect/disconnect devices</td>
<td>Virtual Machine Administrator</td>
</tr>
<tr>
<td></td>
<td>Migration with VMotion</td>
<td>Virtual Machine Administrator on both the farm that contains the source and the target machine</td>
</tr>
<tr>
<td></td>
<td>Migration</td>
<td>Virtual Machine Administrator on both the farm that contains the source and the target machine</td>
</tr>
<tr>
<td></td>
<td>Deploying templates with or without customization</td>
<td>Virtual Machine Administrator on both the farm that contains the source and the target machine</td>
</tr>
<tr>
<td></td>
<td>Cloning with or without customization</td>
<td>Virtual Machine Administrator</td>
</tr>
<tr>
<td></td>
<td>Scheduling tasks - power operations</td>
<td>Virtual Machine User</td>
</tr>
<tr>
<td></td>
<td>Scheduling tasks - deploying or migration</td>
<td>Virtual Machine Administrator</td>
</tr>
<tr>
<td></td>
<td>Cancelling a running operation</td>
<td>Virtual Machine Administrator</td>
</tr>
<tr>
<td></td>
<td>Viewing events</td>
<td>Virtual Machine User</td>
</tr>
</tbody>
</table>

**Using the Hierarchy to Apply Access Rights**

All VirtualCenter objects are contained within a hierarchy in VirtualCenter. Permissions (role+user pairs) are inherited through the VirtualCenter object hierarchy. When a role and user pair are assigned to an object, all objects that are hierarchically under the object inherit the same role+user assignments. For example, if a role+user pair is assigned to a farm group, all members of the role+user pair have the access rights and
privileges assigned to all the objects contained in the farm group. Permissions can also be explicitly assigned to any object in the VirtualCenter hierarchy.

If a user is not assigned to an object with a specific role, the user cannot see or take action upon the object. Changes to a user’s permissions are implemented when the user logs on. If the user is currently logged on, the old permissions continue until the user exits and logs on again. Objects created after a user logs on inherit the parent object’s permissions.

The figure below illustrates a distribution of user permission. Refer to Abbreviations on page 16 for a description of abbreviations.

When an object is moved within the VirtualCenter hierarchy, the object assumes the permission settings of its new parent object. Assigned permission pairs (role+user) are inherited from parent objects. In the figure, if VM2 is moved to VM group 2, user1 loses the VirtualCenter Administrator privileges, but keeps the Virtual Machine User privileges.
The figure below illustrates changes in permission when a virtual machine moves to a virtual machine group where the permissions granted had been inherited. Refer to Abbreviations on page 16 for a description of abbreviations.

Moving Virtual Machine Changing Role + User Status

If the object has explicit permissions that are less than the permissions at the new location, the higher-level permission granted at the virtual machine group level is applied. The lower-level explicit permission is removed. In the example, if VM3 moves to VM group 1, no flag indicates that an explicit permission exists. If the object is returned to a location with no conflict, VirtualCenter reinstates the explicit assignment.
The figure below illustrates the change in permissions when a virtual machine is moved to a virtual machine group where the user has a higher level inherited permission. Refer to Abbreviations on page 16 for a description of abbreviations.

Using hierarchical inheritance, you can increase access permissions for users (or groups) as you descend into the VirtualCenter object hierarchy. However, once you pair higher role levels with a user (or group) at an object hierarchy level, you cannot reduce permissions at lower levels of the hierarchy. For example, if a user (or group) is paired with Virtual Machine Administrator role at a virtual machine group level, you cannot reduce the same user+role to Read Only User for any of the virtual machines contained within that virtual machine group.
The figure below illustrates when a permission level does not change through an explicit role+user assignment. Refer to Abbreviations on page 16 for a description of abbreviations.

![Diagram showing permission levels]

Reducing Role + User Not Allowed Through Conflicting Hierarchy
Planning Access Permission

For each object in the VirtualCenter hierarchy, determine what permissions you want to grant for each VirtualCenter user and group. Typically, lower level permission roles are assigned at higher level locations in the hierarchy. As you move down into the branches of the hierarchy, users and groups permissions naturally start to differentiate: some users and groups require higher permission roles in some branches, while other users and groups require higher permission roles in other branches.

**Note:** Several users may access the VirtualCenter server from different VirtualCenter clients at the same time. VirtualCenter does not explicitly restrict users with the same login and password from accessing and taking action in VirtualCenter.

Remove users from the Windows Domain Controller or Active Directory, and they lose permissions to all objects in the VirtualCenter system on their next attempts at login. Users that are currently logged in and are removed from the Windows databases retain their VirtualCenter permissions as long as they remain logged in. Once logged out, they can no longer access the VirtualCenter system. Individual permissions, or those granted as part of inclusion in another group, are not affected.

Change a user’s name in the Windows Domain Controller or Active Directory, and the existing user name becomes invalid in the VirtualCenter system.

Preparing GSX Server or VMware Server Windows Host Virtual Machines

A GSX Server or VMware Server virtual machine on a Windows host runs as one of the following three user accounts:

- **The user who powers on the virtual machine** – the virtual machine runs as the account of the user who powered on the virtual machine until the virtual machine is powered off. Other users can connect to the virtual machine but it still runs as the user who powered on the virtual machine.

- **The local system account** – the virtual machine runs as the local system account.

- **A specific user account** – the virtual machine runs as the user account specified when you created the virtual machine or edited its settings.

The type of user account is specified when you create the virtual machine, and you can change it in the GSX Server or VMware Server virtual machine settings editor. See your GSX Server or VMware Server documentation for more information.
To allow VirtualCenter to perform all the functions on any GSX Server or VMware Server virtual machine, every GSX Server or VMware Server virtual machine must be configured to run as a specific user account — the user account specified when the host was added to VirtualCenter.

Any virtual machine created through VirtualCenter on a GSX Server or VMware Server Windows host is configured to run as this user. This ensures that the virtual machines have corresponding access to all datastores.

**Note:** If the virtual machine created through VirtualCenter on a GSX Server or VMware Server Windows host is later modified in a GSX Server or VMware Server console to run as the local system account or a specific user account, then the virtual machine runs as that user account, and not as the user account specified when the host was added to VirtualCenter. If it is modified in a GSX Server or VMware Server console to run as the user that powers it on, when the virtual machine is powered on from the VirtualCenter client, it runs as the user account specified when the host was added to VirtualCenter.

**Note:** The only way to change the user account VirtualCenter uses for running virtual machines on a GSX Server or VMware Server Windows host is to remove the GSX Server or VMware Server host from VirtualCenter, then add it back again.

If you configured virtual machines on a GSX Server or VMware Server Linux host, you should make sure you have the correct permissions to run them.
Setting Parameters for Identifying Users and Groups

If you have domains with thousands of users or groups in them, adjust the search settings for use in the Select Users or Groups dialog.

To adjust users and groups search parameters:

1. From the VirtualCenter client, choose File > VMware VirtualCenter Settings.
2. Make your changes to the VMware VirtualCenter Settings dialog.

   a. Click the Advanced tab. Scroll to the ads parameters.
   b. Change the values as needed.

   **ads.maxFetch** – Specifies the maximum number of users and groups the VirtualCenter displays from the selected domain in the Select Users or Groups dialog. To specify no maximum limit, enter zero (0).

   **ads.timeout** – Specifies in seconds, the maximum amount of time VirtualCenter allows the search to run on the selected domain. Searching very large domains can take a very long time. If this value is set to zero (0), the time limit is disabled.

   **ads.checkInterval** – Specifies the time in minutes between permissions checks. VirtualCenter verifies that all users and groups known to VirtualCenter currently exist in Windows. For example, if user Smith was assigned permissions and in the domain the user’s name was changed to Smith2, VirtualCenter concludes that Smith no longer exists and removes permissions for that user.
Assigning Access Permissions

To assign a user or group role level permission:

1. Log on as a user with the VirtualCenter Administrator role.
2. From the VirtualCenter client, display the inventory panel and expand the appropriate object.
   Click the Inventory button in the navigation bar. Expand the inventory as needed, and click the appropriate object.
3. With the appropriate object selected, view the Permissions panel and click Permissions tab.
4. Start the Add Permissions sequence.
   a. Right-click the Inventory button.
   b. Select the object to add the user+role to.
   c. Choose Add Permission from the object’s right-click menu or the Edit menu.
5. Select the users or groups and the new permission for the object.

   a. Enter a search string to narrow the search in the domain.

      VirtualCenter searches the domain for both the user login name and the full
      user name but lists only the matching user login names. For example, if you
      enter william, user names, such as wsmith, jonesw, williamjones, could all
      be displayed, depending upon your user naming conventions.

   b. Choose a domain from the Look In box.

   c. Enter a user or group name in the unlabeled field across the middle of the
      panel. Or select the user or groups from the scrollable list in the Name field.

   d. Click Add.
6. Set the role for the selected user on the selected object.

   a. Select the user or group name from the permissions box.
   b. Select the radio button for the appropriate permission.

7. Add as many users and groups with assorted permission roles as needed. Click **OK**.

   VirtualCenter adds the permission to the list of permissions for the object.

   The list of permissions references all users and groups that have roles assigned to the object, and where in the VirtualCenter hierarchy the role is assigned.
Changing Access Permissions

To change the permission role for a user or group:

1. From the VirtualCenter client, display the inventory panel and expand the appropriate object.
   Click the Inventory button in the navigation bar. Expand the inventory as needed, and click the appropriate object.

2. With the appropriate object selected, view the Permissions panel and click Permissions tab.

3. Identify and select the object where the permission is defined.
   a. Select an object to which the permission is defined.
   b. Display the Permissions list. Click the Permissions tab.
   c. Click the linked object in the Defined in column.

   VirtualCenter displays the Permission panel for the object to which the permission was defined.

4. View the Change Access Rule dialog box.
   Select the user permission to change. Select Properties from either the Edit or right-click menu. Double-clicking will also bring up the Change Access Rule dialog.
5. Select the appropriate role for the user or group.

Click the appropriate radio button in the Change Access Rule screen. Click **OK**.

![Change Access Rule dialog box]

When you change a rule on an object that does not define the rule but inherits it, a new rule is created for the user on that object even though you specified a change. The change creates a new rule for the object that is different from the inherited rule.
Removing Access Permissions

To remove a permission role for a user or group:

1. Log on as a user with the VirtualCenter Administrator role.

2. From the VirtualCenter client, display the inventory panel and expand the appropriate object.
   Click the Inventory button in the navigation bar. Expand the inventory as needed, and click the appropriate object.

3. With the appropriate object selected, view the Permissions panel, click Permissions tab.

4. Identify and select the object where the permission is defined.
   a. Select an object to which the permission is defined.
   b. Display the Permissions list. Click the Permissions tab. Click the linked object in the Defined in column.

   VirtualCenter displays the Permission panel for the object to which the permission was defined.

5. Remove the permission setting.
   Select the user permission to remove. Choose Remove from either the Edit or right-click menu. VirtualCenter removes the permission setting.

   **Note:** There is no additional warning that the permission is going to be removed.
Alarms —
An entity that monitors one or more properties of a virtual machine, such as processor load. Alarms user green, red, and yellow color coding issue notifications as directed by the configurable alarm definition.

Clone —
The process of making a copy of a virtual machine. This process includes the option to customize the guest operating system of the new virtual machine. When a clone is created VirtualCenter provides an option to customize the guest operating system of that virtual machine. Clones can be stored on any host within the same farm as the original virtual machine.

Configuration —
See Virtual machine configuration file.

Console —
See VMware Virtual Machine Console.
Custom networking —
Any type of network connection between virtual machines and the host that does not use the default bridged, host-only or network address translation (NAT) networking configurations. For instance, different virtual machines can be connected to the host by separate networks or connected to each other and not to the host. Any network topology is possible.

Customization —
The process of customizing a guest operating system in a virtual machine as it is being either deployed from a template or cloned from another existing virtual machine. Customization options include changing the new virtual machine identification and network information.

Datastore —
The storage locations for the virtual machine files.

Drag and drop—
A feature of VMware VirtualCenter that allows you to move virtual machines easily between groups.

Events —
A message record of VirtualCenter activities. Through the Navigation option all the events are displayed. Through an object specific panel, only events relative to that object are displayed.

Farm —
A required structure under which hosts and their associated virtual machines are added to the VirtualCenter server. VirtualCenter server supports multiple farms. A host can be managed only under one farm.

Farm groups —
An optional grouping structure, it is contained within the Server Farms structure. The VirtualCenter server supports multiple farm groups. Farm groups can contain other farm groups and farms.

Guest operating system —
An operating system that runs inside a virtual machine.

Headless —
A program or application that runs in the background without any interface connected to it. A running virtual machine that has no consoles connected to it is running headless.
**Host**

The physical computer on which the VirtualCenter virtual machines are installed.

**Host-only networking**

A type of network connection between a virtual machine and the host. Under host-only networking, a virtual machine is connected to the host on a private network, which normally is not visible outside the host. Multiple virtual machines configured with host-only networking on the same host are on the same network.

**Inventory**

Provides a view of all the monitored objects in VirtualCenter. Monitored objects include: Server Farms, farms, farm groups, hosts, virtual machines, and virtual machine groups.

**Migration**

Moving a powered off virtual machine between hosts.

**Migration with VMotion**

Moving a virtual machine that is powered on and has met selected requirements, including the activation of VMotion on both the source and target host. When a migration with VMotion is performed, the operations of the virtual machine can continue without interruption.

**New Virtual Machine Wizard**

A point-and-click interface for convenient, easy creation of a virtual machine configuration. It prompts you for information, suggesting default values in most cases. It creates files that define the virtual machine, including a virtual machine configuration file and (optionally) a virtual disk or raw disk file.

**Nonpersistent mode**

If you configure a virtual disk as an independent disk in nonpersistent mode, all disk writes issued by software running inside a virtual machine with a disk in nonpersistent mode appear to be written to disk but are in fact discarded after the virtual machine is powered off. As a result, a virtual disk or raw disk in independent-nonpersistent mode is not modified by VirtualCenter.

**Persistent mode**

If you configure a virtual disk as an independent disk in persistent mode, all disk writes issued by software running inside a virtual machine are immediately and permanently written to a virtual disk in persistent mode. As a result, a virtual disk or raw disk in
independent-persistent mode behaves like a conventional disk drive on a physical computer.

**Allocated disk** —
A type of virtual disk where all disk space for the virtual machine is allocated at the time the disk is created. This is the default type of virtual disk created by VirtualCenter.

**Raw disk** —
A hard disk in a virtual machine that is mapped to a physical disk drive or partition on the host machine. A virtual machine's disk can be stored as a file on the host file system (see Virtual disk) or on a local hard disk. When a virtual machine is configured to use a raw disk, VirtualCenter directly accesses the local disk or partition as a raw device (not as a file on a file system). It is possible to boot a previously installed operating system on an existing partition within a virtual machine environment. The only limitation is that the existing partition must reside on a local IDE or SCSI drive.

**Read Only User** —
A role where the user is allowed to view the inventory but not allowed to perform any tasks.

**Redo log** —
The file that stores the changes made to a disk in undoable or nonpersistent mode. You can permanently apply the changes saved in the redo log to a disk in undoable mode so they become part of the main disk files. For a disk in nonpersistent mode, however, the redo-log file is deleted when you power off or reset the virtual machine without writing any changes to the disk.

**Resume** —
Return a virtual machine to operation from its suspended state. When you resume a suspended virtual machine, all applications are in the same state they were when the virtual machine was suspended.

**Role** —
A VirtualCenter pre-defined set of access rights and privileges. There are four roles, each subsequent role includes the privileges of the lesser role.

**Scheduled Tasks** —
A VirtualCenter activity that is configured to occur at designated times. The Tasks panel displays a list of and a means to schedule selected activities.
Server Farms —
The top level structure for the VirtualCenter server. There is only one Server Farms per VirtualCenter server.

Supported partition —
A virtual disk partition that VMware Tools can prepare for shrinking, such as one of the drives that comprise the virtual hard disk. You can choose to not prepare certain partitions for shrinking.

Suspend —
Save the current state of a running virtual machine. To return a suspended virtual machine to operation, use the resume feature.

Template —
A golden image of a virtual machine. This typically includes a specified operating system and configuration which provides virtual counterparts to hardware components. Optionally, a template can include an installed guest operating system and a set of applications. Templates are used by VirtualCenter to create new virtual machines.

Template upload directory —
A template upload directory is located on the VirtualCenter server machine. A copy of the original virtual machine virtual disks are placed in the directory you specify as the template upload directory. This is typically used for creating templates from non-ESX Server, GSX Server, VMware Server virtual machines that are stored locally to the VirtualCenter server.

Templates —
Provides a list of and a means to import virtual machines and store them as templates for deploying at a later time to create new virtual machines.

Unsupported partition —
A virtual disk partition that VMware Tools cannot prepare for shrinking. Unsupported partitions include read-only drive partitions, partitions on remote devices and partitions on removable devices such as floppy drives or CD-ROM drives.

Virtual disk —
A virtual disk is a file or set of files that appear as a physical disk drive to a guest operating system. These files can be on the host machine or on a remote file system. When you configure a virtual machine with a virtual disk, you can install a new operating system into the disk file.
Virtual machine —
A virtualized x86 PC environment in which a guest operating system and associated application software can run. Multiple virtual machines can operate on the same host machine concurrently.

Virtual Machine Administrator —
A role where the user is allowed to perform all the virtual machine management functions.

Virtual machine configuration —
The specification of what virtual devices (disks, memory size, etc.) are present in a virtual machine and how they are mapped to host files and devices.

Virtual machine configuration file —
A file containing a virtual machine configuration. It is created by the New Virtual Machine Wizard. It is used by VirtualCenter to identify and run a specific virtual machine.

Virtual Machine Properties —
A point-and-click control panel used to view and modify the resource settings of all the virtual machines on a host.

Virtual Machine Groups —
An optional grouping structure, it is subset to a farm. VirtualCenter server supports multiple virtual machine groups. Virtual machine groups contain virtual machines and other virtual machine groups.

Virtual Machine User —
A role where the user is allowed to perform power operations on virtual machines.

VirtualCenter Administrator —
A role where the user is allowed to set the user+role permissions and controls the VirtualCenter licensing.

VirtualCenter client —
A user interface that runs locally on a Windows machine.
The VirtualCenter client runs on a networked machine. This can be on the same machine as the VirtualCenter server or another networked machine. The VirtualCenter client requires a monitor for access to the graphical user interface.
**VirtualCenter database** —
A persistent storage area, for maintaining status of each virtual machine and user managed in the VirtualCenter environment. This is located on the same machine as the VirtualCenter server.

**VirtualCenter agent** —
Installed on each virtual machine host, it coordinates the actions received from the VirtualCenter server.

**VirtualCenter server** —
A service that acts as a central administrator for VMware servers connected on a network, to direct actions upon the virtual machines and the virtual machine hosts. VirtualCenter server is the central working core of VirtualCenter.

**VMotion** —
Enables moving running virtual machines from one ESX Server to another without service interruption. It requires licensing on both the source and target host. Feature that is activated by the VirtualCenter agent. The VirtualCenter server centrally coordinates all VMotion activities.

**VMware Tools** —
A suite of utilities and drivers that enhances the performance and functionality of your guest operating system. Key features of VMware Tools include some or all of the following, depending on your guest operating system: an SVGA driver, a mouse driver, the VMware guest operating system service, the VMware Tools control panel and support for such features as shared folders, drag and drop in Windows guests, shrinking virtual disks, time synchronization with the host, VMware Tools scripts and connecting and disconnecting devices while the virtual machine is running.

**VMware Virtual Machine Console** —
Interface to a virtual machine that provides access to one or more virtual machines on the local host or a remote host running VirtualCenter. You can view the virtual machine’s display to run programs within it or modify guest operating system settings. In addition, you can change the virtual machine’s configuration, install the guest operating system or run the virtual machine in full screen mode.
Index

A
access 485
  assigning 482
  inheritance 473
  removing 487
  users and groups 470
Access database 72
acting on objects 136
adding
  CD ROM 368
  DVD 368
  ethernet adapter 374
  existing virtual machines 200
  farm groups 168
  farms 166
  floppy drive 371
  hard disks 372
  hardware 367
  hosts 177
  NIC 374
  parallel port 375
  SCSI drive 371
  serial port 377
  USB controller 381
  virtual machine groups 212
  virtual sound adapter 382
ads.checkInterval 159
ads.maxFetch 159
ads.timeout 159
advanced settings 158, 385
agent. See also VirtualCenter agent
alarm
  SNMP notification 158
alarms 21, 35, 158, 407, 414
  creating 420
  editing 425
  email notification 414
  information panel 453
  inventory tab 407
  preparing SMTP notification 415
  preparing SNMP notification 416
  properties 164
  removing 426
  tab 431, 453
answering pending questions 209
assigning 482
  permissions 482
attributes 151
audio
  configuring 363
availability report 58
B
BusLogic SCSI adapter in virtual machine 246
C
cancel
  scheduled task 405
CD ROM
  adding 368
  configuring 348
changing 485
  access permissions 485
  disk resource settings 392
  memory resource settings 390
  network resource settings 393
charts 153
  disk resource 463
  entries 459
  event indicators 459
  memory resource 463
  network resource 464
  processor resource 462
client
  firewall 100
  navigation bar 144
client.timeout.long 159
client.timeout.normal 158
cloning
  customization 32
  existing virtual machines 307
  guest customization 325
  manually 308
  templates 283
cloning virtual machines 31, 312
collecting statistics 465
color coding 150
columns in lists 152
components 17
installation 75
installing separately 109
concurrent deploy 270
configure datastores 271
configuring
audio 363
CD ROM 348
DVD 348
ethernet adapter 355
firewall 129
floppy drive 350
hard disk 351
measurement intervals 464
memory 354
mouse 365
NIC 355
parallel port 358
ports 100
processor 362
SCSI controller 358
SCSI device 351
serial port 360
USB 366
virtual machines 345, 494
connected host state 174
connecting hosts 185
Console
information panel 455
menu 142	tab 431, 455
VirtualCenter 455
creating
alarms 420
new virtual machine 236
scheduled task 397
virtual machines 34
virtual machines from templates 294
custom attributes 151
customization
clones 32
deploy templates 324
hardware requirements 52
Linux 342
Linux guest operating system 338
Microsoft Sysprep tools 319
Open Source installation 321
requirements 51
templates 32
Windows 342
Windows guest operating system 327
Windows requirements 52
customizing
guest operating systems 319
performance charts 460
D
database
installation 67, 75
SQL Server 69
datastore
configure for GSX Server 271
datastores 17
templates 27, 266
debugging
advanced settings 385
server.options settings 158
deleting
templates 285
deploy
concurrently 270
deploy template 29, 294
customization wizard 324
device mapping 253
disconnected host state 174
disk
eexisting 252
disk mapping 253
disks
raw 492
removing virtual machines 201
resource charts 463
virtual 493
virtual disk size in new virtual machine 237
drag and drop 490
DVD
adding 368
configuring 348
E
editing
alarms 425
templates 287
virtual machine configuration 34
virtual machines 345
email
notification option 415, 416
notification type 414
enabling VMotion 226
ESX Server
management interface 159
mapping system LUN 253
new virtual disks 250
virtual disk 250
ESX Server golden images
templates 274
ethernet adapter
adding 374
configuring 355
events 21, 35, 407, 411
chart indicators 459
exporting 412
information panel 437, 452
inventory panel 409
navigation bar 409, 431
navigation toolbar 133, 144
panel 407
tab 431, 452
viewing all 410
viewing selected 410
events options
navigation bar 437
executing actions 136
exporting
events 412
performance data 467
F
farm groups 19
adding 168
moving farms 169
removing 169	tabs 433
farm summary 441
farms 19
adding 166
information panel 441, 447
moving to a farm group 169
removing 167
summary tab 441
tab 431, 447
tabs 433
viewing 447
filtering lists 152
firewall 100
configure client port 129
floppy drive
adding 371
configuring 350
G
general settings
virtual machine 383
Gigabit Ethernet 356
golden image 263
ESX Server 274
groups
access 470
GSX Server 248
configure datastore 271
host user types 478
new virtual disks 248
powering on 205
virtual machines as templates 269, 273
guest customization
cloning 325
Linux 327, 342
starting wizard 324
Windows 327, 342
guest operating system
customization requirements 51
customizing Linux 338
customizing Windows 327
defined 490
installing in new virtual machine 258
new virtual machine 236
guest operating systems
customizing 319
H
hard disks
adding 372
configuring 351
hardware
adding 367
configuring 348
customization requirements 52
headless 490
hierarchy
 permissions 473
host.reconnectThreshold 158
host-only networking
 defined 491
hosts 17, 27
 adding 177
 allocating resources 194
 connecting 185
 firewall 100
 GSX Server 478
 information panel 448
 licenses 127
 management interface 159
 managing settings 197
 power states 187
 processor licensing requirements 47
 reconnecting 190
 removing 191
 removing virtual machine files 200
 resource shares 195
 states 174
 summary data 467
 summary tab 443
 tab 431, 448
 tabs 433
 VirtualCenter managed host requirements 43
I
 icons 150
 IDE
 virtual disk 248
 Image file
 ISO 349, 368
 individual
 performance charts 459
 information panel 35, 147, 439
 inheritance
 access rights 473
 Installation
 log 57
 installation
 components 75
 database 67
 Microsoft Access Database 72
 Microsoft Sysprep tools 319
 modifying 109
 Oracle database 68
 separate components 109
 instance.id 158
 inventory 21
 information panel 439
 navigation bar 431, 439
 navigation toolbar 133, 144
 object tabs 433
 tabs overview 431
 inventory panel 35, 147, 439
 events tab 409
 ISO image file 349, 368
 K
 Knowledge base 54
 L
 licensing
 adding licenses 127
 requirements 47
 Linux
 completing guest customization
 342
 customizing guest 327, 338
 listening ports 100
 lists 152
 local Oracle database 68
 log.verbose 159
 logging on
 VirtualCenter management server
 124
 logs 56
 availability report 58
 service console messages 58
 VMkernel messages 58
 VMkernel warnings 58
 LSI Logic SCSI adapter in virtual machine 246
 LUN
 mapping 253
 M
 managed
 virtual machines templates 275
 management interface 159
manually
  changing resource settings 387
cloning virtual machines 308
deploying templates 296
migrating with VMotion 228
mapping
  system LUN 253
memory
  configuring 354
  resource charts 463
  size for virtual machine 244
menu
  console 142
  main 141
  popup 142
Microsoft Access database 67, 72
Microsoft SQL Server database 67
Microsoft Sysprep tools 319
migrating with VMotion 228
migration 33, 215, 218
  powered off virtual machine 221
migration with VMotion 33, 217
  enabling 226
modifying
  installation 109
monitoring
  objects 135
mouse
  configuring 365
moving
  powered on virtual machines 217
  virtual machines 33, 218
  virtual machines between virtual machine groups 213
  virtual machines to virtual machine groups 212
Network
  using Gigabit Ethernet 356
network
  custom networking 490
  host-only 491
  resource charts 464
Network driver
  vlane 356
  vmxnet 356
new virtual machine wizard 236, 491
new virtual machines
  from templates 294
Newsgroups 54
NIC
  adding 374
  configuring 355
notification
  alarm options 414
  run script option 415
  SNMP trap 415
notification option
  email 415
  power off virtual machine 415
  reset virtual machine 415
  SMTP 415
  SNMP 416
  suspend virtual machine 415
O
objects 136
  monitoring 135
  renaming 133
  selecting 133
  viewing 133
ODBC connection 67
ODBC database 69
Open Source
  installation 321
operating system
  guest 490
Oracle
  database 67
  preparing database 68
P
panels
  information 147
  inventory 147
parallel port
  adding 375
  configuring 358
parameters
  search users and groups 480
pending questions 209
percentage
  alarm types 414
perf.level 159
perf.numThreads 159
performance
  individual charts 459
  information panel 457, 459
  measurement intervals 464
  settings 156
  summary charts 457
  tab 431, 457
performance charts 465
  customizing 460
  exporting data 467
  panel legend 460
  range options 460
  resources 462
  statistics 465
  statistics detail 466
permissions 485, 487
  assigning 482
  information panel 454
  inheritance 473
Read Only User 22, 23, 470
  tab 431, 454
users and groups 470
Virtual Machine Administrator 23, 471
Virtual Machine User 23, 470
VirtualCenter Administrator 24, 471
port
  configure client 129
  firewall 100
ports
  configuring 100
power off
  notification option 415
  toolbar 204
  virtual machine manually 205
  virtual machines 203
power on
  run script 203
  toolbar 204
  virtual machine manually 205
  virtual machines 203
power states
  hosts 187
  modifying options 384
  transitional 204
  virtual machines 203
powering on
  GSX Server 205
preparing
  Open Source installation 321
  SMTP notification 415
  SNMP notification 416
  templates 269
processor
  configuring 362
  licenses 127
  licensing requirements 47
  resource charts 462
properties
  alarms 164
  scheduled task 163
  templates 164
  virtual machines 162
  VMotion 160
properties dialog box
  virtual machine 494
Q
  question pending 209
R
  raw disk
    defined 492
Read Only User 22, 23, 470
reconnecting
  hosts 190
redo log 492
reimporting
  template 289
reinstalling VirtualCenter 103, 106
remote Oracle database 68
removing 487
  access permissions 487
  alarms 426
  farm groups 169
farms 167
files from disk 201
files from hosts 200
hosts 191
scheduled task 404
virtual machine groups 213
virtual machines 200
VirtualCenter 103, 106
renaming
virtual machine 383
renaming objects 133
requirements
guest customization 51
hardware customization 52
SDK Package 42
VMware SDK 42
Web Service 42
Windows guest customization 52
rescheduling
scheduled tasks 403
reset
notification option 415
toolbar 204
virtual machines 203
resource
change disk allocation 392
resource allocation
new virtual machine 243
resource settings
manually changing 387
resources
allocating hosts 194
change memory allocation 390
change network allocation 393
new task wizard 388
performance charts 462
virtual machine settings 161
restarting
guest operating system 203
VirtualCenter agent 121
VirtualCenter management server 119
resume
defined 492
run script 203
virtual machines 203
roles 22, 23, 24, 470, 471, 482
S
scheduled task 21, 35, 312
creating 397
deploying templates 302
information panel 434
migrating powered off virtual machine 223
migrating with VMotion 230
overview 396
power on or off virtual machine 206
properties 163
removing 404
rescheduling 403
scheduled tasks
cancel 405
script
notification option 415
SCSI
virtual disk 248
SCSI controller
configuring 358
SCSI device
configuring 351
SCSI drive
adding 371
SDK Package
requirements 42
security
GSX Server 478
users and groups settings 480
selecting objects 133
serial port
adding 377
configuring 360
server agent, See also VirtualCenter agent.
Server Farms 19
tabs 433
server options 159
service console messages 58
settings 158
hosts 197
new task wizard 388
SNMP 158
timing for task 397
users and groups 480
reset 204
suspend 204
tools
  VMware Tools 495
troubleshooting 54
U
uninstalling VirtualCenter 103, 106
unmanaged virtual machines
templates 274
unsupported partition 493
upload directory 27, 266, 269
  setting 156
USB
  configuring 366
USB controller
  adding 381
user interface 35
users
  access 470
  starting VirtualCenter 118
  Windows Active Directory 478
  Windows Domain Controller 478
V
viewing
  alarms tab 453
  charts 153
  events tab 452
  farms 447
  hosts tab 448
  lists 152
  objects 133
  permissions tab 454
  virtual machines 449
VirtualCenter events 410
viewing VirtualCenter Console 455
Virtual disk
  disk type 248
  specifying IDE 248
  specifying SCSI 248
virtual disk 248
  creating new virtual machine 242
  defined 493
  ESX Server 250
  GSX Server 248
  size 237
virtual disks
existing 252
new 248, 250
virtual hardware
  guest customization 52
Virtual machine
  log 57
virtual machine
  configuring hardware 348
  creating new 236
  defined 494
  existing disk 252
  general settings 383
  information panel 445
  installing guest operating system 258
  installing VMware Tools 260
  migrating manually 221
  migrating with VMotion 228
  migrating with VMotion manually 228
  modify power state response 384
  new virtual disk 242
  renaming 383
  resource allocating new virtual machine 243
  resources 161
  scheduling clone 312
  scheduling migrating with VMotion 230
  scheduling migration 223
  summary tab 445
VirtualCenter managed virtual machine requirements 44
Virtual Machine Administrator 22, 23, 471
virtual machine control panel 346
virtual machine groups 19
  adding 212
  moving virtual machines 212
  removing 213
  tabs 433
virtual machine name 239
virtual machine properties 162
  defined 494
Virtual Machine User 22, 23, 470
virtual machines 17, 27
  adding to VirtualCenter 200
advanced settings 385
change disk resource settings 392
change memory resource settings 390
change network resource settings 393
changing resource settings 387
cloning 307
configuring 345
creating 34
editing 34, 345
information panel 449
migration 218
migration with VMotion 217
power states 203
properties 162
removing 200
removing from disk 201
schedule power on or off 206
tab 431, 449
tabs 433
use as templates 269
Virtual SCSI adapter, BusLogic or LSI Logic 246
virtual sound adapter
adding 382
VirtualCenter Administrator 22, 24, 471
VirtualCenter agent
installation 75
restarting 121
VirtualCenter client 18, 35
configure firewall 129
installation 75
navigating 133
requirements 41
starting 124
window layout 140
VirtualCenter Console 455
VirtualCenter database 18
installation 75
requirements 41
VirtualCenter management agent 18
VirtualCenter management server 18
installation 75
licenses 127
licensing requirements 47
logging on 124
VirtualCenter server
verify started 119
VirtualCenter.PortNumber 159
vlance network driver 356
VMkernel
messages 58
warnings 58
VMotion 18
enabling 226
licenses 127
licensing requirements 47
migrating manually 228
migrating powered on virtual machine 228
migration 33
properties 160
requirements 48
scheduling migrating virtual machine 230
VMware Authorization Service
log 61
VMware Management Interface
log 56
VMware Open Source components 321
VMware Registration Service
log 56
VMware SDK
requirements 42
VMware Tools
defined 495
installing 260
VMware Virtual Machine Console 495
log 56
vmxnet network driver 356
virtual network component 356
W
Web Service
requirements 42
Windows
completing guest customization 342
customizing guest 327
Windows Active Directory 478
Windows Domain Controller 478
wizard
    new virtual machine 491
Workstation
    virtual machines as templates 269,
    273